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Preface
This book documents the AccuRev Graphical User Interface (GUI). It provides the content for the 
AccuRev context-sensitive help.

Audience
This document is intended for end users and administrators who use the AccuRev GUI in the performance 
of their jobs. It is not mean to be a tutorial—we assume that you have had some form of AccuRev training. 

See the AccuRev™ Installation and Release Notes for installation procedures and any late-breaking 
information about the current release.

Using This Book
The contents of this book are intended to be used as on-line help within the GUI. This book format is 
provided only as a convenience for users who wish to browse through the help outside of the AccuRev 
client. Because the content was developed as on-line help, the book is not designed to be read in a linear 
fashion. You will find that discussions tend to jump from topic to topic with little transition material easing 
the way between them. 

The chapters in this book are divided by functional areas:

Chapter Description

Overview of the On-Line Help Describes the AccuRev on-line help mechanism and its organization 
and features.

Using the AccuRev GUI Provides a high-level view of the AccuRev GUI.

The File Browser Describes in detail how to use AccuRev’s features to work with your 
files.

The StreamBrowser Describes in detail AccuRev’s unique stream architecture for 
organizing your work.

The History Browser Describes how to use AccuRev to view the past operations that 
have been performed on your files.

Diff, Merge, and Change Palette Explains how to view the differences between versions of your 
files, how to merge those differences, and how to use the 
AccuRev’s unique Change Palette to cross-promote elements to 
specific streams.

Security Describes features such as file locking, stream locking, access 
control lists (ACLs), and other ways of controlling accessing to 
your data.

AccuWork Describes AccuRev’s tightly integrated issue tracking feature.

Miscellaneous Error Displays Explains the messages that provide help buttons for more 
detailed information.
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Typographical Conventions
This book uses the following typographical conventions:

Contacting Technical Support
AccuRev offers a variety of options to meet your technical support needs. For complete information about 
AccuRev technical support services, visit our Web site:

http://www.accurev.com/support.html

License Issues
If you are having trouble with a license for your AccuRev product, visit the License Self Help page first to 
see if there is a solution for your problem:

http://www.accurev.com/support/license-self-help.html

Other Support Issues
To obtain technical support for an AccuRev product:

• Go to http://support.accurev.com/

• Or write AccuRev technical support at support@accurev.com

When you contact AccuRev technical support, please include the following information:

• The AccuRev version 

• The operating system

• If you are using an AccuBridge™ product:

• The AccuBridge version

• The version of the system used by the AccuBridge (JIRA or Rally, for example)

Support and Troubleshooting Explains how to contact AccuRev Customer Support, provides 
discussions of some commonly-encountered issues, and also 
describes how to configure various web browsers to work with 
AccuRev on-line help.

Convention Description

blue sanserif Used for sample code or output.

red monospace Used for examples.

bold Used for command names, and button names in the AccuRev GUI

light italic Used for emphasis, book titles, and for first use of important terms

blue italic Identifies a hyperlink (to a page or Web URL, for example)

Chapter Description

http://www.accurev.com/support.html
http://www.accurev.com/support/license-self-help.html
http://support.accurev.com/
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• A brief description of the problem you are experiencing. Be sure to include which AccuRev interface 
you were using (Web user interface, AccuRev GUI, or CLI), any error messages you received, what 
you were doing when the error occurred, whether the problem is reproducible, and so on.

• A description of any attempts you have made to resolve the issue, including using the resources 
described in Other Resources.

• A simple assessment of how the issue affects your organization.

Other Resources
In addition to contacting AccuRev technical support, consider taking advantage of the following resources:

• AccuRev Known Problems and Solutions – http://www.accurev.com/support/kps.html

The AccuRev Known Problems and Solutions page describes known problems in released versions of 
AccuRev products.

• AccuRev User Forum – http://www.accurev.com/ubbthreads/

The AccuRev User Forum is a valuable resource. In addition to access to AccuRev’s international user 
community, the User Forum is the place to go for resources like:

• The AccuRev knowledge base

• The AccuRev FAQ

Register as a User Forum member today.

• AccuRev documentation – http://www.accurev.com/documentation.html

This page provides access to AccuRev product documentation for all current and previous releases of 
most AccuRev products.

http://www.accurev.com/support/kps.html
http://www.accurev.com/ubbthreads/
http://www.accurev.com/documentation.html
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1. Overview of the On-Line Help
This document contains all of the information available in the AccuRev Graphical User Interface (GUI) 
on-line help. When you click on a Help button in AccuRev, you will be taken to a page somewhere within 
this book.

This chapter provides a quick overview of the AccuRev Help mechanism. The help system was upgraded 
in AccuRev Release 5.2, so there is information here of interest for users who are familiar with the older 
help system found in releases prior to 5.2. 

If You Are a New AccuRev User
The AccuRev GUI provides extensive documentation in the form of a context-sensitive help system. This 
help not only covers the AccuRev GUI, but also provides access to the complete AccuRev documentation 
set, in both HTML and PDF format. The help can be invoked from the AccuRev Help menu or from the 

Help  button on the toolbar anywhere in the AccuRev GUI.

If you click on Help > Help Contents & Manuals, AccuRev opens a browser that includes a navigation 
pane, containing Contents (TOC), Index, and Search tabs.

If you click on a Help button, or click on the Help menu option for “This Screen”, AccuRev displays 
context-sensitive help focused on the topic of interest. In this case, the navigation pane is collapsed to save 
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screen space, but it can be displayed by clicking on the Show Navigation  button in the upper-left 
corner of the display. 

Note: Once the Navigation pane has been opened, it cannot be closed, but you can click and drag its 
right border toward the left and make it almost zero width.

All documentation is provided in both HTML and PDF. Typically you search or browse to the information 
you need in the HTML. If you decide you want to view the PDF version of the current document, you click 

the PDF button  in the upper-right of the Help window.

If You Are Upgrading From a Previous AccuRev 
Version
If you have used the AccuRev GUI on-line help in releases previous to 5.2, you will notice a number of 
differences. If you have used recent versions of the AccuRev Web UI, or the “manuals” help that was 
introduced AccuRev Releases 4.9 and 5.1, you might recognize some of the features, and notice that all 
AccuRev help has now been standardized on a single platform.

What has Changed? And Why?
The new on-line help allows us to respond to several customer requests:
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• We have brought back a PDF version of the GUI Help documentation, which was removed from the 
doc set several releases ago. This PDF, named the AccuRev On-Line Help Guide, is now a standard 
part of the AccuRev documentation set, just like the Administrator’s Guide or the CLI User’s Guide.

• The entire document set (except for AccuBridge, WebUI Help, and Release Note documents) are now 
packaged together with the on-line help, and can be searched and viewed with a single mechanism. 
The Contents and Index from all documents are now available from tabs displayed in the help window 
navigation pane. If you want to find all references to “Change Packages”, you can enter this query in 
the Search tab, and find all references to this term across all six of the books in the documentation set. 
(And the results are weighted with a “relevance score”, so you avoid wasting time looking at relatively 
minor references). If you use a browser that accepts cookies from a local file system, you will also see 
a Favorites tab in the navigation page, which allows you to store links to frequently-accessed topics.

• We can now provide cross-links between the on-line help and the doc set, so if a help discussion refers 
to a chapter in the Administrator’s Guide, you can click on a link and be taken directly to that 
discussion.

Since the new Help system is now based on the same document source as the rest of the documentation set, 
it is easier for us to share content between documents, and to consolidate rendundant sections. Expect the 
documentation to undergo constant reorganization and improvement in future releases.

What About the PDFs?
The new help system provides both HTML and PDF versions of all documents. Whenever you have an 
AccuRev help window open, you can access the PDF for the currently displayed document by clicking the 

PDF button  in the upper-right of the Help window. 

To achieve this integration, the help system installs its PDFs in document-specific subfolders on the client 
machine, such as <accurev_install>/doc/WebHelp/AccuRev_Admin/AccuRev_Admin.pdf, 
<accurev_install>/doc/manual_help/AccuRev_User_CLI/AccuRev_User_CLI.pdf, etc.

However, long time users of AccuRev are accustomed to finding all AccuRev documentation PDFs at 
<accurev_install>/doc. We heard from Release 4.9 users that the new, nested folders were too hard to 
access, so we now also provide a copy of the PDFs (including the new On-Line Help Guide) in the 
traditional <accurev_install>/doc directory.

Also, Windows users who are acccustomed to having direct access to the PDFs through the Start -> 
AccuRev menu will find that this avenue is still available.

How Do I Access the Help Without Starting the 
Client?
Many AccuRev users like to access the documentation without necessarily starting the AccuRev client. 
This is easy: make a new bookmark in your browser to <accurev_install>/doc/WebHelp/
AccuRevHelp.htm
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How Do I Configure My Browser to Work With the 
New Help?
As browsers have matured, they have often added tighter security requirements with new releases. Since 
the AccuRev help is based on Javascript, and is accessed from a local file system rather than through a web 
server, you may need to configure the security settings on your preferred browser to display the help. If the 
AccuRev help fails to display properly the first time you try to use it, please see Configuring a Web 
Browser to View Help Topics in Appendix C Support and Troubleshooting for more details, and check the 
Release Notes for any late-breaking changes.
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2. Using the AccuRev GUI
This chapter describes the basics of using the AccuRev GUI.

Mechanics of the AccuRev GUI
The following sections discuss overall aspects of the AccuRev GUI display and user interface.

Starting the GUI
You can start the AccuRev GUI from the desktop (Windows only) or from a command shell:

• On the Windows desktop, double-click the  AccuRev icon. There is also an AccuRev group in 
the Start > Programs menu.

• In a command shell, use the acgui command:

> acgui     (Windows)
> acgui &   (UNIX) 

The way the GUI window initially appears varies. It might be blank, or it might open one or more tabs, 
displaying your work from the preceding GUI session. The AccuRev GUI reopens:

• The File Browser tabs, each displaying the contents of an individual workspace or stream.

• The StreamBrowser tabs, each displaying the hierarchy of streams, snapshots, and workspaces for 
a particular depot.

• The AccuWork tabs, each showing the set of AccuWork queries defined for a particular depot (and, 
if you've defined a default query, its results).

The Multiple-Tab Display
The AccuRev GUI window uses multiple tabs to enable you to switch quickly among several activities.

For example, you might wish to switch among:

• Viewing the contents of your main workspace, using the File Browser. 

• Viewing some or all the versions of a particular file, using the Version Browser.

• Viewing a list of all depots in the AccuRev repository.

• Viewing the streams in a particular depot, using the StreamBrowser.
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Organizing Tabs
By default, AccuRev displays tabs in a single row. When the number of tabs exceeds the available space to 
display them, AccuRev adds a scroll button that provides access to tabs that are not currently visible:

If you prefer, you can set a preference so that AccuRev displays the tabs in as many rows as needed. See 
Tab Layout on page 43 for more information.

Closing Tabs
At any time, you can "clean up" by closing one or more of the tabs in either of these ways:

• Right-click on a tab control to display its context menu, then select Close, Close Others, 
or Close All.

• Click the "X" icon on the tab control.

Cloning Tabs
The AccuRev GUI assumes that you want to avoid having multiple tabs with the same contents. So, for 
example, if there's already a File Browser tab on workspace brass_mnt_john and you execute an Open 
Workspace command on the same workspace, the GUI simply brings the existing tab to the front.

If you do want to have two or more tabs showing the same data structure, use the File > Clone Tab 
command (or choose Clone Tab from the tab context menu). Cloned tabs enable you, for example, to work 
in two different parts of a large stream hierarchy (two StreamBrowser tabs), or to work in two different 
folders of a workspace (two File Browser tabs).

Note: The History Browser, Version Browser, and Stream Version Browser do not support 
tab-cloning .

Refreshing Tabs
The data displayed on a GUI tab can become out of date as a result of your work on other GUI tabs, your 
work using the AccuRev CLI, and/or other users' work. AccuRev displays a "refresh" icon next to the tab 
title if it determines that the tab's data may be out of date.

The command View > Refresh (or function key F5, or the main GUI menu toolbar Refresh icon) updates a 
tab's data. You can configure the GUI to refresh tab data automatically whenever you switch tabs: invoke 
the command Tools > Preferences, and clear the Require Manual Refresh checkbox.



AccuRev®  On-Line Help Guide 7

Current User, Depot, and Workspace
With a few exceptions, you must be logged in (See “The Login Command” on page 36.) as a particular 
AccuRev user in order to execute AccuRev commands. An indicator in the lower left corner of the GUI 
window shows the current user (the one who is currently logged in).

Typically, the AccuRev repository is organized into multiple depots. For example, there might be separate 
depots for the development, testing, and documentation groups. Most GUI tabs display the data from one 
particular depot. When you're using a particular tab, the associated depot is termed the current depot. Its 
name is displayed at the bottom of the GUI window.

Many tabs have a current workspace context: the workspace that is the source of (or the possible 
destination of) the data that the tab displays. The name of the current workspace is displayed at the bottom 
of the GUI window, along with the pathname of its workspace tree.

Keyboard Accelerators
In a dialog box, you can "press" buttons using Alt key sequences, such as Alt-C for Cancel. The Esc key 
also performs a Cancel operation in any dialog box.

In some dialog boxes, you don't even need to use the Alt key when invoking a keyboard accelerator: In a 
"Yes/No" dialog box, you can type Y or N (either uppercase or lowercase). In a message or confirmation 
box (no input field), you can indicate Ok by typing O (either uppercase or lowercase), or by pressing 
Enter.

Many commands can be invoked with a keyboard accelerator, without opening any menu at all. The 
accelerators for such commands are listed on the menu itself. Keyboard accelerators for frequently 
performed commands are summarized in the following table.

Command Keyboard Accelerator Availability

Update Ctrl+U File Browser

Add Ctrl+Shift+A  File Browser
 Default Group

Keep Ctrl+K  File Browser
 Default Group

Promote Ctrl+Shift+P  File Browser
 Default Group

Merge Ctrl+M  File Browser
 Default Group

Element Permissions Ctrl+E  File Browser
 Default Group
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Integration with the AccuRev Web UI
In addition to the AccuRev GUI described in this document, AccuRev also provides a Web User Interface 
(Web UI) which gives users access to many non-filesystem-based AccuRev features from any supported 
web browser. The Web UI server must be installed and configured by an AccuRev administrator, who will 
provide AccuRev users with a web address through which they can access the Web UI functionality.

Defunct Ctrl+T  File Browser
 Default Group

Diff Against
 Most Recent Version
 Backed Version
 Basis Version
 Overlapping Changes (Mine)
 Overlapping Changes (Theirs)
 File in Other Stream
 File on Disk

 Ctrl+Shift+D
 Ctrl+D
 Ctrl+Shift+B
 Ctrl+Shift+M
 Ctrl+Shift+T
 Ctrl+Shift+O
 Ctrl+Shift+F

 File Browser
 Default Group

Revert to 
 Most Recent
 Backed

 Ctrl+R
 Ctrl+Shift+R

 File Browser
 Default Group

History
 Show History
 Browse Versions
 Browse Stream Versions

 Ctrl+H
 Ctrl+Shift+H
 Ctrl+Shift+Alt+H

 File Browser
 Default Group

Go to
 Previous diff
 Next diff
 First diff
 Last diff

 Ctrl+
 Ctrl+
 Ctrl+Shift+
 Ctrl+Shift+

Diff/Merge view

Search Ctrl+F  File Browser
 Diff/Merge view

Cut Ctrl+X Text fields and some tables

Copy Ctrl+C Text fields and some tables

Paste Ctrl+V Text fields and some tables

Select All Ctrl+A Text fields and some tables

Save Ctrl+S Diff/Merge views

Print Ctrl+P Tables in all views

Command Keyboard Accelerator Availability
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Once configured, the Web UI can be easily accessed from the AccuRev GUI via two buttons on the main 
menu bar:

Open in Web

When you click this button, the current view will be opened in a web browser.

Copy URL to Clipboard

Stores a URL that you can use to bring up the current view in a web browser. This is useful if you 
would like to share the current view with another user. Use keyboard sequence CTRL-V, or an 
application “paste” command to retrieve the text from the clipboard. (For example, Windows users 
might open Notepad, and use the Edit>Paste command to enter the URL into the open document.)

Also, the Web UI will automatically come up when you access an AccuWork issue if any of the following 
three conditions is true:

• If the AccuRev administrator has configured the site to view issues only in the Web UI (see 
Configuring the Web User Interface (Web UI) on page 25 of the AccuRev Administrator’s Giude).

• If you have set your local preferences to view issues only in the Web UI (see AccuRev Preferences  
(Tools > Preferences Command) on page 41).

There are certain views that cannot be opened from the AccuRev GUI in the Web UI. For example, 
manipulation of files in a local file system cannot be performed from a web browser for security reasons, 
so while you can get a File Browser web view of a dynamic stream, you cannot bring up a File Browser 
web view of your workspace. In these cases, you will see the message “URL not available for this view” 
when you try to use these buttons.

Note: For these features to function, the AccuRev Web UI server must have been installed and configured 
with your AccuRev server. If your web browser or clipboard show a URL containing the string “null” (for 
example, null/stream/1/?view=sb), the AccuRev Web UI server is not available. Information about 
installing and configuring the AccuRev Web UI server is available to AccuRev administrators in the 
AccuRev Installation and Release Notes, the AccuRev Web Interface Installation and Release Notes, and 
the AccuRev Administrator’s Guide.

While some features that are available in the AccuRev GUI are not available in the Web UI, other features, 
such as Bulk Update for AccuWork issues, are available only in the Web UI. 

Find, Search, and Filter Features
The AccuRev GUI provides several ways to locate and filter information:

• To display elements with specific statuses, see Working in the Searches Pane on page 59.

• To limit the number of streams displayed in the StreamBrowser, see Filtering Streams, Snapshots, 
and Workspaces on page 141 and Using Stream Favorites on page 151.

• To search for elements by name in your Workspace, see Searching by Element Name on page 64.

• To find streams by name in the StreamBrowser, seeFind Stream on page 160.

• To filter the results of the “find streams by name” and “search for elements by name” features, see 
Displaying and Filtering Stream Find Results on page 161 and Filtering Your Search Results on 
page 65.
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• To filter the results of various list dialogs, such as the Choose Depot dialog (see Filter Results on 
page 15).

Working with Tables
In many contexts, the AccuRev GUI displays data in the form of a rows-and-columns table.

Example: File Browser's Details pane

Example: Workspaces tab

The AccuRev GUI often presents information in the form of a table, with multiple rows and multiple 
columns. You can adjust all such tables, to maximize their usefulness, as described in the following 
sections.
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Adjusting the Widths and Order of Columns
In any table, you can adjust columns widths and change the column order as follows:

• To resize the columns, click and drag the column separators.

• Double-clicking the column separator to a column's right resizes the column to exactly fit its 
longest value.

• To rearrange the columns, click and drag the column headers.

Sorting the Rows of a Table
Initially, the rows of a table are sorted on one column (single-column mode). A direction icon in the 
header for that column indicates whether the sort is lowest-to-highest or highest-to-lowest.

Note: In the Details pane of the File Browser (and any other table that lists file names and directory 
names in the same column), a lowest-to-highest sort places all directories before all files; a highest-to-
lowest sort places all files before all directories. 

Left-click on any column header to continue in this mode:

• Click on the current sort column to reverse the sort order.

• Click on another column to make it the sort column.

 You can switch at any time to multiple-columns mode, in which you define a primary sort column, a 
secondary sort column, and so on. Right-click any column header to switch sort modes.
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A "1" appears next to the direction icon in the current sort column, indicating that this is now the primary 
sort column.

Click another column to make it the secondary sort column. A direction icon annotated with "2" appears in 
this column, and the rows are reordered according to the two-level sort. Continue in this way to define 
additional sort levels.

In multiple columns mode, you can:

• Left-click on any column header without a direction icon: this defines an additional sort level, 
using that column.

• Left-click on any column header that already has a direction icon: this reverses the sort order at 
that sort level.

• Left-click on any sort column's level number (1, 2, etc.) to change the sort level of that column.

The table's rows are resorted automatically each time you perform any of these actions.

Using the Keyboard to Navigate through a Table
The keyboard's navigation keys -- up-arrow, down-arrow, PgUp, PgDn, Ctrl-PgUp, Ctrl-PgDn --move a 
table's selection highlight in the expected way. In addition, you can navigate by typing any alphanumeric 
character; this moves the selection highlight to the next row whose entry in the (primary) sort column 
begins with that character.

Printing Tables
You can print tables in views throughout the AccuRev GUI by choosing File > Print from the AccuRev 
menu or by typing Ctrl+P. You cannot print tables that appear in dialog boxes.

What Gets Printed
When you print a table, AccuRev prints the table headings and table contents for every column and row in 
the table. Column widths and sort order are preserved; you might want to adjust the width of a table’s 
columns or change the sort order before you print. Printed pages include a footer that displays the date the 
table was printed and a page number. If you are printing a table of query results, the query name is printed 
at the top of each page.

Note that AccuRev prints a table’s entire contents, even if only a portion of it is visible online. For 
example, if a query returns 65 records, the printed table includes all 65 records, even if only 30 are visible 
at a time. Similarly, some tables in AccuRev and AccuWork use a single line per row and display ellipses 
(...) for columns that are not wide enough to display their full contents. Printed tables are not limited to one 
line per row, and AccuRev wraps column contents, if necessary, when printing the table.
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Previewing What You Print
When you print a table, AccuRev displays a preview window that lets you see what the printed page will 
look like. 

The preview window provides several settings that give you additional control over the output, as 
summarized in the following table.

How to Print a Table
To print a table:

1. Display the table you want to print.

2. Choose File > Print from the AccuRev menu, or type Ctrl+P.

Setting Description

Orientation Lets you choose between Portrait and Landscape layout. Portrait is the default.

Tip: Try changing the orientation to Landscape to fit more columns on a single page.

Scaling Lets you specify whether you want:
 All table columns printed on the same page (Fit to 1 page)
 The scale of the table to determine how many columns fit on a single page

By default, the Scaling setting is set to 100%, which provides good readability.

Tip: Use a larger scale for bigger type.
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AccuRev displays the Print Preview window.

3. Optionally, use the preview settings to adjust the output. See Previewing What You Print on page 13 if 
you need help with this step.

Tip: If using the preview settings does not provide the output you expect, click the Close Preview but-
ton and make adjustments on the source table (resizing or adding/dropping columns, for example).

4. When you are satisfied with the output displayed in the Print Preview window, click the Print button 

( ).

AccuRev displays the familiar Print dialog box, an example of which is shown here.

You use the fields on the Print dialog box to specify characteristics of the print job (specifying a 
printer, the number of pages you want to print, and so on). 

5. Change any print job settings as needed and click Print to print the table.

Choosing a Depot to be Used for a Command
In many situations, AccuRev must execute a command in the context of a particular depot. In many cases, 
it selects the depot context automatically. In other cases, it prompts you to select a depot from a list of all 
the depots in the AccuRev repository.

Using the Choose Depot Dialog
The depot names are initially sorted alphabetically (A-Z). You can click the Name header to reverse the 
sort order (Z-A).Choose a depot in either of these ways:

• Select a depot name and click Ok.

• Double-click a depot name.
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Filter Results
Optionally, use the filter field at the top of the dialog to narrow down your results. If only one element 
remains, AccuRev automatically selects it.

Choosing a Stream to be Used for a Command
In some situations, AccuRev prompts you to select a stream from a list of all the streams in a particular 
depot. If you have set a Stream Favorite, not all streams appear in this dialog. See Using Stream Favorites 
on page 151 for more information.

Using the Choose Stream Dialog
The stream names are initially sorted alphabetically (A-Z). You can click the Name header to reverse the 
sort order (Z-A).

Choose a stream in any of these ways:

• Select a stream name and click Ok.

• Double-click a stream name.

The File Chooser Dialog
In many contexts, AccuRev prompts you to specify a location in your machine's local disk storage.
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In each context where you choose a file for input or output, AccuRev suggests the directory you most 
recently used in that context (or defaults to your home directory).

Where appropriate — for example, in specifying attachments to an issue record — you can specify 
multiple files at the same time using the standard multiple-selection mechanism: hold down the CTRL key 
while selecting the items .

In some contexts in which you specify a file (or other data structure) to be created, the dialog includes a    
New Folder button. This enables you to create a new directory 'on the fly' in which to create the data 
structure.

AccuWork Export File Types
The AccuWork Export and Export Table commands create a file from the contents of one or more issue 
records. In these contexts, the export file must have one of these formats, which you choose from the File 
Type listbox:

HTML

Standard Web-page format. On Windows machines, AccuWork automatically invokes your 
default web browser, to display the export file.

The contents of the issue record are rendered as one or more HTML tables. In a web browser, each 
table cell changes height and width when you adjust the size of the browser window. This is 
particularly useful for viewing the contents of multiple-line text fields.

XML

A more highly structured document, suitable for data interchange. Many web browsers can display 
XML documents. 

Note: The XML-format file does not include a DTD or Schema.



AccuRev®  On-Line Help Guide 17

CSV

("comma-separated values") A line-by-line text format, suitable for importing into various 
applications. On Windows machines, AccuWork automatically attempts to invoke Microsoft 
Excel, to display the export file.

User-Specified Names for AccuRev Entities
AccuRev deals with many kinds of named entities: files, directories, pathnames, depots, users, 
and so on. The table below details the restrictions on user-defined names for the various entities. 
Note that all names are case-sensitive; for example, user john is not the same as user John.

Note: In the table below, “characters” means NON-NULL characters. Do not subtract 1 to 
account for the terminating NUL.

The GUI Main Toolbar
The main toolbar gives you quick access to commonly used features:

From left to right, the icons are:

Open Workspace

See: Opening a Workspaces Tab on page 27

Kind
Maximum Name 

Length
Characters Allowed in 

Name
Character Restrictions

depot
stream
snapshot
workspace
reference tree

79 A-Z,a-z,0-9
- _ . + @ SPACE 

cannot begin with a digit or with "."

user
group

99 same as above must begin with a letter

password 19 any none (caution: this means that special 
characters, such as BACKSPACE are valid 
password characters)

pathname of slice
(of a depot or 
replica)

255 name validation performed 
by the operating system

applied by the operating system

pathname of 
workspace
pathname of 
reference tree

127 name validation performed 
by the operating system

applied by the operating system

segment 
(between slashes) 
of element 
pathname

255 name validation performed 
by the operating system

applied by the operating system



18 AccuRev®  On-Line Help Guide

View Streams

See: Opening a StreamBrowser Tab on page 137

View Issue Queries, Create Issue, Open Issue

See: The AccuWork Queries Tab on page 303, and The Edit Form Tab on page 287

Refresh

See: Refreshing Tabs on page 6

Help

See: Overview of the On-Line Help on page 1

The GUI Main Menu
The following sections describe the menus found along the toolbar of the GUI display.

The File Menu

The New Depot Command
The New Depot command creates a new depot in the AccuRev repository.

Invoking the New Depot Command
You can invoke the New Depot command in any of these ways:

• Choose File > New > Depot from the GUI main menu.

• Choose Admin > Depots from the GUI main menu to open a Depots tab (See “The Depots Tab” on 
page 46.). Then click the New button.

Using the New Depot Dialog
The New Depot dialog includes basic options (always visible) and advanced options (visibility controlled 
by a Basic/Advanced button).
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Basic Options
Depot Name

No two depots in the same AccuRev repository can have the same name. See User-Specified 
Names for AccuRev Entities on page 17.

Note: Reusing a depot name

This can be done—but it's risky (it cannot be undone) and it takes some work. You must first 
remove the existing depot with the desired name from the repository. For details, see "Removing a 
Depot from the AccuRev Repository" in the AccuRev Administrator's Guide.

Advanced Options
Physical location ...

The location you choose here must be on a hard drive on the machine where the AccuRev Server 
process runs. Be sure that the location does not overlap the location of any other depot, or any 
AccuRev workspace or reference tree. See User-Specified Names for AccuRev Entities on page 17.

If you do not specify a physical location, the new depot is placed under directory storage/depots 
within the AccuRev installation area.

A depot’s physical location is said to be a slice of the overall AccuRev repository . To change the 
location of an existing depot, use the CLI command chslice.

Files should be case ...

Note: We strongly recommend that you make your depots case-insensitive, for compatibility with 
Microsoft Windows. Some Windows applications can change the case of a filename without informing 
you; if your depot is case-sensitive, the file appears to be renamed.

All depots store names of files and directories exactly as they are originally entered (e.g. 
WidgetGetCount or cmdListAll). Likewise, AccuRev client programs display these names exactly 
as they were originally entered. The difference is that:
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• A case-sensitive depot allows users to create two objects in the same directory, with names 
that differ only in their case (e.g. makefile and Makefile).

• A case-insensitive depot (default) does not allow two objects in the same directory to have 
names that differ only in their case.

A depot’s case-sensitivity can be changed with the CLI chdepot command, as follows:

You can always change a depot’s case from insensitive to sensitive.

You can only change from sensitive to insensitive if the depot contains no elements.

See chdepot in the AccuRev CLI User’s Guide for more information.

Exclusive locking

Selecting the exclusive file locking option causes all workspaces created for this depot to use 
AccuRev exclusive file locking.

See File Locking on page 271.

The New Workspace Command
The New Workspace command creates a workspace, with a particular stream in a particular depot as its 
backing stream. The workspace can subsequently be reparented to another stream in the same depot.

Invoking the New Workspace Command
You can invoke the New Workspace command in a number of ways:

• Choose File > New > Workspace from the GUI main menu.

• In an  Open Workspace dialog, click the New button. 

Note: To open this dialog, select File > Open Workspace from the GUI main menu, or click the  
button on the GUI main toolbar.

• Choose  New Workspace from the context menu of a stream or snapshot in the StreamBrowser.

Using the New Workspace Wizard
AccuRev prompts you to specify the settings for the new workspace with a multiple-screen "wizard".

The New Workspace Command: Screen 1 of 3—
Specifying the Depot and Backing Stream

With the File > New > Workspace command, there may be no "current stream" context. In this case, 
AccuRev starts with this screen, prompting you to specify a stream context:

Video Tip Click this link to view an introductory video on creating a workspace.

http://www.accurev.com/sites/default/files/videos/55-training-doclinks/dev_Access_Existing_Project_Source.wmv
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Depot

Select one of the repository's depots. This populates the Basis Stream listbox with the streams 
(and optionally, snapshots) of the specified depot.

Basis Stream

Select a stream or snapshot, to act as the backing stream for the new workspace.

Note: Is it advisable to base a workspace on a snapshot?

You can create new versions in a workspace based on a snapshot. But you won't be able to 
promote those versions to the snapshot (which is immutable, and so can't "accept" new versions). 
To get one or more of the versions out of the workspace, you can:

• Reparent the workspace to a dynamic stream, then promote the versions you've created in the 
workspace.

• Using the File Browser in another workspace, open one of the version tools on a particular 
element. Then use the Send to Workspace (See “The Send to Workspace Command” on 
page 129.) command to get the version that was created in the snapshot-based workspace.
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The New Workspace Command: Screen 2 of 3—
Choosing a Name and Location for the Workspace)

Name of Workspace to Create

No two workspaces in the same AccuRev repository can have the same name, even if they are in 
different depots. Moreover, streams, snapshots, workspaces, and reference trees all share the same 
namespace: no two of them can have the same name. SeeUser-Specified Names for AccuRev 
Entities on page 17.

A workspace name always ends with a username suffix. For example, if your username is akp and 
you specify thorn_dvt as the workspace name, AccuRev creates a workspace named 
thorn_dvt_akp.

Notes:

Can I type in the username suffix myself?

Yes. If your username is akp and you enter a workspace name that ends with _akp, AccuRev 
doesn't change the name before creating the workspace.

Can I type in someone else's username suffix?

No, you cannot create a workspace for some other user in this way (or in any other way). If your 
username is akp and you enter the workspace name thorn_dvt_john, AccuRev creates a work-
space named thorn_dvt_john_akp.
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Location

You can specify any location in the client machine’s file system for the new workspace tree. You 
can also create a workspace tree on a remote machine’s disk, as long as that location is accessible 
on your machine. Access controls imposed by the operating system and/or network file system 
may restrict where you can create a workspace. See User-Specified Names for AccuRev Entities on 
page 17.

Here are some guidelines for using the Append workspace name to its location checkbox:

• If you are creating a new, empty workspace, enter the name of an existing directory (or 
Browse to it) and check the checkbox.

• If you are declaring that AccuRev should consider an existing directory to be a workspace, 
enter that directory's pathname and clear the checkbox.

In any case, make sure the Workspace will be created at value is correct before leaving this wizard 
screen.

Notes:

• Don’t create a workspace within the AccuRev installation area — typically, C:\Program 
Files\AccuRev (Windows) or /opt/accurev (UNIX/Linux).

• Don’t create a workspace within another workspace.

• Don't cross a physical file system boundary, whether local or remote. (For example: If you 
create a workspace at location /opt/workspaces/derek, an error occurs if a remote file 
system is mounted at /opt/workspaces/derek/src .)
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The New Workspace Command: Screen 3 of 3—
Configuring the Workspace)

Type of File Locking

This setting controls whether development in this workspace uses serial or parallel methodology. 
If you choose parallel development, you may still be restricted to using serial development on 
certain files; AccuRev supports locks on individual file elements. (See File Locking on page 271.)

None (parallel development): The version-controlled files in the workspace tree are writable at 
any time. There is no need to perform an anchor operation on a file before beginning to work on it.

Anchor Required: Each version-controlled file in the workspace tree is read-only until you use 
the Anchor command to make it writable. This also makes the file active in the workspace.

Note: The Anchor command makes the version currently in the workspace.

Exclusive Lock: Like Anchor Required, and also causes AccuRev to prevent users in sibling 
workspaces from working on the same file concurrently. (See File Locking on page 271.)

Initial Contents

Same as Basis stream For each element, AccuRev copies the current version in the backing 
stream to the workspace tree. If no version of an element currently appears in the backing stream, 
it won't appear in the new workspace, either.

Pick and choose from Basis stream: AccuRev doesn't copy any files to the workspace tree. To 
begin working in the workspace, use the File Browser's Include/Exclude facility to configure the 
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set of elements to appear in the workspace. (Using the File Browser's Include/Exclude Mode on 
page 98.)

EOL (Text-file line terminators)

Whenever AccuRev copies a version of a text file from the repository to the workspace tree, it uses 
the line terminator you configure here.

Platform EOL: Use the line terminator for the operating system on the machine where the 
AccuRev GUI is running.

Always use Windows EOL: Use the sequence CR-LF (hex 0C-0A) as the line terminator.

Always use UNIX EOL: Use NL (hex 0A) as the line terminator.

The New Stream and Change Stream Commands
(Stream Configuration dialog)
The New Stream and Change Stream commands open a dialog in which you specify/revise the 
configuration of a new/existing stream.

Invoking the Command
In the StreamBrowser, right-click a stream to select it and display its context menu. Then,

• Choose New Stream from the context menu to create a new stream below the selected stream.

• Choose Change Stream from the context menu to revise the configuration of the selected stream.

Using the New Stream / Change Stream Dialog
Enter or revise the following specifications, then click Ok.
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Name

No two streams in the same AccuRev repository can have the same name, even if they are in 
different depots. See User-Specified Names for AccuRev Entities on page 17.

Basis

The parent stream of the stream you are reconfiguring. Changing this entry reparents the stream 
when you click Ok.

In a New Stream dialog, this field is not editable, because you selected the parent stream when you 
invoked the command.

Stream Type

The type of the stream:

• Dynamic stream

• Snapshot 

Note: Selecting Snapshot is equivalent to invoking the command New Snapshot instead of New 
Stream.

• Pass-through stream

In a Change Stream dialog, this field is not editable. You cannot change the type of an existing 
stream.

Date & Time

By default, a stream inherits the versions currently in its parent stream . If you assign a basis time 
to a stream, it inherits the versions that were in the parent stream at a specified point in time.

None

(disabled for New Snapshot or if you select Snapshot as the stream type) No basis time; in the 
future, the stream will inherit the versions currently in its parent stream .

Now

The stream or snapshot will contain the versions that were in its parent stream at the time you 
clicked Ok in this dialog.

As of transaction #

Enter an integer transaction number. The stream or snapshot will contain the versions that were in 
its parent stream at the time the specified transaction was created.

Specified

Enter a specific time. The stream or snapshot will contain the versions that were in its parent 
stream at the specified time.

You can fill in the individual subfields manually, or use the  Select Date button to display 
choices ("2 days ago", etc.) that fill in the subfields automatically. Once these subfields are filled 
in, you can revise them individually or by clicking the Select Date button again.

Note: 

1. Dynamic stream with basis time vs. Snapshot
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Setting a basis time on a stream does make it like a snapshot of its parent stream -- initially. But after 
that, new versions can be promoted to such a "time-based stream" from child workspaces and from 
other streams; you cannot promote new versions to a snapshot. Since you can change the basis time of 
a time-based stream as often as you wish, it can serve as a "moving snapshot" of its parent stream.

2. Another way to control which versions are inherited from the parent stream

The basis-time facility includes versions based on when they were created. The include/exclude facil-
ity includes elements based on their pathnames.

The Workspaces Tab / The Open Workspace Dialog
The Workspaces tab displays summary information on some or all of the workspaces in the AccuRev 
repository.

The Open Workspace dialog, a slight variant of the Workspaces tab, makes it easy to open a  File Browser 
tab on a selected workspace.

From either one, you can create a new workspace.

Opening a Workspaces Tab
Choose View > Workspaces from the GUI main menu.

Invoking the Open Workspaces Command

Choose File > Open Workspace from the GUI main menu, or click the  button in the GUI main toolbar.

Workspaces Tab Layout
The Workspaces tab contains a table with these columns:

User

(appears if Show all workspaces is checked) The user who owns the workspace.
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Status

(appears if Include deactivated trees is checked) Active indicates that the workspace is available 
for use. Inactive indicates that the workspace is currently deactivated. Inactive workspaces can be 
reactivated. See the Remove and Reactivate commands below.

Name

The simple name of the workspace, including the suffix that indicates the user who owns the 
workspace.

Location

The pathname of the workspace tree on the machine where it resides.

Host

The name or IP address of the machine where the workspace tree resides.

Stream#

The integer stream-ID of the workspace. This number is unique with the workspace's depot only, 
not across the entire repository.

Note: More precisely, this integer identifies the private workspace stream that is an integral part of the 
workspace. A depot's streams, snapshots, and workspaces share the same "pool" of stream-IDs.

Target Transaction

(appears if Show details is checked) The depot's transaction level at the time the Update command 
was most recently invoked on the workspace. Update attempts to load versions created in 
transactions up to and including the target transaction. If the Target Transaction and Update 
Level are the same, the workspace's most recent update completed successfully.

Update Level

(appears if Show details is checked) The highest-numbered transaction whose versions have been 
copied to the workspace in an update.

Type

(appears if Show details is checked) An integer that indicates the type of workspace stream: 1 
(standard workspace), 9 (exclusive-file-locking), or 17 (anchor-required).

EOL

(appears if Show details  is checked) The type of line terminator used when an update copies text-
file versions to the workspace tree: Auto (line terminator used by the host machine's OS), UNIX 
(NL), or Windows (CR-LF).

Working in a Workspaces Tab
You can apply filters to control the amount of data displayed in the workspaces table, and you can perform 
a number of operations on a selected workspace.

See also:

Working with Tables on page 10.
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Controlling Which Workspaces are Displayed
Include deactivated trees

If checked, the table includes workspaces that have been deactivated with the Remove command. 
This also adds a Status column; deactivated workspaces have Inactive status, and are shaded.

Show all workspaces

If checked, the table includes workspaces created by all users. This also adds a User column.

If cleared, the table includes your workspaces only.

Controlling the Data Displayed for Each Workspace
Show details

If checked, the table includes these columns: Target Transaction, Update Level, Type, and 
EOL.

Operating on a Selected Workspace
You can choose any of the following commands from the context menu of a selected workspace:

Open (Workspaces tab)

Ok (Open Workspace dialog)

Using a File Browser tab, display the entire contents of the workspace.

Edit

Modify the configuration of the workspace.

Reactivate

Bring back into active service a workspace that was previously deactivated with the Remove 
command.

Remove
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Deactivate a workspace. The workspace cannot be used to perform AccuRev commands, although 
the workspace tree is not changed in any way. The workspace no longer appears in the 
StreamBrowser display (unless you use the StreamBrowser's Show including hidden option).

You can use the Reactivate command to bring back a Remove'd workspace.

Creating a New Workspace
Click the New button at the bottom of the Workspaces tab to invoke the New Workspace wizard (see The 
New Workspace Command on page 20).

The New Snapshot Command

The New Snapshot command opens a dialog in which you define of a snapshot of the stream you selected.

Invoking the New Snapshot Command
In the StreamBrowser, right-click a stream and choose New Snapshot from the context menu.

Note: There is no "Edit Snapshot" command, because a snapshot cannot be modified in any way.

Using the New Snapshot Dialog
The New Snapshot dialog is identical to the New Stream dialog (See “Using the New Stream / Change 
Stream Dialog” on page 25.), except that:

• The stream type Snapshot is preselected.

• You must specify a basis time (the None radio button is disabled).

Updating a Workspace

The principal purpose of an AccuRev workspace is to provide an isolated location for performing 
development tasks. The changes you make do not affect your colleagues until you decide to make them 
public, using the Promote command. Likewise, the changes that others make do not immediately affect 
your workspace. You must execute an Update command to bring versions created (and then promoted) by 
your colleagues into your workspace.

You invoke the Update command in the File Browser, using the File > Update command or a button above 
the Workspace Explorer.

Video Tip Click this link to view an introductory video on creating snapshots.

Video Tip
Click this link to view an introductory video on updating your 
workspace.

http://www.accurev.com/sites/default/files/videos/52-training/Getting_Code_That_Others_Checked_In_and_Merging_In_Changes.wmv
http://www.accurev.com/sites/default/files/videos/52-training/Creating_a_Second_Snapshot.wmv
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During execution of the Update command, a progress window appears (See “The Update Progress Box” 
on page 130.). A user preference controls how this window is used.) See “AccuRev Preferences  (Tools > 
Preferences Command)” on page 41.

Prior to executing the Update command, you can use File > Update Preview  or the Update Preview filter 
in the Searches pane to see what the Update will do.  See “Working in the Searches Pane” on page 59.

Kinds of Changes Involved in an Update
At its simplest, an update just copies versions of some file elements from your workspace's backing stream 
into the workspace. For example, your colleagues may have edited the contents of files colors.java and 
main_menu.java, created new versions of them in their workspaces, then promoted the versions to the 
common backing stream. When you invoke Update, the new versions of those two files are copied from 
the depot to your workspace, overwriting the older versions of the file.

In addition to incorporating such content changes into your workspace, Update incorporates namespace 
changes :

• renaming of a file

• moving of a file to another directory

• creation of new files and directories

• defuncting of existing files and directories

AccuRev tracks namespace changes in the same way as content changes -- by saving each change as a new 
version in your workspace. If you Rename file colors.java to colours.java, the change is recorded as a new 
version of the file. Changing the name again, to hues.java, creates another new version.

Similarly, defuncting file rgb.java creates a new version of the file in your workspace.

Note: See “Renaming a Modified File Before Keeping It” on page 123.

How Update Works
The following sections provide an overview of how Update works.

Deciding Which Elements to Update
The basic Update strategy is to leave the files you're working on undisturbed, and to copy any new 
versions of other files into the workspace. This enables the workspace to provide the safety of isolation, 
while still "keeping in touch" with other users' progress.

Roughly speaking, Update partitions the files in your workspace tree into two categories, to determine 
which are candidates for updating:
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Files that you're currently working on. AccuRev uses the concept of default group to keep track of the 
files you're working on. Files are placed in the default group when you process them with such AccuRev 
commands as Send to Workspace, Keep, and Rename. These files are not candidates for updating, because 
it would overwrite your changes.

All the other files. The files that you're not currently working on are candidates for updating. AccuRev 
will update all such files for which a more recent version exists in the backing stream.

But things are not quite this simple. You might have edited other files, too, without preserving the changes 
with the Keep command. Such files have (modified) status.

In many cases, no one else has been working on those files. If no new versions of the (modified)-status 
files have been created in the backing stream since your most recent Update, the update proceeds, leaving 
those files alone.

But suppose one or more of the files does have a new version in the backing stream. In this case, the file's 
status is (modified)(overlap). Update won't simply overwrite the file with the backing-stream version, but 
it can attempt to merge the file with the backing-stream version:

• If user preference Update Resolves Trivial Merges is not selected, Update terminates immediately 
with an error box:

• If user preference Update Resolves Trivial Merges is selected, Update determines whether a 
merge can be performed automatically on all files with (modified)(overlap) status. If so, the 
update proceeds. If not, the update terminates with an error box:

Notes:

1. Members of the default group are "active" elements.

AccuRev documentation often uses the term active to describe the elements that are members of the 
default group.

2. Improving the performance of the non-member search.

To improve performance, timestamp and pathname optimizations enable Update to avoid examining 
every file in the workspace tree.

3. Anchor-required workspaces and exclusive file locking.
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By default, AccuRev allows you to edit any file in a workspace at any time -- it doesn't  require you to 
perform a "check out" operation on a file before editing it. This provides convenience and flexibility, 
but the edited files (with "non-member" status) can abort an Update. You can use the anchor-required 
workspace and/or exclusive file locking feature to ensure files never get "non-member" status, thus 
guaranteeing that Update will always proceed. See “File Locking” on page 271.

4. Determining which elements need to be updated: performance note.

This step is efficient and speedy. Update needs to consider only the elements that were involved in 
transactions recorded since the workspace's previous update. Only these transactions can contain 
changes that have not yet been incorporated into the workspace.

Transferring Data from the Repository
Update next applies both content changes and namespace changes to elements in the workspace:

• It applies content changes to file elements by copying the backing-stream versions from the 
repository to the workspace tree. For (modified)(overlap)-status files, it merges the backing-
stream version with the file in the workspace tree.

• It handles namespace changes to file and directory elements by creating, removing, renaming, and/
or moving objects in the workspace tree.

Recording the Update
After it has completed the updating of versions in the workspace, Update changes the values of two 
workspace parameters:

• scan threshold: the more recent this value, the more effective the Timestamp Optimization used 
both by Update and by certain File Browser searches.

• update level: after an update, the workspace is "up to date as of transaction N "; N is the 
workspace's update level. The higher this value, the fewer transactions your next invocation of 
Update will need to examine, in order to determine which elements need to be updated.

When Update does not Work
Sometimes AccuRev is not able to complete an Update operation, typically because a file cannot be 
overwritten due to permissions, or because it is open in another application. In this case, you will see an 
"Update Failed" warning. Use the View Log File button on this dialog to display the details of the failure, 
which should allow you to troubleshoot and correct the issue. 
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More on Update ...
For a more detailed description of how Update does its work, see section "The Update Algorithm" in 
AccuRev Technical Notes.

The Properties Command
The Properties command displays a message box with information about the selected element.

Invoking the Properties Command
Choose Properties from the context menu of an element in the Details tab of the File Browser.

The Properties Display
File Path

The depot-relative pathname of the element in the current stream or workspace.

File Type

The element type of this version.

File EID

The integer that identifies this element. An element's simple name or pathname can change, but 
not its element-ID. No other element -- past, present, or future -- in the same depot can have this 
element-ID.

Version

The version-ID of this version.

File Status

The current status of this version.

Target Path

(element link or symbolic link) The depot-relative pathname of the link's target.

The Issues Menu
See The AccuWork Queries Tab on page 303.

See The Edit Form Tab on page 287.

The Tools Menu

The Synchronize Time Command

The Synchronize Time command changes the system clock on the client machine to match the clock on the 
AccuRev Server machine. This succeeds only if the operating system grants you the right to make this 
change.

The Show Info Dialog
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The Show Info dialog displays overall information about your AccuRev work environment.

Opening a Show Info Dialog
Choose Tools > Info from the GUI main menu.

Show Info Tab Layout
Principal

Your AccuRev user identity, as established by AccuRev's Login command.

Host

The name or IP address of the client machine on which the AccuRev GUI is running.

Server name

The name or IP address of the server machine on which the AccuRev Server process is running. 
You can switch servers as part of the login process.

Port

The port number on which the AccuRev Server listens to client requests.

ACCUREV_BIN

The directory on the client machine where AccuRev executables are stored. In older versions of 
AccuRev, you sometimes needed to create an environment variable with this name. This is no 
longer necessary.

Client time

The system time on the client machine. (The parenthesized integer is the number of seconds since 
Jan 1, 1970.)

Server time

The system time on the server machine. (The parenthesized integer is the number of seconds since 
Jan 1, 1970.)

If the client time and server time differ by more than 5 seconds, many AccuRev commands fail to 
execute. Use the Tools > Synchronize Time command to fix this problem.

The Server Tasks Tab
The Server Tasks tab lists the current set of "worker threads" in the multi-threaded AccuRev Server 
process. At any given moment, each worker thread is executing one of the server subtasks that implement 
a particular client command. Each command from a client program translates to at least two server 
subtasks.

Opening a Server Tasks Tab
Choose Tools > Server Tasks from the GUI main menu.

Server Tasks Tab Layout
The Server Tasks tab contains a table with the following columns:
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Task ID

The ID number of the client-server connection. Each client command establishes a separate 
connection with the server.

Task Name

The name of the server subtask being executed by this worker thread. This typically matches the 
name of the client command, such as Update.

User

The AccuRev username of the user who issued the client command.

Host

The IP address of the client machine where the user invoked the client command.

Status

0 = slot assigned to worker thread, but thread not active yet (set by master thread).

1 = worker thread active (set by worker thread).

2 = worker thread completed, but master thread has not yet cleared the slot for reuse (set by worker 
thread).

Start Time

The time at which the worker thread started working on this subtask.

Seconds on Server

The number of seconds ("wall clock" time) that this worker thread has been running.

Note: Command-line interface to this command

You can use the AccuRev CLI to list the Server Tasks tab data:

1. Create a text file, for example tasks.xml, with this one-line XML document:

<tasklist/>

2. Execute this AccuRev CLI command:

accurev xml -l tasks.xml

Working in the Server Tasks Tab
The Server Tasks tab display is informational only. See also: See “Working with Tables” on page 10.

The Login Command
The Login command establishes your AccuRev user identity. In the "User Name" field, you must enter the 
name of a registered AccuRev user . If your organization has more than one AccuRev repository (each 
managed by a separate AccuRev Server process), you can choose a particular Server to connect to.

Note: Active and inactive users. A user name can be Inactive (Remove User command) or Active 
(when first created; Reactivate User command). When you log in, the username must be currently 
Active.

See also: Security on page 261
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Invoking the Login Command
Choose Tools > Login from the GUI main menu. This command is invoked automatically ...

• at the beginning of an AccuRev GUI session if there is no valid session file in the .accurev 
subdirectory of your home directory

• when you invoke a command that requires user authentication, but your session has expired

Using the Login Dialog
To login

Type in your username -- and if you have one, your password -- then click Ok. Passwords are 
case-sensitive.

To switch to another server

Open the listbox by clicking the down-arrow, then select another AccuRev Server (hostname/port-
number combination).

Then, complete the login by typing your username (and password).

To add an AccuRev Server to the listbox

Click the  button to display the Available AccuRev Servers dialog. (See “Using the Available 

AccuRev Servers Dialog” on page 282.). Click the  Add Server button to specify:

• The hostname (or IP address) where the additional AccuRev Server runs.

• The IP port number on which it listens for AccuRev client requests.

The "session" File
A successful Login command creates an encrypted file in subdirectory .accurev of your home directory. 
This file records your AccuRev username and password, along with the IP address of your client machine. 
Most AccuRev client commands can be executed only by an authorized user. Such commands send the 
information in your session file to the AccuRev Server process, so that you don't need to repeatedly 
"remind" the AccuRev Server who (and where) you are.
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Session Expiration
Session files are automatically deleted by the AccuRev Server after an administrator-configurable interval, 
which defaults to 240 minutes. This implements a session-expiration feature.

Multiple Session Files for Different Servers
The name of the session file includes the hostname and port number of the AccuRev Server. If you Login 
to different AccuRev Server processes, you'll have multiple session files, one for each Server. Example:

session_VENUS_5050
session_MARS_5050
session_MARS_5999

These session files indicate that your are logged in to an AccuRev Server on host venus, listening on port 
5050, and are also logged into two different AccuRev Server processes on host mars.

Multiple Session Files for the Same Server
What if you want to be testuser john in one GUI window, but testuser mary in another -- both using the 
same AccuRev Server? You can't have two session files with the same name (for example, 
session_VENUS_5050) in your .accurev subdirectory. But you can have two or more session files with the 
same name in different .accurev subdirectories. The AccuRev GUI uses the value of environment variable 
ACCUREV_HOME as the location of the .accurev subdirectory (and will create this subdirectory, if 
necessary). It also uses ACCUREV_HOME whenever it checking for the existence of a session file in order 
to authenticate you.

Example (Windows):

1. Set ACCUREV_HOME to c:\myusers\john.

2. Create directory c:\myusers\john.

3. Start the AccuRev GUI.

4. Login as john.

5. Set ACCUREV_HOME to c:\myusers\mary.

6. Create directory c:\myusers\mary.

7. Start another instance of the AccuRev GUI.

8. Login as mary in this second instance.

Hint: Setting up scripts to run the AccuRev GUI makes it easier to ensure that the GUI will be running with 
the environment variable set correctly.

The Change Password Command
The Change Password command changes (or creates) the password for your AccuRev user identity.

See also: Security on page 261.

Invoking the Change Password Command
Choose Tools > Change Password from the GUI main menu.
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Using the Change Password Dialog
Type the new password twice, once in the Password field, and again in the Confirm Password field. 

The change takes place only if your two entries match exactly. 

Filter Users/Groups
(View Users/Groups Command)

Invoking the Filter Users/Groups Command
You invoke this command choosing View > Users/Groups from the GUI main menu.

Using the Dialog
The View > Users/Groups command allows you to restrict the set of users and groups displayed in certain 
places in the AccuRev GUI. 

When you invoke the command, a dialog shows a list of all the users and groups you have defined within 
AccuRev. You can:

• Click the Show all users radio button to remove any restrictions on the display of users.

• Click the Show only selected groups/users radio button to enable filtering. Then click the 
checkbox in the Select column for each user or group you would like to display. When you have 
finished your selections, click the Ok button to enable the filter.
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Use the Show including hidden checkbox to include users that have been deactivated with the Remove 
command in the list shown in this dialog. These users are displayed with a grey background. 

Scope of the Users/Groups Filter
The users and groups you specify will appear in lists of users in the following  locations: 

• Workspaces drop-down list in the StreamBrowser.

• All drop-down lists in AccuWork that contain user or group data (such as Assigned to or Submitted 
by), and throughout the workflow.

• Add to Stream Filter dialog.

• Send to Issue dialog (when change-package-level integration is set up between AccuRev and 
AccuWork).
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AccuRev Preferences 
(Tools > Preferences Command)
The Tools > Preferences command opens a tabbed dialog, in which you can manage a set of parameters 
that influence the way the AccuRev looks and works. The preferences you set here apply only to you. They 
are stored in file preferences.xml, in subdirectory .accurev of your home directory. (By default, AccuRev 
determines your home directory by making a call to the operating system. If environment variable 
ACCUREV_HOME is set, AccuRev uses the value of this variable as your home directory.)

General Page
Enable Issue Preview

Controls the automatic inclusion of an Edit Form pane below the Query Results pane in a 
AccuWork Queries tab. The contents of the issue record that is currently selected in the Query 
Results pane is automatically displayed in the Edit Form pane.

The toolbar of the Query Results pane includes a  Show Issue Form button, which toggles the 
inclusion of the Edit Form pane.

Despite the name "Preview", the Edit Form pane is fully functional: you can revise, save, and 
export the contents of issue records in this pane.

Note: This option will be disabled if your AccuRev GUI is configured to display issues in the 
AccuRev Web UI. This will be the case if:

• Your AccuRev Administrator has configured your site to use the Web UI for AccuWork.

• You have set your local preference to “Open Issues In Web Only”. (See next section.)

Show Progress Log

Controls whether the Update or Update Preview dialog includes a scrollable text field that displays 
the names of up to 2000 elements that are being updated (or would be updated).

If this option is checked, the dialog looks like this:
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If this option is cleared, the dialog looks like this:

After the command finishes its work, a complete log is always available, through the View Full 
Log button in the dialog.

Show External Objects

Controls whether the File Browser's Details pane displays files and directories with a status of 
(external). External objects are files and directories that have not been placed under version 
control (using the Add to Depot command, for example). This setting applies only when navigating 
the workspace using the Workspace Explorer: if you perform a search for external objects using 
the Searches pane, objects with an (external) status are displayed regardless of this setting. Can be 
used with the Include Ignored Objects preference. See Controlling the Display of External Objects 
on page 98 for more information on using these preferences.

Include Ignored Objects

Controls whether ignored objects are displayed in the File Browser’s Details pane. An ignored 
object is an external file or directory that matches a pattern specified using the 
ACCUREV_IGNORE_ELEMS environment variable or .acignore file. Objects matching an ignore 
pattern are displayed with a status of (ignored). This preference is available only if the Show 
External Elements preference is also selected. See Controlling the Display of External Objects on 
page 98 for more information on using this preference.

See Chapter 3 Specifying Ignore Patterns for External Objects in AccuRev Technical Notes for 
more information on specifying ignore patterns.

Confirm On Exit

Controls whether the AccuRev GUI prompts for confirmation when you invoke the File > Exit 
command or attempt to shut the GUI window.

Require Manual Refresh

If this preference is cleared, the data displayed on a "buried" GUI tab is automatically refreshed, if 
necessary, when you switch to that tab. The AccuRev GUI signals that a refresh is necessary with 
a "refresh" icon next to the tab title.

If this preference is checked, the data on a "buried" tab is not refreshed automatically when you 
switch to it. Use the View > Refresh command (or function key F5) to refresh the data.

Keep Session Active

Controls whether the session file in the .accurev subdirectory of your home directory will be 
deleted when you end the AccuRev GUI session. This file is created by the Tools > Login 
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command, and is used by other AccuRev commands to establish your identity (and the identity of 
your client machine).

Update Resolves Trivial Merges

Enables the Update command to perform a merge operation on text file elements that are not in a 
workspace's default group, but have (overlap)(modified) status. The merges are performed and 
the Update proceeds only if for all such files, the merge is completely automatic (there are no 
conflicting changes).

Display of element name in tables

Controls how element pathnames are displayed in tables: in a single Element column, or in 
separate Name and In Folder columns.

Dialog Confirmations

Controls whether or not AccuRev displays confirmation messages when you:

• Close all other tabs open in the AccuRev GUI (by right-clicking on a tab and choose Close 
Others, for example)

• Click the Show All Streams button in the StreamBrowser, which is an operation that can take 
a long time depending on the size and complexity of your stream hierarchy

Tab Layout

When you open more tabs than can be displayed in the AccuRev window, a scroll button appears 
to provide access to tabs that are not currently visible. If you prefer, you can have AccuRev display 
all tabs at the same time; in this case, tabs are displayed in as many rows as needed.

Options are:

• One row (the default)

• Multiple rows

Tip: Press Ctrl+F6 to display a dialog box that lists all open tabs.

Online Help Browser

The full pathname of the web browser to be used for displaying the GUI’s context-sensitive help 
screens. This field also determines what web browser to use if your client is configured to work 
with the AccuRev Web User Interface (Web UI).

Diff/Merge Page
The Diff/Merge tab allows you to specify supported third-party tools to use with AccuRev. Note: Any 
tools that you specify must be defined in your PATH variable before launching the AccuRev GUI. If you 
specify a tool and it does not work, this is the most common cause. 

Diff

Specifies the graphical file-comparison tool to be invoked by the GUI's Diff command. You can 
choose AccuRev's own tool or one of the supported third-party tools from the combo-box. 
Alternatively, you can type a command line to be executed when the Diff command is invoked. 
This command line must include substitution patterns:

%1%  Quoted pathname of the first version to be compared.

%2%  Quoted pathname of the second version to be compared.
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%3%   Unquoted title string for the first version (can be displayed by file-comparison 
tool).

%4%  Unquoted title string for the second version (can be displayed by file-comparison 
tool).

Make sure the file-comparison tool  is located in a directory on your search path. Alternatively, use 
a full pathname to specify the file-comparison tool. Examples:

MyDiff /G %1% %2%

C:\SuperCompare\SCgui %1% %2%
Notes:

What's the difference between Ignore Whitespace and Ignore Changes in Whitespace?

Ignore Whitespace causes all SPACEs, TABs, and empty lines to be ignored, and thus 
overrides any setting of Ignore Changes in Whitespace.

Ignore Changes in Whitespace applies only where whitespace already exists; it does not 
apply where new whitespace is introduced or existing whitespace has been completely deleted.

Example 1: When comparing these two text strings:

compareme

compare me

Example 2: When comparing these two text strings:

compare     me

compare me

I changed my preferences, but I don't see any changes in the Diff tab.

Changing preferences does not automatically affect Diff tabs that are currently open. To apply 
the preferences, refresh the tab in any of these ways:

• Click the  Refresh button on the GUI window's main toolbar.

• Run the View > Refresh command on the GUI window's main menu.

 Table 1. 

[ ] Ignore Whitespace
[ ] Ignore Changes in 

Whitespace
Does Diff see difference?

X either No

- X Yes

- - Yes

 Table 2. 

[ ] Ignore Whitespace
[ ] Ignore Changes in 

Whitespace
Does Diff see difference?

X either No

- X No

- - Yes
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• Press function key F5.

Merge

Specifies the graphical text-file merge tool by be invoked by the GUI's Merge command. This 
command line must include substitution patterns:

%a%  quoted filename of the closest common ancestor version.

%1%  quoted filename of the version in the backing stream, or other non-workspace 
version.

%2%  quoted filename of the version in the workspace.

%3%  unquoted title string for the closest common ancestor version (can be displayed by 
text-file-merge tool).

%4%  unquoted title string for the backing-stream version (can be displayed by text-file-
merge tool).

%5%  unquoted title string for the workspace version (can be displayed by text-file-merge 
tool).

%o%  quoted name of the merge-output file -- a temporary file for storing the results of 
the merge.

Make sure the text-file-merge tool  is located in a directory on your search path. Alternatively, use 
a full pathname to specify the text-file-merge tool.

Note: Do I have to use a 3-way merge tool?

No. You're free to use a 2-way merge tool, which takes into account the two contributor versions 
only, not any of their ancestors.

But even if you don't use a 3-way merge tool, AccuRev records the merge operation (which 
appears as a red line in the Version Browser). Future merges involving this element can use this 
record to simplify the work needed to perform a 3-way merge.

Tab size

(AccuRev's graphical Diff and Merge tools only) The number of spaces to be displayed for each 
TAB character.

Character Encoding

(AccuRev's graphical Diff and Merge tools only) Specifies the character encoding of the 
contributor versions: either UTF-8 or the operating system default.

Ignore Whitespace

(AccuRev's graphical Diff tool only) Controls whether whitespace is taken into account when 
comparing text lines.

Ignore Changes in Whitespace

(AccuRev's graphical Diff tool only) Controls whether a change in the amount of whitespace in a 
text line is considered to be a change to that line.

Ignore Case

(AccuRev's graphical Diff and Merge tools only) Controls whether uppercase and lowercase 
characters are considered to be the same when comparing text lines.
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Version Browser Page
Initial display mode

Specifies the mode that a new Version Browser tab begins in. Basic mode displays "important" 
versions only, for example omitting intermediate versions in workspace streams. Expanded mode 
displays all versions. Buttons at the bottom of the Version Browser tab switch between the two 
display modes.

Initial transaction count

How many of the most recent transactions (and equivalently, versions) a new Version Browser 
should display. Controls in the Version Browser toolbar change this count.

StreamBrowser Page
Display Default Group in Stream Browser

Controls whether the StreamBrowser includes a current development activity control (  or  or 
) for each stream and workspace with active elements. Disabling this feature can significantly 

improve StreamBrowser performance.

Enable StreamBrowser History

Controls the inclusion in the StreamBrowser toolbar of controls that enable you to "turn back the 
clock", viewing a depot's stream hierarchy as it existed at any point in the past. You must refresh 
any existing StreamBrowser tabs to make a new setting effective.

Fit Stream Width to Stream Name

By default, AccuRev sets the display of streams in the StreamBrowser so that the width of all 
streams in a virtual column is as wide as the longest stream name in that column. For example, a 
stream named ac_5.5_build is as wide as a stream named 
ac_5.5_dev_workflow_itr4_doc_dfoster. The default setting provides a uniform presentation that 
makes viewing the stream hierarchy easy, but it also requires a lot of horizontal space. 

If you prefer, you can use this preference to make each stream only as wide as its name. With this 
setting, the presentation of a given stream hierarchy is typically more compact, making more 
streams visible at a time.

The Admin Menu

The Depots Tab

The Depots tab lists some or all of the depots in the AccuRev repository. 

Opening a Depots Tab
Choose Admin > Depots from the GUI main menu.
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Depots Tab Layout

Status

(appears if Show removed depots is checked) Active indicates that the depot is available for use. 
Removed indicates that the depot has been permanently removed from the repository. (The 
maintain rmdepot command permanently and irreversibly removes a depot from the repository. 
See "Removing a Depot from the AccuRev Repository" in the AccuRev Administrator's Guide.)

Depot #

The unique integer that identifies a particular depot. This identifier cannot be modified.

Name

The depot's name, which must differ from all other depot names in the repository. A depot can be 
renamed, but its depot number never changes.

Slice #

Same as Depot#.

Working in a Depots Tab
You can control the display of removed depots.

See also: Working with Tables on page 10

Controlling Which Depots are Displayed
Show removed depots

If checked, the table includes the depots that have been permanently deactivated with the 
maintain utility (see the AccuRev Administrator's Guide). This also adds the Status column to the 
table; removed depots have Inactive status, and are shaded.

Creating a New Depot

New
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Click this button to invoke the The New Depot Command on page 18 .

The Reference Trees Tab
The Reference Trees tab displays summary information on some or all of the reference trees in the 
AccuRev repository.

Opening a Reference Trees Tab
Choose Admin > Reference Trees from the GUI main menu.

Reference Trees Tab Layout
The Reference Trees tab contains a table with these columns:

Status

(appears if Show including hidden is checked) Active indicates that the reference tree is available 
for use. Inactive indicates that the reference tree is currently deactivated (but can be reactivated).

Name

The name of the reference tree.

Location

The pathname of the reference tree on the machine where it resides.

Host

The name or IP address of the machine where the reference tree resides.

Stream#

The integer stream-ID of the stream on which the reference tree is based. This number is unique 
with the reference tree's depot only, not across the entire repository.

Target Transaction

(appears if Show details  is checked) The depot's transaction level at the time the Update 
command was most recently invoked on the reference tree. Update attempts to load versions 
created in transactions up to and including the target transaction. If the Target Transaction and 
Update Level are the same, the reference tree's most recent update completed successfully.

Update Level

(appears if Show details  is checked) The highest-numbered transaction whose versions have been 
copied to the reference tree in an update.

Type

(appears if Show details  is checked) The integer 3, indicating that the type of data structure is a 
reference tree.

EOL

(appears if Show details  is checked) The type of line terminator used when an update copies text-
file versions to the reference tree: Auto (line terminator used by the host machine's OS), UNIX 
(NL), or Windows (CR-LF).
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Working in a Reference Trees Tab
You can apply filters to control the amount of data displayed in the reference trees table, and you can 
perform a number of operations on a selected reference tree. See also: Working with Tables on page 10

Controlling Which Reference Trees are Displayed
Show including hidden

If checked, the table includes reference trees that have been deactivated with the Remove 
command. This also adds a Status column; deactivated reference trees have Inactive status, and 
are shaded.

Controlling the Data Displayed for Each Reference Tree
Show details

If checked, the table includes these columns: Target Transaction, Update Level, Type, and 
EOL.

Operating on a Selected Reference Tree

You can choose any of the following commands from the context menu of a selected reference tree:

Open

In this release, the Open command is disabled. You cannot view the contents of a reference tree 
using the AccuRev GUI.

Edit

Modify the configuration of the reference tree.

Reactivate

Bring back into active service a reference tree that was previously deactivated with the Remove 
command.

Remove

Deactivate a reference tree. The reference tree cannot be Update'd.

You can use the Reactivate command to bring back a Remove'd reference tree.

Creating a New Reference Tree
Click the New button at the bottom of the Reference Trees tab to invoke the Using the New Workspace 
Wizard on page 50.

The New Reference Tree Command
The New Reference Tree command creates a reference tree for a specified stream.

Invoking the New Reference Tree Command
1. Choose Admin > Reference Trees from the GUI main menu, to open a Refs tab.

2. Click the New button at the bottom of the tab.
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Using the New Workspace Wizard
The wizard for creating a new reference tree is essentially similar to the The New Workspace Command 
wizard.

The Triggers Tab
The Triggers tab displays the triggers defined for a specified depot.

See also: Security on page 261.

Opening a Triggers Tab
Choose Admin > Triggers from the GUI main menu.

Triggers Tab Layout
The Triggers table includes these columns:

Type

pre-create-trig, pre-keep-trig, pre-promote-trig, or server-post-promote-trig.

Execute

The simple name or pathname of the script (or other program) that executes when the trigger fires.

Working in a Triggers Tab

The Triggers tab is informational only. All trigger maintenance is performed with the AccuRev 
CLI. See the description of the mktrig and rmtrig commands. The data in the Triggers tab is the 
same as that displayed by the CLI command show triggers.

The Slices Tab
The Slices tab shows the physical storage locations of the depots in the AccuRev repository. If the 
repository is replicated, it shows the locations of the depots in the local replica repository only.

Opening a Slices Tab
Choose Admin > Slices from the GUI main menu.
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Slices Tab Layout

The Slices tab contains a multi-column table.

Status

(appears if Show including hidden is checked) Active indicates that the depot is available for use. 
Inactive indicates that the depot has been permanently removed from the repository. (The 
maintain rmdepot command permanently and irreversibly removes a depot from the repository. 
See "Removing a Depot from the AccuRev Repository" in the AccuRev Administrator's Guide.)

Slice#

The unique integer that identifies a particular depot. This identifier cannot be modified.

Location

The pathname of the slice's top-level directory. This location can be changed -- for example, to 
move the depot to a larger and/or faster disk.

Working in a Slices Tab
You can control the display of removed depots. See also: Working with Tables on page 10.

Controlling Which Slices are Displayed
Show including hidden

If checked, the table includes the slices of depots that have been permanently deactivated with the 
maintain utility (see the AccuRev Administrator's Guide). This also adds a Status column; 
removed depots have Inactive status, and are shaded.

The Locks Command
The Locks command maintains the set of locks that apply to a dynamic stream. Locks control the ability to 
Promote versions to/from the stream, the ability to configure the stream's contents with the include/exclude 
facility, and the ability to modify the stream's settings.

See also: Security on page 261.

Invoking the Locks Command
You can open a Locks dialog in the StreamBrowser in any of these ways:
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• Right-click a dynamic stream, and select Locks from the context menu.

• (if there are currently one or more locks on the stream) Click the Locks icon that appears below the 
stream

The Locks Dialog Box
On a given stream, you can create one lock of each type:

Lock All

Disables promotion of versions to/from the stream; disables include/exclude mode changes to the 
stream; disables the Change Stream command for the stream. (Does not disable the Remove 
command.)

Lock Promotes To

Prevents versions from being added to the specified stream’s default group. Disables promotion to the 
stream.

Lock Promotes From

Prevents the removal of versions from the stream’s default group. Disables promotion and purging 
from the stream.

A Lock All setting takes precedence over "to" and/or "from" settings.

You can restrict the effect of the lock:

Only for

The lock applies only to the specified user, or to all the members of the specified group.
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Except for

The lock applies to all users, except for the specified user, or except for all the members of the 
specified group.
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3. The File Browser
AccuRev's job is to keep track of your files. Accordingly, one of AccuRev's main GUI tools is the File 
Browser. The File Browser makes it easy to view, monitor the status, and change the contents of elements 
located in AccuRev workspaces. You can also use the File Browser to view, monitor the status, and 
perform limited operations on elements in streams and snapshots.

You can have any number of File Browser tabs open concurrently in an AccuRev GUI window -- each one 
displaying the contents of a difference workspace, stream, or snapshot.

See Also:

Alternatives to the File Browser on page 57

Browsable Data Structures on page 57

Opening a File Browser Tab
There are several ways to open a File Browser tab in the AccuRev GUI. When you start a new GUI 
session, one or more File Browser tabs (and other tabs) might open automatically, enabling you to continue 
from where you ended the previous session. To open a File Browser on any of your workspaces, use one of 
these techniques:

• Select File > Open Workspace from the command menu (or click the  Open Workspace toolbar 
button). Select a workspace and click Ok, or double-click it. 

• On a StreamBrowser tab, make sure the desired workspace is displayed. To open another user's 
workspace, change the listbox setting at the bottom on the tab from Current User to the 
appropriate username. 

• There is also an All Workspaces setting. Right-click the desired workspace, and select Open from 
the context menu. Or just double-click the desired workspace.

A new File Browser tab opens with the top-level folder in the Workspace Explorer selected.

Leaving and Returning to a File Browser Tab
You can leave a File Browser, switching to another tab in the AccuRev GUI, then return to that File 
Browser tab later. When returning to a File Browser tab, it's a good idea to refresh the display (with View > 

Refresh , the  toolbar button, or function key F5). This ensures that the File Browser display reflects any 
work you performed "between visits" to the tab.

Alternatively, you can close the tab altogether: right-click the title, then select Close from the context 
menu. You can also close the tab using the "X" icon on the tab control itself.

File Browser Tab Layout
The File Browser display resembles that of Windows Explorer. To the familiar Workspace Explorer and 
Details pane, it adds a unique Searches pane. You can execute AccuRev commands by selecting from the 
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GUI window's main menu, by clicking toolbar buttons, or by using the context (right-click) menus of items 
in the File Browser display.

The Workspace Explorer enables you to navigate the folder (directory) hierarchy of a workspace or stream. 
When you're using the Workspace Explorer, the Details pane displays the contents of the currently-
selected folder.

The Search pane lists element-status searches that you can apply to the entire workspace or stream. When 
you're using the Searches pane, the Details pane displays all the elements that meet the selected search 
criterion. (In the AccuRev CLI, the search facility is described using the term "filter".) For example, it can 
display all the files you've edited and saved with the Keep command.

GUI Window Indicators
When you're working in the File Browser, the indicators at the bottom of the AccuRev GUI window show 
the name of the current workspace or stream. For a workspace, it also shows the location of the workspace 
tree in disk storage.  The name of the workspace's backing stream is shown at the top of the Workspace 
Explorer.
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Working in the File Browser's Panes
Click on the links below for more information on working in the File Browser's panes.

• Working in the Workspace Explorer on page 58

• Working in the Searches Pane on page 59

• Working in the Details Pane on page 66

• Updating a Workspace on page 30

Alternatives to the File Browser
The File Browser is not intended to completely replace the Windows Explorer or comparable tools on 
UNIX systems. For example, the File Browser does not attempt to implement the Windows "file types" 
functionality, based on filename suffixes.

Some people do most of their work inside an integrated development environment (IDE), such as Visual 
Studio or Eclipse. These environments have their own "explorer" or "file browser" built in, typically 
organizing files into separate "projects". You can use AccuRev commands within an IDE if an AccuBridge 
integration for that environment is available (or an integration from a third-party developer). Even if you 
use an IDE most of the time, you may want to use the File Browser occasionally:

• The IDE does not display all of a file's configuration-management properties, such as the current 
version-ID.

• Certain AccuRev commands cannot be executed through the IDE integration, only from the 
AccuRev File Browser.

It's important to keep in mind that you can use a wide variety of tools to make content changes to a file, but 
you must use AccuRev commands to make valid namespace changes: renaming, moving to another 
directory, or deleting. The AccuBridge IDE integrations support these namespace operations.

Browsable Data Structures
You can open a File Browser tab on these AccuRev data structures, each of which provides access to a 
configuration of your organization's version-controlled files and directories:

• workspace 

• stream 

• snapshot 

AccuRev also supports a data structure similar to a workspace, called a reference tree. You cannot open a 
File Browser tab on a reference tree. (But the Admin > Reference Trees command displays the references 
trees created for a particular depot.)

For a full discussion of these data structures, see the AccuRev Concepts Manual.



58 AccuRev®  On-Line Help Guide

Working in the Workspace Explorer
The Workspace Explorer includes a tree control, for navigating the folder (directory) hierarchy of a 
workspace. 

It works in the standard way:

• A "+" (or right-arrowhead) control indicates that the folder has a subhierarchy that is not currently 
displayed. Left-click this control to open the subhierarchy.

• A "-"  (or down-arrowhead) control indicates that the folder has a subhierarchy that is currently 
displayed (in part, or in its entirety). Left-click this control to close the subhierarchy.

You can also double-click the folder icon or the folder name next to a control to open or close it.

When you select a particular folder (directory), the objects in that folder appear in the Details pane.

Working in Include/Exclude Mode
The set of directories that appears in the Workspace Explorer depends on whether the File Browser is 
currently in include/exclude mode (see Using the File Browser's Include/Exclude Mode on page 98):

• When you're in include/exclude mode, the Workspace Explorer displays the depot's entire 
directory hierarchy (as it is inherited from higher-level streams). This enables you to change your 
include/exclude configuration.

• When you leave include/exclude mode, the File Browser applies the include/exclude rules; the 
Workspace Explorer displays only the directories that are configured to be included in the 
workspace or stream.
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Workspace Explorer Command Reference
You can invoke the following commands from the Workspace Explorer toolbar. 

Update

 Update the workspace or reference tree.

Open Basis Stream

Open the basis (backing) stream in a separate File Browser tab.

Working in the Searches Pane
The File Browser can organize the contents of a workspace or stream by AccuRev status, instead of by 
directory location. (You can also search by element name. See Searching by Element Name on page 64 for 
details.) When you click one of the items in the Searches pane (e.g. Kept), the File Browser searches the 
entire workspace or stream for objects that meet that search criterion, and displays those elements in the 
Details pane. You can perform commands on these objects, using the toolbars and menus.

File Browser searches enable you to see "just the files you care about", instead of all the files in your 
workspace. (The AccuRev CLI uses the term "filter" instead of "search".) Which files do you care about? 
Roughly speaking, a workspace contains a copy of its backing stream -- often, the entire source base -- 
which might include hundreds or thousands of files. But for a given development project, you'll probably 
modify only a handful of the files. You may not need the other files at all; or you may need them for 
general reference, or to enable you to perform software builds and tests in the workspace.

The searches are not mutually exclusive: some objects may be selected by more than one search criterion -
- for example, Kept and Pending: every object selected by a Kept search will also appear in the results of a 
Pending search.
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See also:

AccuRev Element Status on page 86

Using the File Browser's Include/Exclude Mode on page 98

Performing Searches of the Entire Workspace or Stream
To perform a search of the entire workspace, dynamic stream, or snapshot on which you opened the File 
Browser, just click one of the search criteria in the Searches pane. AccuRev performs the search and 
displays the resulting set of elements in the Details pane.

You can perform as many searches as you like; the File Browser remembers the results of the most recent 
search of each kind. So, for example, you might:

1. Click the Kept search criterion to search for files with (kept) status in your workspace.

2. Click the Overlap search criterion to search for files with (overlap) status in your workspace.

3. Click the Kept search criterion again.

Instead of performing another search, the File Browser just displays the results of your previous search for 

files with (kept) status. You can refresh the display (with View > Refresh , the  toolbar button, or 
function key F5) to have the File Browser perform the Kept search again, in order to take into account 
recent changes.

The cache of search results is maintained until you close the File Browser tab.

Restricting a Search to a Subtree
The Search in Selected Folder checkbox at the bottom of the Searches pane enables you to restrict any 
search to the subtree of the folder that is currently selected in the Navigation pane.

If you check or clear this checkbox when the Details pane already contains the results of a search, 
AccuRev automatically performs the search again in the restricted (or unrestricted) context. If Search in 
Selected Folder is checked, the folder context appears in the Searches pane banner:
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Search Progress Box
A search can be almost instantaneous or not, depending on the number of elements in the workspace or 
stream. During a longer search, AccuRev displays a progress box. 

If you click the Run in Background button, the progress box is replaced by an indicator in the lower right 
corner of the GUI window:

The indicator disappears when the search completes.

Search Criteria
The Searches pane contains these search criteria:

Pending

(workspace only) Select elements whose status includes either (modified) or (kept). These are 
elements that have had a content change or a namespace change.

Modified

(workspace only) Select files whose status includes (modified). This indicates a content change 
that has not yet been preserved with Keep (but may have followed a previous Keep).

Kept

(workspace only) Select files whose status includes (kept). These are files whose content changes 
have all been preserved with Keep, or elements with namespace changes (Rename or Defunct 
command).
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Non-member

(workspace only) Select files whose status includes (modified) but not (member). These are files 
that have content changes, but are not in the workspace's default group. They have not been 
activated with a Keep or Anchor command since the file's last update or promotion.

Default Group

Select elements whose status includes (member). These are elements in the workspace's default 
group, for which you've entered one of these commands: Keep, Rename, Defunct, Anchor.

Update Preview

Displays what elements would be affected by an update operation, and enables you to easily select 
the elements and perform operations on them in advance of the update. By default the following 
columns are displayed: 
• Element -- (When "Display of element name..." is set to "single column") The depot-relative 

path of the element in the  workspace, followed by the name of the element as it currently 
appears in the workspace.

• Name -- (When "Display of element name..." is set to "separate name and in-folder") The 
name of the element as it currently  appears in the workspace.

• In Folder -- (When "Display of element name..." is set to  "separate name and in-folder") The 
depot-relative path of the element in the  workspace.

• Status -- See AccuRev Element Status on page 86. 

• Action -- What will happen to the element if you proceed with the update. Possible values are 
move, remove, create, overlapped, re-link, replace content, and no such element. For elements 
with a status of no such element, the only operations that are enabled are History and 
Properties.

• Real -- The workspace and version where the current version of the selected element is 
defined.

• New Name  -- If the element has been renamed in the backing stream, the name which will 
appear in the workspace after the update.

Note: The File >Update Preview menu option now displays this filter rather than the text display 
generated in previous releases.

Overlap

Select elements whose status includes (overlap) -- the current version in the parent stream is not 
an ancestor of this version. This means there might be content changes or namespace changes in 
the parent stream version that are not present in this version.

You must perform a Merge with the parent stream version before you can Promote your version. If 
you're in a dynamic stream, you must perform the Merge in the Change Palette.

Tip: The Overlap filter also displays elements with a (twin) status. See Resolving (twin) Status on 
page 91 for more information.

Deep Overlap

Select elements that satisfy the Overlap search criterion in the current workspace or stream, along 
with Overlap elements in the parent stream, in the grandparent stream, and so on -- all the way up 
the depot's stream hierarchy. From the Deep Overlap filter display, you can merge your changes to 
resolve the overlap and then keep the merged file. The Overlap Filter display updates to show the 
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merged element with a (kept) (Member) status, and you can select it and promote to the backing 
stream. 

Tip: The Deep Overlap filter also displays elements with a (twin) status. See Resolving (twin) 
Status on page 91 for more information.

Underlap

Select elements whose status includes (underlap) -- the current version in the parent stream is not 
an ancestor of this version, but the parent-stream version already contains all the changes of this 
version. In most cases, you can safely Revert to Backed your version, so that you'll get the parent-
stream version the next time you Update the workspace (see Revert to Backed Dialog on 
page 125). Alternatively, you can perform a merge, just as with (overlap)-status elements.

Modified in Default Group

(workspace only) Select elements whose status includes both (modified) and (member). This is 
the intersection of the sets of files selected by the Modified and Default Group search criteria.

External

(workspace only) Select files and directories that exist in the workspace tree, but have never been 
placed under version control with the Add to Depot command.

Missing

Selects elements that should be present, but aren't. That is, there's a version of the file or directory 
in the workspace stream, but the file or directory was removed from the workspace tree by an 
operating system command or some non-AccuRev program.

Stranded

Select the elements in the default group that have become stranded. In the Details pane, a stranded 
element is identified by its element-ID, since it has no pathname in the workspace or stream.

Notes: Example

Here's the most typical scenario for stranding a file in a workspace:
1. Create a new version of a file with Keep. This places the file element in the workspace's default 

group.

2. Remove the file's parent directory with Defunct. With the parent directory gone, there's no 
pathname in the workspace to the file element.

For more information, see Version Control of  Namespace-Related Changes on page 37 in 
AccuRev Technical Notes.

Defunct

Selects the elements in the default group of a workspace or dynamic stream whose status is 
(defunct).

Search and Display Optimizations
Many of the File Browser's searches described above require that AccuRev consider every file in your 
workspace, even the external objects that you have not placed under version control (editor backup files 
and files produced by software builds, for example). If your workspace contains many thousands of files, 
such operations can be time-consuming. 

AccuRev can use a Timestamp Optimization algorithm during a full-workspace search to significantly 
improve search performance. See Timestamp Optimization: Controlling the Determination of (modified) 
Status on page 98 for more information.
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In addition, you can specify ignore patterns to reduce "visual clutter" in the File Browser and lists returned 
by commands such as stat -x. See Chapter 3 Specifying Ignore Patterns for External Objects in the 
AccuRev Technical Notes for more information.

Deep Overlap Optimization
The Deep Overlap Optimization checkbox controls whether or not to consider and display elements 
beyond a time basis stream.  

When checked (default), deep overlap elements beyond a time basis stream are not displayed. This 
improves performance, and also simplifies the display by not showing elements that are not relevant.

When unchecked, these  elements are displayed, but with orange highlighting.  

This setting is not saved between GUI sessions.

Operating on Elements Selected by a Search
The set of elements located by a search are displayed in the Details pane. The operations that you can 
perform on these elements are described in Details Pane Command Reference on page 77.

Notes:

• Selecting all the objects located by a search

Selecting all objects in the Details pane can be particularly useful after a search. For example, to pro-
mote all files that you've saved with Keep:

1. Click Kept in the Searches pane

2. Select one file in the details pane

3. Press Ctrl-A to selects all the elements in the Details pane

4. Invoke the Promote command.

• Disappearing search results

A file can disappear from the Details pane if you change it in a search-related way. For example, after 
you promote all the files displayed by a Kept search, the files' status changes from (kept) to (backed). 
Accordingly, the files disappear from the Kept search results.

Searching by Element Name
In addition to searching by element status as described in the previous section (Working in the Searches 
Pane on page 59), you can also search your Workspace for elements with names that include specified 
characters.
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To enter a search string, type the characters in the Search field at the right end of the toolbar:

You can enter any character that is legal for an AccuRev element name. Wildcards ("*" and "?") are 
accepted.

Press Enter or click the binocular icon when done. AccuRev displays a “Stat processing” status box while 
it searches the database for all elements in the Workspace context that include the string that you entered. 

Note: Unless you have the Search in Selected Folder checkbox selected (see below), the search 
returns results from the entire Workspace, not just the file structure that is displayed when you 
initiate the search.

Click the Run in Background button if you want to do other things while AccuRev searches. AccuRev 
searches the Workspace for all elements that include the string in any part of the name. So for example, 
performing a search for "test" will return all elements with names like "Testplan.doc", 
"regression_test_suite", “script.test”.

Note that:

• The search can be narrowed down to a particular directory by clicking that directory  in the tree 
view and enabling ing the Search in Selected Folder checkbox.

• Search is available only for locally accessible Workspaces, not for Workspaces on a different 
machine. Search is also not available for dynamic streams.

• If the search results return a directory, you can click on it to view that directory in directory mode. 
The directory tree on the left expands and selects the correct node/directory.

Filtering Your Search Results
To fine-tune the results of your search, you can enter characters in the Filter Results field. As you type a 
string, the search results shown in the File Browser display will be narrowed down to only those containing 
the characters you enter. The rules for Filter strings are the same as for the search.

To clear the filter, click the X button in the Filter Results field.
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Working in the Details Pane
This topic discusses the tasks that you'll probably perform most often with AccuRev -- working with 
elements in the Details pane of the File Browser.

Details Pane Layout
The Details pane displays the contents of a particular directory (folder) if you've made a selection in the 
Workspace Explorer, or the set of objects resulting from a search that you've selected in the Searches pane.

The display includes several columns of information. You can control which columns are displayed: right-
click any column header and choose Format Columns from the context menu:
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The Details pane columns are:

Name

The name of the object, either a file or a directory, in this workspace or stream. AccuRev allows 
you to rename and relocate objects, so a file might have a different name and/or a different 
directory location in another workspace or stream.

When the Details pane is displaying the contents of a single folder, the Name column shows the 
name of each object in the folder. The highlight in the Workspace Explorer indicates which folder 
is being displayed.

When the Details pane is displaying the results of a search through the entire workspace or stream, 
a user preference controls whether element pathnames are displayed as a single column (Element) 
or two columns (Name and In Folder).
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Status

One or more keywords that indicate the AccuRev status of the element in this workspace or 
stream.

See also:

AccuRev Element Status on page 86
Version

A version-ID that indicates the version of the element that currently appears in this workspace or 
stream.
• Workspace: If you have modified an element, but not yet promoted it to the backing stream, 

the version-ID indicates a version in the workspace stream. These are described as " active 
elements", or as "members of the workspace's default group". For inactive elements (those you 
haven't modified or activated with Anchor or Send to Workspace), the Version column 
indicates a version from some higher-level stream, which your workspace stream inherits.

If this column is blank, the file or directory has not been placed under version control. Such 
objects have the status external.

• Stream: If the element is currently active in the stream (is in the stream's default group), the 
version-ID includes the name of this stream. Otherwise, the version-ID includes the name of 
the higher-level stream from which this stream inherits the version.

ElemType

File element: the element type of this version of the element: text, ptext, or binary.

Directory element: the keyword dir.



AccuRev®  On-Line Help Guide 69

Link element: the keyword link.
Id

The element-ID of the element.
Last Modified

A date-timestamp, indicating the last time this element was modified. In a workspace, this is the 
same as the timestamp reported by the operating system for the object in the workspace tree.

Size

The size of this version of the file (or the file version referenced by this version of an element link 
or a symbolic link). The size of a directory is reported as "0KB".

Lock Type

Either parallel or serial, indicating the element's current development mode. See The Locks 
Command on page 51.

Options that Affect the Details Pane Display
Several options provide fine-tuning over which elements are displayed in the Details pane, and affect 
which keywords appear in the Status column:

• (Workspace only) Controlling the Display of External Objects on page 98

• (Workspace only) Timestamp Optimization: Controlling the Determination of (modified) Status on 
page 98

• Controlling the Display of Element Names on page 77

Switching in and out of  include/exclude mode also changes which elements are displayed in the Details 
pane.

Performing Operations in the Details Pane 
Working with elements in the Details pane follows this pattern:

1. Select one or more files and/or directories.

2. Invoke an AccuRev command, either:

• ... by clicking one of the File Browser's toolbar buttons, or

• ... by right-clicking a selected object and choosing a command from the context menu, or

• ... by choosing a command from the submenu of the GUI window's main menu.

The file-selection gestures are the same ones used by Windows Explorer:

• To select a file, click it with the left mouse button.

• To select a contiguous range of files, click-and-drag with the left mouse button.

• To select all the files in a directory, select any one of them, then press Ctrl-A.

• To add or subtract a file from an existing selection, hold down the Ctrl key and click that file with 
the left mouse button.

• To extend an existing selection to a particular file, hold down the Shift key and click that file with 
the left mouse button.

• Typing a character selects the next file or directory whose name begins with that character (if the 
Details pane listing is sorted on the Name column).



70 AccuRev®  On-Line Help Guide

Common Usage Scenarios
As a version control system, AccuRev keeps track of changes that users make to files and directories. The 
following sections describe common usage scenarios, showing how AccuRev change-tracking is reflected 
in the File Browser's Details pane: in changes to the status of objects, and in creation of new versions of 
objects.

Editing a File's Contents
Perhaps the most common scenario is "non-conflicting development": modifying a file that no one else is 
working on concurrently. Initially, the Status column in the Details pane shows the file's status as 
(backed): your workspace contains an unmodified copy of a version in the backing stream. The Version 
column contains a version-ID, indicating which backing-stream version it is:

Invoke the  Edit command on the file, using the toolbar button or the file's context menu. This launches 
a text editor session on the file. (You can use environment variable AC_EDITOR_GUI or EDITOR to control 
which text editor is launched.)

When you end the edit session, the file's status changes to (modified). This indicates that you've modified 
the file in your workspace since the last time you synchronized the file in your workspace with the depot, 
for example with a Keep or Update command. (That is, you've changed the file in the workspace tree, but 
not the element in the workspace stream.)

You can edit the file as many times as you wish. The file's status remains (modified). To have AccuRev 

record a new version of the file, invoke the  Keep command on it. If you wish, enter a comment in the 
dialog box that appears. The comment string becomes a permanent annotation to the version, viewable 
with the History Browser (see The History Browser on page 193).

The Keep command creates a new version of the file in the workspace stream. This version is said to record 
a content change to the file. The File Browser also has commands for performing namespace changes.

The file's status changes to (kept)(member); this indicates that you've recorded a new version, and that 
the file is currently active in your workspace (is a member of the workspace's default group).
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The Version column shows the version-ID of the newly created version. Note that this version is recorded 
in your private workspace stream (in this example, talon_dvt_john); previously the Version column 
indicated that your workspace contained a version from the public backing stream (talon).

You can continue modifying the file with the  Edit command, and saving new versions in the depot with 

the  Keep command. The file's status will alternate between (modified)(member) and 
(kept)(member). The persistence of the (member) indicator reflects the fact that the file remains active 
in your workspace until you promote your changes to the backing stream or undo your changes.

Renaming or Moving a File
In addition to tracking changes to the contents of files, AccuRev tracks namespace changes:

• To rename an element within the same directory, invoke the  Rename command. You can't use 
this command to rename (external) objects. 

• To move a file to a different directory in the depot, right-click the file and select  Cut from the 
context menu. Then right-click the destination directory in the Workspace Explorer (not the 

Details pane) and select  Paste from the context menu. You can cut-and-paste a multiple-file 
selection in the same way. 

You can also use the Rename command to move a file to a different directory; specify a relative 
pathname (such as ..\otherdir\myfile.c ) as the new name for the file.

AccuRev records a namespace change to a file in the same way it records a content change: by 
creating a new version of the file in the workspace stream.

As with a content change, the file's status changes to (kept)(member). Making a namespace change to a 
file activates it -- creates a new version in the workspace stream and makes it a member of the workspace's 
default group -- just like Keep'ing a content change.

You can also rename and/or move a directory.

Notes:

• Status of a renamed file element: a special case

If the file also has content changes that have not yet been saved with Keep, the status becomes (modi-
fied)(member).

• Reusing the old element name

After you rename an element, you are free to create a new element with the old name. If you do so, and 
then you decide to discard your renaming of the original element (Revert to Backed command), then 
the original element disappears from your workspace. (See also: Caution on Reusing the Name of a 
Renamed Element on page 123.)

Following Through by Promoting the Changes
Initially, the content changes and/or namespace changes you make to a file are recorded only in your 
workspace's private stream. This keeps your work isolated from your colleagues' work. When you're ready 
to share your changes to a file with your colleagues, you Promote the active version from your workspace 
stream to the backing stream. This makes your changes available to all workspaces that are based on the 
same backing stream.
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Note how the version-ID in the Version column changes:

• Before the promotion, it indicates the particular version of the file that is active in your workspace 
(in this example, version talon_dvt_john\5 ).

• After the promotion, it indicates that version's newly created version-ID in the backing stream (in 
this example, talon_dvt\8).

Having been promoted to the backing stream, the file is no longer active in the workspace (is no longer in 
the default group of the workspace stream). Accordingly, it loses its (member) status and returns to being 
(backed) -- its original status before you started working on the file. That is, the workspace returns to 
"inheriting" the version of the file currently in the backing stream -- which happens to be the version you 
just promoted there!

Note: Combining the Keep and Promote commands

Strictly speaking, you must Keep a file's changes before you can Promote them. But as a convenience, 
the File Browser enables the Promote command for files that are (modified), but not (kept). 
Invoking Promote performs both a keep transaction and a promote transaction.  

Following Through by Undoing the Changes
Inevitably, you sometimes decide not to share your changes to a file with your colleagues -- instead, you 
decide to discard the changes altogether. The Revert to Backed command (right-click the element, and then 
choose Revert To... > Revert to Backed) undoes all the content and/or namespace changes you have made 
to an active file. The file's status reverts to (backed), and your workspace "rolls back" to using the version 
that it contained the last time the file's status was (backed). It might be a version that you brought into 
your workspace with a recent Update command; or it might be a version that you created in your 
workspace, then Promote'd to the backing stream.

Notes:
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• Reverting namespace changes

If your changes to a file included renaming it or moving it to a different directory, invoking Revert 
to Backed causes the file to disappear from its new location and return to its original pathname.

• Variant command: Revert to Most Recent Version

The variant command, Revert to Most Recent Version, is useful if you've modified a file's contents 
repeatedly, creating one or more intermediate versions in your workspace with the Keep command. 
Revert to Most Recent Version discards any content changes you've made since the most recent 
Keep. The file's status reverts from (modified) to (kept). The file remains active in the work-
space, so it retains its (member) status.

Changing a Directory
In addition to tracking changes to files, as discussed in the preceding sections, AccuRev tracks changes to 
directories. AccuRev's model for directory-level changes is simple, but somewhat different from the model 
used by the operating system (and by some other version-control systems). AccuRev considers the 
following to be changes to a directory:

• Renaming a directory

• Moving a directory to another location in the depot's directory hierarchy

• Deleting a directory

The following are not changes to a directory:

• Creating a new file (it's a change to the file itself)

• Renaming an existing file (it's a change to the file itself)

• Deleting a file (it's a change to the file itself)

Note that it is only changes involving a directory's pathname that are considered to be changes to the 
directory itself. Changes to a directory's contents are not considered to be changes to the directory itself.

You change a directory's pathname in the same way you change a file's pathname -- with the Rename 
command (Edit > Rename) or with Cut and Paste commands. When you make such a change, AccuRev 
records a new version of the directory in the workspace stream. 
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The new version-ID appears in the Version column of the Details pane (in this example, talon_dvt_john\2). 
And the directory's status changes to (kept)(member) -- just as it does for a file's namespace change.

Deleting a File -- Accidentally or Temporarily
An AccuRev workspace tree is an ordinary directory tree, typically located on your machine's hard drive. 
Nothing prevents you (or perhaps, some rogue cleanup script) from using operating system commands to 
delete one or more of the files under version control. On occasion, you may even want to delete some files 
temporarily -- for example, to test the robustness of your build or installation procedure.

By definition, deleting a file at the operating system level makes it disappear from disk storage. Operating 
system tools, such as Windows Explorer or the UNIX ls command, will detect that the file no longer exists. 
But the file does not disappear from the File Browser display. AccuRev knows that the file should be in the 
workspace, because the file element still exists in the workspace's built-in stream. (The workspace stream 
is located in the AccuRev depot. It's unaffected by the operating system's delete-file commands.)

Accordingly, when a version-controlled file is deleted at the operating system level, the File Browser 
continues to list it, but indicates the file's status as (missing).

Note that the Version column continues to indicate which version of the file should be in the workspace. To 
restore that version, invoke the Populate command from the missing file's context menu.

Deleting a directory at the operating system level is similar to (but potentially more destructive than) 
deleting a file. The entire directory subtree is deleted from disk storage, and the directory is listed by the 
File Browser as (missing). To recover the entire directory tree, invoke the Populate command from the 
directory's context menu. Be sure to select the Recursive option from the Populate dialog.
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Deleting a File -- Intentionally and Permanently
Sometimes, you want to delete a file permanently (see note). That is, you want the file to disappear from 
your workspace, and from other users' workspaces, too. The file might be related to a product feature that 
was cancelled. Or perhaps a code reorganization rendered the file unnecessary.

Deleting a file at the AccuRev depot level (rather than simply at the operating system level) is called 
defuncting, and is implemented by the Defunct command.

Defuncting a file removes it from the workspace's disk storage (that is, deletes the file at the operating 
system level). In addition, the Defunct command is recorded in the depot. It may be surprising at first, but 
AccuRev manages the defuncting of a file in the same way as it manages the creation of new versions. To 
AccuRev, defuncting is just another kind of change that can happen to a file:

• Defuncting "activates" a file in the workspace stream, recording the fact that you've made a change 
to the file. In addition to getting (defunct) status, the file gets the (kept) and (member) statuses, 
just as if you had performed a Keep command.

• AccuRev records the change as a new version of the file in the workspace stream (in this example, 
version talon_dvt_john\10).

• At first, the defuncting of a file is isolated to your own workspace. The file continues to exist in 
other users' workspaces.

• To "share" the defuncting of a file, you Promote the change to the backing stream. This causes the 
file to disappear from your workspace stream, and from the File Browser display. The file will 
disappear from other users' workspaces when they invoke the Update command.

• As always, you propagate the change -- in this case, removal of the file -- throughout the depot by 
promoting the defuncted file from the backing stream to the depot's higher-level streams.

Note: Defuncting isn't really permanent (and the file isn't even really gone)

The Defunct command does not actually remove the file element from the AccuRev repository. 
Because AccuRev is TimeSafe, old versions of the file continue to exist in the repository. You can 
see such versions in snapshots of streams, in History Browser displays, etc. You can restore such 
elements with the CLI command undefunct.

Incorporating Others' Changes into Your Workspace
As you and your colleagues make changes to a project 's code base, the contents of your private 
workspaces diverge more and more. It's a software-development best practice to periodically incorporate 
others' changes into your workspace, effectively resynchronizing the workspaces (partially or fully). The 
Update command performs this task, by copying versions that your colleagues have Promote'd to the 
backing stream into your workspace.
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This is an oversimplification. For some elements, you must use the merge operation to incorporate other's 
changes into your workspace. For a complete discussion of the update operation, see Updating a 
Workspace on page 30.

Merging Your Changes with Someone Else's Changes
AccuRev supports concurrent development: two or more users can start with the same version of a file and 
make changes to that file independently -- both content changes and namespace changes. After one of the 
users Promote's his changes to the backing stream, each of the others must Merge her own changes with 
the newest version in the backing stream, using the Merge tool. We describe here how to initiate a merge 
operation.

As you work on a file, Keep'ing intermediate versions in your workspace, the file's status alternates 
between (modified) and (kept). At any point, you may notice that an additional indicator, (overlap), 
appears in the Status column. To make sure you notice, the File Browser displays the entry with a yellow 
highlight.

Note: Elements with a (twin) status are also highlighted in yellow. See (twin) on page 88 for more 
information.

This means that a new version of the file has been promoted to the backing stream. Typically, one of your 
colleagues has edited the file and promoted her version to the backing stream. It may also be that someone 
has promoted a new version of the file to a higher-level stream, and the backing stream dynamically 
inherits the new version "from on high".

Whenever a file's status is (overlap), the Merge command is enabled. The execution of a Merge command 
concludes with the Keep'ing of a new version in your workspace.
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In this example, the Merge involved incorporating a namespace change: the file's name has changed from 
report_writer.pl to reporter.pl. When you Promote this merged version to the backing stream, the file's 
status returns to (backed).

Note: Underlap status

The status (underlap) is similar to (overlap), in that an element has changed in your workspace and 
also in the backing stream. With (underlap), the changes in your workspace version have already 
been promoted to the backing stream (from another workspace, or from a stream elsewhere in the 
depots stream hierarchy). You can resolve an underlap in the same way as an overlap -- by merging and 
promoting. But in many cases, it is more appropriate to use the Revert to Backed command to undo the 
changes in your workspace.

Controlling the Display of Element Names
Typically, the elements found by a search are located in a number of different folders, throughout the 
workspace. A user preference controls how to display the locations of the elements:

• Display the complete depot-relative pathname of the object as a single string (Element column). 

• Display the object's simple name (Name column) separately from the pathname to its parent directory 
(In Folder column).

Use the Tools > Preferences command to make this choice ("Display of element name in tables"). It 
affects all instances of the File Browser, along with other tools that display element pathnames.

Details Pane Command Reference
You can invoke the following commands from the Details pane toolbar or the context menu of a selected 
file or directory. Some of the commands operate on a multiple-element selection. Other commands are 
available from the Workspace Explorer toolbar.

Only a subset of these commands are available when the File Browser is in include/exclude mode.

Go to root

Have the Details pane display the contents of the depot's (and workspace's) top-level directory.

Up one level

Have the Details pane display the contents of the current directory's parent.

If the current directory is the target of a directory link, this command switches to the target's 
parent, not to the directory containing the link.

Open (equivalent to double-click)

File: 
(Windows) Run the appropriate command on the file, according to its file type (the Windows file-
typing system—"file associations”—does not provide for assigning a file type if the filename has 
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no suffix.)
(UNIX) Open a text editor on the file.

Directory: Have the Details pane display the contents of the directory.

Element link or symbolic link: This command operates on the target of the link.

View

(text files only) Open a text editor on a temporary copy of the currently selected file. (You can use 
environment variable AC_EDITOR_GUI or EDITOR to control which text editor gets invoked. If 
neither variable is set, AccuRev selects a program provided by the operating system.)

Link to a file element: this command operates on the target of the link.

Save As

Copy the currently selected file or directory to another location. The entire subtree below a 
directory is copied.

Element link or symbolic link: this command operates on the target of the link.

Edit

Open a text editor. (You can use environment variable AC_EDITOR_GUI or EDITOR to control 
which text editor gets invoked. If neither variable is set, AccuRev selects a program provided by 
the operating system.)on the currently selected file. (Select exactly one file before invoking this 
command.)

The File Browser automatically updates the file's status indicators after an edit session. If you have 
changed the file's contents, AccuRev automatically includes the (modified) status indicator in the 
Status column.

Note: You can also change the contents of files using operating system commands, scripts, and third-
party tools, including integrated development environments (IDEs). In this case, invoke the command 
View > Refresh or press function key F5 to update the Details pane status indicators.]

Link to a file element: this command operates on the target of the link.

Add to Depot

(workspace only) Place the selected files/directories under version control. All the selected objects 
must currently have (external) status. For each one, AccuRev creates version 1 in the workspace 
stream.

Link to a directory: If the (external) object is a symbolic link (UNIX/Linux) or a junction point 
(Windows), this command's default is to create an AccuRev element link, not an AccuRev 
symbolic link. The target of the link must be a directory element visible in your workspace. If you 
wish to convert all such directories to AccuRev symbolic links, use the Add links as symbolic 
links checkbox in the Add to Depot dialog box.

Note: Windows junction points are not supported on FAT or FAT32 file systems.

Keep

(workspace only) Create a new version in the workspace stream for each selected file. All of the 
selected objects must be file elements; none can have (external) status and none can be a 
directory. A dialog appears, in which you can enter a comment string and select other options.

Typically, you invoke the Keep command on files that you've been working on, and thus have 
(modified) status. But this is not a requirement. If you Keep a file that you have not modified, a 
new version is created with identical contents.
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The first time you Keep a file, it becomes active in the workspace (by being placed in the 
workspace's default group). After that, you can modify and Keep the file as many times as you 
like. The file remains active in the workspace until you run the Promote or Revert to Backed 
command on it.

Link to a file element: this command operates on the target of the link.
Note: An element link can never have (modified) status; both creating a link and changing its target 
give the element link (kept) status. Thus, the element link itself never needs to be Keep'ed.

Special case: Renaming a Modified File Before Keeping It on page 123

Anchor

(workspace Actions and context menu only) Make the selected files/directories active in the 
workspace (by placing them in the workspace's default group). The files/directories themselves are 
not modified in the workspace tree. Typically, you anchor a file in your workspace to prevent a 
subsequent Update command from overwriting it with a newer version. (Update overwrites 
inactive files only, not active ones.)

File(s) that you Anchor must not currently be the workspace's default group. Anchor creates a new 
version in the workspace stream. This new version simply records the fact that the file is officially 
active in the workspace.

Element or symbolic link: this command operates on the link itself.

Notes:
• Anchor creates a virtual version

Other commands that create a new version in a workspace (Keep, Move, Defunct, undefunct 
(CLI only)) create a real version. These commands record an actual change to the element, or 
to its visibility.

But Anchor creates a virtual version, because you haven't made a change to the element -- 
you've merely reinstated some existing version.

See Real Versions and Virtual Versions on page 134.

• Anchor-required and exclusive file locking workspaces

In an anchor-required or exclusive file locking workspace, you must run the Anchor command 
on a file before modifying its contents. When you anchor a set of elements in an anchor-
required or exclusive file locking workspace, a dialog appears if one or more of them are 
active in a sibling workspace. This enables you to select/deselect individual elements to be 
anchored. Note that the elements that are active in the sibling workspace are initially 
deselected. This makes it easy to avoid the situation where multiple users are working on the 
same file(s) concurrently. The exclusive file locking feature guarantees that this situation won't 
occur.

SeeThe Locks Dialog Box on page 52.

Promote

Send the active version of the selected files/directories to the parent stream. The promoted 
element(s) become inactive in the workspace or stream (are removed from the default group). The 
status of the elements becomes (backed). 

Element or symbolic link: this command operates on the link itself, not on the target of the link.

Notes:
• Promote creates a virtual version
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The version that Promote creates in the parent stream is a virtual version. No data is copied 
from your machine to the repository by this command; it just creates new entries in the 
repository database.

See Real Versions and Virtual Versions on page 134.

• Promoting from a time-based stream

When you promote a version from a time-based stream, it does not become inactive in that 
stream. Doing so would cause the promoted version to disappear from the stream, because the 
stream would now inherit a version that was created prior to the basis time.

• Integration between configuration management and issue management

If either or both of the integrations between AccuRev's configuration management and issue 
management facilities is enabled, a particular AccuWork query is executed and its results 
displayed.

You can select one or more of the issue records and click Ok; or you can type one or more 
numbers (SPACE-separated) in the Issue # input field. The integration(s) record information 
about the Promote transaction in the issue record(s) you designate.

Note: If you have enabled the use of third-party issue tracking system (ITS) keys in the 
AccuWork schema, the Select Issue (Change Package) dialog displays additional controls 
that let you specify whether you want to use AccuWork issue numbers or third-party keys 
when selecting issues to promote against. See the section “Using Third-Party Keys in the 
AccuRev GUI” in the AccuRev® Technical Notes for more information.

Merge

(workspace only) For each selected file, perform a merge operation, involving two versions: the 
one in your workspace and the one in the workspace's parent stream. The resulting "merged 
version" is saved as a new version in the workspace stream.

The merge operation takes into account both the contents of the versions to be merged and the 
pathnames of those versions. Thus, at the completion of a Merge command, a file might have a 
different name or be located in a different directory, or both.
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Element or symbolic link: this command operates on the link itself, resolving conflicting changes 
to the link object. For example, two users might each have "retargeted" a link (to different 
pathnames), using Copy / Paste. Or two users might each have renamed a link (to different 
names).

Resolve Twin Status

(workspace Actions and context menu only) For each selected element, resolve the element’s 
(twin) status using either a wizard or defunct actions. See Resolving (twin) Status on page 91 for 
more information.

Revert to Backed

(workspace Actions and context menu only) For each selected element, remove all changes you've 
made since the last time you Promote'd it, or since the last Update of the workspace -- whichever 
is more recent. For files, this includes both content changes and namespace changes. For 
directories, this includes namespace changes only. For links, this command operates on the link 
itself, "undo"ing any changes you've made to the specification of the link target. For example, you 
might have changed the link with the defunct or rename commands. Or you might have used 
Copy / Paste to point the link at a different target directory.

The selected elements become inactive in the workspace (they are removed from the workspace's 
default group). The status of the elements becomes (backed).

When you invoke this command in a dynamic stream, the depot's pre-promote-trig trigger fires. 
That's because, like a Promote, the command changes which version of the element appears in the 
stream.

Revert to Most Recent Version

(workspace Actions and context menu only; file element with (modified) status only) Replace the 
file with the most recent version you created with Keep. (This command does not undo any 
namespace changes you made with Rename or with Cut-and-Paste.) Use this command when 
you've saved one or more intermediate versions of the file(s), and you want to discard further 
changes you've made since a Keep.

The selected elements remain active in the workspace. That is, they are not removed from the 
workspace's default group. The (modified) status of the elements changes to (kept).

If you've modified a file but not yet performed a Keep on it, this command works like Revert to 
Backed.

Link and directory elements: this command is disabled, because a link or directory element cannot 
have (modified) status.

Annotate

(text files only) Open an Annotate tab, displaying the contents of the selected version. Each text 
line is annotated with information on how it was created.

Link to a file element: this command operates on the target of the link.

Show History

Open a History Browser tab, containing the transactions involving the selected element.
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Browse Versions

Open a Version Browser tab, showing all the versions of the selected element, and their 
interrelationships (ancestry).

Browse Stream Versions

Open a Stream Version Browser tab for the selected element. This tab displays the depot's stream 
hierarchy, much like the Stream Browser. But on this tab, each stream represents the version of 
the selected element that appears in that stream.

Diff Against...
Most Recent Version

(workspace Actions and context menu only) Compares the file in your workspace tree with the 
version currently in your workspace stream. Use this command if you've modified the file since 
the last time you performed a Keep on it, or since you last Update'd it.

You can invoke this command on a multiple-file selection. A separate tab opens for each file.
Backed Version

(workspace Actions and context menu only) Compares your version with the version currently in 
the backing stream. In a workspace, "your version" is the file in your workspace tree. If the file has 
(modified) status, there is no official version in the repository with the same contents. In a stream, 
"your version" is that stream's current version.
Note: If you are in a time-based stream, AccuRev uses the version that was in the backing stream 
at the basis time, not the version currently in the backing stream.

This might include the changes stored in several intermediate versions that you've created with 
Keep. For example, you might use this command to see all the changes you've made to a file since 
you Update'd your workspace and starting working on the file.
Note: This example assumes no one else has promoted a new version to the backing stream in the 
meantime.]

You can invoke this command on a multiple-file selection. A separate tab opens for each file.
Basis Version

(workspace Actions and context menu only) Compares your version with the version that you 
started working with, before making your recent changes.

You can invoke this command on a multiple-file selection. A separate tab opens for each file.

WIP (Work in Progress)

(workspace Actions and context menu only) Open a WIP tab, displaying the active elements in 
workspaces and/or streams related to the selected stream.

Rename

(workspace Edit menu only) Change the name of the selected element, using the Rename dialog. 
The new name can be in a different directory within the depot. Thus, this command can perform a 
"move" as well as a "rename". See Resolving Namespace Conflicts on page 253.

This command activates the object (by including it in the workspace's default group). The (kept) 
and (member) flags are added to its status.

If you change the contents of a file, then rename it without first performing a Keep, the version 
created by Rename does not contain the content changes, just the name change. The file's new 
status reflects this, having the (modified) and (member) flags.
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Copy

(workspace Edit menu only) Designate the selected object (file, directory, or link) to be the target 
of an element link or a symbolic link. Use the Paste command to complete the creation of the link 
object.

Tip: You can use the Ctrl+c keyboard shortcut for Copy.

Cut

(workspace Edit menu only) Mark the currently selected element to be moved to another directory 
in the same depot. To finish the relocation, right-click the destination directory (in either the 
Folders or Details pane) and select Paste.

Tip: You can use the Ctrl+x keyboard shortcut for Cut.

Paste

(workspace Edit menu only) The behavior of Paste varies slightly based on whether you used Copy 
or Cut to place the element on the clipboard.
• Paste after Cut -- (workspace only) Specify the destination for an element that has been 

marked for relocation with the Cut command.

• Paste after Copy -- (directory in workspace only) Create an element link or symbolic 
link in the selected directory. The target of the link is the file, directory, or link element 
on which you previously invoked the Copy command.

You can create a link that points to another link. A chain of links can be arbitrarily long, but 
must end at some file element or directory element. By default, the link object has the same 
name as the target object. But you can change the name in the Paste Link dialog, which 
appears after you perform the Copy operation.

If the name you specify does not currently exist, AccuRev creates a new link element (add 
transaction). If the name you specify is an existing link element, AccuRev changes the target 
of that link element (keep transaction).

Tip: You can use the Ctrl+v keyboard shortcut for Paste.

Delete

(workspace only) Remove the selected element(s) from the workspace tree . This command does 
not affect the depot -- AccuRev still thinks the deleted objects should be there, so it continues to 
list them, with (missing) status.

To remove an element from the depot's stream hierarchy, so that its removal will be reflected in 
other users' workspaces (after you Promote the change and they perform an Update), use the 
Defunct command instead of Delete.

Defunct
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(workspace only) Remove the selected element(s) from the workspace tree , and also change their 
status to (defunct). This also activates the elements in the workspace stream -- they're "in the act 
of being deleted". Accordingly, the elements also get the (kept) and (member) status flags.

Notes:
• Promoting a defunct element

When you Promote a defunct element, it disappears entirely from the workspace stream, and 
from the File Browser display. The element becomes (defunct), and also active, in the 
backing stream.

• Updating a defunct element

When you Update a workspace below a stream with a (defunct) file or link, the file or link is 
removed from the workspace tree. For a (defunct) directory, Update removes the directory 
and its entire subtree from the workspace tree.

Populate

For each selected element, copies the version that is currently in the workspace stream to the 
workspace tree. This has the effect of undoing an accidental deletion, or discarding edits that you 
have not yet preserved with Keep.

A dialog controls the ability to populate entire directory subtrees, along with the ability to 
overwrite files in the workspace tree. 

New File

Bring up a dialog to create an empty file in the current directory, and optionally place it under 
version control.
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New Folder

Bring up a dialog to create an empty subdirectory in the current directory, and optionally place it 
under version control. 

Send to Issue

Create a new entry (or modify an existing entry) in the change package section (Changes tab) of 
one or more issue records. The version you specify becomes the head version of the change 
package entry; AccuRev determines the corresponding basis version automatically.

The default query for the current depot is executed, and the results are displayed in a dialog. You 
are prompted to choose one or more of the issue records selected by the query. You can also create 
a new issue record, whose number will be entered in the dialog.

Send to Change Palette

(dynamic stream only) Load the selected versions into the Change Palette, so that they can be 
promoted to another stream. For some versions, a merge might be required prior to the promotion.

Properties

 Displays information about the selected element. The data items displayed vary with the type of 
element.
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AccuRev Element Status
Development work involves making changes to elements -- both files and directories. As files get edited in 
workspaces, new versions get created in workspace streams, and existing versions get promoted to higher-
level streams, AccuRev shows you the current status of each element. Keep in mind that the status of an 
element in your workspace may be different from its status in other workspaces and streams.

An element's file status is indicated by a set of one or more status indicators (or flags), each in the form of 
a parenthesized word. For example:

(overlap)(kept)(member)

Even though we use the term "file status", each directory element also has a status in each workspace and 
stream. A subset of the status indicators is used to report directory statuses.

These controls affect the File Browser's display of elements and their file statuses:

• User Preferences

• Show External Objects 

• Include Ignored Objects

• Timestamp Optimization (File Browser checkbox; see Timestamp Optimization: Controlling the 
Determination of (modified) Status on page 98 for more information)

File Status Indicators
The following sections detail the AccuRev status indicators, organized by category:

Link-Related Indicators
(elink)

The element is an element link. (The link's icon is .)

(slink)

The element is a symbolic link. (The link's icon is .)

(missing-target)

For an element link, the target element is not present in the workspace or stream. This can occur if the 
target element is removed from the workspace tree by an operating system command. It can also result 
from an Include from Stream or Exclude command. For a symbolic link, there is no object at the 
target pathname.

(modified-target)

For an element link, the target element has been modified (either a content change or a namespace 
change) in the workspace or stream.

(corrupted)

For an element link in a workspace, AccuRev and the operating system disagree on the link target. 
That is, the target element recorded in the AccuRev repository differs from the target in the operating 
system’s instantiation of the link in the workspace tree. This can occur if you modify or replace a link 
using operating system commands instead of AccuRev commands.
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A cross-linked element (see (xlinked) below) gets (corrupted) status if AccuRev does not overwrite 
the element during execution of the Include from Stream command, because the element has 
(modified) or (kept) status in the workspace. This should not occur during normal operation.

Presence of the Element in the Workspace or Stream
(defunct)

The element has been marked for removal from the workspace or stream with the Defunct command.

Workspace: the element has already been removed from the workspace tree (local disk storage). It will 
be removed from the workspace stream (in the depot) when you Promote the element to the parent 
stream.

Dynamic stream: the element will be removed from the stream (in the depot) when you Promote the 
element to the parent stream.

(external)

(workspace only) The file or directory has not been placed under version control. (There's an object in 
the workspace tree, but no element has been created in the workspace stream.)

(ignored)

(workspace only) An external file or directory that matches a pattern specified in either the 
ACCUREV_IGNORE_ELEMS environment variable, the .acignore file, or the --ignore option for the add, 
stat, and files CLI commands.

(excluded)

The element does not appear in the workspace because it has been excluded, using the include/exclude 
facility. For file elements, it's likely that the exclusion was explicitly set on the directory in which the 
file resides, or on a higher-level directory that includes the file.

(xlinked)

This version of the element appears in the workspace or stream by virtue of a cross-link (Include from 
Stream command) — either on the element itself or on its parent directory or a higher-level directory.

(missing)

(workspace only) The workspace "should" include a version of this element, but doesn't. This occurs 
when you delete version-controlled files from the workspace tree using operating system commands, 
or using the AccuRev Delete command. If an operation causes the target of an element link to be 
removed from a workspace, AccuRev removes the element link, also, causing it to have (missing) 
status.

(no such elem)

This status can appear under two circumstances:

Update preview: The element does not currently exist in your workspace, but will be created if you 
proceed with the update.

Element security: An AccuRev administrator has changed your access to an element or namespace 
with the eacl command during your session, and you are now denied access to something that was 
already displayed in your File Browser.
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(twin)

The element is one of multiple elements in the workspace that exist at the same pathname. At most one 
of these elements can be accessed through the pathname; the other(s) can be accessed through their 
unique element-IDs. Elements with this status appear with a yellow highlight.

See Resolving (twin) Status on page 91 to learn different ways to resolve an element’s (twin) status.

Note: Elements with (overlap) status are also highlighted in yellow. See (overlap) on page 88 for 
more information.

(stranded)

The element is active in the workspace or stream, but there currently is no pathname to the element.

See Chapter 8 Version Control of  Namespace-Related Changes in AccuRev Technical Notes for more 
information on stranded elements.

Changes to the Element
(modified)

(workspace only) The file has been modified in the workspace since the most recent Update or Keep. 
You can control how AccuRev determines whether a file has this status: see Timestamp Optimization: 
Controlling the Determination of (modified) Status on page 98.

(kept)

A new version of the element has been created with Keep, Rename, or Defunct (or the CLI command 
undefunct) and the file has not subsequently been modified, promoted to the backing stream, or purged 
(Revert to Backed).

(member)

The element is active in the workspace. Commands that create a new version in the workspace or 
stream also make the element active there (if it isn't already).

Relationship to the Version in the Parent Stream
(backed)

The version in the workspace stream is the same as the version in the backing stream. And you have 
not changed the element since the last time you Promote'd it or purged it with Revert to Backed, or 
since the most recent Update of your workspace.

(stale)

(workspace only) The element needs to be updated, because the version in the backing stream has 
changed since the workspace's latest Update. And since you have not changed the element in your 
workspace, it can be safely updated (no unpreserved changes will be overwritten).

(overlap)

The element has changed both in this workspace or stream, and in the parent stream. This indicates that 
a merge is required before you can promote your changes to the parent stream. Elements with this 
status appear with a yellow highlight.

Note: Elements with (twin) status are also highlighted in yellow. See (twin) on page 88for more 
information.
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(underlap)

The element has changed both in this workspace or stream, and in the parent stream -- but the parent 
stream already contains the changes in this workspace or stream. In many cases, it is most appropriate 
to use Revert to Backed to remove your changes from this workspace stream. In other cases, you can 
merge and promote, just as with an (overlap)-status element.

Note: In a workspace, Revert to Backed restores the version of an element that was in the parent 
stream at the time of your workspace’s most recent Update. You might need to perform another 
Update to bring the version causing the (underlap) status into the workspace.

File Status Diagram
This diagram shows many of the file statuses, illustrating how an element's changing status indicates its 
development progress. This diagram suggests that as more work is performed on an element, it "rises to a 
higher level" of development. (That's the idea behind having a command named "promote".) The diagram 
also depicts the fact that AccuRev tracks changes to an element in two "dimensions":

• It records changes made by AccuRev commands as new versions in the depot.

• It detects that a file's contents have changed at the operating system level.

This diagram captures the following facts:

• Before you start working on an element, it's unchanged along both the AccuRev dimension and the 
operating-system dimension. Its status is (backed).
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• When you modify the contents of a file, it changes along the operating-system dimension only, and 
becomes (modified).

• The following involve changes along the AccuRev dimension. This makes the element active in 
the workspace, so its status indicates that it is a (member) of the default group.

• When you Keep a file that you've modified, its status becomes (kept).

• An element can also achieve (kept) status through a namespace change -- Rename or Defunct 
command. This is a change along both the AccuRev and operating-system dimensions.

Note: The CLI command undefunct, which reinstates a previously defuncted object, works similarly. 
This command is not in the GUI.

• The Anchor command change a file along the AccuRev dimension only. The file's status becomes 
(member).

• You can create any number of intermediate versions of a file in the workspace, by repeatedly 
modifying the file then Keep'ing it. Throughout this process, the file remains a (member) of the 
workspace's default group. In addition, its status toggles between (kept) and (modified).

• You can Promote an element whose status is (kept). This returns the element's status to (backed) 
-- the workspace now uses the newly promoted version in the backing stream.

The following images show which statuses are matched by a particular File Browser search:.

• Pending
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• Modified

• Kept

• Non-Member

• Default Group

• Modified in Default Group

• External

• Overlap

• Stranded

• Missing

Resolving (twin) Status
An element has a (twin) status when it and another element have the same pathname in a dynamic stream. 
Elements with (twin) status are highlighted in yellow in the File Browser, Change Palette, and the default 
group to make them easy to spot. Both directories and files can have (twin) status.

Elements with (twin) status cannot be promoted until their (twin) status is resolved. To resolve an 
element’s (twin) status, you can:

• Defunct one of the elements in conflict. For example, you might decide to defunct the version of the 
element that is in the workspace, implicitly keeping the one that is in the backing stream.

• Rename one of the elements in conflict. This action lets you keep both versions in AccuRev.

You can perform defunct and rename operations manually using commands in either the AccuRev GUI or 
the AccuRev CLI, but the AccuRev GUI provides enhanced features -- a twin status resolution wizard, and 
one-step defunct operations -- that help simplify the process of resolving an element’s (twin) status. The 
remainder of this section describes these features and when to use them.

Locating Twin Elements
You can locate elements with a (twin) status using either the Overlap or Deep Overlap search filters. 
Elements are highlighted in yellow where they are displayed (in the File Browser and Change Palette, for 
example). See Performing Searches of the Entire Workspace or Stream on page 60 for more information on 
AccuRev searches.

The Twin Resolution Wizard
AccuRev provides a wizard you can use to resolve an element’s (twin) status. You should consider using 
the twin resolution wizard if:

• You want to compare the elements that are in conflict. Before deciding whether to defunct or 
rename an element that is in conflict, it can be useful to compare the versions side-by-side. The twin 
resolution wizard provides a Diff view for directories and files. The information that is displayed 
varies by type -- colors are used to show changed, added, and deleted text in text files, for example. 
See Diff View Varies Based on Element Type for more information. AccuRev also displays the element 
ID (EID) of the versions in conflict.
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• You want to view element history. A Show History button for both versions of the element that is 
in conflict opens the History Browser, allowing you to review the transactions and changes associated 
with each version.

• You want to merge the elements’ contents. The twin resolution wizard’s Merge Contents page 
includes the same tools as AccuRev’s Merge view, allowing you to review and accept or reject 
proposed changes. When you choose the element in which you want to save the merge changes, 
AccuRev automatically defuncts the other version. Merge is available for text files only.

Note that you can use the twin resolution wizard on individual elements only. You can, however, defunct 
multiple elements at one time. See Defuncting Twin Elements for more information.

Diff View Varies Based on Element Type
The following list summarizes how the twin resolution wizard’s Diff view varies for directories and 
different types of files.

• Directories. When you resolve a directory with a (twin) status, the twin resolution wizard displays 
navigable trees for the directories that are in conflict, allowing you to easily compare directory 
contents.

• Text files. When you resolve a text file with a (twin) status, the twin resolution wizard displays a Diff 
view with color-coded text to show you where the files in conflict differ.

For details about using the Diff view, see The Diff Tool on page 211.

With text files, you can optionally choose to merge contents; in this case, the twin resolution wizard 
displays a full-featured Merge view, as shown here:
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For details about using the Merge view, see The AccuRev Merge Tool on page 237.

• Binary files. If the file type of the element with (twin) status is binary, the twin resolution wizard 
displays a table that summarizes information about each version (the date the file was last modified, 
real and virtual version numbers, and so on).

• Image files. To allow simple visual inspection of versions that are in conflict, the twin resolution 
wizard renders images for .jpeg, .jpg, .gif, and .png file types, as shown in the following illustration.

Images of other types are treated as plain binary files.
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Where You Can Run the Wizard
You can run the twin resolution wizard from the:

• File Browser

• Default group

• Change Palette

The basic procedure for running the wizard is the same regardless of where you start. However, there are 
slight differences to consider when running the wizard from the Change Palette. These differences are 
identified in the following procedure, How to Run the Wizard.

How to Run the Wizard
To run the twin resolution wizard:

1. Right-click the element whose (twin) status you want to resolve.

Note: The twin resolution wizard can be used on individual elements only.

2. Choose Resolve Twin Status > Use Wizard from the element’s shortcut menu.

AccuRev displays the first page of the twin resolution wizard. Instructions and actions appear at the 
top of the view, as shown here:

Versions of the element in conflict appear in a panel beneath the instructions as described in the section 
Diff View Varies Based on Element Type.

Note for Change Palette users: If you are cross-promoting from one stream to another (not from a 
stream to a workspace), AccuRev first displays the Please Choose a Workspace dialog box. The Please 
Choose a Workspace dialog box displays a list of workspaces off the destination stream you selected 
when creating the Change Palette. AccuRev needs this workspace in order to resolve the twin 
elements. For example:
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Choose the destination stream workspace you want to use and click Ok to continue. 

If the destination stream workspace you select in the Please Choose a Workspace dialog box does not 
contain a version of the twin element with a (backed) status, AccuRev displays a warning message. 
AccuRev will not start the twin resolution wizard until you have addressed the situation described in 
the warning message.

3. In the Diff view, review the versions of the element that are in conflict and then specify whether you 
want to keep one or both elements:

• Keep one element. Choose this option if you know which element you want to keep; AccuRev 
will automatically defunct the other. Then, click Next and go to Step 4.

Note: If you want to merge the contents of a text file that is in conflict, choose this option.

• Keep both elements. Choose this option to keep both elements. Then, click Next and go to Step 6.

Note that if you click the Show History button for an element, you must return to the twin resolution 
wizard to complete the resolution process. The wizard and the History Browser views are independent.

4. On the Keep One Element page, select the version of the element you want to keep. 

If you are resolving the (twin) status of a directory, binary file, or image file, or of a text file whose 
contents you do not wish to merge, go to Step 7. 

If you are resolving the (twin) status of a text file and you want to merge file contents, select the 
Merge the contents of the two elements check box. Then, click Next and go to Step 5.
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5. In the Merge view on the Merge Contents page, review the results panel, which displays the changes 
that will be saved to the file you chose in Step 4. You can use the tools of the Merge view to keep or 
reject individual changes. See The AccuRev Merge Tool on page 237 for more information.

When you are satisfied with the proposed merge results, go to Step 7.

6. On the Keep Both Elements page, select the version of the element you want to rename, and then enter 
the new name in the Name field. 

Note that you can change only the element’s name, and not its path; the element will remain in the 
same directory and same stream (workspace or backing, for example) that you choose in this step.

7. Click Finish.

AccuRev resolves the element’s (twin) status as you specified in the wizard.

Note for Change Palette users: If you are cross-promoting changes from one stream to another (not 
from a stream to a workspace), AccuRev displays the Promote dialog box, identifying elements in the 
destination stream workspace that need to be promoted in order to complete the twin resolution 
process. Names for these elements are appended with the suffix .old_<EID>, where <EID> is the 
element ID (EID) of the version you chose to defunct in Step 4. For example, if resolving the twin 
element resulted in defuncting an element with the name fabricator.c and an EID of 92, the element 
name displayed in the Promote dialog box would be fabricator.c.old_92.
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Defuncting Twin Elements

AccuRev lets you explicitly defunct one or more elements with a (twin) status directly from the shortcut 
menu. That process is described here.

When to Use Defunct
Consider using defunct to resolve an element’s (twin) status when:

• You know which of the elements in conflict you want to defunct (the version in the workspace, and not 
the version in the backing stream, for example)

• You do not need to compare or merge the elements’ contents before defuncting

• You want to resolve multiple elements with a (twin) status at the same time

How to Defunct Twin Elements
To defunct one or more twin elements:

1. Select the elements whose (twin) status you want to resolve.

Tip: Use SHIFT+ and CTRL+ to select multiple elements.

2. Right-click one of the selected elements and choose Resolve Twin Status from the shortcut menu.

3. Next, choose the version you want to defunct (workspace or backing stream, for example).

Note: The same version is defuncted for all of the elements you selected in Step 1.

AccuRev displays a message asking you to confirm the defunct operation.

4. Choose Yes to defunct the version of the selected elements.

Choose No to cancel the defunct operation.

If you are defuncting the twin element from the File Browser, you are done. 

Note for Change Palette users: If you are defuncting the twin element from the Change Palette, 
AccuRev displays the Please Choose a Workspace dialog box. The Please Choose a Workspace dialog 
box displays a list of workspaces off the destination stream you selected when creating the Change 
Palette. AccuRev needs this workspace in order to resolve the twin elements. For example:

Choose the destination stream workspace you want to use and click Ok to continue. 

If the destination stream workspace you select in the Please Choose a Workspace dialog box does not 
contain a version of the twin element with a (backed) status, AccuRev displays a warning message. 
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AccuRev will not start the twin resolution wizard until you have addressed the situation described in 
the warning message.

Timestamp Optimization:
Controlling the Determination of (modified) Status

Note: This topic applies to workspaces -- not to dynamic streams or snapshots.

In various situations, AccuRev searches some or all of your workspace tree to determine which files's 
status should include the (modified) indicator.

The AccuRev administrator can specify which method is the site default by setting an environment 
variable. See Timestamp Optimization (TSO) in the AccuRev Administrator’s Guide for more information.

Controlling the Display of External Objects
Note: This topic applies to a File Browser displaying the contents of a workspace -- not a dynamic 
stream or snapshot.

By default, the Details pane of the File Browser shows both elements and external objects. The Show 
External Objects preference provides an all-or-none control over the display of external objects -- even 
those external objects you might have instructed AccuRev to ignore when they match a user-specified 
ignore pattern.

If you also want AccuRev to display ignored external objects, select the Include Ignored Objects 
preference, too.

See AccuRev Preferences  (Tools > Preferences Command) on page 41 to learn more about setting 
preferences in AccuRev. See Chapter 3 Specifying Ignore Patterns for External Objects in the AccuRev 
Technical Notes for more information and examples of how to specify ignore patterns.

Using the File Browser's Include/Exclude Mode
By default, a workspace contains a copy of each file under version control in a particular depot. (More 
precisely, a workspace contains a copy of each version in a particular stream.) But sometimes, you don't 
want or need a copy of every file -- for example, if your current assignment doesn't include "rebuilding the 
world" each night. The depot might contain many thousands of files, of which you might need only a small 
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subset. The File Browser's Include/Exclude facility enables you to define and work with a subset of the 
depot's elements.

When you check (or clear) the Include/Exclude Mode checkbox, the File Browser immediately switches 
into (or out of) Include/Exclude mode. (There's no Ok button to press.).

The File Browser works significantly differently in this mode, as described in the following sections.

See also: Getting Only the Files You Need: the Include/Exclude Facility on page 26 of the AccuRev 
Concepts Manual.

File Browser Layout in Include/Exclude Mode
In Include/Exclude mode, both the Folders and Details panes show all elements in the workspace or 
stream. Elements that are currently excluded have (backed)(excluded) indicators in the Status column. 
For example, if top-level directory doc is excluded, the File Browser still shows it in both the Folders and 
Details panes:
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You can navigate into an excluded directory. Its elements have (missing)(excluded) status, except for 
those that are stranded, which have (member)(excluded) status.

The File Browser gets a new pane, the rules pane, in Include/Exclude mode. This pane shows include and 
exclude rules that affect the current workspace or stream:

• If the Show Inherited Rules checkbox is cleared, only the rules that were explicitly set for the current 
workspace are listed.

• If the Show Inherited Rules checkbox is checked, the listing also includes rules inherited from higher-
level streams. The Set in Stream column indicates which higher-level stream.

In Include/Exclude mode, the Details pane toolbar changes: most of the buttons for AccuRev's version-
control commands -- Keep , Promote , Merge , etc.-- disappear. Instead, buttons for the several Include/
Exclude commands appear. A few of the standard toolbar buttons remain, to aid you in navigating the 
depot and determining element history.
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Working in the Rules Pane
The sections below describe how to work in Include/Exclude mode:

Adding Rules
In each depot, there is one hard-coded base rule: the depot's base stream has an include rule that specifies 
the depot's top-level (root) directory. This rule makes the depot's entire directory hierarchy visible in the 
depot's base stream.

Any number of rules can be added. Each rule applies to a particular pathname within the depot's directory 
hierarchy ("Element"), and applies at a particular level in the depot's stream hierarchy ("Set in Stream"). A 
rule set in a dynamic stream gets inherited by lower-level streams; but a rule for the same element in a 
lower-level stream or workspace overrides a rule in a higher-level stream.

Examples:

Include/Exclude Example 1: Excluding a Directory on page 104

Include/Exclude Example 2: Simulating a Sparse Workspace on page 104

Removing Rules
To remove an existing rule that appears in the rules pane:

1. Make sure that your File Browser tab is displaying the stream or workspace in which the rule was 
explicitly set (Set In Stream column). If necessary, open a new File Browser on that stream or 
workspace.

2. Right-click the rule, and select Clear Rule from the context menu.

When you remove a rule from a stream, the effect is immediate on the stream itself and on streams below 
it. The effect does not take place on workspaces below the stream until they are Update'd.

When you remove a rule from a workspace, the effect is immediate on the workspace itself: files are 
copied into the workspace tree if you remove an exclude rule; files are deleted from the workspace tree if 
you remove an include rule.
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Leaving Include/Exclude Mode
To leave Include/Exclude mode in a workspace or stream, clear the checkbox at the bottom of the 
Workspace Explorer. The rules pane disappears, and the Details pane reverts to:

• not displaying elements that have been excluded from the current workspace or stream

• including the standard Details pane toolbar

Include/Exclude Mode Commands
The following commands are available in the File Browser's Details pane, when you have selected Include/
Exclude mode:

Go to root

Have the Details pane display the contents of the depot's (and workspace's) top-level directory.

Up one level

Have the Details pane display the contents of the current directory's parent.

Include

Make the selected element(s) appear in the workspace or stream. If you specify a directory 
element, the entire subtree below it will appear in the workspace or stream, too.

As usual, the particular versions that will appear in the workspace or stream are the ones inherited 
from the backing stream.

Include Directory Only

Make the selected directory element(s) appear in the workspace or stream, but not any of the 
elements within the directory. You can use subsequent Include or Include Directory Only 
commands to make part of the directory's contents appear.

This command enables you to include files and directories that are deep in a depot’s directory 
hierarchy, without having to include lots of other, unwanted elements. If you include a file or 
directory that is several levels below an include-only directory, AccuRev automatically creates the 
necessary Include Directory Only commands required to "dig down" to the level of the desired 
data.
Example:

A depot contains a tools subdirectory, which contains a src subdirectory, which contain a scripts 
subdirectory, which contains two subdirectories, perl and python. If you need only the python 
subdirectory, not the rest of the tools subtree, use these commands:

• Invoke Include Directory Only on tools

• Invoke Include on python

In the Rules pane, note that AccuRev automatically creates "incldo" (Include Directory Only) 
rules for the intermediate directories, src and scripts.
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Include from Stream

Establish a cross-link, making the selected element(s) appear in the workspace or stream. Instead 
of inheriting versions of the element(s) from the backing stream (as with the Include command), 
inherit the versions from the stream you specify in the Basis Stream dialog.

Use the toolbar to filter the streams shown in the dialog. 
Note: For cross-linking to succeed, the element must have been present in the selected Basis Stream at 
the time your workspace was last updated. In a time-based stream, you cannot create a cross-link to 
another time-based stream (or to a snapshot) whose basis time is 'in the future' with respect to your 
stream.

• The Refresh button contacts the AccuRev Server to refresh the list of streams shown.

• The Snapshots Only checkbox restricts the streams shown to snapshot streams only. This setting 
(as well as the sort order of the columns in the dialog) is stored as a preference.

• The Name Filter field filters the streams shown using the text you enter in the field. If the stream 
name contains the text entered in this field, the stream appears. Otherwise, it is filtered out and 
does not appear.

• If you specify a directory element, the entire subtree below it will appear in the workspace or 
stream, too.

Note: As of AccuRev 4.5: in a stream, you cannot Promote to cross-linked elements; in a workspace, 
you cannot Keep (or Anchor, or Defunct, etc.) cross-linked elements.

Exclude

Remove the selected element(s) from the workspace or stream. For a workspace, the elements are 
deleted from the workspace tree. If you specify a directory element, the entire subtree below it will 
be removed.

Properties

Displays information about the selected element: pathname, file type of current version, and 
element-ID.
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Include/Exclude Example 1: Excluding a Directory
To exclude a particular directory from the current workspace or stream, add a new rule for it:

1. Make the directory appear in the Details pane, by going to its parent directory in the Workspace 
Explorer. 

2. Select the directory to be excluded and click the  Exclude button in the toolbar. Alternatively, right-
click the directory and select Exclude from the context menu. 

Alternative: if a rule already exists for the directory -- set at the current level in the stream hierarchy or at a 
higher level -- you can invoke Exclude from the context menu of that rule in the rules pane.

When you exclude a directory, AccuRev removes the entire directory tree below it is removed from the 
workspace or stream. Popup windows have you confirm your intention and provide access to a log listing 
all the excluded elements.

The new exclude rule now appears in the rules pane:

If you're in a dynamic stream, AccuRev reminds you that elements won't be removed from workspaces 
below that stream until they are Update 'd. But keep in mind that element exclusion is instantly inherited 
by streams below that stream.

Note: If you want to remove some, but not all, of a directory tree from a workspace or stream, you 
must use an Include Directory Only rule, not an Exclude rule. See the other examples.

Include/Exclude Example 2: Simulating a Sparse Workspace
If you're accustomed to working in a "sparse" workspace (supported in older versions of AccuRev), you 
may want to do the include/exclude equivalent in a new workspace:

• remove all elements from the workspace
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• add back to the workspace just the elements that you want to appear in it

The first step is accomplished by setting an Include Directory Only  rule for the depot's top-level directory. 
Since the top-level directory never appears in the File Browser's details pane, you must invoke the 
command from the rules pane, not the details pane:

1. Make sure that Show Inherited Rules is checked in the rules pane, causing the depot's base rule to be 
displayed.

2. Right-click the base rule, and select Include Directory Only.

This creates a new rule , at the workspace level, for the top-level directory. This rule overrides the rule you 
just right-clicked, and replaces it in the rules pane:

If you subsequently remove this new rule, the overridden rule will reappear in the rules pane, and will 
reapply to your workspace.

The Add to Depot Command

The Add to Depot command places the selected files and/or directories under version control. For each file/
directory, this includes:

• Creating an element in the depot.

• Creating the version 1 of the element in your workspace stream.

The status of each file/directory changes from (external) to (kept).

Invoking the Add to Depot Command
In the Details pane of a File Browser that is open on a workspace, select one or more files and/or 
directories. All the selected objects must currently have (external) status. Then:

• Click the  toolbar button, or

• Right-click the selection and choose Add to Depot from the context menu.

Video Tip
Click this link to view an introductory video on getting files under 
AccuRev control.

http://www.accurev.com/sites/default/files/videos/55-training-doclinks/dev_Add_New_Source_To_Project.wmv
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The Add to Depot dialog appears, which you use to complete the command.

Using the Add to Depot Dialog
The Add to Depot dialog includes basic options (always visible) and advanced options (visibility 
controlled by a Basic/Advanced button).

Basic Options
Comment

You can enter a comment string in the text box. (AccuRev "seeds" the text box with your most 
recent Add to Depot comment made during the current AccuRev GUI session.) The comment 
string becomes a permanent annotation to the version you're creating.

AccuRev itself does not require a comment, but your organization can establish such a 
requirement by putting a trigger on the Add to Depot command.

Advanced Options
Choose File Type

By default, AccuRev determines the element type for the newly created version automatically 
(text or binary). You can override the default by specifying either of these types or ptext (a 
variant of text). See AccuRev Element Types on page 134.

Choose Lock Type

Choosing Enable File Locking places a lock on the element, to enforce serial development in 
sibling workspaces for that element. This ensures that users in sibling workspaces won't have to 
merge their work on this element. The lock remains on the element until you (or someone else) 
changes this value to Disable File Locking in a subsequent Keep command. See The Locks Dialog 
Box on page 52.

Add links as symbolic links

By default, a symbolic link (UNIX/Linux) or junction point (Windows) is added to the depot as an 
AccuRev element link, not as an AccuRev symbolic link. Use this checkbox to cause such objects 
to be converted to AccuRev symbolic links.

Results of an Add to Depot Operation -- the Details
The Add to Depot command does the following:

• Creates a new element in the depot— A new element object is created in the depot to which your 
workspace belongs. AccuRev will track all future changes to this element -- both content changes and 
namespace changes.

• Creates the first version of the element—A new version object is created in the workspace stream. It 
has a unique version-ID, such as talon_dvt_mary/1 ("the first version of this element created in 
workspace talon_dvt_mary"). A version object is immutable, and cannot be removed from the 
repository. The version created by Add to Depot is termed a real version, because it represents an 
actual change to an element.

• Preserves the contents of the new version—The contents of the new version are preserved permanently 
in the repository. AccuRev copies the file in your workspace tree to a container file in the depot. No 
AccuRev operation modifies or removes the container file (exception: archive command).
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• Sets the element status—The file element gets the status flag (kept) in your workspace. It also gets the 
(member) flag, indicating that the element is active in your workspace.

Note: "Undoing" an Add to Depot operation

There is no true "undo" operation in AccuRev version control, since that would violate the TimeSafe 
principle. But invoking the Revert to Backed command on a file that you just added to the depot (and 
have not promoted) is a very close approximation. The newly created element disappears from your 
workspace; you can retrieve its initial version only by using the unique element-ID. (CLI commands 
hist -fv and cat -e).

The Anchor Command
The Anchor command makes the selected files active in the workspace (places them in the workspace’s 
default group), without modifying them. Typically, you anchor a file in your workspace to prevent it from 
being overwritten with a newer version by a subsequent Update command. (Update overwrites inactive 
files only, not active ones.)

Must-anchor situations: You must anchor a file before editing it if

• You are working in an anchor-required or exclusive file locking workspace, or

• A development lock has been placed on that particular file element.

The Send to Workspace command is a variant of Anchor. Instead of activating the version that is currently 
in your workspace, Send to Workspace can activate any version of the element.

Invoking the Anchor Command

In the Details pane of the File Browser, select one or more file elements whose current status is (backed). 
Then, invoke the command in any of these ways:

• Click the  Anchor toolbar button.

• Right-click the selection to bring up its context menu, then choose Anchor.

In either of the must-anchor situations described above, if any element to be anchored is currently active in 
any sibling workspace, the Anchor dialog box appears, to help you complete the command.
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Using the Anchor Dialog

The Annotate Tab
The Annotate command lists the entire contents of the selected version of a text file, annotating each line 
with:

• The timestamp of the version in which that line was added to the file.

• The number of the transaction in which that version was created.

• The user who performed that transaction.

A version timeline makes it easy to view the contents of any version of the text file.

Opening an Annotate Tab
In the Details pane of the File Browser, select one text-file element. Then, invoke the command in any of 
these ways:

• Click the  Annotate toolbar button.

• Right-click the selection to bring up its context menu, then select Annotate.
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Annotate Tab Layout
The contents of a text file are listed as a multiple-column table. Each row represents one line of the text 
file.

The columns contain:

• Date column: the timestamp of the version in which that line was added to the file.

• # column: the number of the transaction in which that version was created.

• User column: the AccuRev username of the user who created that version.

• Line column: the line number of the text

• Content column: the contents of the text line

In a (modified)-status file, one or more lines have not yet been saved with the Keep command. For such 
lines, columns 1-3 are empty.

Working in an Annotate Tab
When you click on a cell in the Date, #, or User column, AccuRev highlights all the lines whose value in 
that column matches the value in the cell. This makes it easy to:

• Find all the lines added or changed in a particular version (click in the Date or Transaction # column).

• Find all the lines created by a particular user (click in the User column).

Using the Version Timeline
A timeline appears at the top of the Annotate tab, with an entry for each version of the text file element.
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You can use the timeline's slider control to switch among the file's versions. (Alternatively, just click a 
timeline entry to jump to that version.) Whenever you switch to a different version, AccuRev automatically 
highlights the lines that were added or changed in that version.

The Defunct Command
The Defunct command removes elements from active use in your workspace. That is, for each 
element you specify, it:

• removes the file, directory, or link from your workspace tree

• marks the element as (defunct) in the workspace stream

• makes the element active in the workspace, by adding it to the workspace's default group

Operating system commands won't find a defunct element (because it really is gone from the workspace 
tree), but the File Browser can see the element in your workspace stream, where it is both (defunct) and a 
(member).

Defunct does not remove an element from the depot altogether (no operation removes an element 
altogether -- that would violate AccuRev's TimeSafe property).  And it does not make an element 
disappear for all users. Defunct just removes an element from a particular workspace. The element remains 
visible in other streams and workspaces -- at least until you Promote it.

Invoking the Defunct Command
In the Details pane of a File Browser that is open on a workspace, select one or more file elements. Then:

• Click the  Defunct toolbar button, or

• Right-click the selection and choose Defunct from the context menu.
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The Defunct dialog appears, prompting you to confirm your intention to remove the element(s).

Defuncting a Directory
If any of the elements you specify is a directory, Defunct works recursively: it removes the directory itself 
and elements under that directory. Only the specified directory itself becomes (defunct); the objects 
below it are simply removed from the workspace tree, but do not become (defunct) in the workspace 
stream.

The precise result depends on whether any elements located below the defuncted directory are active:

• If no element below the defuncted directory is active, the entire directory tree is removed from your 
workspace tree.

• If one or more elements below the defuncted directory is active, those elements become stranded. A 
stranded element is not removed from your workspace tree, but its status becomes (external), since 
the workspace stream no longer has a valid pathname to the object.

Caution: In all cases of defuncting a directory, a file below the defuncted directory that you have 
edited -- but never preserved with Keep -- will be removed from the workspace tree. (Such files are not 
officially "active" in the workspace.) This removes data for which there might be no other copy.

Promoting a Defunct Element
After Defunct'ing an element, you use Promote to propagate its removal to your workspace's backing 
stream. The element won't appear in a File Browser that is open on your workspace, but it will appear, with 
(defunct) status, in a File Browser that is open on the backing stream.

Bringing Back a Defunct Element

You can usually recover the backed version of the (defunct) element by invoking the Revert to Backed 
command on it. However, if either of the following conditions apply, the correct way to recover the version 
is to invoke the accurev undefunct command from the CLI.

• If you have kept changes in your workspace before defuncting. Remember that if you Revert to 
Backed an element which has not been Promote'd, you eliminate the version of that element in your 
workspace.

• If you have Promote'd the (defunct) element, so that it no longer appears in the File Browser.

The Past and Future of a Defunct Element
When a user in a sibling workspaces performs an Update, the element will disappear from that workspace.
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With each successive promotion up the stream hierarchy, a defunct element disappears from the source 
("promote from") stream, and becomes active, with (defunct) status, in the destination ("promote to") 
stream.

AccuRev's TimeSafe property means that you cannot change the past. This means that a defunct element 
remains in old snapshots of streams. You can always get information about the element (if you know which 
stream it still exists in) using the History Browser.

The Delete Command
The Delete command removes an object -- file, directory, or link -- from a workspace tree. It's equivalent to 
using an operating system command or tool (e.g. Windows Explorer, UNIX rm command) to delete the 
object. This command does not make any change in the AccuRev repository.

If the object is under version control (that is, it's an AccuRev element), its status becomes (missing). If 
not, the object is simply removed from your workspace's local disk storage.

Invoking the Delete Command
In the Details pane of a File Browser that is open on a workspace, select one or more objects. Then:

• Click the  Delete toolbar button, or

• Right-click the selection and choose Delete from the context menu.

The Delete dialog appears, prompting you to confirm your intention to remove the object(s).

The Keep Command

The Keep command creates a new version of one or more file elements. Both the contents of the version 
and its identity are stored permanently in the AccuRev repository. For each file you Keep:

• AccuRev copies the contents of the file currently in your workspace tree to the associated depot in the 
repository.

• AccuRev assigns a version-ID to the new version, consisting of the workspace's name and an integer. 
For example, the version-ID

talon_dvt_mary/17

Video Tip Click this link to view an introductory video on checking in your work.

http://www.accurev.com/sites/default/files/videos/52-training/Editing_And_Checking_In_Code.wmv
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... identifies the 17th version of the file element that was created in the workspace named talon_dvt_mary.

Invoking the Keep Command
In the Details pane of a File Browser that is open on a workspace, select one or more file elements. Then:

• Click the  Keep toolbar button, or

• Right-click the selection and choose Keep from the context menu.

The Keep dialog appears, which you use to complete the command.

The Keep Dialog
The Keep dialog includes basic options (always visible) and advanced options (visibility controlled by a 
Basic/Advanced button).

Basic Options
Comment

You can enter a comment string in the text box. (AccuRev "seeds" the text box with your most 
recent Keep comment made during the current AccuRev GUI session.) The comment string 
becomes a permanent annotation to the version you're creating.

AccuRev itself does not require a comment, but your organization can establish such a 
requirement by putting a trigger on the Keep command.

Advanced Options
Choose File Type

By default, AccuRev determines the element type for the newly created version automatically 
(text or binary). You can override the default by specifying either of these types or ptext (a 
variant of text). See AccuRev Element Types on page 134.

Choose Lock Type

Choosing Enable File Locking places a lock on the element, to enforce serial development in 
sibling workspaces for that element. This ensures that users in sibling workspaces won't have to 
merge their work on this element. The lock remains on the element until you (or someone else) 
changes this value to Disable File Locking in a subsequent Keep command. See The Locks Dialog 
Box on page 52.

Results of a Keep Operation -- the Details
The Keep command does the following:

Creates a new version

A new version object is created in the workspace stream. It has a unique version-ID, such as 
talon_dvt_mary/13 ("the 13th version of this element created in workspace talon_dvt_mary"). A 
version object is immutable, and cannot be removed from the repository. The version created by 
Keep is termed a real version, because it represents an actual change to an element.

AccuRev allows you to invoke the Keep command on a file whose contents you haven't modified. 
So the new version might actually have the same contents as its predecessor.
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Preserves the contents of the new version

The contents of the new version are preserved permanently in the repository. AccuRev copies the 
file in your workspace tree to a container file in the depot. No AccuRev operation modifies or 
removes the container file (exception: archive command).

Sets the element status

The file element gets the status flag (kept) in your workspace. It also gets the (member) flag, 
indicating that the element is active in your workspace. (It's possible that the element already had 
one or both these status flags, from previous activity in your workspace.) If the element previously 
had (modified) status, this flag is removed.

Notes:
Content changes and namespace changes

The Keep command preserves content changes only, not namespace changes. Suppose you edit a 
file, so that it has (modified) status, then give it a new name with the Rename command. The 
new version that Rename creates does not record your content changes. The file will still have 
(modified) status until you preserve the contents changes with Keep.

"Undoing" a Keep operation

There is no true "undo" operation in AccuRev version control, since that would violate the 
TimeSafe principle. The Revert to Backed command provides a close approximation. If you want 
to "undo" some, but not all of several intermediate Keep's, perform a Revert to Backed command 
followed by a Send to Workspace of the intermediate version.

The New Folder Command
The New Folder command creates a new, empty folder (directory) in the current directory (the directory 
that's highlighted in the Workspace Explorer) of your workspace tree. It can also add the directory to the 
depot -- that is, place the directory under version control by converting it to an element. Note that New 
Folder is not available when you're working in the Searches pane. 

If you choose not to place the directory under version control, you can do so later ...

• explicitly, with the Add to Depot command

• implicitly, when you place any file or subdirectory below the new directory under version control

Invoking the New Folder Command
In the Workspace Explorer of the File Browser, navigate to the directory in which you want to create the 

new directory. Then, click the  New Folder button in the Details pane toolbar.
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Using the New Folder Dialog
You can specify these settings for the new directory:

Name

The simple name (leaf name) of the new directory.
Add to Depot

If checked, AccuRev will place the newly created directory under version control, by converting it 
to a directory element. The Add to Depot dialog appears, in which you can specify a comment.See 
The Add to Depot Command on page 105.

The New File Command
The New Folder command creates a new, empty folder (directory) in the current directory (the directory 
that's highlighted in the Workspace Explorer) of your workspace tree. It can also add the directory to the 
depot -- that is, place the directory under version control by converting it to an element. Note that New File 
is not available when you're working in the Searches pane. 

If you choose not to place the file under version control, you can do so later with the Add to Depot 
command.

Invoking the New File Command
In the Workspace Explorer of the File Browser, navigate to the directory in which you want to create the 

new file. Then, click the  New File button in the Details pane toolbar.

Using the New File Dialog
You can specify these settings for the new file:

Name

The simple name (leaf name) of the new file.
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Add to Depot

If checked, AccuRev will place the newly created file under version control, by converting it to a 
file element. The Add to Depot dialog appears, in which you can specify a comment, the file's 
element type and optional exclusive file locking.

The Patch From Command
The Patch From (or Patch) command performs a patch operation on a text-file element, incorporating 
some of the changes in a specified "patch from" version into the version in your workspace. The combined 
contents are saved, with Keep, as a new version in your workspace.

 The patch operation is operationally similar to a merge operation, which incorporates all of the changes in 
a specified version. (In fact, both operations use the same tool, either AccuRev's Merge tool or a third-
party text-file-merge tool.)

Patch vs. Merge
When you merge version V of a file into your workspace version, you are saying:

"combine my file with version V, taking into account all the changes in version V, back to the common 
ancestor"

When you patch version V of a file into your workspace version, you are saying:

"combine my file with version V, taking into account only the recent changes to version V"

To find the "recent changes to Version V", AccuRev scans backward through the file’s ancestry, starting at 
version V and stopping when it encounters ...

a version that was originally created in another workspace

... or ...

a version that was promoted to another stream

This backward search defines a patch to the element. Version V is termed the head version of the patch. 
The older version is termed the basis version of the patch. The patch consists of all the versions of the 
element between the basis version and head version. The basis version itself is not included in the patch -- 
it precedes the set of "recent changes" in version V. The head version is included in the patch -- it contains 
the latest of the recent changes.

In identifying versions "between" the head and basis versions, AccuRev follows both direct ancestor and 
merge ancestry lines. In particular, if version V was created by a merge, its "recent changes" include both 
contributors to the merge.

Historical note
Prior to AccuRev 3.5.5, the Patch From command used a simpler definition of "recent changes to Version 
V" -- it meant "just the changes between version V and its immediate predecessor". (In effect, the Show 
Patch List command still uses this definition of patch, showing all the individual versions whose changes 
need to be propagated between two streams.)

For example, suppose user Mary recently created versions 4, 5, 6, and 7 of a file in her workspace, 
talon_dvt_mary. When patching version talon_dvt_mary/7 into your workspace version, AccuRev 
previously only incorporated the changes between versions talon_dvt_mary/6 and talon_dvt_mary/7. The 
limitation of this simple algorithm is clear: you probably wanted to incorporate all of Mary’s recent 
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changes — the modifications in versions 4, 5, 6, and 7. In previous releases, you would have had to 
perform four separate Patch From commands to achieve this result.

Example 1
Before Mary started her recent work, she updated her workspace. This brought in a version of the file 
originally created by another user -- say, version brown_dvt_john/5. Then she proceeded to create versions 
5 through 7 in workspace brown_dvt_mary.

Derek decides to patch version brown_dvt_mary/7 into his workspace. He invokes the Patch From 
command from the context menu of this version. AccuRev searches backward through the element's 
ancestry, and includes the set of changes recently made in Mary's workspace: this set includes 
brown_dvt_mary/5 through brown_dvt_mary/7; the patch doesn't include the two versions created in 
workspace brown_dvt_john.

Example 2
Mary started a task by bringing version brown_dvt_john/6 into her workspace with an update. Then she 
created versions brown_dvt_mary/4 through brown_dvt_mary/6, promoted her work to the backing stream, 
and then created two more versions: brown_dvt_mary/7 and brown_dvt_mary/8.

When John patches version brown_dvt_mary/8 into his workspace, AccuRev decides that only the versions 
since the promotion — versions 7 and 8 — contain "recent changes". The idea is that a promotion typically 
marks the end of a programming task, not an intermediate checkpoint.
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Example 3
John patches version trike_dvt_mary/3 into his workspace, creating version trike_mnt_john/1. Because 
Mary's version was created by a merge, the patch includes the recent changes to both merge contributors.

Invoking the Patch From Command
You can invoke Patch From on a selected version in the following contexts:

 In the Version Browser (when invoked from a workspace), to patch from an arbitrary version.

 In the History Browser (when invoked from a workspace), to patch from the version in a particular 
transaction.

AccuRev processes the files you specify one-by-one. For each file, it does one or both of the following:

 Prompts you, in one or more dialogs, to resolve namespace-level conflicts.

 Invokes AccuRev's Merge tool or the other tool you've configured, in order to perform the patch oper-
ation. AccuRev's Merge tool opens in a separate tab within the AccuRev GUI window; any other tool 
opens in its own window.

The Patch Algorithm
The Patch From command performs its content-level work with the Merge tool. Submitting a different set 
of versions to this tool effectively implements the patch algorithm (see The Merge, Patch, and Reverse 
Patch Algorithms on page 247).

The Populate Command
For one or more selected elements, the Populate command copies the version that is currently in the 
workspace stream to the workspace tree. This has the effect of undoing an accidental deletion, or 
discarding edits that you have not yet preserved with Keep.

Invoking the Populate Command
Select one or more file and/or directory elements in the Details pane of the File Browser. Then, choose 
Populate from the context menu of the selection.

Using the Populate Dialog
You can select one or both of these options:
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Recursive

For each selected element that is a directory, perform a Populate on that element and on all 
elements below it.

Overwrite

For each file element, replace the file (if any) currently in the workspace tree. By default, Populate 
silently declines to overwrite an existing file.

The Populate Progress Box
The Populate command displays a progress box, much like the one used by the Update command.

The Promote Command

The Promote command sends one or more versions from one stream to another, making the versions 
accessible in the destination stream -- and in workspaces and streams below it. A single transaction in the 
AccuRev depot records the creation of the new version(s) in the destination stream.

The basic use of Promote is to take the private versions that you've created in your workspace stream and 
make them public by sending them to the workspace's backing stream.

Promote can also send versions from a dynamic stream to any other dynamic stream. You can do such 
higher-level promotion using the File Browser or StreamBrowser tool. Promoting from a stream to a non-
parent ("cross-promotion") requires use of an additional tool, the Change Palette.

Real versions and virtual versions
The Promote command creates a virtual version in a dynamic stream. By contrast, the Keep command (as 
well as Anchor, Send to Workspace, Revert, Rename, Defunct, and the CLI-only command undefunct) 
creates a real version in a workspace stream. See Real Versions and Virtual Versions on page 134.

Inheritance of promoted versions
After you promote a version, it can be inherited by all dynamic streams and workspaces below the backing 
stream. Inheritance by dynamic streams is automatic; inheritance by a workspace occurs when the user 
Update's it.

Overlap status and merging
If an element has (overlap) status, you cannot promote it. You must merge your version with the version in 
the backing stream, to create a new, merged version. You can then promote the merged version.

Underlap status
The status (underlap) is similar to (overlap), in that an element has changed in your workspace and also in 
the backing stream. With (underlap), the changes in your workspace version have already been promoted 
to the backing stream (from another workspace, or from a stream elsewhere in the depot’s stream 

Video Tip
Click this link to view an introductory video on promoting your changes 
to the parent stream.

http://www.accurev.com/sites/default/files/videos/52-training/Promoting_Changes_From_A_Child_Stream_To_Its_Parent.wmv
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hierarchy). In many cases, it is most appropriate to use the Revert to Backed command to 'undo' the 
changes in your workspace. In other cases, you can merge and promote, as with (overlap)-status elements.

Invoking the Promote Command
You can promote versions in several contexts:

File Browser: Details pane

Select one or more elements in the Details pane of the File Browser. Then, click the  button in the 
Details pane toolbar, or choose Promote from the selection's context menu. This promotes the versions to 
the backing stream.

Stream Browser (graphical display only)

• Drag-and-drop the  icon below a workspace to the backing stream, to promote all the versions 
currently in that default group.

• Drag-and-drop the  icon below a dynamic stream to its parent stream to perform a standard 
promotion

• Drag-and-drop the  icon below a dynamic stream to any other dynamic stream to initiate a cross-
promotion. The versions are loaded into the Change Palette, where you complete the promotion 
(perhaps after performing some merges).

Stream Browser: Default Group subwindow

In the graphical display, click the   icon below a workspace or stream to open a subwindow displaying 
the versions currently in the default group of that workspace or stream. Select one or more versions, then:

• Click the  button in the subwindow toolbar (or choose Promote from the selection's context menu) 
to promote the versions to the backing stream.

• Click the  button in the subwindow toolbar (or choose Send to Change Palette from the selection's 
context menu) to load the versions into the Change Palette where you complete the promotion 
(perhaps after performing some merges).

Using the Promote Dialog
The Promote dialog provides these command options:

Comment

You can enter a comment string in the text box.
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(AccuRev "seeds" the text box with your most recent Promote comment, made during the current 
AccuRev GUI session.) The comment string becomes a permanent annotation to the transaction 
that creates the new version(s) in the destination stream.

AccuRev itself does not require a comment, but your organization can establish such a 
requirement by putting a trigger on the Keep command.

Promote (element list)

(only for direct-promotions to the parent stream -- not for cross-promotions) All the versions you 
specified are listed in a table. You can deselect individual versions by clearing the checkbox in the 
table's Promote column. Deselected versions will not be promoted.

Promoting Dependent Elements
A dependent element is an element that has a relationship with another element. Dependent elements must 
be promoted as a group in order to resolve the dependency. This section describes how dependencies can 
be created and how to promote them.

How Dependencies Can Be Created
A dependency can be created when you rename an element in the workspace using the name of another 
element that has also been renamed and promoted to the backing stream. For example, imagine that you 
add the following files to your workspace, and then keep them and promote them to the backing stream:

proposed_tracker.c

beta_tracker.c

ref_tracker.c
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Next you rename these elements in the workspace as follows:

proposed_tracker.c is renamed as accepted_tracker.c
beta_tracker.c is renamed as proposed_tracker.c
ref_tracker.c is renamed as beta_tracker.c

The element accepted_tracker.c can be promoted freely -- it has simply been renamed using a new 
name (that is, the name of an element that has not already been promoted to the backing stream). Notice, 
however, that elements beta_tracker.c and ref_tracker.c were renamed with names of elements that 
have already been promoted to the backing stream and now have dependencies (proposed_tracker.c and 
proposed_tracker.c, respectively), creating a dependency -- proposed_tracker.c cannot be promoted 
from the workspace without accepted_tracker.c. Similarly, beta_tracker.c requires that both 
proposed_tracker.c and accepted_tracker.c be promoted with it.

Element dependencies can also be created during the twin resolution process.

How to Promote Dependent Elements
When AccuRev detects a dependency during a promote operation, it displays a message alerting you to 
the dependency and the requirement to promoted dependent elements together, as a group. 

When you dismiss the message, the Promote dialog box appears. Dependent elements are included in the 
table, along with any other files you have selected for promote, as shown in the following illustration:

Dependent are displayed with a warning icon in the Dependency column. Elements that share a 
dependency are highlighted using the same color. Because dependent elements must be promoted together, 
clearing the Promote check box for one element in a group clears it for all elements in that group.
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The Rename Dialog
The Rename command changes the pathname at which an element is accessed. You can use this command 
to perform a simple renaming, to move an element to another directory, or both. You cannot move an 
element to another depot.

Invoking the Rename Command

Select an element in the Details pane of the File Browser. Then, click the  button in the Details pane 
toolbar, or choose Rename from the selection's context menu.

Using the Rename Dialog
Type a new pathname for the element:

• Type a simple name to rename the element, leaving it in the same directory.

• Type a relative pathname to move the element to another directory in the depot (and possibly rename 
the element, too).

(You cannot type a depot-relative pathname.)

In either case, a single move transaction records the changing of the element's pathname in your 
workspace.

Renaming a Modified File Before Keeping It
You can create a new version of a file element in your workspace, recording either a content change or a 
namespace change. But you can't do both at once. For example, suppose you:

1. Edit the contents of file color.java, so that it gets (modified) status.

2. Use the Rename command to change the filename to hue.java.

This creates a new version of the file element in your workspace, recording the name change, but not the 
content change. To preserve the content change, you must use a separate Keep command to create a second 
new version.

Caution on Reusing the Name of a Renamed Element
The ability to reuse the name of a renamed element provides significant flexibility for project refactoring 
tasks. But it also introduces a complication: what happens if you rename an element, create a new element 
at the same pathname, then invoke the Revert to Backed command on the renamed element?

The renamed element cannot revert to its old pathname, because there’s a new element at that pathname. 
The original element simply disappears from your workspace. You might wonder “Why does the element 
not get (stranded) status?” The Revert to Backed command makes an element inactive in the workspace. 
The (stranded) status applies only to active elements.

At this point, your workspace contains a new element at the given pathname, and the parent stream 
contains the original element at that pathname. Attempting to promote the new element would produce a 
'name already exists in parent stream' error. Use one of the following procedures to return this pathname to 
a consistent state:
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If you want to return to using the original element
1. Rename the new element, to a name like myfile.java.DISCARDED.

2. Defunct the new element

3. Promote the new element to the backing stream

4. At this point, the original element reappears in the Details pane, with (missing) status.

5. Invoke the Populate command on the original element.

If you want to discard the original element and use the new element
These steps must be performed with the AccuRev CLI, which supports defuncting of the "disappeared" 
element using its element-ID.

1. Defunct the original element in the workspace, using the command accurev defunct –e <element-
ID>.

2. Promote the defuncted version to the backing stream.

The Revert Command
The Revert command implements an "undo change" capability for dynamic streams. It doesn't actually 
remove any versions from the stream or transactions from the repository; that never occurs, since it would 
be a violation of AccuRev's TimeSafe principle. Instead, Revert creates a new version of one or more 
elements in a workspace based on the stream. 

Note: There is one exception to this workspace requirement: the Revert Change Package command 
option to continue without using a workspace, available in the StreamBrowser. (See “Revert Change 
Package” on page 168.)

The contents of the new version are the result of "subtracting out" a certain set of changes from the stream's 
current version:

• the changes that were added to the stream in a specified promote transaction, or

• the changes contained in a change package that is currently in the stream.

The "subtracting out" of content changes is performed by the Merge tool. Submitting a different set of 
versions to this tool effectively implements the reverse patch algorithm (see Reverse Patch: Removing 
Content Changes on page 252).

After the Revert command completes, you can verify the correctness of its work (and make further 
changes, if appropriate) in the workspace. Then, you can complete the "undo change to stream" process by 
promoting the new versions.

Note: Again, the Revert Change Package command available in the StreamBrowser has an option to 
continue without using a workspace. The results of this revert are placed directly in the stream itself. 
However, AccuRev recommends that you still build and test these changes in an updated 
workspace to verify the results. 
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Invoking the Revert Command
There are several ways to invoke the Revert command:

• Reverting a Transaction. Open a History Browser tab, showing the transactions for the dynamic 
stream where you want to perform the "undo". To do this, choose View > Streams from the GUI main 
menu (and, if prompted, choose the depot containing your stream). Right click your stream, and 
choose Show History from the context menu. Then right-click the transaction to be reverted, and 
choose Revert from the context menu. Only transactions whose action is promote can be reverted.

• Reverting a Change Package. Open a Stream Issues tab, showing the issues whose change packages 
are in the dynamic stream where you want to perform the "undo". To do this, choose Show Issues from 
the context menu of any dynamic stream in the StreamBrowser. Or choose Show Diff by Issues from 
the context menu of a dynamic stream, then select another stream to compare it with.

Choosing a Workspace
AccuRev displays the workspaces that both:

• ... belong to you, and

• ... are children of the stream whose transaction or change package you wish to revert

The workspace you select will be used to perform a reverse patch operation. AccuRev invokes the Merge 
tool in a special mode to perform this operation, with the file in the selected workspace as one of the 
contributors. It refuses to proceed if the file is currently active in the workspace.

Choosing a Workspace for the Revert Command

AccuRev displays the workspaces that both:

• Belong to you, and

• Are children of the stream whose transaction or change package you wish to revert

The workspace you select will be used to perform a reverse patch operation. AccuRev invokes the Merge 
tool in a special mode to perform this operation, with the file in the selected workspace as one of the 
contributors. It refuses to proceed if the file is currently active in the workspace.

Revert to Backed Dialog
For each selected element, this command remove all changes you've made since the last time you 
Promoted it, or since the last Update of the workspace -- whichever is more recent:

• File elements: this includes both content changes and namespace changes.

• Directory elements: this includes namespace changes only.

• Link elements: this command operates on the link itself, "undo"ing changes you've made to the 
specification of the link target.

The selected elements become inactive in the workspace (they are removed from the workspace's default 
group). The status of the elements becomes (backed).

For a detailed discussion of the Revert to Backed command, see Chapter 12 Notes on Revert to ... and 
Diff Against... GUI Commands in the AccuRev Technical Notes.
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Trigger Firing
When you invoke this command in a dynamic stream, the depot's pre-promote-trig trigger fires. That's 
because, like Promote, this command changes which version of the element appears in the stream.

Revert to Most Recent Version Dialog
(This command is enabled only in a workspace, and only for file elements with (modified) status. Link 
and directory elements cannot have (modified) status.)

This command replaces (by invoking the Populate command) each selected  file with the most recent 
version you created with Keep. Use this command when you've saved one or more intermediate versions of 
the file(s), and you want to discard further changes you've made since a Keep.

The selected elements remain active in the workspace. That is, they are not removed from the workspace's 
default group. The (modified) status of the elements changes to (kept).

If you've modified a file but not yet performed a Keep on it, this command works like the Revert to Backed 
Dialog.

The Send to Issue Command 

The Send to Issue command creates or modifies change package entries for one or more elements in one 
or more issue records. When first created, a change package entry has the same structure as a patch: the set 
of 'recent changes' to an element. After subsequent modifications, a change package entry can include a 
much broader set of changes.

The command has several variants, providing different ways to specify the data to be sent to the change 
package(s):

• You specify a version, which AccuRev interprets as the head version of a patch. AccuRev 
automatically determines the corresponding basis version.

• You specify both the head version and basis version of a patch.

• You specify an existing change package entry, to be sent to one or more additional change package(s).

Invoking the Send to Issue Command
You can invoke Send to Issue in the following contexts. Note that each context provides access to some, 
but not all, variants of the command.

• In the Version Browser, choose Send to Issue or Send to Issue (specifying basis) from the context 
menu of any version.

• In the Versions pane of the History Browser, select one or more versions and choose Send to Issue 
from the selection's context menu.

• In the Stream Version Browser, choose Send to Issue from the context menu of any version.

• In the Changes subtab of an issue record or the Change Package Contents pane of a Stream Issues tab, 
select one or more change package entries and choose Send to Issue from the selection's context menu.
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Specifying the Basis Version of the Change
In the Send to Issue (specifying basis) variant of the command, you specify the basis version , defining the 
extent of the change to be sent to the change package(s). After you invoke the command, the mouse pointer 

changes to . Click the version you wish to be the basis version for the change. (You can press the Esc 
key at this point to cancel the command.)

The basis version you specify must be an ancestor of the head version. If it isn't, an "Invalid Change 
Package" error occurs.

Using the Send to Issue Dialog
AccuRev prompts you to specify one or more issue records, in which change package entry(s) will be 
created or modified. 

If you've specified one of your AccuWork queries as the default query, AccuRev executes the query and 
displays the results. 

Note: If you have enabled the use of third-party issue tracking system (ITS) keys in the AccuWork 
schema, the Select Issue (Change Package) dialog displays additional controls that let you specify 
whether you want to use AccuWork issue numbers or third-party keys when selecting issues to 
promote against. See the section “Using Third-Party Keys in the AccuRev GUI” in the AccuRev® 
Technical Notes for more information.

You can select one or more of the issue records:

• By clicking: left-click to select an issue record. Hold down the Ctrl or Shift key to select multiple 
records.

• By typing: enter one or more numbers, separated by SPACEs.

• By filtering: enter text into the "Only show issues that contain" field, then click to choose an issue from 
the filtered list. Delete the text in that field to remove the filter and display all issues.

You also have two other options for specifying issue records other than the initial set shown by the dialog: 
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• Choose an issue record associated with another user. To do so, choose a user or group name from the 
drop-down list to the right of the Issue # field. The set of names shown here is defined when the 
change-package configuration is set (see The AccuWork Schema Editor (Change Packages subtab) on 
page 342).

• Create a new issue using the New Issue button at the bottom of the dialog. Note that if you have 
chosen to display issue records associated with another user, the new issue must be associated with that 
user when you create it, or the issue will not display on the Send to Issue dialog. 

If you don't have a default query, AccuRev prompts you to type in an issue number (or multiple numbers, 
separated by SPACEs).

Failure to Modify an Existing Change Package Entry
The Send to Issue command fails if AccuRev determines that an existing change package entry cannot be 
modified by "adding in" the set of versions you specified. A change package entry must always be 
expressible as "all the versions between the specified head and basis versions". Here are two situations in 
which this is not possible:

Gap in change package entry
This case typically arises when you do work on a task at two different times, and someone else has worked 
on the same element in between. In this example, you created versions 18-20 of a file and created a change 
package entry with those versions. A colleague updated her workspace to bring in your changes, created 
versions 1 and 2 in her workspace, and promoted her changes. You then updated your workspace to bring 
in her changes, and made a new set of changes, in versions 21-23.

Now, you want to add your new changes into the same change package. When AccuRev tries to combine 
the six versions into a single change package entry, it detects the 'gap' consisting of your colleague’s 
versions 1 and 2, and displays an error box.

Fixing the Problem
Typically, you'll want to "span the gap", making the change package entry include the entire series of 
versions — your original changes, your colleague’s changes, and your new changes. You can accomplish 
this by first removing the existing change package entry from the Changes subtab of the issue record, then 
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using the Send to Issue (specifying basis) variant of the command. In this example, you'd specify version 
23 as the head version and version 17 as the basis version. 

Note: You can accomplish the same result even more easily if you encounter this situation while 
executing the Promote command on version 23, and you are using the change-package-based 
integration between AccuRev and AccuWork. In this case, AccuRev offers to 'span the gap' between 
the two change set entries automatically.

Merge required before change package entry can be modified
This case typically arises when developers in different workspaces try to use the same change package. 
There is no simple "gap" between the existing change package entry and the new set of version.

This means there is no way to combine them into a single change package entry.

Fixing the Problem
You can remedy this situation by performing a merge at the element level. (There is no merge operation 
defined at the change package level.)

The Send to Workspace Command
The Send to Workspace command activates the specified version of an element (or set of elements) in a 
particular workspace. All of the elements must currently be inactive that is, have k (backed) status -- in 
the workspace. This command:

• Copies the contents of the specified version from the repository to the workspace tree.

• Changes the status of elements to (member), indicating that it is in the workspace's default group.

This command is a more generalized variant of the Anchor command, which always operates on the 
version of an element that is currently in the workspace.

Invoking the Send to Workspace Command
You can invoke Send to Workspace in any of these contexts:

• In the Version Browser, choose Send to Workspace from the context menu of any version.

• In the Versions pane of the History Browser (displaying the history of an individual element), select 
one or more versions and choose Send to Workspace from the selection's context menu.

• In the Stream Version Browser, choose Send to Workspace from the context menu of any version.
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In each of the above cases, you have a current workspace context -- the workspace name is displayed at the 
bottom of the GUI window. AccuRev sends the selected versions to this workspace.

You can also invoke this command from the Summary pane of the History Browser. Select a single 
transaction and choose Send to Workspace. In this case, you don't necessarily have a current workspace 
context, AccuRev prompts you to select one of the workspaces belonging to you. All the versions in the 
selected transaction are sent to the workspace you select.

Using the Send to Workspace Dialog
Specify a workspace by:

• double-clicking it, or

• selecting it and clicking Ok

You can click the Name column header to reverse the sort order of the workspace names.

The Update Progress Box
The Update and Update Preview commands open a pop-up window to display the command's progress. 
This window displays the filenames being processed one-at-a-time or in a scrolling text pane, depending 
on the setting of the Show Progress Log user preference.

You can use the following command buttons in the progress box:

View Full Log

(enabled after command completes) Display the entire Update or Update Preview log in a separate 
text-editor window.

Save Log As

(enabled after command completes) Create a text file containing the entire Update or Update 
Preview log.
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Run in Background

Close the progress box, but continue command execution. You can proceed to perform other work 
in the AccuRev GUI window. A progress indicator appears in the lower right corner of the GUI 
window.

The indicator disappears when the command completes. If an error occurs during command 
execution, the progress indicator changes to a flashing red error indicator:

Click on the indicator to restore the progress box. The update log will include a description of the 
error.

Cancel (while command is in progress)
Close (after command completes)

Close the progress box. If the Update or Update Preview command is still executing, cancel it.

The WIP (Work in Progress) Tab
The WIP ("Work in Progress") tab shows elements that are currently active in the workspaces below a 
specified set of one or more streams. (A stream's own default group is not included in this listing.)

Opening a WIP Tab
Select a dynamic stream in the StreamBrowser, and choose WIP from its context menu.

WIP Tab Layout

Element (or separate "Name" and "In Folder" columns)

The element's pathname within the depot.
WIP in Workspace

The workspace in which the element is active.
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Working in a WIP Tab
Use radio buttons to specify which stream -- or set of streams -- whose workspaces are to be searched for 
active elements:

Current stream

The stream you selected when invoking the WIP command.
All streams

All streams in the depot.
Current stream including all child streams/workspaces

The entire subhierarchy of streams below the one you selected.
Current stream including all parent streams/workspaces

The entire backing chain of the stream you selected.
A workspace is searched for active elements if it is a direct child of one of the streams you've indicated 
with your radio-button choice. (But pass-through streams are ignored when determining the "direct child" 
relationship. Workspaces whose parent is a pass-through stream are treated as if they were backed but their 
"grandparent" stream.)

The WIP tab display is informational only. You cannot change the status of elements from this tab.

See also: Working with Tables on page 10

The Default Group of a Workspace or Stream
For each dynamic stream and workspace (but not for pass-through streams,  snapshots, or  reference trees), 
AccuRev keeps track of the elements that are currently under active development in that context. This set 
of elements is called the default group of the stream or workspace.

Note: For some purposes, the default group is regarded as containing particular versions of the 
elements -- for example, when you promote a stream's entire default group.

How Elements Become Members of the Default Group
Workspace

The default group is a property of the workspace stream, maintained in the AccuRev repository. 
There are no "hidden files" or other administrative structures in the workspace tree to keep track of 
which elements are active.

The following commands cause an element to become a member of the workspace's default group. 
Note that these commands can be executed only in a workspace, not in a stream.
• Keep

• Rename (or cut-and-paste)

• Defunct

• undefunct (CLI only)

• Merge (ends by performing a Keep)

• Revert (ends by performing a Keep)

• Paste (after a copy, creating a link; CLI command: ln)
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• Send to Workspace / Anchor 

Dynamic Stream

When a version is Promote'd to a dynamic stream, the element becomes a member of the stream's 
default group.

If an element is already in the default group of a workspace or stream when one of the commands listed 
above is executed, the element simply remains a member. In othrer words, the default group's membership 
doesn't change when it's viewed as a set of elements. But it does change if you view the default group as a 
set of particular versions of those elements.]

How Elements are Removed from the Default Group
For both a workspace and a dynamic stream, the following commands remove an element from the default 
group:

• Promote (to the immediate parent stream)

• Revert to Backed

The element returns to a passive state in the workspace or stream. A stream returns to inheriting a version 
of the element from its parent stream; a workspace returns to acquiring versions of the element from the 
backing stream through the Update command.

Cross-promoting an element to a stream that is not the immediate parent stream does not remove the 
element from the default group of the "from" stream.

Viewing the Contents of the Default Group
The Stream Browser can show the development activity currently taking place in each stream or 
workspace. 

A control below the stream or workspace opens or closes a subwindow that displays the details of the 
development activity. The activity details can appear in several ways -- by element, by transaction, or by 
issue record.

For a dynamic stream, the by-element display is a listing of the stream's default group. For a workspace, 
this subwindow displays those members of the default group that would be found in a Pending search (see 
discussion below).

The File Browser's Default Group search displays all the members of the default group of a stream or 
workspace.

Active Versions vs. Pending Changes in a Workspace
A workspace's set of active elements (that is, its default group) is not quite the same as the set of elements 
with pending (not yet promoted) changes. In practice, the sets will often be the same. But in theory, the sets 
are overlapping, but not identical:

• The Default Group search can include elements that are not pending. These are elements that you've 
"checked out" with Send to Workspace or Anchor.
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• The Pending search can include elements that are not in the default group. This is the set of a "non-
member" elements -- those that have been modified (and thus are pending), but are not in the default 
group.

AccuRev Element Types
Each version of a file element has an element type, which identifies the type of data contained in that 
version. Each time you create a new version (with the initial Add to Depot and subsequent Keep's), you can 
change the element type, using the Advanced section of the command's dialog box.

AccuRev supports the following element types. For a newly created version of any type, AccuRev creates 
a new storage file in the file storage area of the AccuRev repository.

binary

When a new binary version is created, the storage file is an exact copy of the file in the workspace 
tree. When you retrieve a binary version from the repository (for example, with Send to 
Workspace or Update), AccuRev makes an exact copy of the storage file in the workspace tree.

text

When a new text version is created, the storage file is created with a single NL character (hex 
character code x0A) at the end of each text line. This means that a version’s storage file may have 
different line terminators than the workspace-tree file you submitted to the command.

When you retrieve a text version from the repository (for example, with Send to Workspace or 
Update), the file created in the workspace tree uses either the UNIX/Linux line terminator (NL / 
hex x0A) or the Windows line terminator (CR-LF / hex x0D-x0A) -- depending on the EOL 
setting for your workspace (see The New Workspace Command: Screen 3 of 3—Configuring the 
Workspace) on page 24).

ptext

ptext versions are handled like binary versions: exact copies are transferred between the 
workspace tree and the file storage area. The difference between ptext and binary files is in how 
they are handled by the Merge and Patch commands.

Real Versions and Virtual Versions
The difference between the Keep and Promote commands highlights an important aspect of the way that 
AccuRev organizes and manages development data. It also highlights the difference between backing 
streams and workspace streams.

Real Versions
All 'real' development -- both content changes and namespace changes -- takes place in workspaces, not in 
dynamic streams or reference trees. The following commands create a new real version of some element 
in the built-in workspace stream of some AccuRev workspace.

• Keep

• Rename (or cut-and-paste)

• Defunct

• undefunct (CLI only)
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• Merge (ends by performing a Keep)

• Revert (ends by performing a Keep)

• Paste (after a copy, creating a link; CLI command: ln)

Virtual Versions
Unlike the commands listed above, the Promote command does not record a change to the contents or 
pathname of any element. Rather, it makes an existing real version available in a new location: a particular 
dynamic stream. The version that Promote creates in a dynamic stream is called a virtual version; a new 
virtual version is a pointer to, or alias for, an existing real version in some workspace stream.

Virtual Versions in Workspace Streams
The commands Send to Workspace and Anchor are special. They create a new version in a workspace 
stream, but the new version is virtual, not real. Why? It's for consistency with the above descriptions of 
real and virtual versions:

• These commands do not preserve a development change, so it doesn't make sense to create a new real 
version.

• These commands make an existing real version available in a new location: a particular workspace -- 
so it makes sense to record the action as a virtual version.
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4. The StreamBrowser
AccuRev's unique StreamBrowser enables graphical control over the entire configuration management 
environment, in a way that is simple, flexible, and powerful. Using the StreamBrowser, you can view and 
manipulate all the streams in a depot, including workspace streams and snapshots.

Opening a StreamBrowser Tab
You can open a StreamBrowser tab to display the streams of the current depot in any of these ways:

• Choose View > Streams from the GUI main menu.

• Click the  View Streams button on the GUI main toolbar.

• Choose View > Streams from the context menu of a depot on a Depots tab.

If there is no current depot, AccuRev prompts you to select one.

StreamBrowser Tab Layout
You can use the StreamBrowser in any of the following display modes, which you select using buttons on 
the StreamBrowser toolbar:

• Graphical mode: displays the depot's stream hierarchy as a tree (root node at the upper left)

• Tabular mode: displays a table containing the depot's streams, snapshots, and workspaces, initially 
sorted by stream name.

• Graphical/tabular mode: both of the above -- the tab is divided into a graphical pane (above) and a 
tabular pane (below). A movable separator bar enables you to adjust the space allocation to the panes.

You can have any number of StreamBrowser tabs open at the same time, each for a different depot. You 
can also open multiple StreamBrowser tabs on the same depot, by invoking the Clone Tab command on the 
context menu of the tab control.
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Graphical StreamBrowser Display
The graphical display of a depot's stream hierarchy is organized as follows:

• The depot's root stream (top-level) is at the left edge. 

• A given stream's children appear to its right; the children are arranged vertically, in this order:

• Workspaces, in alphabetical order

• Dynamic streams with no basis time and pass-through streams, in alphabetical order (capitalized 
stream names appear first, followed by stream names starting with the characters [, \, ], ^, _, and `, 
followed by non-capitalized stream name)

• Dynamic streams with basis times and snapshots, ordered by basis time (most recent first)

• Each stream is annotated with an icon that indicates the kind of stream:

dynamic ("normal") stream

time-based dynamic stream
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workspace stream

snapshot (static stream)

pass-through stream

• Each stream or workspace that has active elements (that is, a non-empty default group) is displayed 

with a special control that opens and closes a subwindow showing the activity's details. See The 
Default Group of a Workspace or Stream on page 132 for a general discussion of the default group.

• Each stream can have a lock, which prevents certain operations involving that stream from being 
performed. 

If a lock exists on a stream, a special control appears, which provides access to The Locks Dialog Box 
on page 52.

• Each stream may be associated with a workflow, available through the AccuRev workflow feature. If 
workflow rules have been set for a stream, a workflow icon appears.
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Clicking the workflow icon displays the Workflow Rules Summary dialog box, from which you can 
review the rules that have been set for that stream. Clicking the Open Web UI to Edit Rules button 
opens the AccuRev Web UI, from which you can edit existing rules or create new ones.

Workflow rules are defined in the AccuRev Web UI. See "Using Workflow to Manage Issues" in the 
AccuRev® Web Interface User’s Guide, Version 2012.1 or later for information about workflow.

• Each stream may be mapped to a branch in a Git repository, via the optional AccuRev GitCentric™ 
product. If a stream is mapped to a Git branch, a Kando icon appears. 

Clicking the Kando icon displays information about any Git branches and their repositories that are 
mapped to this stream via Kando.

See the AccuRev Kando documentation for more information 

See Controlling the Display on page 141 to learn about the ways you can filter the StreamBrowser display.
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Tabular StreamBrowser Display
In tabular display mode, the StreamBrowser tab contains a table listing some or all of the current depot’s 
streams (including snapshots and workspaces). If you have applied a Stream Favorite to restrict the display, 
only the stream paths and children (if any) for the selected streams appear in the table. (A stream path is a 
subset of the stream hierarchy that starts at the root stream and ends at the stream being referenced.)

The checkboxes and list box at the bottom of the tab work the same way as in graphical mode to control 
which streams are included in the table. The StreamBrowser’s tabular mode offers the same commands 
(toolbar and context menus) as the graphical mode.

See also: Working with Tables on page 10.

Working in the StreamBrowser
The following sections describe working in the StreamBrowser. Note that many of these operations can be 
performed only in the graphical display, not in the tabular display.

Controlling the Display
Initially, the StreamBrowser displays all of the depot's currently active dynamic streams, along with 
workspaces for the current user. It does not display any snapshots, nor any item that you have deactivated 
with the Remove command.

Note: If you have applied a Stream Favorite, only a subset of the streams in the depot appear.

Applying a Stream Favorite
A Stream Favorite is a way to limit the stream hierarchy shown in the StreamBrowser to the stream path of 
a specific stream and all its children. See Using Stream Favorites on page 151 for more information.

Filtering Users/Groups

The Filter Users/Groups  button on the main AccuRev toolbar allows you to restrict the set of users and 
groups displayed in the StreamBrowser and other locations in the AccuRev GUI. See Filter Users/Groups 
(View Users/Groups Command) on page 39 for more information.

Tip: You can also create Stream Favorites to limit the stream hierarchy shown in the StreamBrowser and 
any list of streams available in the AccuRev GUI. See Using Stream Favorites on page 151 for more 
information.

Filtering Streams, Snapshots, and Workspaces
You can adjust the numbers and types of streams shown by using the controls at the bottom of the 
StreamBrowser tab:

Include hidden streams

This checkbox is a toggle switch: it reveals/hides the data structures that have been Remove'd. (The 
Remove command doesn't actually delete anything from the depot; the data structure just becomes 
invisible and inactive.)
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Snapshots

This drop-down list controls how many snapshots are visible in the StreamBrowser. It contains the 
choices No Snapshots (the default), All Snapshots, Past week, Past 2 weeks, and Past 4 weeks. 
(Check the Include hidden streams checkbox if you want to see snapshots that have been 
Remove'd.) No matter what the setting, a snapshot remains visible if there are any workspaces or 
streams below it. 

Workspaces

This drop-down list controls which of the depot's workspaces are visible in the StreamBrowser. It 
contains the choices All Workspaces, No Workspaces, Current User (the default), Unassigned, and 
the name of each registered AccuRev user and group. (Check the Include hidden streams 
checkbox if you want to see workspaces that have been Remove'd.) To control which users and 
groups appear in this list, use the Filter Users/Groups (View Users/Groups Command) on page 39 
command.

Only stream paths to workspaces

This checkbox is a toggle switch. Select it to filter the streams so that only the stream paths to 
workspaces -- the streams directly connecting the root stream to the workspace -- are visible in the 
StreamBrowser. Unselect it to remove the filter. Use the Workspaces list to control which 
workspaces are shown.

Expanding and Collapsing Subtrees
In the graphical display mode, each stream that has "children" (workspaces and/or snapshots) is displayed 
with an expand/collapse control. Collapsing causes the entire hierarchy below the stream to disappear from 
the screen. This affects the StreamBrowser display only. It does not affect the operation of the stream in 
any way.

Changing the StreamBrowser View
If your depot has a large or complex stream hierarchy, not all of its streams and workspaces will be visible 
on your display. To change your view of the stream hierarchy, you can:

 Use the StreamBrowser’s horizontal and vertical scroll bars

 Use your mouse to drag the stream hierarchy -- place the pointer on the StreamBrowser background, 
press and hold mouse button one, and then move the mouse to change the view.

Historical View of the Stream Hierarchy
If the Enable StreamBrowser History preference is checked (AccuRev Preferences  (Tools > Preferences 
Command) on page 41), a set of history controls are added to the toolbar. This enables you to view the 
stream hierarchy as it existed at any point in the past.
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Viewing a Stream's Current Development Activity
The StreamBrowser can show the development activity currently taking place in each stream or workspace. 

A control below the stream or workspace opens or closes a subwindow that displays the details of the 
development activity. The activity details can appear in several ways -- by element, by transaction, or by 
issue record.

Use the development-activity mode controls at the right side of the StreamBrowser toolbar to determine 
how the activity details will be displayed. (The icons on the controls below the streams and workspace 
change accordingly.) You can change modes either before or after opening an activity subwindow.

Viewing Activity By Element
When displaying activity by element, the subwindow displays:

• dynamic stream: the results of a Default Group search

• workspace: the intersection of the results of a Default Group search and the results of a Pending search

See Active Versions vs. Pending Changes in a Workspace on page 133 for more information on the 
relationship (and differences) between these two searches.

You can select one or more of the element versions and invoke commands on them, using the subwindow's 
toolbar. The commands available are the same as in the File Browser: see Details Pane Command 
Reference on page 77.

You can also perform these drag-and-drop operations:

• Dragging the subwindow control (but not elements within the subwindow) to the parent stream or 
another dynamic stream performs a Promote or Send to Change Palette operation on all the element 
versions in the subwindow.
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•

• Dragging the subwindow control (or a selection of one or more versions within the subwindow) to a 
workspace performs a Send to Workspace operation.

Viewing Activity By Transaction
When displaying a stream's activity by element, the subwindow displays the transactions that created the 
versions that are currently active in the stream. This display is the same as that in the Summary pane of an 
Active Transaction tab; see The Active Transactions Tab (Show Active Transactions command) on 
page 174. You can select one or more transactions and perform commands on them, just as in the Active 
Transactions tab.

Viewing Activity By Issue Record
When displaying a stream's activity by issue record, the subwindow displays the issue records that are in a 
particular stream. This display is the same as that in the Issues pane of a Stream Issues tab (see The Stream 
Issues and Stream Diff (Issues) Tabs on page 164). You can select one or more issue records and perform 
commands on them, just as in the Stream Issues tab.

You can also perform this drag-and-drop operation:

Dragging the subwindow control (but not elements within the subwindow) to the parent stream or 
another dynamic stream performs a Promote or Send to Change Palette operation on all the versions in 
the change packages of the subwindow's issue records.

Reparenting Streams and Workspaces
AccuRev lets you change the backing stream (parent stream) of any dynamic stream or workspace. The 
StreamBrowser makes it simple: you just drag-and-drop a stream or workspace from its current location in 
the hierarchy to its new parent.

The entire subhierarchy moves to the new location. Changing a data structure's location in the stream 
hierarchy is called reparenting. If the StreamBrowser display contains many streams or the stream 
structure is very complex, an alternative method of reparenting a stream is to select Reparent from the 
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context menu of the stream or workspace, then navigate to and click the new parent stream. You are asked 
to confirm the operation.

Important: After you change the location of a workspace, be sure to Update it. This ensures that the 
workspace contains the correct set of versions, many of which it will inherit from its new parent. Likewise, 
after changing the location of a stream, all workspaces in the subhierarchy below that stream should be 
Update'd.

Notes:

Snapshots

You cannot reparent a snapshot; both the contents and the parentage of snapshot are fixed permanently.

Exclusive file locking workspaces

You cannot reparent (or change any of the other specifications) of a workspace created with the 
exclusive file locking feature.

Time-based streams

If you reparent a time-based stream, AccuRev asks whether you wish to retain the basis time or 
remove it.

Reconfiguring a Stream
Using the drag-and-drop operation changes the stream’s parent. To change other stream values (like its 
name or basis time, for example), use the Change Stream command on the stream context menu.

Although you can give a new name to an existing stream, you cannot proceed to create a new stream with 
the old name. The old name remains associated with its stream. The only way to reuse a stream name is to 
completely remove the stream's depot from the AccuRev repository, using the AccuRev administration 
utility, maintain.
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Setting or Changing a Stream's Basis Time
By default, a stream inherits all versions from its parent, no matter when those versions were created. If 
you assign a basis time to a stream, it inherits only those versions created before the specified point in time. 
(The File Browser's include/exclude facility provides another way to restrict which versions get inherited 
from the parent stream.)

Creating New Streams, Snapshots, and Workspaces
The context menu of any data structure in the StreamBrowser includes commands for creating new 
structures at that point in the hierarchy. New Stream and New Snapshot display dialogs similar to that of 
Change Stream. The New Workspace command invokes a wizard that steps you through the process of 
defining a new workspace: you specify a name and a location on disk; you can also make some optional 
settings, such as controlling how line endings in text files are to be handled.

Working with Stream Properties
A stream property is a name/value pair you associate with a stream. Values can be strings or files. For 
example, you might want to create a property named nightly_build for your build stream, and specify a log 
file as its value -- 9_20_12_build.txt. Note that stream properties are not TimeSafe; if you edit or 
remove a property, you cannot roll back to the prior name/value pair. 

This section describes how to create and manage stream properties using the AccuRev GUI. You can also 
set and manage stream properties using the AccuRev CLI. See the documentation for the CLI setproperty 
command for more information.

Note: Do not confuse stream properties with configuration settings for a stream (such as stream name and 
basis time). You manage a stream’s configuration settings through the Change Stream dialog box. See 
Reconfiguring a Stream on page 145 for more information.

Creating a Stream Property
To create a stream property:

1. In the StreamBrowser, right-click the stream for which you want to set one or more properties and 
choose Properties... from the context menu.

Alternatives: If the stream already has one or more properties defined for it, you can click the stream 

properties icon ( ), or choose Actions > Properties from the menu.

The Stream Properties dialog box appears.



AccuRev®  On-Line Help Guide 147

Tip: Both the Name and Value columns can be resized. 

2. Click the Add button.

The Set Stream Property dialog box appears.

3. In the Name field, enter the name you want to use for the property.

4. In the Value field, select the Text or File radio button based on the property value you want to enter. 
Then:

• For a string value, type the value in the entry field.

• For a file value, type the full path and file name in the entry field, or click the Browse... button to 
navigate your file system and select the file. (See Working with File Type Values on page 149 for 
more information on using files for stream property values.)

Tip: To use a stream property as a "tag" or label, leave the Value field empty.

5. Click Ok.

The Set Stream Property dialog box closes, and the new stream property appears in the Stream Proper-
ties dialog box.

Note: If you specify a file for the stream property value, AccuRev displays only the file’s name, and 
not its full path, in the Value field of the Properties for Stream: list.

6. If you want to add another stream property, click Apply to save your work and then return to Step 2. 
Otherwise, click Ok to save your work and close the Stream Properties dialog box.
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Editing a Stream Property
When you edit a stream property, you can change its value (including the value type), but you cannot 
change the property’s name. To rename a stream property, first remove the stream property as described on 
page 148 and then create a new stream property with the name you want. 

To edit a stream property:

1. In the StreamBrowser, right-click the stream whose properties you want to edit and choose 
Properties... from the context menu.

Alternatives: Click the stream properties icon ( ) on the stream, or choose Actions > Properties 
from the menu.

The Stream Properties dialog box appears.

2. Select the stream property whose value you want to change and click the Edit button.

The Set Stream Property dialog box appears. For example:

3. Change the value type and/or value as needed. See Creating a Stream Property on page 146 if you 
need help with this step.

4. Click Ok.

The Set Stream Property dialog box closes, and the revised stream property appears in the Stream 
Properties dialog box.

5. If you want to edit another stream property, click Apply to save your work and then return to Step 2. 
Otherwise, click Ok to save your work and close the Stream Properties dialog box.

Removing a Stream Property
To remove a stream property:

1. In the StreamBrowser, right-click the stream whose property you want to remove and choose 
Properties... from the context menu.

Alternatives: Click the stream properties icon ( ) on the stream, or choose Actions > Properties 
from the menu.

The Stream Properties dialog box appears.

2. Select the stream property you want to remove and click the Remove button.

Tip: You can use Shift+ click and Ctrl+ click to select multiple stream properties.
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The properties you selected are removed from the Stream Properties dialog box.

3. If you want to remove another stream property, click Apply to save your work and then return to 
Step 2. Otherwise, click Ok to save your work and close the Stream Properties dialog box.

Working with File Type Values
If you create a stream property that uses a file as its value, you can:

 Save a copy of the file -- Select the stream property in the Stream Properties dialog box and click the 
Save File As button.

AccuRev displays the Save As dialog box, which you can use to save a local copy of the file associated 
with the stream property.

 View a copy of the file -- Select the stream property in the Stream Properties dialog box and click the 
View File button.

AccuRev displays a copy of the file in the editor associated with that file type.

Note that, in either case, you are not working with the file that was uploaded to the AccuRev Server when 
you created the stream property. If you change the local copy of the file and want to use the new version for 
the stream property value, you must edit the stream property and specify the file’s full path and file name 
as you did when you first created the property.

Commands Available in a StreamBrowser Tab

Open

(File and context menu only) Using a File Browser tab, display the entire contents of the selected 
stream, snapshot, or workspace.

Find

Find the streams whose name includes a specified character string. A Find dialog appears.

New Stream

Create a new dynamic stream or pass-through stream, based on (that is, as a child of) the selected 
stream or snapshot. A Stream Configuration dialog appears.

New Workspace

Create a new workspace, based on (that is, as a child of) the selected stream or snapshot. A New 
Workspace wizard helps you to configure the workspace.

New Snapshot

Create a new snapshot, based on (that is, as a child of) the selected stream  A New Snapshot dialog 
appears.

Change Stream

(Actions and context menu only) Modify the configuration of the selected dynamic stream or pass-
through stream. A Stream Configuration dialog appears.

Reparent

(Context menu only) Change the backing stream (parent stream) of the selected dynamic stream or 
workspace. 
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Remove

After confirmation, hide the selected stream, snapshot, or workspace. This removes the object 
from the StreamBrowser display.

Removal affects how the object can be used:
• Workspace: deactivates the workspace, so that it cannot be used in AccuRev commands.

• Stream or snapshot: no effect; you can still promote to the stream, create a substream of it, or 
reparent it.

Note: Removing a workspace that belongs to another user -- You cannot do this using the AccuRev 
GUI. The rmws -s command in the AccuRev CLI provides this capability.

Reactivate

(Actions and context menu only) Undo a Remove command for the selected stream, snapshot, or 
workspace.

Locks ... (Lock/Unlock Stream)

(Dynamic stream only) Lock a stream, to disable various operations that modify the stream. If a 
stream is already locked, a lock icon appears in the StreamBrowser graphical display, and in the 
Locks column of the tabular display. A Lock dialog appears: see The Locks Command on page 51.

WIP (Work in Progress)

(Actions and context menu only) Open a WIP tab, displaying the active elements in workspaces 
and/or streams related to the selected stream.

Show All Overlaps

(Workspace only) Using an Overlaps tab: for active file elements (those in the workspace's default 
group), display all overlaps involving versions in the workspace's entire backing chain (higher-
level streams) -- not just overlaps between the workspace and its immediate parent stream.

Show Active ...

There are three commands to display the stream's development activity, using the appropriate tool 
for the current development-activity mode:

Element mode: open a File Browser tab on the selected stream, and execute a search for 
active elements.

Transaction mode: open an Active Transactions tab, showing the transactions that created 
the versions currently in the selected stream's default group.

Issue Record mode: open a Stream Issues tab, showing the change packages that have been 
(partially or completely) incorporated into the selected stream.

The way the three commands appear on a stream's context menu varies with the development-
activity mode: the command for the current mode appears at the top-level of the context menu; the 
commands for the other two modes are in a submenu. For example, the following illustration 
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shows how the menu choices appear if the StreamBrowser is currently displaying activity by issue 
record. 

Show History

Using a History Browser, display the transactions that created versions in the selected stream.

Show Diff By Files

Using a Diff Streams window, show the element-by-element differences between the selected 
stream and another stream (which AccuRev prompts you to specify).

Show Diff By Issues

(Actions and context menu only) Using a Stream Issues window, show the differences between the 
selected stream and another stream (which AccuRev prompts you to specify). The differences are 
shown in terms of change packages instead of individual elements.

Send to Change Palette

Send the active elements for the selected stream to the Change Palette.

Show Patch List

(Actions and context menu only) Using a Patch List tab, list all the individual versions whose 
changes are in the selected stream, but are not in another stream (which AccuRev prompts you to 
specify).

Graphical Display

Display the depot's stream hierarchy as a tree.

Tabular Display

Display the depot's stream hierarchy as a table.

Graphical/Tabular Display

Display the depot's stream hierarchy as a tree in one pane, and as a table in another pane.

Using Stream Favorites
A Stream Favorite is a way to limit the stream hierarchy shown in the StreamBrowser to the stream path of 
a specific stream and all its children. If your organization has depots containing thousands of streams, 
Stream Favorites is a powerful tool to improve system performance and focus attention on just the streams 
you're interested in.

Note: Although you create and apply Stream Favorites in the StreamBrowser, their use affects the display 
of streams throughout the AccuRev GUI. Any list of streams available in the GUI will contain only the 
subset of streams shown in the StreamBrowser.
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Stream Favorites and Stream Filters
Prior to AccuRev Version 5.5, Stream Favorites were called stream filters. The idea behind them -- to 
provide a handy way to create different views of the streams in your depot -- is the same, but there are a 
few important differences:

• Stream Favorites are created and managed in a more straightforward way

• Stream Favorites can be shared with other users in the depot

• Stream Favorites are accessed through the StreamBrowser

If you are upgrading from AccuRev Version 5.4.1 or earlier, AccuRev automatically converts existing 
stream filters to Stream Favorites.

Stream Favorites and StreamBrowser Display Filters
When AccuRev displays streams in the StreamBrowser, it applies Stream Favorites first. Any display 
controls in the StreamBrowser are then applied to the filtered set of streams. Occasionally, the interaction 
between Stream Favorites and display controls might produce an unexpected result. For example, if you 
have selected the Only stream paths to workspaces checkbox at the bottom of the StreamBrowser, only 
those paths that lead to workspaces will be displayed, even if the current Stream Favorite includes streams 
that do not lead to workspaces. If your Stream Filter does not produce the expected display in the 
StreamBrowser, remember to check the display controls to verify that these local settings are not affecting 
the outcome.

Creating a Stream Favorite

To create a Stream Favorite:

1. In the StreamBrowser, click the Show Stream Favorites button ( ).

The Stream Favorites panel appears.

2. Click the New button.

The Create Stream Favorite dialog box appears.
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3. In the Name field, enter the name for the Stream Favorite.

4. By default, Stream Favorites are private -- that is, the Stream Favorite you create can be used only by 
you. If you want to be able to share your Stream Favorite with others, click the Public radio button.

5. Use the Stream Search to locate the streams in your depot that you want to mark as favorites:

Note: By default, AccuRev searches the depot for any streams that contain the string you enter, but 
you can change that to matches, starts with, or ends with. The search field is case-sensitive -- searching 
on, say, AccuRev and accurev will yield different results.

6. When you have specified your search criteria, click the Search button.

AccuRev displays the streams that match your search criteria in the Search Results list box.

7. Use the Add and Add All buttons to choose the streams you want to mark as favorites.

Tip: You can use Shift+ and Ctrl+ click to select more than one stream at a time.

8. If you want to search for other streams to include in this Stream Favorite, return to Step 5.

9. If you change your mind about including a stream in this Stream Favorite, select it in the Selected 
Streams list box and click the Remove button.

10. When you have finished choosing streams, click Ok to create the Stream Favorite.

The new Stream Favorite appears in the Stream Favorites panel under the My Favorites folder.
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Tip: Private Stream Favorites are displayed with a simple star icon ( ). Public Stream Favorites are 

displayed with the star icon against a blue background ( ).

11. To apply the Stream Favorite, double-click it. See Applying a Stream Favorite on page 154 for more 
information.

Working with Stream Favorites

This section describes common procedures used with Stream Favorites.

Applying a Stream Favorite
To apply a Stream Favorite, double-click it. 

In addition to changing the StreamBrowser display itself, AccuRev shows information about the current 
Stream Favorite in two places:

• The Showing Stream Favorite field at the top of the StreamBrowser identifies which Stream Favorite 
is active.

• The Number of favorite streams field at the bottom of the StreamBrowser indicates how many 
streams were specified as favorites in the current Stream Favorite.

Clearing a Stream Favorite from the StreamBrowser
To clear a Stream Favorite, click the Show All Streams button at the bottom of the Stream Favorites panel.

Depending on the size and complexity of your stream hierarchy, showing all streams can take a long time. 
AccuRev displays an informational message, which gives you the chance to cancel the operation.
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Tip: If you check the Do not show this again check box, you can restore this dialog box by clearing the 
Skip "Show All Streams" checkbox on the General tab of the AccuRev Preferences dialog box (Tools > 
Preferences).

Editing a Stream Favorite
You can make the following changes to a Stream Favorite:

• Name

• Public or private status

• The streams that make up the Stream Favorite

To edit a Stream Favorite:

1. In the Stream Favorites panel, right-click the favorite you want to change and choose Edit from the 
shortcut menu.

The Edit Stream Favorite dialog box appears.

2. Change the Stream Favorite as needed.

3. Click Ok.

Deleting a Stream Favorite
When you delete a Stream Favorite that you created as a public Stream Favorite, it will no longer be 
available to any users who might have added it to their Stream Favorites panel.

To delete a Stream Favorite:

• In the Stream Favorites panel, right-click the Stream Favorite you want to delete and choose Delete 
from the shortcut menu.

Getting Others’ Stream Favorites

In addition to creating your own Stream Favorites, you can add Stream Favorites created by other users to 
your Stream Favorites panel. To be accessible to you, they must have been created as public, and not 
private, Stream Favorites. If the author of a public favorite you have added to your Stream Favorites panel 
later deletes that favorite, it will no longer appear on your Stream Favorites panel.

Note: When you add a user, you get all of that user’s public favorites.

To add others’ Stream Favorites to your Stream Favorites panel:

1. If the Stream Favorites panel is not already open in the StreamBrowser, click the Show Stream 

Favorites button ( ).



156 AccuRev®  On-Line Help Guide

2. In the Stream Favorites panel, click the Add Public button.

The Add Other Users’ Public Favorites dialog box appears.

3. Select one or more users from the list.

Tip: Use Crtl+ and Shift+ click to select multiple users at the same time.

4. Click Ok. 

The users you selected appear in the Public Favorites folder. 

5. To view other users’ public Stream Favorites, click the + next to their name.

Removing Other Users’s Stream Favorites
To remove another user’s Stream Favorites from the Public Favorites folder in your Stream Favorites 
panel:

• In the Stream Favorites panel, right-click the user whose Stream Favorites you want to remove and 
choose Remove from the shortcut menu.
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The user, and all of that user’s favorites, is removed from the Public Favorites list in your Stream 
Favorites panel.

The Overlaps Tab
The Overlaps tab displays all versions with (overlap) status, both in the selected workspace and 
in the workspace's entire backing chain.

Opening an Overlaps Tab

Choose Show All Overlaps from the context menu of a workspace on a Stream Browser tab.

Overlaps Tab Layout

The Overlaps tab contains a table with these columns:

Element (or separate "Name" and "In Folder" columns)

The pathname within the depot of the element with the overlap.
Status

The status of the version in that workspace or stream.
Overlap Stream

The workspace or stream that contains a version with (overlap) status.
Version

The version-ID of the version in that workspace or stream.

Working in an Overlaps Tab

For versions in dynamic streams (but not workspaces), you can begin the process of resolving the 
overlap:

1. Select one or more versions located in the same dynamic stream.

2. Right-click the selection, and choose Send to Change Palette from the context menu.

This opens a Change Palette tab, with an entry for each version you selected. The destination 
stream is automatically set to the parent of the stream where those versions are located. You can 
resolve the overlaps by performing merges on those versions.
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The Remove Stream Command
(and the Remove Workspace Command)

You can invoke the Remove command on a stream, snapshot, or workspace. This hides the item from the 
Stream Browser and the Workspaces tab, but you can use the checkbox in both these tabs to view removed 
("hidden") items.

This command does not remove the object from the depot — that would violate AccuRev’s TimeSafe 
property. It disables some operations, but not all:

• You cannot work in a removed workspace.

• You can promote versions to a removed stream.

To bring back a removed object, make it visible with the Show including hidden checkbox, then invoke the 
Reactivate command on it.

Invoking the Remove Stream Command
In the StreamBrowser, choose Remove from the context menu of a stream or snapshot. Restrictions:

This command is disabled if there are any streams, snapshots, or workspaces below the one to be 
removed.

Invoking the Remove Workspace Command
In the StreamBrowser, choose Remove from the context menu of a workspace. Restriction: You must be 
logged in as the user who owns the workspace

Default Group Subwindows in the StreamBrowser
Each workspace and dynamic stream has a default group, consisting of the elements that are 
currently active in that context. (More precisely, the default group contains a version of each 
active element.) In graphical mode, the StreamBrowser can display the default group for one 
workspace or stream at a time.

Opening a Default Group Subwindow

The StreamBrowser displays a   Default Group icon for each workspace and dynamic stream 
with a non-empty default group. Click this icon to open a subwindow displaying the default 
group.

You can display default groups just one-at-a-time -- the subwindow closes automatically if you 

click the  icon of another workspace or stream.

Note: If you don't see any   icons, but you know some elements are active...

A user preference (Display Default Group in StreamBrowser) controls whether the Stream 
Browser spends the time to determine the contents of the default group of each stream and work-
space in its display.
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Default Group Subwindow Layout
The default group subwindow has essentially the same layout as the File Browser's Details pane:

• A table, showing the members in the default group.

• A toolbar, for performing operations on the members.

StreamBrowser's default group subwindow vs. File Browser's Default Group 
search
The results of a Default Group search in the File Browser are not always the same as the contents of the 
StreamBrowser's Default Group subwindow:

• The File Browser's search displays all the members of the default group.

• The StreamBrowser's subwindow displays only those members with Pending status. This does not 
include elements that are active by virtue of a Send to Workspace or Anchor command. If the default 

group is non-empty, but contains only non-Pending elements, the  icon will appear, but clicking it 
brings up an error box.

•  Working in a Default Group Subwindow

The toolbar in the Default Group subwindow contains many of the same buttons as the toolbar of the File 
Browser's Details pane. In particular, you can select one or more elements, then promote them to the 
backing stream.

Note: If you want to promote all the elements in the default group subwindow to the backing stream, 

you don't need to open the subwindow at all. Just drag-and-drop the   icon below the workspace or 
stream to the backing stream. (The backing stream is the only stream you can target with this drag-and-
drop operation.)

StreamBrowser History
Like the individual files under version control, a depot’s stream hierarchy undergoes change, too. Initially, 
the depot contains a single base stream. Thereafter, additional dynamic streams are created, along with 
snapshots and user workspaces. Each such change in the stream hierarchy creates a new "state" of the 
hierarchy. You can browse through all these states, like browsing through a slide show, using the History 
controls in the StreamBrowser toolbar:
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Find Stream
The StreamBrowser search feature enables you to find a stream or workspace whose name contains a 
specified character string. You can use this feature in any of the StreamBrowser's display modes: 
graphical, tabular, or combined.

Invoking the Find Stream Dialog
You can access the StreamBrowser Find dialog in one of three ways:

• Click the Search icon ( ) in the StreamBrowser toolbar.

• Type Ctrl-F in a StreamBrowser view.

• Right-click over a stream and click Find.

Note that if you right-click, your search will be limited only to the streams under the stream where you 
right-clicked. Otherwise, ALL streams in the depot matching your search will be found.

Using the Find Dialog

Type characters in the text box that match all or part of the stream name(s) you are looking for. Make sure 
the Case Sensitive option is set as desired. You can enter any character that is legal for an AccuRev stream 
name. Wildcards ("*" and "?") are accepted. The find operation will match the string in any part of the 
name. So for example, performing a case-insenstive search for "Devel" will return streams with names like 
"devel_stream", "Old_Development".
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Displaying and Filtering Stream Find Results
The results are displayed in a StreamBrowser tabular display.

To fine-tune the results, you can enter characters in the Filter Results field. As you type a string, the 
streams shown in the results display will be narrowed down to only those containing the characters you 
enter. The rules for Filter strings are the same as for Find String.

The Stream Diff (Files) Tab
(Show Diff By Files command)

The Stream Diff (Files) tab displays the element-by-element differences between two streams. Each stream 
can be a dynamic stream, a snapshot, or a workspace stream. AccuRev determines the differences by 
examining the elements' version-IDs in each stream. It does not compare the contents of file versions (but 
you can, using this tab's Show Difference command).

A stream comparison can report these differences

• A file element has been modified in one or both streams. (When analyzing the contents of a 
workspace, this command always uses the version currently in the workspace stream (which might be 
inherited from a higher-level stream). This version differs from the file in the workspace tree if the file 
has (modified) status.)

• An element has been renamed in one or both streams.

• A new element has been added to one of the workspaces (Add to Depot command) or streams 
(Promote command)

• An element has been removed from one of the streams (Defunct command).

Opening a Stream Diff (Files) Tab
1. In the StreamBrowser, select a stream, snapshot, or workspace.

2. Choose the Show Diff by Files command from the selection's context menu, or click the  button on 
the StreamBrowser's toolbar.

3. The mouse pointer changes to . Left-click another stream, snapshot, or workspace.
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Stream Diff (Files) Tab Layout
The Stream Diff (Files) tab contains a table, each row of which details one element. Above the table is the 

name of the Destination Stream (the one you selected with the  mouse pointer) and Source Stream (the 
one you selected before invoking the command).

The columns of this table are:

Element #2 (or two columns: Name #2, In Folder #2)

The pathname of the same element in the destination stream. If empty, the element is present only 
in the source stream. Note that a user preference controls whether the element pathnames are 
displayed in a single column, or in two columns.

eid #2

The element-ID of the element.
Version #2

The version-ID of the destination stream's version of the element.
Element #1 (or two columns: Name #1, In Folder #1)

The pathname of the element in the source stream. If empty, the element is present only in the 
destination stream. Note that a user preference controls whether the element pathnames are 
displayed in a single column, or in two columns.

eid #1

Same as eid #2. (The element-ID is immutable. It is unique within the depot, but not within the 
entire repository.)

Version #1

The version-ID of the source stream's version of the element.
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Working in a Stream Diff (Files) Tab
In any row of the Stream Diff table, you can left-click to select an element's version in either stream/
workspace:

Then, you can invoke a command, using the Stream Diff tab toolbar or the selection's context menu. Some 
commands operate on the particular version you selected; other commands operate on the overall element.

Commands That Operate on the Selected Version

Open (equivalent to double-click)

Windows: Run the appropriate command on the file, according to its file type. (The Windows file-
typing system — "file associations" — does not provide for assigning a file type if the filename 
has no suffix.) 

UNIX: Open a text editor on the file.

View

(text files only) Open a text editor on a temporary copy of the selected version.

Save As

Copy the selected version to another filename.

Commands That Operate on the Overall Element

Browse Versions

Open a Version Browser tab, showing all the versions of the selected element, and their 
interrelationships (ancestry).

Browse Stream Versions

Open a Stream Version Browser tab for the selected element. This tab displays the depot's stream 
hierarchy, much like the Stream Browser. But on this tab, each stream represents the version of the 
specified element that appears in that stream.

Show History

Open a History Browser tab, containing the transactions involving the selected element.
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Show Difference

(file elements only) Compares the contents of the two streams' versions of the selected element. 
Note that when analyzing the contents of a workspace, this command always uses the version 
currently in the workspace stream (which might be inherited from a higher-level stream). This 
version differs from the file in the workspace tree if the file has (modified) status.

The Stream Issues and Stream Diff (Issues) Tabs
The Stream Issues and Stream Diff (Issues) tabs are essentially similar. A table in the Issues pane (upper) 
displays the issue records that are in a particular stream. The Change Package Contents pane (lower) 
displays the entries in a selected issue record's change package.

Note: Terminology -- issues "in" a stream

Strictly speaking, the only objects that are "in" a stream are versions. It makes sense to describe a set of 
versions as being "in" a stream. And so, it makes sense to describe the set of versions in a change package 
as being "in" a stream. From there, we make the leap to describing the AccuWork issue record containing 
the change package as being "in" a stream.

Opening the Tab
To open a Stream Issues tab, showing the contents of a stream in terms of change packages: choose Show 
Active Issues from the context menu of any stream, or snapshot, or workspace in the StreamBrowser. Note: 

If the StreamBrowser is displaying development activity by issue record, you can click the   icon under 
the stream itself to open a subwindow containing the same data as a separate Stream Issues tab.

To open a Stream Diff (Issues) tab, showing the difference between two streams in terms of change 
packages:

1. In the StreamBrowser, select a stream, snapshot, or workspace.

2. Choose the Show Diff by Issues command from the selection's context menu, or click the  button on 
the StreamBrowser's toolbar.

3. The mouse pointer changes to   . Left-click another stream, snapshot, or workspace.
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Stream Issues Tab Layout
The Stream Issues tab includes two panes, each with its own toolbar:

• The Issues pane displays selected fields from the issue records whose change packages are "in the 
stream"— partially or completely. (To get here, use the Admin> Schema Editor command to open a 
Schema Editor tab. Go to the Change Packages subtab, and select fields to be displayed in the upper 
Change Package Results pane).When you're comparing the contents of two streams, this pane displays 
the issues whose change packages are in one stream, but not the other.

• The Change Package Contents pane displays the entries in the change package of the currently 
selected issue record. 

Working in the Issues Pane
You can control which issues are displayed, and you can invoke commands on one or more issues' change 
packages.

Controlling Which Issues are Displayed
Checkboxes at the bottom of the Issues pane control which issues are displayed. The Show Active, Include 
Incomplete Issues, and Include Hierarchy checkboxes appear only when you're displaying a single stream's 
change packages. (When comparing streams, AccuRev always proceeds as if these checkboxes are 
cleared.) The Bidirectional checkbox appears only when you're comparing two streams.

Show Active 

If checked, an issue is included only if one or more of its versions was promoted to the stream, but 
has not yet been promoted from the stream to its parent. This helps you to concentrate on current 
programming efforts, rather than those that were completed long ago.

Note: For the purposes of the Show Active filter, a Revert to Backed operation has the same effect as 
a Promote operation. For a workspace, substitute the phrase "created in" for "promoted to". 

Include Incomplete Issues 
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If cleared, the listing includes only issues that are completely in the stream, where “completely in” 
means that for every change package entry, the head version (Version column) itself is in the 
stream, or one of its descendants is in the stream.

If checked, the listing includes all issues, including ones that are partially in the stream, where 
“partially in” means that for some but not all change package entries, the head version (Version 
column) itself is in the stream, or one of its descendants is in the stream.

On the Change Package Contents pane, the Status column and background shading indicate which 
change package entries are "in" the stream and which are not in ("missing" from) the stream.

Include Hierarchy

(available only if Show Active is checked) If checked, also includes issues that are in the streams 
below the selected stream.

Bidirectional

(Stream Diff only) If cleared, the Issues pane displays the issue records in the first stream 
("source"), but not in the second stream ("destination").

If checked, the listing also displays the issues that are in the second stream, but not in the first 
stream. Color-shading helps you to distinguish the two sets of change packages.

Commands Available in the Issues Pane
Select one or more issues to invoke commands on the issues, or on their change packages. 

These commands are available through context menus and in the toolbar of the issues pane.

Open Issue

Open an edit form on the selected issue, and display the Changes tab.

Promote Issue(s)

Stream Issues tab (enabled only if Show Active is set and Show Incomplete is cleared): promotes 
each currently-active head version in the issue's change package to the parent stream. That is, if a 
version listed in the Version column is currently active in the stream on which you invoked the 
Show Issues command, that version is promoted to the parent stream.

Example:
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The following illustration shows the Stream Issues tab for dynamic stream plum12_dvt.

Invoking the Promote command on issue #7 causes some or all these versions to be promoted. The 
versions promoted are the ones that are currently in the workspace's default group:
• version 8/30 of chap03.doc

• version 9/36 of commands.c

• version 9/10 of end.bat

Stream Diff (Issues) tab (works only for issues in the source stream, not for issues in the 
destination stream): promotes each currently-active head version in the issue's change package 
from the source stream to the destination stream. If there is an overlap between the two streams for 
any element, the promote operation fails with a "merge required" error box.

Send to Change Palette

(enabled only if Show Active is set and Show Incomplete is cleared) Opens a Change Palette tab, 
containing each head version in the issue's change package.

Send to Issue

Adds (or combines) the selected issue record's change package entries with those of one or more 
other issue records. A popup window prompts you to specify the destination issue record(s).
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Revert Change Package

(Formerly named Revert by Change Package.) Removes the changes in the selected issue's change 
package from the stream. A dialog appears offering you two options for performing this operation:

In reverse order, these options are:

• Use a workspace to peform revert — Choose this option if you wish to test the results of the 
revert before promoting them back into the stream. You must choose a workspace to which 
you have access to perform the revert. (All workspace appear in the selection list. If you select 
a workspace to which you do not have access, AccuRev will display an error). The revert 
operation typically involves one or more reverse patch operations on file elements' contents, 
performed with the Merge tool. 

Important: If no valid workspaces exist, this dialog is bypassed and you are prompted 
whether or not to proceed without a workspace (see below). A "valid" workspace is one of 
your own workspaces which has local (or accessible mounted) storage on the machine that the 
revert is being performed from. If none of your workspaces are attached to the stream the 
issue is being reverted from, or for some reason are not accessible from the machine that the 
client is running on, you can still proceed with the revert, keeping the new file versions 
directly in the stream.  However, AccuRev warns you that this is what happening if you choose 
to proceed with the revert operation. 

Note: This feature is not intended to be used within a workspace; it is meant to be executed 
within a stream, but with the aid of a workspace to perform any necessary Merge operations. If 
you try to execute this operation directly within a workspace, you will get an error 
message: "You need to have at least one workspace associated with stream..." Try the 
following workaround:

1. Create a new stream between the workspace and its backing stream.
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2. Promote the issue to the new stream.

3. Invoke the Revert Change Package Using Workspace command on that issue in the new stream.

• Continue revert operation without using a workspace — Similar to Use a workspace to 
peform revert, except that the results are placed directly in the stream, without the requirement 
of a workspace. This means that the results of the revert will be immediately propagated 
downstream in the hierarchy. 

AccuRev prompts you for an issue number against which to the record the Revert changes. 
Either create a new issue, or select an existing issue that you created specifically for this 
Revert. (You should rarely—if ever—select an existing issue that has been used for previous 
operations.) Then peform whatever merge changes are required by the revert. 

Important: If no workspaces to which you have access exist, the dialog described above is 
bypassed and you are simply prompted whether or not to proceed without a workspace.

Note: Continue revert operation without using a workspace saves the step of merging and 
testing the revert in a workspace and then promoting the changes, but at the risk of propagating 
the changes as soon as the revert has been completed. This feature should not be used casually 
by developers, as you could easily propagate complex, untested changes to other users. This 
feature is useful for reverting relatively simple changes, or for backing out a change in an 
isolated build stream. AccuRev recommends that you build and test these changes in an 
updated workspace to verify the results, before promoting or cross-promoting the changes to 
other users.

Show Dependencies

Opens an Issue Dependencies tab, displaying the change package dependencies of the selected 
issue record(s).

Working in the Change Package Contents Pane
Select any change package entry and invoke any of the commands described below. In most cases, the 
operation is performed on the entry's head version (Version column). You can invoke the Remove and Send 
to Issue commands on a selection consisting of two or more change package entries.

Open (equivalent to double-click)

Windows: Run the appropriate command on the file, according to its file type. (The Windows file-
typing system — "file associations" — does not provide for assigning a file type if the filename 
has no suffix.) 

UNIX: Open a text editor on the file.

View

Open a text editor on a temporary copy of the currently selected version (text files only).

Save As

Copy the currently selected version to another filename.

Promote

Promote the head version(s) of the selected entry(s) to the parent stream.
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Remove

Remove the selected entry(s) from the change package.

Diff Against Basis

Compare the selected version with the corresponding basis version.

Show History

Open a History Browser tab, containing the transactions involving the selected file or directory.

Browse Versions

Open a Version Browser tab, showing all the versions of the selected file or directory, and their 
interrelationships (ancestry).

Send to Issue

Copies the selected entryies to another issue record's change package. If there is an existing entry 
for an element in a destination change package, an attempt is made to combine the existing entry 
with the entry you specified.

The default query is executed, and the results are displayed in a dialog. You are prompted to 
choose one or more of the issue records selected by the query. You can also create a new issue 
record, whose number will be entered in the dialog.

Properties

Displays a message box with information about the selected element.

The Issue Dependencies Tab
The Issue Dependencies tab contains a hierarchical display of the dependencies of a selected set of issue 
records -- that is, the set of issue records on which the selected records depend.

Note: In this description, "issue record N" is shorthand for "change package of issue record N".

From this tab, you can propagate issues' change packages to other streams, using simple Promote 
commands and/or the Change Palette. When propagating an issue's change package to another stream, you 
can choose to propagate the changes in the issue's dependencies, as well.

Opening an Issue Dependencies Tab
In a Stream Issues or Stream Diff (Issues) tab, select one or more issue records in the Issues pane, then click 

the  Show Dependencies toolbar button or invoke the Show Dependencies command from the selection's 
context menu.

Change Package Dependencies
The concept of a change package depending on another change package (or an issue record depending on 
another issue record) is complex, utilizing several aspects of AccuRev’s product architecture. But the basic 
idea is familiar: when you ask for something, you sometimes get more than you asked for.

This Version Browser example shows three sets of changes to an element, each assigned to a different issue 
record: #2, #4, and #13.
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At this point, issue record #13 is active in stream brass_dvt. Promoting that issue record — for example, 
using the Stream Issues tab — promotes version brass_dvt/6 (real version: brass_dvt_phil/25).

Promoting issue record #13 would give you "more than you asked for": it would automatically promote 
issue records #2 and #4, as well. We describe this situation by saying that issue record #13 depends on 
issue records #2 and #4.

In practice, most issue records' change packages contain entries for multiple elements, not a single 
element. In many cases, the promotion causes issue records #2 and #4 to be "partially in" the destination 
stream, not "completely in".

Dependency Defined
The discussion above is conceptual and informal. Here’s a rigorous definition of change package 
dependency:

Issue A depends on issue B, in the context of a promotion from stream S1 to stream S2, if issue A is 
active in stream S1 and at least one element meets all the following conditions:

• The element has a change package entry in both issue A and issue B.

• The head version of the element’s entry in issue A is a descendant of the head version in issue 
B. (That is, the A version contains the changes made in the B version.)

• Stream S2’s version of the element is not either the head version of the element’s entry in issue 
B or a descendant of it. (That is, the changes made in the B version have not yet been 
promoted to stream S2.)

The Dependency Context
Note that the definition of change package dependency cites a pair of streams as its context. The Issue 
Dependencies tab shows dependencies in the context of a promotion ...

• from the stream or workspace on which you opened a Stream Issues tab ...

• to its parent stream.

The Dependency Hierarchy
For each issue record, there is a dependency hierarchy: the issue directly depends on several issues; each of 
those issues directly depends on several issues; and so on.
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The Issue Dependencies tab uses a tree control to represent the dependency hierarchy.

Issue Dependencies Tab Layout
The Issue Dependencies tab layout is similar to that of the Stream Issues tab: two panes, each with its own 
toolbar. The upper pane is the Issues Pane, and the lower one is the Change Package Contents Pane:

Issues Pane
The Issues pane displays the issue records that were selected for the Show Dependencies command.

Note: For each issue record, it displays the fields specified in the Change Package Results section of 
the Schema Editor's Change Packages tab.

If an issue record has dependencies, a tree control appears, initially in the collapsed state. Color-coding and 
icon differences indicate dependency-related information about the individual issue records:

As you expand issue records' dependency hierarchies, you may discover that some issue records that you 
initially selected for the Show Dependencies command also appear as dependencies at lower levels. To 
help you keep track, color-coding is used at the lower levels:

• Issue records that you initially selected for the Show Dependencies command appear without a tinted 
background.

• Issue records that you did not initially select appear with a tinted background. These are the "new 
records" added to the listing by the dependency analysis.

Variations in an issue record's icon provide more information about that issue's dependencies:

• (no sub-icon): the issue has no dependencies in this context.

• (yellow warning sub-icon): all of the issue's dependencies are included in the set you initially 
selected for the Show Dependencies command (the issues at the top hierarchy level).

• (red warning sub-icon): some of the issue's dependencies are not included in the set you initially 
selected for the Show Dependencies command.
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Change Package Contents Pane
The information displayed in the Change Package Contents pane varies depending on the setting of the 
dependencies drop-down list.

Toogle between the two settings to display dependencies to and from the issue selected in the upper pane. 
This changes the information displayed in the bottom pane. 

The far right column toggles to display the "Depends On" or "Are Dependent On" issues. 

The versions are displayed as follows:

Show Issue(s) That The Selected Issue Depends On -- Displays the versions in those issues that the 
selected issue depends on.

Show Issue(s) That Are Dependent On The Selected Issue -- Displays the versions in the selected issue.

Working in the Issues Pane
Use the tree control to navigate the dependency hierarchy of an issue record.

Select one or more issue records, and invoke any of these commands from the selection's context menu:

Open Issue

Open an edit form on the selected issue record, and display the Changes tab.

Promote Issue(s)
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Promote each currently-active head version in the issue(s)' change package(s) to the parent stream. 
That is, if a version listed in the Version column is currently active in the stream from which you 
invoked the Show Dependencies command, that version is promoted to the parent stream.

Promote Issue(s) with All Dependencies

Similar to Promote Issue(s), but also include the issue records on which the selected issue(s) 
depend.

Send to Change Palette Issue(s)

Similar to Promote Issue(s), but instead of promoting active versions, invoke the Send to Change 
Palette command on them.

Send to Change Palette Issue(s) with All Dependencies

Similar to Promote Issue(s) with All Dependencies, but instead of promoting active versions, 
invoke the Send to Change Palette command on them.

Show Dependencies

Open another Issue Dependencies tab, with the selected issue records at the top level.

Working in the Change Package Contents Pane
In this pane, you can perform the same operations as in the corresponding pane of a Stream Issues or 
Stream Diff (Issues) tab.

The Active Transactions Tab
(Show Active Transactions command)

When the Stream Browser is displaying element activity by transaction (not by element or by issue record), 
the Show Active Transactions command opens an Active Transactions tab, containing the transactions that 
created the versions that are currently active in a particular stream or workspace. 

It may be the case that some, but not all, of the transaction's versions are currently active; the other 
versions may have already been promoted to the parent stream.

Notes:

Multiple transactions for the same element

If several Promote transactions created successive versions of the same element in a stream, and 
that element has not been promoted to its parent (or purged with Revert to Backed), then all of 
those Promote transactions will appear in the Active Transactions listing.

That is, a transaction is listed if the changes that it sent to the stream have not yet been promoted 
(or purged) out of the stream.
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"Checkout" and "Revert to Backed" transactions not included

Transactions whose value in the Action column is co ("checkout") or purge are not included in the 
Active Transactions tab. Such transactions are created by the Send to Workspace, Anchor, and 
Revert to Backed commands.

Comparison with Show History command

The set of transactions displayed by Show Active Transactions is a subset of the transactions 
displayed by Show History. You can think of Show Active Transactions as displaying a stream's 
"current history", rather than its "ancient history".

Opening an Active Transactions Tab

In the StreamBrowser, make sure development activity is being displayed by transaction (   button at 
right side of StreamBrowser toolbar). Choose Show Active Transactions from the context menu of a stream 
or workspace.

Note: You can't invoke this command on a depot's base stream. The "active" concept does not apply to 
the versions in this stream, because there is no higher-level stream to promote versions to, and to 
inherit versions from.]

Active Transactions Tab Layout
The layout of the Active Transactions tab is virtually identical to that of the History Browser. Exception:

The Versions pane includes an extra column, "Status". The (member) flag indicates that the element is 
currently active in the workspace or stream. The lack of this flag indicates that the element is no longer 
active (because it has been processed with the Promote command or the Revert to Backed command). 
This column also includes the (overlap) flag, if appropriate.

Working in a Active Transactions Tab
The sets of commands available in the Summary pane (upper) and Versions pane (lower) of the Active 
Transactions tab are virtually identical to those available in the History Browser. The differences are:

Promote

This command is enabled only in the Active Transactions tab, not in other History Browser 
contexts. In the Summary pane, it promotes the transaction's versions to the parent stream.

Note: Some of the transaction's versions may no longer be active, having been promoted or purged 
(Revert to Backed command). Invoking Promote operates on the versions that are still active.

In the Versions pane, it promotes the selected version (or set of versions) to the parent stream.

Revert

The Revert Transaction command is enabled in other History Browser contexts, but not in the 
Active Transactions tab.
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The Stream Version Browser
The Stream Version Browser tool is a variant of the Stream Browser. It displays the stream hierarchy for an 
entire depot; each stream, snapshot, and workspace in the display represents a version of a specified 
element.

Opening a Stream Version Browser Tab
The Stream Version Browser displays information about one particular element. In a File Browser, select a 

file or directory element in the Details pane. Then click the  Browse Stream Versions toolbar button.

Stream Version Browser Tab Layout
The Stream Version Browser display is almost exactly the same as the StreamBrowser display. But the 
pathname of the specified element is displayed in the upper right corner of the tab. Also, the workspace 
that you were in (when you invoked the Stream Version Browser from in the File Browser) is displayed at 
the bottom of the GUI window.

Each box in the Stream Version Browser display represents the version of the specified element that is 
currently in that stream, snapshot, or workspace. A workspace box indicates the version in the workspace 
stream, which is not necessarily the same as the file in the workspace tree. They differ if the file has 
(modified) status.

Working in a Stream Version Browser Tab
The Stream Version Browser has many of the same commands as the StreamBrowser for controlling the 
display. These commands, available in the Stream Version Browser toolbar, include:

Search for Stream

Find the stream(s) whose name includes a specified character string. A Search for Stream dialog 
appears.

Graphical Display
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Display the depot's stream hierarchy as a tree 

Tabular Display

Display the depot's stream hierarchy as a table

Graphical/Tabular Display

Display the depot's stream hierarchy as a tree in one pane, and as a table in another pane.

Similarly, the Stream Version Browser includes many of the same commands as the Version 
Browser, for operating on a selected version of an element. These include:

Open 

Run the appropriate command on the version, according to its file type.

View 

Open a text editor on a temporary copy of the currently selected version (text files only).

Save As 

Copy the currently selected version to another filename.

Merge From 

Merge the selected version into the version in the workspace from which the Stream Version 
Browser was invoked.

Patch From 

Patch the selected version into the version in the workspace from which the Stream Version 
Browser was invoked.

Send To Workspace 

Activate the selected element in the workspace from which the Stream Version Browser was 
invoked.

Send To Issue 

Record the selected version in the change package section (Changes tab) of one or more issue 
records. The default query is executed, and you are prompted to choose one or more of the records 
selected by the query. You can also create a new issue record, to which the selected version(s) will 
be sent.

Show Difference 

Compare the selected version with another version of the element. AccuRev changes the mouse 
pointer, to prompt you to select the other version.

Properties 

Displays a message box containing information about the selected version.
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Patches and Change Packages
A patch is a set of versions of a text-file element, whose changes have been incorporated into another 
version of the element with the Patch (or Patch From) command. Informally, a patch consists of one user's 
"recent changes" to the element. The patch facility was designed to easily transfer to another development 
context the set of changes that were made to an element for a particular development task.

A change package contains a set of entries, each of which (usually) has the same form as a patch. But 
change package entries can be modified (added to) after they are first created. Such modified entries don't 
fit the "recent changes" description; rather, a change package entry can act like an accumulator, recording 
all the changes made to the element to fulfill a particular development task. The change package facility 
was designed to track exactly what element-by-element changes go into the bugfix or feature that the issue 
record describes.

Structure of a Patch
The Patch command creates a new version in a workspace. This version is termed the head version of the 
patch. AccuRev automatically determines a corresponding basis version by scanning backward through 
the element’s ancestry. The basis version is the most recent version that was either:

• originally created in another workspace

• created in the same workspace, then was promoted to the backing stream

Example 1: If patching from version wheat_dvt_john/4, AccuRev determines that John's "recent changes" 
to this element started with version wheat_mnt_john/1. (John used Send to Workspace to bring this "mnt" 
version into his "dvt" workspace.)

Example 2: If patching from version wheat_dvt_mary/5, AccuRev determines that Mary's "recent 
changes" to this element started with version wheat_dvt_john/14. (John created that version and promoted 
it to backing stream wheat_dvt. Mary brought the version into her workspace with an update.)
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Example 3: If patching from version wheat_dvt_mary/14, AccuRev determines that Mary's "recent 
changes" to this element started with version wheat_dvt_mary/11. (Mary created that version -- maybe for 
the same development task, but maybe not -- and promoted it to backing stream wheat_dvt. Then she 
continued working on the element.)

The patch consists of all the versions between the head version and the basis version. (The head version is 
included in the patch; the basis version isn't.)

Notes:

Patches involve real versions, not virtual versions

AccuRev's patch facility involves working with the contents of text files. And AccuRev records 
changes to files' contents as real versions in workspaces. Accordingly, AccuRev only uses real 
versions in its patch manipulations. If you specify a virtual version in some dynamic stream as the 
"patch from" version, AccuRev automatically uses the real version for which the virtual version is 
an alias.

What it means to be "between" the head and basis versions

In the simplest case, a patch's head version was derived from its basis version by a series of Keep 
commands (and maybe a Rename). In this case, it's easy to determine the set of versions that are 
between the head and basis versions. But what if one or more of the versions was created with 
Merge? Here's an example:

What if we "patch from" version wheat_dvt_john/42?  

The basis version corresponding to this head version is the most recent one created in another 
workspace and brought into workspace wheat_dvt_john by an update -- that is, version 
wheat_dvt_mary/52. What versions are "between" these two versions? AccuRev determines the 
answer by finding this set difference:
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In this case, the difference between the two subsets of the element's version graph consists of eight 
versions, from two different workspaces.

Patch Display

In the Version Browser, a version created by Patch is connected to the "patch from" version with 
a dashed red line. Selecting this version highlights the versions in the patch.

Structure of a Change Package
Each issue record in an AccuWork issue database includes its own change package. A change package can 
contain entries for any number of elements -- but only one entry per element. The elements must belong to 
the same depot as the issue database. 

Each change package entry is similar to a patch -- it consists of all the element's versions between a 
designated head version and basis version. This is a more general structure, because there is no "one user's 
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recent changes" restriction to the scope of versions. The only restriction to is that the basis version be an 
ancestor of the head version -- so that the set of "between" versions is well-defined.



182 AccuRev®  On-Line Help Guide

Change Package Display
In the Changes subtab of an issue record's edit form (and equivalently, in a Stream Issues tab), a change 
package is displayed in a table, each row showing one change package entry. Example:

As with a patch, each change package entry has a head version (Version column) and a basis version.

Creating a New Change Package Entry

Typically, a new change package entry is exactly like a patch -- the Send to Issue command and 
the change package-level integration between AccuRev and AccuWork create an entry whose 
basis version is automatically selected in the same way as the Patch command. When the entry is 
later modified, it assumes the more general structure.

You can create a new change package entry with the more general structure using the "specifying 
basis" variant of the Send to Issue command.

Modifying Existing Change Package Entries
Change packages are designed to track ongoing changes to elements, not just a single set of changes. This 
means there will be times when you want to add a change package entry for a particular element, but an 
entry for that element already exists in the change package. In such situations, AccuWork attempts to 
combine the new entry with the existing one, producing an updated entry that includes all the changes. 
(Recall that there can be at most one entry for a given element in a given change package.)

A Little Bit of Notation
To help explain how AccuWork performs "change package arithmetic" to combine and update entries, 
we'll use a simple notation. Suppose a change package entry contains the set of an element's versions 
defined by these specifications:

the head version is H
the basis version is B 

We'll use the ordered pair [B,H] to indicate this change package entry.
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Three Ways to Modify a Change Package Entry
Now, suppose a new change to an element is to be combined with the existing change package entry [B,H] 
. There are several cases, each handled differently by AccuWork:

Case 1: [B,H] + [H,X] (simple extension of a change package entry)
This simple case typically arises when you think you're done with a task and record your work as 
change package entry [B,H] -- but it turns out that more work on the same element is required. So 
you (or a colleague) start where you left off, with version H, and make changes up to version X. 
Then, you want to incorporate the new set of changes [H,X] into the same change package.

In this case, it's clear that the two series of changes can be viewed a single, uninterrupted series -- 
starting at version B and ending with version X. That is:

    [B,H] + [H,X] = [B,X]

Accordingly, AccuRev updates the change package entry automatically -- keeping B as the basis 
version and changing the head version from H to X.

Case 2: [B,H] + [J,X] (where H is an ancestor of J: "change package gap")
This case typically arises when you do work on a task at two different times, and someone else has 
worked on the same element in between.

In this example, a colleague updated her workspace to bring in your original changes, created 
versions 9 and 10 in her workspace, and promoted her changes. You then updated your workspace 
to bring in her changes, and made a new set of changes.

When AccuRev tries to combine the change [B,H] and the change [ J,X] into a single change 
package entry, it detects that version H and version J are not the same, but that H is a direct 
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ancestor of J. Thus, there is a simple "gap" in the potential combined change package entry (in this 
example, consisting of your colleague's versions 9 and 10).

Probably, your colleague was not working on the same task when she made her changes. (If she 
had been, she would have added her changes to the same change package, as in Case 1.) On the 
other hand, it's probably OK to include the entire, uninterrupted series of versions [B,X] in your 
change set -- this includes both your original changes and your new changes (and, harmlessly, your 
colleague's changes, too).

Accordingly, AccuRev prompts you to approve this "spanning the gap" between the two change 
set entries, in order to create a single, combined entry.

Case 3: [B,H] + [K,X] (where H is not an ancestor of K: "change package merge required")
This case typically arises when developers in workspaces that do not share the same backing 
stream try to use the same change package. There is no simple "gap" between the existing change 
package entry and the new one -- which means there is no way to combine them into a single 
change package entry (the basis version must be an ancestor of the head version).

AccuRev signals this situation with a "change package merge required" message, and cancels the 
current operation.

You can remedy this situation by performing a merge at the element level. (There is no merge 
operation defined at the change package level.) In the example above, merging version H and 
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version X would create a new version; a change package entry with the new version as its head can 
be combined with the existing entry.

Change Package History
How do you display the changes that have been made to a change package? Use the Change Package 
History icon on the Issues toolbar:

This brings up a list of all changes that have been made to the change package, including promotions, and 
elements that have been added ("cpkadd") or removed ("cpkremove"). 

For information about specific changes, select the transaction in the upper pane and view the elements 
associated with that change in the lower pane. 

Change package -- part of an issue record, or just associated with it?

An issue record's change package differs from its user-defined fields (Status, Severity, 

Description, etc.). When you change the value of a user-defined field, the  Save button is 
enabled in the edit-form toolbar. You can discard the change by closing the edit-form tab without 
performing a Save. But the commands that create, modify, and delete change package entries take 
effect immediately. There is no way to discard such changes, and there is no need to Save them. 
(You can Remove a change package entry altogether, but you can't undo the adding of a new 
change to an existing entry.)

Change packages don't participate in the AccuWork's issue-history capability. Modifications to a 
change package don't appear in the Issue History subtab of an edit form (although you can use the 
Change Package History feature described above). And if you use this subtab to view an "old" 
version of an issue record, the Changes subtab still displays the current contents of the change 
package, not the "old" contents.

Given this behavior, you may want to think of a change package as being associated with an issue 
record, rather than being part of it.
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Unaffiliated Changes ("Dark Matter")
It is possible to end up with changes that are not associated with any issue. For example, somebody might 
decide that a file does not belong to an issue and remove it from the change package. Or somebody might 
decide to promote a file in a backing stream, without associating it with an issue. If such element versions 
are not associated with any issue, they are considered unaffiliated (sometimes called "dark matter"). Such 
element versions can lead to confusion, so AccuRev provides a way to view unaffiliated changes in the 
GUI.

In the stream browser, select Show Active Issue mode:

If any unaffiliated changes exist in the stream, the issue table gains an extra row labeled "NONE". If your 
table layout includes the ShortDescription column, you will also see "UNAFFILIATED CHANGES" in 
the row. Clicking this row displays an error message informing you that  "This issue cannot be opened 
because it doesn't really exist". 

There are two ways to deal with unaffiliated changes: short-term and long-term. If you are working under a 
deadline and just need a way to deal with these files so that they don't keep you from promoting everything 
in a stream, you can, for example, just Promote by File without associating the files with an issue. 
However, this is just a temporary fix, and you are just perpetuating the problem and pushing it further up 
your streams.

The long-term, correct solution is to determine why these changes are unaffiliated, and depending on how 
they got into this state, attempt to correct them. Typically there are three ways that an unaffiliated change 
may occur:

• somebody did a Promote By File without specifying an issue 

• somebody removed a file version from a change package (either intentionally or accidentally)

• somebody patched a Change Package entry into a Workspace via the Change Palette (Path to a 
Tracking Issue)

Once you have committed to working with change packages, you should never do Promote By File 
operations without associating the files with an issue. These can result not only in unaffiliated changes, but 
they can also cause incomplete change packages which are another source of confusion (see the 
 "Incomplete Change Packages" chapter of the AccuRev Technical Notes manual for more information). 

In any case, the best way to proceed is to associate the unaffiliated change with an issue, either by using 
Send to Issue for an existing issue, or by creating a new issue to handle this specific change.
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To examine the unaffiliated versions in detail and deal with them, you should right-click the stream and 
click Show Active Issues.
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From the resulting display, you can right-click the unaffiliated elements, explore their history, and then 
take appropriate actions to correct their unaffiliated status. For example, you can use Send to Issue and 
then promote, or promote the files to an issue while promoting from this stream to its parent.

The Patch List Tab 
(Show Patch List command)
The Patch List tab lists all the individual versions whose changes need to be sent from one stream (or 
snapshot, or workspace) to another, so that the second stream will include all the changes in the first 
stream.

Notes:

• Comparison with Stream Diff—You can think of the Patch List tab as providing an "exploded view" of 
the Stream Diff (Files) tab. Whereas Stream Diff provides a simple "before" and "after" perspective on 
how each element changed, Patch List shows all the individual steps (that is, the versions) in 
progressing from the "before" state to the "after" state.

• Patch List and the Patch command—A Patch List table with 24 entries does not mean that you would 
need 24 invocations of the Patch command to propagate all the changes from one stream to the other. 
Each invocation of Patch incorporates all the changes in the specified patch A selected set changes 
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(typically, the 'recent changes' made by one user) to a text-file element. Also, the merge-like operation 
that incorporates those changes in another version of the same element. See merge, basis version, head 
version, change package, reverse patch., which can include multiple versions. (Prior to AccuRev 3.5.5, 
each invocation of the Patch command did incorporate the changes in one version, so the 
correspondence to the Patch List table was exact.)

Opening a Patch List Tab
1. In the Stream Browser, select a stream, snapshot, or workspace.

2. Choose the Show Patch List command from the selection's context menu, or click the button on the 
StreamBrowser's toolbar.

3. The mouse pointer changes to . Left-click another stream, snapshot, or workspace.

Patch List Tab Layout
The Patch List tab contains a table, each row of which details one version.

Element (or separate "Name" and "In Folder" columns)

The element's pathname within the depot.
Note:This is the element's pathname in the first stream at the current time. This may not match its 
pathname at the time of the transaction listed in the Transaction column.

Transaction

The transaction in which this version was created.
Version

The version-ID of the version 

Working in a Patch List Tab
The Patch List tab display is informational only. See also:Working with Tables on page 10
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Streams and Issues
The StreamBrowser and File Browser enable you to see what individual versions are present -- and perhaps 
active -- in a stream. AccuRev also makes it easy to answer questions like these:

• "Are all the changes required to fix bug #4517 in this stream?"

• "Are any of the versions involved in the #4517 fix still active in this stream? (Or have all the changes 
already been promoted to a higher-level stream?)"

• "What new features are still under active development in this stream?"

• "The QA Group says they don't have all the Color Mixer changes for the upcoming release. Is that 
true?"

The key is to go beyond thinking of individual versions to considering collections of versions, called 
change packages. With AccuRev, change packages are implemented by AccuWork issue records. An issue 
record records the details of a bug or feature: its description, how important it is, who originated it, who's 
working on it, and so on. In the AccuRev Enterprise version of AccuWork, an issue record can also keep 
track of the changes that have been made to elements, in order to implement that particular bugfix or new 
feature.

For example, issue record #9 might contain a bug report, "Circles are not round". The bugfix involves 
changes to three elements:

When viewing the issue record through its edit form, go to the Changes tab to view the change package. In 
this example, the change package contains three entries:

• The set of changes that were made between version 5/10 and version 5/24 of element chap03.doc 

• The set of changes that were made between version 5/11 and version 5/17 of element commands.c 

• The set of changes that were made between version 5/7 and version 4/5 of element end.sh 

See Patches and Change Packages on page 178 for the precise definition of "between".

Change Packages "In" Streams
As the versions in a change package are promoted up the stream hierarchy, the change package itself 
implicitly moves up the hierarchy, also. Roughly speaking, a change package has risen to a certain level if 
all its entries have risen to that level. More precisely:

• The change package entry for an element is said to be "in" a particular stream if the element's version 
in the stream is -- or is a descendent of -- the head version (Version column). See also the definition of 
direct/indirect.

Notes:
Why the "or is a descendent  of" clause?
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AccuRev assumes that changes made to an element remain in that element as subsequent versions 
are created. Suppose a change package entry consists of versions 13/4, 13/5, and 13/6 of some 
element. Another user then brings version 13/6 into her workspace with an Update, and creates 
descendent version 49/2. It's fair to say that the change package entry is "in" her workspace, and in 
any stream to which version 49/2 is promoted.

Why mention the head version, but not the basis version?

The basis version of a change package entry is always an ancestor of the head version. AccuRev 
assumes that changes that were present in the ancestor version remain in the later version.
• A change package is said to be "completely in" a particular stream if all of its entries are "in".

• A change package is said to be "partially in" a particular stream if some -- but not all -- of its 
entries are "in". See also the definition of incomplete.

• A change package is said to be "active" in a particular stream if at least one of its head versions 
is in the stream’s default group.
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5. The History Browser
The History Browser displays some or all of the transactions associated with a particular element, stream, 
or depot. In addition to viewing information about a transaction and the versions involved in it, you can 
perform operations on the individual versions (View, Diff, etc.) and on the transaction's set of versions 
(Promote, Revert).

Opening a History Browser Tab
There are several ways to launch the History Browser:

• To view the transactions involving an individual element 

You can have the History Browser display the transactions in which one particular element was 
involved. (Other elements may have been involved in these transactions, too.) Elements are listed in 
various places in the GUI:

• In the Details pane of a File Browser tab

• In the Default Group Contents subwindow of a StreamBrowser

• In an issue record's change package (Changes subtab)

In any of these contexts, you can select an element and click the Show History toolbar button. 
Alternatively, right-click an element and select History > Show History from the context menu.

• To view the transactions involving a particular stream

You can have the History Browser display transactions that affected a particular stream. For a 
workspace stream, this principally includes the keep transactions that create real versions in the 
stream. It can also include co, move, defunct, and undefunct transactions. For a dynamic stream, this 
includes promote transactions to the stream, but not promotions from the stream.

In the StreamBrowser, right-click a stream and select Show History from the context menu.

• To view the active transactions for a particular stream

Every stream has a default group, consisting of the elements that are active in that stream. In the 
Stream Browser, a stream's context menu includes the command Show Active Transactions; it opens a 
History Browser tab and loads the set of transactions (Keep, Promote, etc.) in which the stream's active 
versions were created.

• To view the transactions involving a particular depot

You can view the transactions for an entire depot -- all the elements, in all the streams. Use the Admin 
> Depots command to list all of the repository's depots. Then, select a depot and choose Show History 
from its context menu, or from the Actions group in the main menu.

• To view a single transaction or a specified group of transactions

In the Version Browser, selecting Show History from any version's context menu displays the 
transaction in which that particular version was created.
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If you have used AccuWork to promote files (see Transaction-Level Integration between AccuRev and 
AccuWork on page 347), an issue record's affectedFiles field contains a list of transaction numbers. 

Click the Show History button next to this field to display just those listed transactions.

History Browser Tab Layout
The History Browser appears in a separate tab of the AccuRev GUI's multiple-tab display. The tab is 
divided into three panes:

• The Summary pane displays a group of transactions, one per line. This pane displays overall 
information: transaction number, timestamp, transaction type, etc.

• The Comment pane shows the comment string, if any, that was specified for the currently-selected 
transaction.

• The Versions pane shows all the versions that were involved in the currently-selected transaction. It 
also indicates which change packages , if any, those versions belong to (Issues column).

The Summary Pane
The summary pane displays a table containing a set of transactions, one per row. Each row of the summary 
pane's table displays the following information about an individual transaction:

Time

A timestamp, indicating when the transaction took place.
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Action

The kind of transaction: keep, promote, etc.
User

The principal-name of the user who initiated the transaction.
# (transaction number)

The unique number (within this depot) of the transaction.
Version

(only for transactions involving an individual element) The real version or virtual version of the 
element that was created in this transaction. This column doesn't appear in displays of a stream's 
history or an entire depot's history; the version(s) created by the transaction appear in the Versions 
pane.

Comment

The first line of the user-supplied comment for this transaction. If the comment extends to 
additional lines, an ellipsis ("dot dot dot") appears here. For the full text of the comment, look in 
the Comment pane.

The Comment Pane
The Comment pane displays the full text of the user-supplied comment for the transaction currently 
selected in the Summary pane.

The Versions Pane
The Versions pane displays a table of all the versions, if any, created by the currently selected (highlighted) 
transaction in the Summary pane.

Element (or separate "Name" and "In Folder" columns)

The element's pathname within the depot.
Virtual Version
Real Version

The two version-IDs of this version. The real version-ID indicates the workspace stream where the 
version was originally created. The virtual version-ID is different if this transaction records:

• a promotion of the version to a dynamic stream (Promote command), or

• a check-out of the version to a workspace (Send to Workspace or Anchor command)

See Real Versions and Virtual Versions on page 134.
Ancestor

(transactions in a workspace stream only) The predecessor version, which this version was derived 
from.
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Merge

(keep transaction recorded by the Merge command only) The "from" version to the merge 
operation that created this version.

Patch

(keep transaction recorded by the Patch command only) The "from" version to the patch operation 
that created this version.

Issues

The AccuWork issue records (change packages) to which this version has been added. This field 
indicates that the version is currently in those issue records’ change packages. It does not reflect 
change package membership at the time the version was created, or at any other time in the past.

Features for Third-Party Issue Tracking System (ITS)
If you have enabled AccuRev to work with a third-party ITS, the Versions Pane displays controls that let 
you display AccuWork issue numbers, third-party ITS issue keys, neither, or both.

The first time you display the History Browser, AccuRev displays an informational message alerting you 
to this feature.

Working in the Summary Pane
There's potentially a large number of transactions to display in the Summary pane -- for example, when 
displaying the history of an entire depot. Retrieving all the transactions at once from the depot's database 
can be time-consuming. The History Browser handles this situation by initially retrieving a small number 
of transactions, then letting you control the retrieval of additional transactions with the toolbar located just 
above this table.

Controls at the top of the Summary pane determine which transactions are displayed. You can invoke 
commands on one or more transactions that you select. See Working with Tables on page 10.

Summary Pane Controls
The controls pictured below determine how many transactions (and which ones) are retrieved from the 
depot's database and loaded into the summary pane. Click on a control in the image below for more 
information about it:
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Once a certain set of transactions has been loaded into the summary pane, you can browse through those 
transactions. Click any transaction to select it; the Comment and Versions panes are updated with the 
transaction's details. You can use the usual navigation keys to change the selected transaction: up-arrow 
and down-arrow, PgUp and PgDn, Ctrl-PgUp and Ctrl-PgDn.

Summary Pane Commands
You can select one or more transactions in the Summary pane, and invoke commands on them. Use the 
selection's context menu or the toolbar buttons above the Summary pane.

Revert to Backed

(from dynamic stream history only) For the selected Promote transaction, performs the equivalent 
of an "undo" in a particular child workspace of the dynamic stream. AccuRev prompts you to 
specify which workspace. Older versions of the transaction's elements will be activated in that 
workspace. For details, see the revert reference page in the AccuRev CLI User's Guide.

Diff Against Other Version

(from text-file element history only) Compare the version in the selected transaction with the 
version in another transaction. AccuRev prompts you to select another transaction from the 
summary pane.

Diff Against File in the Workspace

(from text-file element history only, when in the context of a particular workspace) Compare the 
version in the selected transaction with the file in the workspace from which the History Browser 
was invoked. This workspace is listed at the bottom on the AccuRev GUI window. This enables 
you to invoke a comparison with a file that you have changed in your workspace, but have not yet 
preserved in the repository with a Keep command.

This command is disabled if you invoked the History Browser from a non-workspace context.
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Send to Change Palette

(dynamic stream only) Load the selected versions into the Change Palette, so that they can be 
merged and promoted to other streams.

Send to Change Palette (Changes)

(dynamic stream only) Load the selected versions into the Change Palette, so that they can be 
patched to other streams.

Send to Workspace

Activate each of the transaction's versions in a particular workspace. AccuRev prompts you to 
specify one of your workspaces.

Working in the Versions Pane
You can perform several operations on a selected version in the Versions pane, using its context menu or 
the versions pane toolbar.

Open (equivalent to double-click)

Windows: Run the appropriate command on the file, according to its file type. (The Windows file-
typing system — "file associations" — does not provide for assigning a file type if the filename 
has no suffix.) 

UNIX: Open a text editor on the file.

Open Issues

Displays the change package(s) -- that is, the issue record(s) -- to which the version belongs.
Note: A version is "in" a change package if it -- or any of its descendants -- is the head version of an 
entry in that change package.

For a version that belongs to a single change package, an edit form opens on that one issue record. 
For a version that belongs to multiple change packages, an Issues tab opens, listing all the issue 
records.
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View

Open a text editor on a temporary copy of the currently selected file (text files only).

Save As

Copy the currently selected file to another filename.

Merge From

(only when displaying the history of an individual file) Merge the selected version into the version 
in the workspace from which the History Browser was invoked.

Patch From

(only when displaying the history of an individual file) Patch the selected version into the version 
in the workspace from which the History Browser was invoked.

Diff Against Previous Transaction

Compare the selected version with the version that was in its workspace or stream just before the 
version was created. 

Promote

(only available in the Active Transactions tab, not in other History Browser contexts)

Browse Versions

Open a Version Browser on the element whose version you selected.

Send to Change Palette

(dynamic stream only): Load the selected versions into the Change Palette, so that they can be 
promoted to other streams.

Send to Workspace

(only when displaying the history of an individual file) Activate the selected element in the 
workspace from which the History Browser was invoked.

Send to Issue

Create a new entry (or modify an existing entry) in the change package section (Changes tab) of 
one or more issue records. The version you specify becomes the head version of the change 
package entry; AccuRev determines the corresponding basis version automatically.

The default query is executed, and the results are displayed in a dialog (see The Send to Issue 
Command  on page 126). You are prompted to choose one or more of the issue records selected by 
the query. You can also create a new issue record, whose number will be entered in the dialog. 

Properties

Displays information about the selected element. The data items displayed vary with the type of 
element.
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History Browser / Summary Pane Controls
Go to a Particular Transaction

Entering a transaction number in the Search field unloads the current set of transactions, then loads the set 
beginning with the specified number. 

If that particular transaction is not relevant -- e.g. it did not involve the element whose history you're 
viewing -- the set begins with the next older relevant transaction.

History Browser / Summary Pane Controls
Display Transactions with a Particular Comment

By default, the Summary pane displays transactions no matter what comments they contain (if any). To 
filter the display based on transactions' comment fields, type a search string in the Search field, then select 
the Comments only checkbox to enable the filtering.
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History Browser / Summary Pane Controls
Manage Groups of Transactions

The Summary pane table initially contains the 10 most recent relevant transactions. 

To change this count, use the Transaction Count list box. (Each time you change the count, the browser 
returns to displaying the most recent transactions.) Selecting Everything loads all the relevant transactions 
into the summary pane.

Several controls on the toolbar enable you to retrieve additional transactions, which have not yet been 
loaded into the summary pane:

6. The  button unloads the current set of transactions, then loads the next older set of transactions. 

7. The  button unloads the current set of transactions, then loads the next newer set of transactions. 
This button is enabled only when you're viewing the history of an entire depot. 

8. The  button unloads the current set of transactions, then loads the first (newest) set of transactions.

History Browser / Summary Pane Controls
Display Transactions Created in a Particular Interval

By default, the Summary pane displays transactions no matter when they were created. Use the  Set 
Date Interval toolbar button to restrict the display to transactions that occurred in a specified interval.

This changes the setting in the Transaction Count list box to Custom . To cancel the date interval 
restriction, change this list box setting back to 10 Transactions (or something else).
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History Browser / Summary Pane Controls
Display a Particular User's Transactions

By default, the Summary pane displays transactions created by all users. 

To restrict the display to one user's transactions, use the User Filter list box. Select For All Users to turn 
off by-user filtering.

The Version Browser
AccuRev maintains complete ancestry information for each element. The Version Browser displays some 
or all of an element's versions, using color-coded lines to indicate the way in which each version was 
created. You can perform various version-related operations, such as comparing any two versions (text 
files only) and copying any version to your workspace.

Opening a Version Browser Tab
The names of elements appear in many contexts in the AccuRev GUI. These include the Details pane of 
the File Browser, the versions pane of the History Browser, and the Changes tab (change package) of a 

AccuWork issue record. In any of these contexts, you can select one element and invoke the  Browse 
Versions command. (In some cases, this command is a subchoice, under a History menu choice.)

Version Browser Tab Layout
The Version Browser display contains:
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• A yellow box for each version of the specified element. These boxes are arranged in rows, according to 
the workspace or stream in which the versions were created.

One yellow box has a blue outline. This is the version that currently appears in the workspace or 
stream from which you opened the Version Browser tab.

• A timestamp above each version box, indicating when the version was created. The tooltip for the 
version box itself contains the number of the transaction that created the version.

• The name of the workspace or stream, at the right edge of the display.

• Color-coded ancestry lines connecting the versions, indicating how the later version was derived from 
the earlier version.

Tip: Use your mouse to drag the Version Browser display -- place the pointer on the display background, 
press and hold mouse button one, and then move the mouse to change the view.

Ancestry Lines
The Version Browser uses these color-coded lines to indicate ancestry relationships

• direct ancestor (black) -- A user started with the earlier version, modified (or overwrote) it, and then 
performed a Keep, creating the later version. (There are a few other commands, including Rename, that 
might have created the later version. See below for details.)

• alias (green) -- A user promoted the earlier version to create the later version.

• merge (red) -- A user executed the Merge command to create the later version. There are always two 
earlier versions: the black line indicates the direct ancestor (see above) of the later version; the red line 
indicates the version that was merged with the direct ancestor.

• patch (dashed red) -- Similar to merge above; instead of the Merge command, the Patch command 
was used to create the later version.

• revert (dashed blue) -- The later version was created by a 'reverse patch', performed by the Revert 
command. This effectively 'undoes' the changes in a specified transaction or change package.
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Ancestry Relationships
The following sections discuss the kinds of ancestry in more detail.

Direct Ancestor -- Modification of an Existing Version
Probably the most common AccuRev operation is starting with an existing version, making changes, and 
then executing the Keep command to save the changes in a new version. The existing version might have 
been created by you -- for example, with a previous Keep command. Or it might have been created by 
someone else: that user Promote'd the version, then you brought it into your workspace with an Update.

The version in your workspace created by the Keep command is termed a real version, because it 
represents a change to the element. Other commands can create real versions in your workspace, too: 
Rename, Defunct, Undefunct.

The Version Browser uses a solid black line to connect the existing version (termed the direct ancestor or 
predecessor) with the new version.

In the figure above:

• Version 9 in the flax_dvt_mary workspace stream was revised to create version 10 in the same stream.

• Workspace stream flax_dvt_john was updated to incorporate version flax_dvt_mary/10. Then, this 
version was revised to create version flax_dvt_john/2.

• Version 2 in the flax_dvt_john workspace stream was revised to create version 3 in the same stream; 
and version 3 was revised to create version 4.

Exception: a version created by a revert operation is connected to its direct ancestor by a dashed blue line.

Alias -- Virtual Version Ancestry
Workspaces contain real versions, which represent changes to elements. By contrast, all versions in 
dynamic streams are virtual versions, created with the Promote command. Each virtual version is an alias 
for -- that is, a pointer to -- some real version in a user's workspace. The Version Browser uses a green line 
to connect a virtual version in a dynamic stream to the corresponding real version in a workspace.

In the figure above:

• version 4 in stream brown_dvt is an alias for (was promoted from) version 15 in workspace 
brown_dvt_john
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• version 5 in stream brown_dvt is an alias for version 17 in workspace brown_dvt_john

• version 6 in stream brown_dvt is an alias for version 3 in workspace brown_dvt_mary

There's one exception to this scheme. The Anchor or Send to Workspace command creates a virtual version 
in a workspace. It's a virtual version because it doesn't represent a change to the element, but merely the 
restoration of an existing version to the workspace.

Successive Promotions. In a depot with a deep stream hierarchy, it's common to successively promote a 
particular version to the parent stream, then to the grandparent stream, then to the great-grandparent 
stream, etc. 

All the versions created by this series of Promote's are aliases for the same real version. The Version 
Browser shows how all the virtual versions relate back to the original real version.

The versions in streams brown_dvt, brown_tst, and brown are all aliases for the real version 2 in workspace 
stream brown_dvt_mary. (The display does not indicate the fact that the version was promoted from 
brown_dvt to brown_tst, and from brown_tst to brown.)

Merge -- Merging of Two Versions
A standard merge operation combines the contents of these two versions of a file:

• The most recently kept version in your workspace stream. This version contains the changes that you 
have made to the file in your workspace.

Note: It's possible -- but not a best practice -- to perform a merge on a file with (modified) status. 
Since you haven't preserved the recent changes with Keep, AccuRev will have no way to restore the 
file to its state just before the merge. This can be painful if you change your mind or make an error 
during the merge process.]

• The most recent version in the backing stream.

The result file of the merge operation is kept as a new version in the workspace stream. (You can think of 
merging as a fancy text-editing operation; as with any edit to a file, you preserve the results with Keep.) 
This new, merged version has two ancestors: the two versions listed above.

This is all simple enough. There's a twist, though, which shows up in the Version Browser display: 
AccuRev always records real versions, not virtual versions, as the two ancestors of a new, merged version. 
Thus, the ancestors in the standard merge scenario described above are:
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• The most recently kept version in your workspace stream.

• The version in some other workspace stream that was promoted to the backing stream, causing the 
overlap that necessitated the merge.

Example: This screen shot shows a merge from the backing stream brown_dvt to the workspace stream 
brown_dvt_john. 

The new, merged version is brown_dvt_john/12.

Its ancestors are:

• Real version brown_dvt_john/11

• Real version brown_dvt_mary/1, which was promoted to become virtual version brown_dvt/3 in the 
backing stream.

A solid red line shows the merging of data from one workspace, brown_dvt_mary, to a different 
workspace, brown_dvt_john . The black line ("direct ancestor") between versions 11 and 12 in the 
brown_dvt_john workspace reflects the viewpoint that merging is just a fancy text-editing operation, 
automating the creation of the next version of a file in a workspace.

Patch -- Selective Inclusion of Another Version's Changes
A patch operation is similar to a merge operation. In both, text from another version (the "from" version, at 
the left end of the dashed red line) is incorporated into your workspace's version. Here's the difference:

• A merge operation considers the entire contents of the "from" version.

• A patch operation considers only some of the changes in the "from" version. Typically, it's the 'recent 
changes' made by one user, recorded in one version or a set of consecutive versions. See Patches and 
Change Packages on page 178 for full a discussion of patches.

When you select a version created by the Patch command, the Version Browser highlights in red the 
versions contained in that patch.
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Note: Patching and the closest common ancestor

AccuRev tracks patch ancestry separately from merge ancestry. In determining the closest common 
ancestor of two versions for a merge operation, AccuRev takes into account previous merge operations 
(solid red), but not previous patch operations (dashed red) or revert operations (dashed blue).

Revert -- Selective Removal of Changes from a Version
A revert operation is the opposite of a patch operation. (And we describe the Revert command as 
performing a 'reverse patch' operation.) Whereas a patch adds a selected set of changes, a revert removes a 
selected set of changes.

A version created by the Revert command has two ancestry lines:

• A dashed blue line indicates the version from which Revert removed some changes.

• A solid black line indicates the basis version of the removed patch or change package entry.

See Reverse Patch: Removing Content Changes on page 252 for more information on how these ancestry 
lines are created.

Closest Common Ancestor
It's instructive to follow all the black and solid-red lines in an element's Version Browser display. This 
traces the entire ancestry of real versions of an element. In particular, you can use the real-version ancestry 
to determine the closest common ancestor of any two versions. This is the most recent version upon 
which the two versions are both based, by some combination of direct ancestor and merge connections. 
(When considering a virtual version in a closest-common-ancestor analysis, first follow the green line back 
to the corresponding real version.) 

You can also use the CLI command accurev anc -c to find the closest common ancestor of two versions.

In the Merge command, AccuRev determines the closest common ancestor of the two versions to be 
merged, and uses this version to perform a 3-way merge. See The Merge, Patch, and Reverse Patch 
Algorithms on page 247 for more information on the merge algorithm.
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Operations on Versions
You can perform several operations on a selected version, using its context menu or the Version Browser 
toolbar.

Open (equivalent to double-click)

Windows: Run the appropriate command on the file, according to its file type. (The Windows file-
typing system — "file associations" — does not provide for assigning a file type if the filename 
has no suffix.) 

UNIX: Open a text editor on the file.

View

Open a text editor on a temporary copy of the currently selected file (text files only).

Save As

Copy the currently selected file to another filename.

Merge From

Merge the selected version into the version in the workspace from which the Version Browser was 
invoked.

Patch From

Patch the selected version into the version in the workspace from which the Version Browser was 
invoked.

Show History

Open a History Browser tab, showing the transaction that created the selected version.

Diff Against Other Version
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Compare the selected version with another version of the element. 

AccuRev changes the mouse pointer, to prompt you to select the other version. You can click on 
any version in the Version Browser display. You can also click on a stream or workspace label to 
indicate the version currently in that stream or workspace.

Diff Against File in the Workspace

Compare the selected version with the file in the workspace from which the Version Browser was 
invoked. This workspace is listed at the bottom on the AccuRev GUI window. This enables you to 
invoke a comparison with a file that you have changed in your workspace, but have not yet 
preserved in the repository with a Keep command.

Diff Against File On Disk

Compare the selected version with the an arbitrary file on your machine. A File Chooser dialog 
appears, in which you specify the file.

Send to Workspace

Activate the selected element in the workspace from which the Version Browser was invoked. The 
element must currently have (backed) status in the workspace -- that is, it must not be active.

Send to Issue

Record the selected version(s) in the change package section (Changes tab) of one or more issue 
records. The default query is executed, and you are prompted to choose one or more of the records 
selected by the query. You can also create a new issue record, to which the selected version(s) will 
be sent.

Send to Issue (specifying basis)

Record the selected version in the change package section (Changes tab) of one or more issue 
records. You are prompted select a version in the Version Browser display; this version will 
become the basis version in the change package entry.Then, the default query is executed, and you 
are prompted to choose one or more of the records selected by the query. You can also create a 
new issue record, to which the selected versions will be sent. 

Note: The basis version you specify must be an ancestor of the head version. If it isn't, an "Invalid 
Change Package" error occurs.
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Properties

Displays information about the selected element in a pop-up window. The data items displayed 
vary with the type of element.

Version Browser Preferences
The Tools > Preferences command opens a dialog that includes a Version Browser tab, where you can 
control settings that affect the Version Browser. (See “AccuRev Preferences  (Tools > Preferences 
Command)” on page 41.) 
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6. Diff, Merge, and Change Palette

The Diff Tool
The AccuRev GUI provides many ways to invoke a "Diff" command to compare two versions of a text-file 
element. By default, the comparison is performed by AccuRev's own Diff tool, which displays the two 
versions next to each other, using color coding to show the differences and provided convenient navigation 
controls. You can also configure the GUI to use another file-comparison tool (see AccuRev Preferences  
(Tools > Preferences Command) on page 41).

Invoking the Diff Tool (or Another File-Comparison 
Tool)
No matter which tool you've configured to perform file comparisons, you invoke the tool in the same way, 
as described below. AccuRev's Diff tool opens in a separate tab within the AccuRev GUI window; any 
other tool opens in its own window.

There are multiple ways to specify the two versions of a file element to be compared:

In a File Browser, each file's context menu includes a Diff Against... item. There are several choices, each 
of which compares your version (i.e. the file in your workspace) with a version stored in the depot:

• Most Recent Version: Compares your file with the version currently in your workspace stream. Use this 
choice if you've modified the file since the last time you performed a Keep on it (or if you've never 
performed a Keep on it since the last update).

• Backed Version: Compares your file with the version currently in the backing stream. For example, 
you might use this choice to see all the changes you've made to this file since you updated your 
workspace and starting working on the file. (And assuming no one else has promoted a new version to 
the backing stream in the meantime.) This might include the changes stored in several intermediate 
versions that you've created with keep.

• Basis Version: Compares your file with the version that you started working with, before making your 
"recent" changes. For a discussion of the meaning of "recent", see Patches and Change Packages on 
page 178.

• Overlapping Changes: Provides two options to help you identify and resolve conflicts between two 
versions of an element that result in an (overlap) status:

• Mine - Compares the workspace or stream version against the common ancestor in the backing 
stream. This option identifies the changes in the workspace or stream that did not come from the 
backing stream; it is the equivalent of diffing against the last version that you merged with.

• Theirs - Displays only the changes added to the backing stream since the last time you merged 
with the backing stream. This option is useful for identifying the changes to the backing stream 
that caused the overlap condition.

The Overlapping Changes options are available only for elements with an (overlap) status.
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• File in Other Stream: Compares the selected file with a file in another stream or workspace. By 
default, AccuRev selects the file with the same name in the target stream or workspace you select, but 
you can choose any file you wish.

• File on Disk: Compares your file with an arbitrary file on your machine. A standard operating system 
"open file" dialog box open, in which you specify the file.

In a Stream Browser display, view the elements in a stream's default group by clicking the  control 
below the stream. An element's context menu includes the Diff Against... items described above.

In a Version Browser or Stream Version Browser display for a text-file element, you can compare any two 
versions: right-click any version, select Diff Against Other Version from the context menu, then left-click 
any other version.

In a History Browser display for a text-file element, you can compare the versions created in any two 
transactions. Right-click a transaction in the Summary (upper) pane, select Diff Against Other Version 
from the context menu, then left-click another transaction in the Summary pane. Similarly, the Diff Against 
File in the Workspace command enables you to compare the version created in a particular transaction with 
the file currently in your workspace. (That file might contain changes that you haven't yet preserved with 
Keep.)

Diffing One File Against Another
Unlike most other Diff Against operations, in which you choose which version of a file you want to diff, 
there are two Diff Against operations that allow you to diff one file with any other file you choose, Diff 
Against File in Other Stream and Diff Against File on Disk.

Diff Against File in Other Stream
Use this procedure when you want to diff two files that are under AccuRev control.

To diff a file against a file in another stream:

1. In the File Browser, right-click the file you want to diff and choose Diff Against > File in Other 
Stream (or type Ctrl+Shift+O).

AccuRev displays the Select File for Diff dialog box:
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Note that the file you selected is displayed in the instructional text.

2. In the Streams field, select the stream or workspace associated with the file you want to diff against the 
file you selected in Step 1.
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The Stream Navigator is populated with a tree for the stream or workspace you select.

If the file you chose for the Diff operation exists in the selected target stream, AccuRev automatically 
highlights the file in the Stream Navigator pane. You can choose a different file for the Diff operation, 
if appropriate.

Note: To locate the file in the target stream, AccuRev navigates as much of the element’s path as pos-
sible. If AccuRev cannot find a file with the same name in the stream or workspace you select, it dis-
plays a warning message. 

3. Click Ok to diff the two files. 

AccuRev displays the Diff view. See Diff Tab Layout on page 215 to learn about how diff files are dis-
played.

Diff Against File on Disk
Use this procedure when you want to diff a file under AccuRev control with any file on a local or 
networked disk.

1. In the File Browser, right-click the file you want to diff and choose Diff Against > File On Disk (or 
type Ctrl+Shift+F).

AccuRev displays the Open dialog box.

2. Select the file against which you want to diff the file selected in Step 1 and click the Diff button.
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AccuRev displays the Diff view. See Diff Tab Layout on page 215 to learn about how diff files are dis-
played.

Diff Tab Layout
The Diff tool displays the two versions side-by-side in separate panes, so that corresponding text lines in 

the versions line up visually. (You can use buttons  Horizontal Layout and  Vertical Layout at the right 
side of the toolbar to arrange the panes above-and-below.) We'll call them the "before version" (displayed 
on the left, or above) and the "after version". The element pathname and the version-IDs are displayed 
above the versions' contents.

Initially, the two panes are the same width, but you can drag the vertical separator to change the relative 
widths. To make both panes wider, just increase the size of the overall AccuRev GUI window.

Notes:

• Namespace differences

The two versions being compared can have different pathnames: the element may have been 
renamed or moved to another directory within the depot. (This may have occurred in one of the 
versions, or in both of them.) The Diff tool does not highlight or announce such namespace 
differences.
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• Left vs. right

Depending on how you launch the Diff tool, an older version might be displayed on the right, and 
a newer version on the left. We recommend keeping the older version on the left, so that "before" 
and "after" in the descriptions below correspond to reality.

• Comparing binary files

If the versions to be compared are in a binary image format that AccuRev can render, the Diff tool 
simply displays the versions, so that you can determine their differences by inspection. AccuRev 
can render the following image formats:
• JPEG (.jpg or .JPG filename suffix)

• PNG (.png or .PNG)

• GIF (.gif or .GIF)

• Applying changes from the "before" version to your workspace's version

If you're comparing the file in your workspace with another version, you can use the Diff tool to 
edit your file as you view the differences.

See Editing a File Using the Diff Tool on page 219.

Difference Section Color-Coding
Through color-coding, the Diff tool partitions the text into the following kinds of "difference sections":

• Unchanged Section (white background): Text section in which the versions are identical.

• Added Section (green background): Text section that occurs only in the "after" version. Empty space 
with a blue background appears at that point in the "before" version.

• Deleted Section (red background): Text section that occurs only in the "before" version. The deleted 
section appears with a blue background in the "before" version.

• Changed Section (blue background): Sometimes, the Diff tool decides that a text section in the 
"before" version has been revised, producing the corresponding section in the "after" version. The 
before and after sections are not necessarily the same length, in which case some empty space is 
displayed in one of the versions. Both the before and after sections appear with a blue background. 
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Both sections contain red character highlights, indicating the first location in a line where the two 
versions differ:

If a text block has been moved from one location in the file to another, the Diff tool indicates this as two 
separate changes: a deleted section at the original location, and an added section at the new location.

Your user preferences include controls for the Diff tool's handling of whitespace-only differences between 
the versions. (See AccuRev Preferences  (Tools > Preferences Command) on page 41.)

Navigating in a Diff Tab
Most text files are too long to fit on the display screen, and some individual text lines are too wide. 
Accordingly, the panes in which the versions appear have both vertical and horizontal scroll bars. Scrolling 
of the panes is synchronized automatically. Line numbers appear at the left edge of each pane.

For a text file that contains hundreds or thousands of lines, there may be only a few difference sections 
(added, deleted, or revised), separated by large unchanged sections. The Diff tool provides both navigation 
buttons on its toolbar and a difference map for direct access to a particular difference section.

Diff Toolbar Navigation Buttons

Whenever you use one of these buttons to jump to a particular difference section, the Diff tool remembers 
it as the current difference and highlights the lines numbers in both panes.

A "difference N of M" window in the toolbar indicates which difference section is current.

First Diff

(Accelerator key: Crtrl+Shift+) Go to the first difference section.

Last Diff

(Accelerator key: Crtrl+Shift+) Go to the last difference section.

Center Diff

Using the scroll bars or the difference map, you can make the current difference scroll offscreen. 
Click this button to bring it back onscreen.

Previous Diff
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(Accelerator key: Ctrl+) Go to the previous difference section.

Next Diff

(Accelerator key: Ctrl+) Go to the next difference section.

Search

(Keyboard shortcut: Ctrl+F) Search for a text string, in either of the versions being compared. A 
dialog appears, in which you define the search.

This command is also available on the GUI window's main menu: File > Search.

After you've defined a search, you can perform it again, using the command File > Search 
Again on the GUI window's main menu, or its keyboard shortcut: function key F3.

Difference Maps
To the right of each pane, there's a difference map that shows the relative locations and sizes of all the 
difference sections. The maps use the same color-coding (see Color-Coding of the Contributor Versions on 
page 238) as the difference sections themselves. Click on any colored area within a map to scroll both 
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panes directly to the corresponding difference section. (Actually, you can click anywhere in the difference 
map; the panes will scroll to that location, even if the files are identical there.)

Using a difference map merely scrolls the panes; it does not affect which difference is the current 
difference. After you jump to a particular location, click the difference section in either pane to make it the 
current difference.

If you use a difference map, but then want to scroll back to where you were before, click the  Center Diff 
toolbar button.

Editing a File Using the Diff Tool
In addition to comparing two versions of a file, the Diff tool can help you to edit the contents of the version 
in your workspace. This "edit-by-diff" capability is available only when you're comparing your workspace 
version with another version; it's not available when you invoke the Diff tool from the Version Browser or 
History Browser.

Here's a procedure for using this capability (see the toolbar button summary below):

1. Invoke the Diff tool in a File Browser, to compare your workspace version with some other ("before") 
version of the same file.
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2. Click the  Show result of edits button in the Diff toolbar. This opens a third pane (the Edit pane), 
which initially contains the same text as your workspace version.

3. As you browse through the difference sections, you can:

• Edit text manually in the Edit pane.

• Click the  Revert my change toolbar button to swap in the "before" version's text at that point (a 
change, addition, or deletion). The button becomes highlighted to indicate your selection.

• Include both the "before" and "after" versions' text at that point: click the   Revert My Change 

toolbar button, then hold down the Ctrl key and click the  Restore my change toolbar button.

• Alternatively, click the two buttons in the opposite order. Both buttons become highlighted, and 
number annotations indicate the order you selected:

You can then modify the combined text manually.

• Change your mind about a difference section where you've used  and/or , by selecting 
that section and clicking one of those buttons. Any manual edits you've made in that difference 
section are lost.

• Click the  Revert all of my changes button to make the Edit pane the same as the "before" 
version.

• Click the  Restore all of my changes button to make the Edit pane the same as the "after" 
version.
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4. Finish your work in either of these ways: 

• Click the  Save edits and close toolbar button. This simply replaces the file in your 
workspace. (It doesn't perform an AccuRev Keep command.)

• Close the Diff tab to cancel the edit-by-diff session. No changes are saved to the file in your 
workspace.

Note: Edit-by-Diff vs. Merge

Using the edit-by-diff capability is similar to using the Merge Tool (see The AccuRev Merge Tool 
on page 237). But there's an important difference:
• An edit-by-diff operation involves just two versions.

• A merge operation takes into account a third version: the closest common ancestor of the two 
versions being merged.

Diff Toolbar Edit-by-Diff Buttons

Revert my change

Use the "before" version's section at this point. If the  button is currently highlighted, you can 

hold down the Ctrl key and press  to append the "before" section to the workspace version's 
section.

Restore my change

Use the workspace version's section at this point. If the button is currently highlighted, you can 

hold down the Ctrl key and press   to append the workspace version's section to the "before" 
section.

Revert all my changes

Make the Edit pane the same as the "before" version.

Restore all my changes

Make the Edit pane the same as the "after" version.

Save edits and close

Store the current contents of the Edit pane in the workspace's file, without performing a Keep 
operation.
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Main Menu Commands Available in a Diff Tab
Several of the commands in the Edit submenu of GUI window's main menu are enabled when you're 
working in a Diff tab:

Cut

(Keyboard shortcut: Ctrl-X) Cut the selected text to the window system's clipboard.

Copy

(Keyboard shortcut: Ctrl-C) Copy the selected text to the window system's clipboard.

Paste

(Keyboard shortcut: Ctrl-V) Paste the contents of the window system's clipboard.

Select All

(Keyboard shortcut: Ctrl-A) Select the entire contents of the current pane.

Search

(Keyboard shortcut: Ctrl-F) See the Search description above.

Search Again

(Keyboard shortcut: F3) See the Search description above.

The Change Palette Tool
The Change Palette is a tool for propagating changes 'outside the lines' of a depot's stream hierarchy. You 
use it to promote one or more versions from a dynamic stream to a stream other than its parent stream. In 
some cases, a merge operation is required before you can propagate changes between streams; the Change 
Palette helps you to manage the Merge and subsequent Promote commands. You can use Patch instead of 
Merge, in order to send just some -- not all -- of the changes that a version contains.

You can also use the Change Palette to send changes from a dynamic stream to a workspace. This can be 
accomplished with a simple checkout operation, or with a more complex merge or patch operation.

You cannot use the Change Palette to promote versions from your workspace to an arbitrary stream. The 
only destination for versions in a workspace is the workspace’s backing stream, via the Promote command. 
(But you can reparent a workspace to provide a new destination for promoted versions.)
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Opening a Change Palette Tab
Before using the Change Palette itself, you must specify the version(s) that are to be promoted 'outside the 
lines' of the depot’s stream hierarchy. You can do this in the variety of contexts listed below.

From a StreamBrowser: Selected items from a current development activity subwindow

The current development activity subwindow shows the development activity currently taking 
place in a stream or workspace -- by element, by transaction, or by issue record. In this 
subwindow, you can:

1. Select any number of items (elements, transactions, or issue records).

2. Invoke the Send to Change Palette command, using the  toolbar button or the selection's context 
menu.

From a StreamBrowser: All the versions with changes that have not been propagated to the 
destination

Instead of selecting individual versions, you can let AccuRev determine the complete set of 
versions in a source stream that have not yet been propagated to a destination stream or workspace. 

This can include versions that are not currently in the source stream’s default group at all, but are 
inherited from a higher-level stream.

Click the control below the source stream, and drag it to the destination stream or workspace.
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From the Details pane of a File Browser, opened on a stream: Selected versions from the default 
group

This is essentially the same as working in a Default Group subwindow in the StreamBrowser:

1. Select the Default Group search.

2. Select any number of the stream's active versions.

3. Invoke the Send to Change Palette command, using the  toolbar button or the selection's context 
menu.

From a History Browser or Active Transactions tab, opened on a stream: All the versions in 
specified transaction(s)

A History Browser tab shows all the transactions that created (via Promote) versions in a stream. 
An Active Transactions tab shows the subset of these transactions with at least one version still 
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active in the stream. In either one, you can load a Change Palette with the versions created one or 
more selected transactions.

1. Select one or more transactions in the Summary (upper) pane.

2. Invoke the Send to Change Palette command, using the  toolbar button or the selection's context 
menu.
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From a History Browser or Active Transactions tab, opened on a stream: Specified version(s) from 
one transaction

This is similar to the previous case: instead of loading a Change Palette with all the versions 
created in a transaction, you load selected versions from a transaction.

1. Select one transaction in the Summary (upper) pane.

2. Select any number of that transaction's versions in the Versions (lower) pane.

3. Invoke the Send to Change Palette command, using the  toolbar button or the selection's context 
menu.

From a Stream Issues tab, opened on a stream: All the versions in the change package(s) of the 
specified issue record(s)

A Stream Issues tab shows the issue records whose change packages are "in" a particular stream. 

Each change package contains a "patch" of data from one or more text-file elements. You can load 
a Change Palette tab with the versions in one or more issue records' change packages:

1. Select one or more issue records in the Issues (upper) pane.
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2. Invoke the Send to Change Palette command, using the  toolbar button or the selection's context 
menu.

In all cases, a new Change Palette tab appears, loaded with the versions you've specified.

Change Palette Tab Layout
The Change Palette tab includes these panes:

• The Specified Versions pane initially lists all the versions you specified with the Send to Change 
Palette command (or the drag-and-drop operation). The versions' entries are cleared from this pane as 
you work with them using Promote, Merge, Patch, etc. 

• The Merged Versions pane appears only after you've merged or patched versions in the Specified 
Versions pane. It lists the versions created by the Merge or Patch command, and provides a convenient 
way to Promote these versions to the destination stream.

Layout of the Specified Versions Pane
This pane contains a table that initially lists all the versions loaded into the Change Palette.

As you work with these versions, they "migrate" out of this pane:

• Entries for versions that you promote to a destination stream -- or send to a destination workspace -- 
are automatically cleared from the Change Palette.

• Entries for versions that you Patch into a workspace (based on the source or destination stream) are 
also cleared automatically.
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• Entries for versions that you Merge into a workspace (based on the source or destination stream) are 
automatically cleared from the Specified Versions pane. Corresponding entries, representing the 
versions created by the Merge, are added to the Merged Versions pane.

Columns in the Specified Versions Table
The Specified Versions table includes these columns:

Element (or separate "Name" and "In Folder" columns)

The element's pathname within the depot.
Version

The version of the element that was sent to the Change Palette.
Basis Version

The version/basis-version pair defines the "patch data" that will be incorporated into the 
destination version if you invoke the Patch command. (See Patches and Change Packages on 
page 178.)

Transaction

(if you invoked Send to Change Palette from a History Browser or Active Transactions tab) The 
number of the transaction from which you sent this version.

Status

The relationship between the version in the source stream and the version in the destination 
stream:
• (overlap) indicates that you must perform a Merge command prior to Promote'ing this 

element to the destination stream. You can also perform a Patch command to propagate some 
of this version's changes to the destination stream, but this does not resolve the overlap status 
(and so does not enable the Promote command).

• (patch) indicates that the change that you sent to the Change Palette for this element (as 
specified by its entries in the Version and Basis Version columns) is a patch. That is, the 
change does not include the entire set of changes between the source-stream version and the 
closest common ancestor of the source-stream and destination-stream versions. You can 
perform a Patch command to propagate the changes in the patch to the destination stream.

If the element does not also have (overlap) status, the Promote command is enabled for this 
version, too. 

But promoting would propagate more changes to the destination stream than were loaded into the 
Change Palette. AccuRev issues a warning if you invoke Promote on this version.
• A blank indicates that there is no overlap and that the change loaded into the Change Palette is 

not a patch. This means you can safely Promote the version to the destination stream.
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Other Indicators and Controls
The Specified Versions pane also includes:

Source Stream

The name of the stream from which you sent the versions, using Send to Change Palette or the 
drag-and-drop operation.

Destination Stream

Initially blank (unless you used the drag-and-drop operation to load the Change Palette). 
Subsequently, it displays the name of the stream or workspace you've selected as the versions' 
destination.

Resolve overlaps in workspace

This field does not appear until the first time you invoke the Merge command. At that point, 
AccuRev prompts you to specify a workspace for the merge operation to take place in. It then 
displays the workspace's name in this field (which is also a listbox control for changing the name).

Layout of the Merged Versions Pane
This pane contains a table that lists the versions you've created by invoking the Merge command on 
versions in the Specified Versions pane. As you proceed to Promote these newly created versions, their 
entries are cleared from the Change Palette.

The Merged Versions table includes these columns:

Element (or separate "Name" and "In Folder" columns)

The element's pathname within the depot.
Merged in Workspace

The name of the workspace in which the merged version was created. This is not necessarily the 
same for all the listed elements, since you can switch workspaces using the Resolve overlaps in 
workspace control.

Working in a Change Palette Tab
The following sections describe the tasks you perform in a Change Palette tab. The order of the sections 
follows the typical order of tasks. But the Change Palette is a long-lived "work environment", not a simple 
dialog box or sequential wizard. So you might perform just some of the tasks and/or perform them in a 
different order.

Specifying the Destination Stream
If you've loaded versions into the Change Palette using the Send to Change Palette command, you've 
already indicated the source stream, but need to specify the destination stream or workspace. (The drag-
and-drop operation indicates both the source and destination.)
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Click the arrow control next to the Destination Stream field. 

A dialog appears, listing all of the depot's streams and workspaces. Select one to be the destination for 
subsequent commands (Send to Workspace, Promote, Merge, and/or Patch) on the versions in the 
Specified Versions pane.

Example

As the example shows, AccuRev determines a status for each element, describing the relationship between 
the source-stream version and the destination-stream version. Entries with (overlap) status are highlighted 
in yellow.

Note: If the destination is a workspace, AccuRev evaluates the version currently in the workspace 
stream, which is not necessarily the same as the file currently in the workspace tree.

You can change the destination stream at any time, using the arrow control next to the Destination Stream 
field.
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Sending Versions to the Destination Stream
In the Specified Versions pane:

• If the destination is a stream, you can immediately Promote the versions that do not have (overlap) 
status.

• If the destination is a workspace, you can immediately Send to Workspace any or all versions, whether 
or not they have (overlap) status.

Select one or more eligible versions, then click the   button in the pane's toolbar or choose Promote (or 
Send to Workspace) from the selection's context menu. When the command completes, the entry(s) for the 
version(s) are cleared from the Change Palette.

In the Merged Versions pane, you can Promote versions at any time. The versions are active in the 
workspace listed in the Merged in Workspace column; Promote sends them to this workspace's backing 
stream.

Notes:

• If you've used multiple workspaces for merging ...

In each Promote invocation, the set of versions must all be in the same workspace.

 If you've merged using a workspace based on the source stream ...

Promoting sends the merged version to the workspace's backing stream, which is not the destination 
stream you originally specified. You can now promote this version from the workspace's backing 
stream to the original destination stream (no additional merge is required). But you'll need to use 
another instance of the Change Palette to invoke the Promote command.

Merging the Source and Destination Versions
If an entry in the Specified Versions pane has (overlap) status, you cannot immediately promote the 
version to the destination stream. First, you must create a new version by merging the source and 
destination versions.

The merge operation must take place in a workspace that belongs to you and is based on either the source 
or destination stream. If you have not already selected a merge workspace, you must do so before 
performing any merges. (See Merging the Source and Destination Versions on page 231.)

Select one or more versions with (overlap) status, and click the  button in the pane's toolbar or choose 
Merge from the selection's context menu.

The merge operation(s) proceed for the selected element(s), as described in The Merge Command on 
page 235.

Note: If the merge workspace was not up-to-date, it's possible that the element will continue to have 
(overlap) status after the merge. In this case, perform a standard Merge in the workspace before 
promoting the element.
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Selecting a Workspace for Performing Merges

A merged version cannot be created directly in either the source or destination stream, because these are 
dynamic streams — all new versions of AccuRev elements must be originally created in workspaces.

The first time you invoke Merge in the Specified Versions pane, AccuRev prompts you to establish a 
merge workspace, suggesting one that is based on the destination stream. You can also choose a workspace 
based on the source stream.

Notes:

• Which is preferable -- source or destination?

A workspace based on the destination stream is preferable. After you perform the merge, you can then 
accomplish the original task -- propagating a version's changes to the destination stream -- with a 
single Promote. If you use a workspace based on the source stream, you'll need to Promote twice: (1) 
from the merge workspace to the source stream; (2) from the source stream to the destination stream. 
The second one requires you to use another instance of the Change Palette.

• What if no candidate workspace exists?

Click Cancel in the choose-workspace dialog, and do either of the following:

• Create a workspace based on one of the streams.

• Reparent one of your existing workspaces to the source or destination stream. Be sure to Update 
the reparented workspace before using it to perform merges in the Change Palette.

• Dialog box used for patching changes and resolving twin status, too.

The Please Choose a Workspace dialog box is also used when patching changes and resolving an 
element’s twin status. See Patching Changes from the Source Version into the Destination Version on 
page 233 and Resolving Twins from the Change Palette on page 233 for more information.

After you select a merge workspace, its name is displayed at the bottom of the Specified Versions pane. 
You can change this setting at any time; this enables you to use different workspaces to merge different 
versions.
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Patching Changes from the Source Version into the Destination 
Version
If an entry in the Specified Versions pane has (patch) status, you can invoke the Patch command to 
incorporate the patch defined by the Version and Basis Version settings into the destination-stream version. 

Select one or more of these versions, and click the   button in the pane's toolbar or choose Patch from 
the selection's context menu. AccuRev prompts you to select a workspace that belongs to you and is based 
on the destination stream. The patch operation is performed in this workspace, as described in Patches and 
Change Packages on page 178.

When the patch operation is complete, the entry disappears from the Specified Versions pane.

Resolving Twins from the Change Palette
Using the Change Palette to promote elements across streams can reveal the presence of elements with a 
(twin) status, which are highlighted in yellow in the Specified Versions pane. Twin elements (or so called 
twins) can be created when a file with the same name is created in workspaces off both the source and 
destination streams and then promoted to their respective streams. Elements that have a (twin) status 
cannot be promoted across streams until their (twin) status is resolved.

AccuRev provides a twin status resolution wizard and one-step defunct operations designed to help resolve 
twins quickly and easily. See Resolving (twin) Status on page 91 for more information. Note that there are 
considerations when using the twin resolution wizard to resolve twins from the Change Palette.

Multiple Entries for the Same Element
In some cases, the Specified Versions pane of the Change Palette can get populated with multiple entries 
for the same element. Here is a simple scenario:

1. Successive changes to an element, brass.c, get assigned to different AccuWork issue records. For 
example, this illustration shows a two-version change assigned to issue #14, then a one-version change 
assigned to issue #7, then a two-version change assigned to issue #22.

2. At this point, all three issues (#14, #7, and #22) are "in" the stream to which the versions were 
promoted.

3. Open a Stream Issues window for the stream to which the versions were promoted, then select issues 
#14 and #22 and invoke the Send to Change Palette command. Since there is a "change package gap", 
consisting of version 33, between the two change package entries for brass.c, AccuRev cannot 
combine them into a single patch entry. Accordingly, the two entries are entered into the Change 
Palette separately:
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The total number of entries for a given element is displayed in the Count column. The (patch) 
indicators in the Status column indicate that Patch is the appropriate command to invoke on each entry, 
in order to propagate the changes to brass.c in issue records #14 and #22 (and no other changes) to the 
destination stream.

Commands Available in a Change Palette Tab
Clear

Remove the selected entry(s). You can clear entries from either pane. This capability helps you to 
keep track of your work (and the work that you've decided not to do).

If you attempt to close the Change Palette tab when either pane in non-empty, AccuRev prompts 
you for confirmation. Note: Clear is available from the right mouse button context menu; it is not 
currently available from the tool bar.

Promote

(available only if the destination is a dynamic stream)

Specified Versions pane: promote the selected version(s) to the destination stream.

Merged Versions pane: promote the selected version(s) from the workspace listed in the Merged in 
Workspace column to its backing stream.

Send to Workspace

(available only if the destination is a workspace) Performs a Send to Workspace command on the 
selected version(s) in the destination workspace. (see The Send to Workspace Command on 
page 129.)

Merge

Merge the selected version(s) with the corresponding version(s) in the destination stream, creating 
the merged version(s) in the workspace listed in the Resolve overlaps in workspace field. When 
the command finishes, the entry(s) are cleared from the Specified Versions pane, and entry(s) for 
the newly created version(s) are added to the Merged Versions pane.

Patch

Performs a Patch command from each selected version to the corresponding version in the 
destination workspace, or in a workspace that you select below the destination stream. When the 
command finishes, the entry(s) are cleared from the Specified Versions pane.
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Resolve Twin Status

Provides a wizard and other tools to help you resolve an element’s (twin) status. See Resolving 
(twin) Status on page 91 for more information.

Browse Versions

Open a Version Browser tab, showing all the versions of the selected element, and their 
interrelationships (ancestry).

Diff

Compares the selected version with the version in the destination stream or workspace.
Note: When the destination is a workspace, the comparison is performed with the version in the 
workspace stream, not the file in the workspace tree. These are different if the element has (modified) 
status in the workspace.

Properties

Displays information about the selected element. The data items displayed vary with the type of 
element.

The Merge Command
The Merge command combines two versions of an element, producing a new version. (That is, a successful 
merge operation always ends with a Keep. This is a software configuration management best practice.) 
AccuRev can process both content changes and namespace changes in performing a merge. By default, the 
merging of text-file contents is performed by AccuRev's own Merge tool, which uses a 3-way merge 
algorithm (see ).

What about elements that aren't text files? 

The Merge command can also handle any other kind of version-controlled element: binary file, directory, 
or link.

Configuring the GUI to use another text-file-merge tool 
A user preference enables you to configure a third-party tool for merging the contents of text files.

Why Do I Need to Merge?
Perhaps the most common usage pattern in AccuRev is:

• Using Keep to create one or more versions of a text file in your workspace.

• Using Promote to propagate the most recently kept version to the backing stream.

Occasionally, someone else "gets there first". That is, both you and a colleague are working on the same 
file concurrently, each of you using a copy of the file in your own workspace. And the colleague promotes 
his changes to the common backing stream before you do.

Video Tip Click this link to view an introductory video on merging binary files.

http://www.accurev.com/sites/default/files/videos/55-training-doclinks/dev_doc_artist_Dealing_with_Binary_Overlap.wmv
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Before you can promote your own changes to the backing stream, you must first merge (that is, combine) 
the changes from your colleague's version with your changes. Merging ensures that no one's work is 
inadvertently lost or overwritten in a concurrent development environment.

The File Browser makes it easy to tell which files require a merge prior to promotion. If a file needs to be 
merged in your workspace, the Details pane shows the file as having (overlap) status -- that is, the work of 
one or more of your colleagues has overlapped your own work. If you select Overlap in the File Browser's 
Searches pane, the Details pane displays all your (overlap)-status files: all files in the depot that you must 
merge before you can promote them from your workspace to its backing stream.

Higher-Level Merges
Although the above scenario is by far the most common one, AccuRev's flexibility allows for other merge 
scenarios, too:

• You can modify the file in your workspace by "pulling in" the changes from any version of the file, not 
just the backing stream's version.

• You can merge the versions of the file located in any two dynamic streams or snapshots. This involves 
using the Change Palette.

In all cases, however, you use the Merge tool in the same way, to combine the contents of two versions of 
the same file element.

Invoking the Merge Command
No matter which tool you've configured to merge versions, you invoke the Merge command in the same 

way: select one or more files with (overlap) status, then click the  Merge toolbar button. Alternatively, 
choose Merge or Merge From on the selection's context menu. For example:

You can merge versions in the following contexts:

• In the File Browser (when invoked from a workspace), to merge from the version in the parent stream.

• In the Version Browser (when invoked from a workspace), to merge from an arbitrary version.

• In the History Browser (when invoked from a workspace), to merge from the version in a particular 
transaction.
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• In the Change Palette, to merge versions in higher-level streams. (You must choose a workspace to use 
for the merge process.)

AccuRev processes the files you specify one-by-one. For each file, it does one or both of the following

• Prompts you to resolve namespace-level conflicts between the file in your workspace and the other 
specified version. This involves making choices in one or more dialogs.

• Invokes AccuRev's Merge tool or the other tool you've configured, in order to merge the contents of 
the two versions. AccuRev's Merge tool opens in a separate tab within the AccuRev GUI window; any 
other tool opens in its own window.

Notes:

• Invoking the Merge command on multiple files

If you select multiple files, you can choose to have the Merge tool process as many of them 
automatically as possible.

An automatic merge is possible if there are no conflicting changes between the two versions being 
merged. For files in which there are conflicting changes, the Merge tool always opens an interactive 
Merge tab.

• File vs. Version

In all cases, one of the contributors to a merge operation is the file in your workspace. If you've just 
saved the file with the Keep command, the file in your workspace is identical to the most recent 
version in your workspace stream. But if you invoke Merge on a file that you've edited but not yet 
saved with Keep, AccuRev uses the file, not the latest workspace-stream version. Keep'ing before 
Merge'ing is an AccuRev best practice.

The AccuRev Merge Tool

This topic describes AccuRev's own 3-way merge tool. You can also configure the GUI to use another text-
file-merge tool.

Merge Tab Layout
By default, the Merge tool displays the two contributors' contents in side-by-side panes with the contents 
of the contributors' closest common ancestor in a third pane between them. 

Note: Using a toolbar button, you can arrange the contributors' panes vertically, or toggle the visibility 
of the pane containing the closest common ancestor.

Video Tip
Click this link to view an introductory video on using the Merge tool to 
resolve conflicts.

http://www.accurev.com/sites/default/files/videos/55-training-doclinks/dev_Source_Code_Merge.wmv
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The file in your workspace is always on the right. Above them, the Merge tool displays the merged version. 
The contributor panes and closest common ancestor pane are synchronized: scrolling any one of them 
causes the others to scroll, too.

Special cases:

• HTML files

• Binary files

Color-Coding of the Contributor Versions
Like the Diff tool, the Merge tool partitions the contributor versions' contents, displaying unchanged 
sections with a white background and change sections with colored backgrounds. The color-coding 
scheme is a bit different, because the Merge tool has the more complex job of distinguishing conflicting 
changes from non-conflicting ones. In addition, the color-coding scheme depends on which navigation 
mode you're working in.

• For changes that are traversed in the current navigation mode, the Diff tool's color-coding scheme is 
used.

• Changes that navigating in the current mode skips over are colored gray.
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• For a conflicting change, the blocks in all contributors are colored yellow, no matter what the 
navigation mode is.

Example 1: In My changes navigation mode, non-conflicting additions that come from your version 
are colored green; non-conflicting additions that come from the other contributor are colored gray. In 
Their changes navigation mode, the color-coding of non-conflicting additions would be reversed.

Example 2: In Conflicts navigation mode, all conflicting changes are colored yellow; all other change 
sections are colored gray.

Color-Coding of the Merged Version
The merged version is displayed with color-coding, too. Each colored block is a location where a change 
has been incorporated from one of the contributors into the merged version. When it starts, the Merge tool 
performs as much merging as it can automatically, applying all of the non-conflicting changes to the 
merged version. The text is always colored gray. Annotations in the left margin indicate the origin of the 
change:

• left-hand (or upper) contributor:   annotation

• right-hand (or lower) contributor:   annotation

The Merge tool cannot resolve conflicts automatically, so the location of each conflict is initially indicated 
in the merged version by a blank yellow block. As you make selections to resolve the conflicts, the blank 
yellow blocks get filled in with the selected text and are annotated:

• blocks that you select from the left-hand (or upper) contributor:  annotation

• blocks that you select from the right-hand (or lower) contributor:  annotation

• blocks that you select from the closest common ancestor:  annotation

In all cases, the text of a resolved conflict is colored blue.

Resolving Conflicts
You can think of the Merge tool as a special-purpose text editor: it combines the contents of two files, 
producing a third file as the result. Like any text editor, the Merge tool provides you with a set of editing 
and navigation functions; you have a lot of flexibility in choosing which functions to use, and in which 
order.

But the Merge tool does enforce this requirement: you must resolve all the conflicting changes between the 
contributor versions before you can complete a merge operation. Thus, Merge tool usage follows this basic 
pattern:

• Navigate to the various conflict sections.

• Resolve each conflict by selecting a section from the left-hand (or upper) contributor, the right-hand 
(or lower)contributor, or the closest common ancestor. You can also resolve the conflict by selecting 
the sections from more than one of these sources -- even from all three -- in any order.

• (optional) Add manual edits to the merged version.

• Save the results.

These operations (except for manual editing) are controlled by Merge toolbar buttons, as described in the 
following sections.
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Navigating the Display and the Change Sections
Some of the Merge tool's navigation facilities are the same as the Diff tool's:

• The panes have scroll bars, which are automatically synchronized with each other.

• The navigation buttons in the middle of the Merge toolbar work the same way as in the Diff tool, with 
a slight variation:

• If the  Their changes mode button is selected, the navigation buttons traverse just the change 
sections in which the left-hand (or upper)contributor differs from the closest common ancestor.

• If the  All the changes mode button is selected, the navigation buttons traverse all the change 
sections.

• If the  My changes mode button is selected, the navigation buttons traverse just the change 
sections in which the right-hand (or lower) contributor differs from the closest common ancestor.

• If the  Conflicts mode button is selected, the navigation buttons traverse just the sections with 
conflicting changes.

At any given time, one of the change sections is currently selected. The line numbers in both contributor 
panes are highlighted to indicate the selection.

Whenever you use one of these buttons (except for  Search) to jump to a particular change section, the 
Merge tool remembers it as the current change. Selecting a particular change section by left-clicking it in 
either contributor pane makes it the current change.

The Change Section Counter
As you navigate among the change sections, a counter in the Merge toolbar tracks your location, taking 
into account which navigation mode is selected. 

For example, "2 of 4" might mean "you are currently in My changes mode, and you are currently at the 2nd 
of 4 such changes".
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The counter typically changes as you switch navigation modes.

In some cases, the first number may be "0". This occurs when:

• You've just switched modes, and the current change section is not selected by the new mode.

• In Conflicts mode, you've just resolved a conflict, by selecting a section from one contributor. The 
current change section is no longer a conflict, so it's no longer selected by your current navigation 
mode.

Searching for Text
In addition to navigating among the change/conflict sections, you can search for any text string in any 

pane, using the   Search toolbar button (keyboard shortcut: Ctrl-S). 

You can also invoke this command from the context menu that appears when you right-click anywhere in 
either contributor pane.

Selecting a Section from a Contributor (or Multiple Contributors)
Sometimes, the Merge tool can construct a merged version without any help from you. This occurs if all 
the change sections are non-conflicting. The Merge tool just applies all the changes to the merged version 
and announces that it's done. This section describes the more interesting case: the contributors have one or 
more conflicts, which you must resolve.

The Merge tool automatically jumps to the first conflict. That is, it scrolls to the first yellow-highlighted 
change section in the contributors, and the corresponding blank yellow block in the merged version. It's up 
to you to decide which of the changes is to be incorporated into the merged version. You indicate your 
decision using the conflict-resolution toolbar buttons.

• Click the  Take common ancestor change toolbar button to incorporate the original block from the 
closest common ancestor.
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• Click the  Take my change toolbar button to incorporate the changed block from the right-hand (or 
lower) contributor (file in your workspace).

• You can take two of the blocks or all three of them, in any order:

1. Click the   o r  or  conflict-resolution button to select one block.

2. Hold down the Ctrl key, and click another conflict-resolution button. The newly selected block is 
sent to the merged version, below the previously selected block. The conflict-resolution buttons 
are annotated with numbers, indicating the order you selected. (And the tooltip reminds you of this 
"multiselect" capability.)

3. Optionally, repeat the preceding step to include the third block, as well.

You can undo a multiselect by clicking any of the conflict-resolution buttons without holding down the 
Ctrl key. Typically, you'll need to do some manual editing to "smooth out" the combined changes of a 
multiselect.

Note: You cannot undo a multiselect once you've performed a manual edit.

The following two conflict-resolution buttons make large-scale changes -- use them carefully! They both 
effectively override the Merge tool's automatic inclusion of non-conflicting changes into the merged 
version.

• The  Revert all of my changes button makes the merged version the same as the left-hand (or upper) 
contributor version.

• The  Use only my changes button makes the merged version the same as the right-hand (or lower) 
contributor version.

When you click one or more conflict-resolution buttons to resolve a conflict, the selected block(s) appear 
in the merged version and the highlight changes from yellow (unresolved) to blue (resolved). This also 
decrements the change section counter in the Merge toolbar.

Use the  Next navigation button to scroll down to the next conflict. (It may take more than one click if 
your are not in Conflicts navigation mode.) Again, use one of the "take change" buttons to select the text 
from the left contributor or the right contributor (or both of them).

You don't have to resolve the conflicts in order. You can jump around as much as you want among the 
change sections, or scroll through unchanged sections to look up information the affects your merge 
decisions.

Changing Your Mind
You can change your merge decisions as much as you want. For example, you can navigate to a particular 

change section where you had selected  Take their change, and then click the  Take my change button. 
This swaps out their change and swaps in your change.
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Warning: swaps of this kind also discard any manual edits that you have made in that section after initially 
selecting it.

If you want to discard all your merge work, close the Merge tab to abandon the merge session entirely. 

A confirmation dialog box appears, making it less likely that you'll discard your merge work accidentally.

Manual Editing
At any time during a Merge tool session, you can manually edit the contents of the merged version. Just 
click anywhere in the pane containing the merged version, and type. The Delete and Backspace keys work 
as expected. Using context (right-click) menus or the GUI main menu, you can Cut, Copy, and Paste 
sections of text that you've highlighted with the mouse. You can also use the common keyboard shortcuts: 
Ctrl-C or Ctrl-Ins to copy, Ctrl-V or Shift-Ins to paste.

Warning: If you make changes manually within a conflict section that you've resolved with one of the 
conflict-resolution buttons, the manual changes will be overwritten if you return to that section and click 
any conflict-resolution button.

Joining Change Sections
Sometimes, there is a block of lines in a contributor version that you consider to be a single change section, 
but that the Merge tool decides are two separate sections. You can combine the two change sections: 

1. Right-click in the contributor section, and choose Join Sections from the context menu.

2. The mouse pointer changes to   . Click the adjacent section to be joined with the first section.

The Merge tool joins the sections, then readjusts its analysis of the contributors' change sections. Typically, 
this changes the number of conflict sections.

Saving the Merged Version
When you resolve the last remaining conflict by clicking one of the conflict-resolution buttons, the 
Conflicts counter goes to "0 of 0" and the Merge tool displays this message window:

• Clicking Keep & Exit ends the merge session immediately, closing the Merge tab. AccuRev overwrites 
the file in your workspace with the merged version. Then, it a Keeps a new version in your workspace 
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stream, to preserve the merge results. The overlap status of the file is removed, so that you can now 
Promote the new version to the backing stream.

• Clicking Review continues the merge session. This enables you to review your work, change some of 

your merge decisions, and perform manual edits. At any time, you can click the  Keep button in the 
Merge toolbar to complete the merge process.

You can also cancel the entire merge during a review pass by closing the Merge tab without performing a 
Keep.

Notes About Merge Behavior
As of AccuRev Release 4.9, the merge command is now smarter about simple (rebase) merges, resulting in 
simplified display of merge lines in the Version Browser, and simplified change packages. For example, 
assume two developers are working in parallel on the same element, with a common ancestor, and there are 
only regular versions (that is, no patches, merges, or reversions) between the current versions and the 
common ancestor. When these are merged, the resulting version of the merge is rebased to point to the 
merged version. 

In these cases you will not see a red merge line in the Version Browser. Instead, the comment section of the 
merged file will contain an entry similar to: “merged, rebased to <version>”. In other words, if a 
merge results in a change that you would have received if you had simply done an update, it is not 
displayed as a merge. See the screenshots under Notes: on page 248.

Commands Available in a Merge Tab

Navigation Mode Radio Buttons

Their changes

When this radio button is selected, the navigation buttons take you to the change sections in which 
the left-hand (or upper) contributor differs from the closest common ancestor.

All the changes

When this radio button is selected, the navigation buttons take you to all the change sections.

My changes

When this radio button is selected, the navigation buttons take you to the change sections in which 
the right-hand (or lower) contributor differs from the closest common ancestor.

Conflicts

When this radio button is selected, the navigation buttons take you to all the sections that contain 
conflicting changes.
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Navigation Buttons

First change/conflict

Go to, and select, the first change section (or unresolved conflict section)

Last change/conflict

Go to, and select, the last change section (or unresolved conflict section)

Center current change/conflict

Scroll the contributor panes (if necessary), to make the currently selected change section visible.

Previous change/conflict

Go to, and select, the preceding change section (or unresolved conflict section)

Next change/conflict

Go to, and select, the next change section (or unresolved conflict section)

Change section counter

Display only, not a button. See The Change Section Counter on page 240.

Search

Bring up a dialog to define a search in one of the panes for a specified text string.

Conflict Resolution Buttons

Invoking a "Take ... change" operation replaces a previously chosen change section at that location. It also 
wipes out any manual edits you may have performed in that change section.

Take their change
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Copy the currently selected change section in the left (or upper) contributor pane to the results 
pane.

Take common ancestor

Copy the the original block from the closest common ancestor to the results pane.

Take my change

Copy the currently selected change section in the right (or lower) contributor pane to the results 
pane.

Revert all my changes

Make the merged version the same as the left-hand (or upper) contributor version.

Use only my changes

Make the merged version the same as the right-hand (or lower) contributor version.

The "Keep merge results" Button

Keep results and close

Preserve the current contents of the merge results pane as a new version of the element, using the 
Keep command. (The Keep dialog box does not appear.) The Merge tab for this file then closes 
automatically.

Pane Selection Buttons

Show results of edits

Toggle the visibility of the merged version pane. This enables you to see more data in the two 
contributor panes.

Show HTML result

(appears for file with .htm or .html suffix only) Toggle switch: display the context of the merged 
version as plain text, or render the contents as HTML.

Show Ancestor Panel

Toggle switch: display/hide the closest common ancestor pane.

Horizontal Layout

(default) Places the "other" contributor pane to the left of the "workspace" contributor pane.

Vertical Layout

Places the "other" contributor pane above the "workspace" contributor pane.
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The Search Command
The Search command in the AccuRev Diff tool or Merge tool searches for a specified character string in 
one of the tool’s panes -- workspace contributor (lower right), stream contributor (lower left), ancestor 
(center), or results (top).

Invoking the Search Command

Click the  button in the Merge toolbar.

Using the Search Dialog
Type a character string in the text box, and make sure the Direction, Window, and Case Sensitive options 
are set in the desired way. Then click the Search button.

The Merge, Patch, and Reverse Patch Algorithms
The AccuRev GUI uses the same tool to perform interactive merge operations, interactive patch 
operations, and interactive reverse patch operations (Revert command) on the contents of a text-file 
element. In all these operations:

• AccuRev analyzes two contributor versions of a file, along with a third version designated as the 
closest common ancestor of the two contributors.

• The two contributor versions' contents are combined to produce a new version of the file, which is 
saved in the repository with a Keep command. Sometimes, the new version can be produced 
completely automatically; other times, you have to interactively resolve conflicts between the 
contributor versions.

The only differences among the several operations are in which versions are designated to be the 
contributors and the closest common ancestor. These differences are detailed below.

Notes:

• Using a third-party tool for merge, patch, and reverse patch operations

By default, merge, patch, and reverse patch operations are performed by AccuRev's own Merge tool. If 
you configure a third-party text-file-merge tool, it will be used for all these operations. The algorithm 
used by the third-party tool is not necessarily the same as that used by AccuRev's Merge tool.

• Merging, patching, and reverting namespace changes

Any merge, patch, or reverse patch operation can involve namespace changes in addition to (or instead 
of) content changes. AccuRev compares the pathnames of the two contributor versions, and in some 
cases applies a pathname change with the Rename command. If both a Rename and a Keep are 
performed, the Rename transaction comes first.

See Resolving Namespace Conflicts on page 253 for more details.

Merge: Incorporating Content Changes
In a Merge or Merge From command, the analysis performed on the two contributor versions goes beyond 
a simple diff: AccuRev determines how each difference represents a change from the closest common 
ancestor version. (To emphasize the Merge tool's perspective, we use the term “change section” to describe 
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a location where the contributors differ from each other. In the context of the Diff tool, we use the term 
“difference section”.)

Versions in a 3-Way Merge
The versions of an element that figure in AccuRev's 3-way merge algorithm are:

1. Workspace version (appears in lower right pane of Merge tool)

This is also called the "to" version. The merge results will be saved as a new version in some 
workspace, replacing the version displayed in this pace. Which workspace is the new version created 
in?

• In the most common merge scenario, you invoke the Merge command in a File Browser open on a 
particular workspace. The new version is created in that workspace.

• You can invoke Merge From or Patch From in any of the version tools.

• In this case, the new version is created in the workspace from which you launched the version tool. 
It's listed in the status bar at the bottom of the GUI window.

• If you invoke Merge from the Change Palette, you are prompted to specify a workspace in which 
to perform the merge. The new version is created in that workspace.

2. Stream version (appears in lower left pane of Merge tool)

This is also called the "from" version.

• In the most common merge scenario, this is the version in the workspace's backing stream.

• If you're using one of the version tools, this is the version on which you invoked Merge From or 
Patch From.

• In the Change Palette, this is the version in the "source stream".

3. Closest common ancestor version (not displayed in Merge tool)

AccuRev takes into account previous merge operations, but not previous patch operations, in 
determining the closest common ancestor of the workspace version and the stream version.

Notes:

• Workspace File vs. Workspace Version

AccuRev always uses the file in the workspace tree as the first contributor. If you've just saved the file 
with the Keep command, the file in your workspace is identical to the most recent version in your 
workspace stream. But if you've edited the file without Keep'ing it, there's a difference.

In all cases, the version currently in the workspace stream is used in the determination of the closest 
common ancestor version.



AccuRev®  On-Line Help Guide 249

• How can I tell which is the closest common ancestor? How will the results of the merge appear in the 
Version Browser?

In the Version Browser, you can identify the common ancestor by visual inspection. In the AccuRev 
CLI, use the command anc -c. The results of the merge will appear differently in the Version Browser 
if you are merging with a version from the backing stream than they will if you merge with a non-
backing stream version. Consider the following examples:

The example above shows the most common case: merging the file with your modifications in your 
workspace (A) with a version with different changes in the backing stream (B). The closest common 
ancestor for A and B is C. This is considered a “rebase” merge, and the result appears as follows:

A new version is created (D) for the merged content. Note that in this case no red merge line is 
displayed. Instead, the merge is noted in the in the comments and in the tooltip which appears when 
you hover over the resulting version at D.
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If you merge with a version that is not in the backing stream, the common ancestor is still easy to 
determine:

Again, the file with your modifications in your workspace is at (A). The version with different changes 
in a different stream is at (B). The closest common ancestor for A and B is C. 

And again, the result of the merge is a new version shown at D. But note that for this more complex 
merge, AccuRev indicates the merge process with a red line. (In versions prior to 4.9.1, all merges -- 
including rebase merges-- were displayed with this red line.

Handling Change Sections
AccuRev processes each change section by comparing (1) the workspace version's content, (2) the stream 
version's content, the closest common ancestor's content:

• Non-conflicting change: Only one contributor — either the 'from' version or the 'to' version — 
changed the content in the section; the other contributor didn't make a change. AccuRev automatically 
includes the change in the merged version. 

• Conflicting change: Both contributors changed the content in the section. AccuRev highlights the 
section in yellow; you must resolve the conflict by selecting one contributor's change to be included in 
the merged version.
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• Identical change: Both contributors changed the content in the section in exactly the same way. 
AccuRev doesn't flag this section at all; the agreed-upon change is automatically included in the 
merged version.

Example 1: non-conflicting change

Suppose a change section consists of 13 lines that occur in contributor #2 but not in contributor #1. To 
determine what kind of change this represents, the Merge tool looks at the corresponding location in the 
closest common ancestor version:

• If those 13 lines exist in the ancestor version, the Merge tool concludes that a change was made in 
contributor #1 (the lines were deleted) but no change was made in contributor #2 (the lines are still 
there).

• If the 13 lines do not exist in the ancestor version, the Merge tool concludes that a change was made in 
contributor #2 (the lines were added) but no change was made in contributor #1 (nothing was added).

In both these cases, there was a change from the common ancestor in exactly one of the contributors. The 
Merge tool deems this a "non-conflicting change". It incorporates the change (be it an addition, a deletion, 
or a revision of existing text) into the merged version.

Example 2: conflicting change

Let's take another example. A one-line error message has a slightly different wording in the two 
contributors:

• Contributor #1:

#define E_COLOR498 "No color with that name was found."
• Contributor #2:

#define E_COLOR498 "Color name unknown."
The following line occurs at the corresponding location in the closest common ancestor version:

#define E_COLOR498 "Huh?"
In this situation, the Merge tool finds a change from the common ancestor in both contributors, not just 
one of them. This is a "conflicting change" (or more simply, a "conflict"). The Merge tool doesn't try to 
decide which contributor's change is better. It just makes it easy for you to make this decision when 
you perform the merge.

Example 3: identical change

It sometimes happens that both contributors have made the same change from the common ancestor 
version. For example, both contributors might have replaced this error message:

Huh?
with this one:

No such color
The Merge tool does not identify this as a difference section, because there's no difference between the two 
contributors. It silently incorporates the agreed-upon change into the merged version.

Patch: Incorporating Content Changes
In a Patch From command, the two contributor versions are the same as in a Merge command:

• The lower right pane contains the version in your workspace.

• The lower left pane contains the stream (or "from") version -- the version, located in some other 
stream, that you selected when invoking the Patch From command.
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But the patch algorithm does not use the actual closest common ancestor of these two contributors as the 
third version. Instead, it regards the stream version as being the head version of a patch, and uses the 
corresponding basis version as the closest common ancestor. (See Structure of a Patch on page 178.)

Using the basis version instead of the actual closest common ancestor effectively modifies the algorithm 
for handling change sections, enabling AccuRev to distinguish changes that are "in the patch" from 
changes made in other versions:

• If a change in the "from" version is in the patch, patching works in exactly the same way as merging. 
This means that it is possible (and perhaps automatic) that the "from" version's change will be included 
in the results of the Patch From command.

• If a change in the "from" version is not in the patch, it is ignored -- the workspace version's change is 
automatically included in the results. (Why automatically? This case fits the definition of a non-
conflicting change: "not in the patch" means that the text in the stream version is the same as the text in 
the basis version (playing the role of closest common ancestor). Since only one contributor, the 
workspace version, has a change that differs from the version designated as the closest common 
ancestor, that contributor's change is accepted automatically.)

Reverse Patch: Removing Content Changes
In a Revert command, the changes in a specified set of versions are removed from a stream's current 
versions of those elements:

• When reverting a transaction, AccuRev regards each version in that transaction as being the head 
version of a patch, and removes all the changes in that patch from the element.

• When reverting a change package, AccuRev removes all the changes in each element's change 
package entry.

For more information on the structure of a patch and a change package entry, see Patches and Change 
Packages on page 178.

For each element it processes, the Revert command uses the AccuRev Merge tool (or user-configured tool) 
to perform the operation that removes a set of changes from the current version. We use the term reverse 
patch to describe this process, but it's really just another instance of effectively modifying the merge 
algorithm by switching around the versions.

When the Merge tool is invoked by Revert:

• The version you selected when invoking the Revert command is designated to be the closest common 
ancestor.

• The lower left pane contains the version currently in the stream.

• The lower right pane contains the version that was in the stream just before the version being reverted 
was promoted there.

In this algorithm's switching around of the versions, the basis version of the change package entry being 
reverted (or the basis version corresponding to the Promote'd version being reverted) becomes the direct 
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ancestor of the newly created version. The reverted element's Version Browser display shows this 
relationship:

Resolving Namespace Conflicts
Note: This topic discusses conflicts that can occur when two developers change the pathname of an 
element. The same kind of conflicts can occur when two developers change the target element an 
element link or the target pathname of a symbolic link. The same dialogs appear in both kinds of 
conflict situations.

Kinds of Namespace Changes
AccuRev distinguishes between these two kinds of namespace changes to an element (file, directory, or 
link):

• Rename: Changing the element's simple name (or "leaf name"):

cmds.java --> commands.java
• Move: Relocating the element to another directory in the depot::

cmd_intf/commands.java --> cmd_intf/utils/commands.java
Note: What about renaming the directory in which a file resides?

Renaming of the parent directory is not the same as moving a file to another directory. AccuRev 
considers this renaming:

cmd_intf --> cmd_interface
... to be change to the parent directory element, but not a change to the file elements within it. (This 
change to the parent directory has the side-effect of changing the pathnames of all elements below it.)

In a parallel development environment, namespace changes can overlap in the same way as content 
changes. For example, you and a colleague might rename the same file in your workspaces:

cmds.java --> commands.java

cmds.java --> all_commands.java
If your colleague promotes his change first, then the file will get (overlap) status in your workspace. 
Before you can promote the file, you must use the Merge command to resolve the namespace conflict. 

In general, your work on a file element can overlap with a colleague's work in three ways:

• You both have made a namespace change of the rename kind.

• You both have made a namespace change of the move kind.
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• You both have made a content change to the file.

Any combination of these kinds of changes is possible. AccuRev first prompts you to resolve the 
namespace conflicts, if any, as described below. Then, it passes control to the Merge tool (or another tool 
that you've configured), to perform the content merge.

Resolving a "Rename" Conflict
A namespace conflict of the rename kind occurs when two versions' simple names differ from the simple 
name of their closest common ancestor (and also differ from each other).

AccuRev allows you to resolve the conflict by taking any of the three simple names.

Resolving a "Move" Conflict
A namespace conflict of the move kind occurs when two versions are located in different directories than 
their closest common ancestor (and also different directories from each other).

AccuRev allows you to resolve the conflict by choosing any of the three parent directories as the file's 
location.
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Note: What are the "EID" annotations? AccuRev tracks directory elements by their immutable 
element-IDs (EIDs). It lists the parent directories' EIDs in this dialog to help you identify them; the 
directories might have different names/pathnames in different streams.

Merging Versions of a Binary File
No generally accepted algorithm exists for merging the contents of binary-format files. But it is quite 
possible for a binary-format element to get into an overlap state in a concurrent development environment.

Example: Two team members might each revise the corporate logo file using an image editor, and then 
Keep it. One of them then Promotes the file to the backing stream, creating an overlap situation in the other 
workspace. 

To resolve a binary-file overlap, you invoke the Merge command, just as for a text file. The Binary Merge 
dialog appears.

Using the Binary Merge Dialog
The Merge tool, seeing that versions to be merged are in binary format, offers the only two possible 
choices: 

Workspace version

Create a new version using the file in your workspace tree, and mark that version as having been 
merged with the version in the backing stream. You can now Promote this new version to the 
backing stream.

Stream version

This invokes the Revert to Backed command, which resolves the situation by purging the 
(overlap)-status version from your workspace. The workspace reverts to using the version of the 
file that was in the backing stream at the previous update.

The file's status becomes (stale), because the version that previously caused the overlap is in the 
backing stream. To bring that version into your workspace, perform an Update.
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Merging Versions of an HTML File
AccuRev's merge algorithm treats HTML-format files just like all other text files: merging takes place line-
by-line; no attempt is made to parse the files' HTML data structures in determining difference sections.

To help you determine whether the merge process is producing a valid (and desirable) result, an HTML 
viewer is built into the Merge tool.

At any time, you can click the   Show HTML Result button at the right side of the toolbar. (This button 
appears only when you're merging a file with a .htm or .html suffix.)

Clicking the Show HTML Result button displays a rendering of the merged HTML-format text in the upper 
pane. This button is a toggle: click it again when you're finished viewing the rendered HTML code and you 
want to return to performing the merge.

Merging Versions of a Link
The Merge command can merge changes made to element in two different contributor versions.

Basic Merge Algorithm
The basic procedure for handling changes in a merge operation is the same for all elements, including link 
elements:

• At the time of the merge, one contributor is located in a workspace, where the new version will be 
created); the other contributor is the version in the workspace's backing stream or some other dynamic 
stream. (You might have specified this second version as part of a particular transaction or change 
package.)

• If just one contributor makes a change from the contributors' closest common ancestor, AccuRev 
incorporates the change into the new, merged version automatically.

• If both contributors make a change from the contributors' closest common ancestor, AccuRev regards 
this as a conflict, which you must resolve during the merge process.

For a more detailed discussion, in the context of changes to the contents of a text file, see Handling 
Change Sections on page 250.

What Constitutes a Change to a Link?
Given that the algorithm for handling changes is basically the same for all elements, the only thing special 
about merging versions of a link is the nature of changes to a link element.

• AccuRev tracks namespace changes to a link:

• Initial creation of the link. Note: A link object is created as either an element link or a symbolic 
link. You cannot switch the type of an existing link object.

• Renaming the link.

• Moving the link to another location in the depot's directory tree.
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Each of the above changes creates a new version of the link element.

• AccuRev also tracks changes to the contents of a link -- that is, changes to the link's target element (for 
an element link) or to the link's target pathname (for a symbolic link). Each such change creates a new 
version of the link element.

Link Merge Procedure
Execution of the Merge command on a link element never involves the Merge tool (or third-party tool), 
which is designed to process the contents of text files.

A conflict at the content-level merge is handled by a link-specific dialog:

A conflict at the namespace-level merge involves making choices in the same one or two dialogs used for 
all kinds of elements.

Merging Versions of a Directory
The Merge command can merge changes made to a directory (folder) element in two different contributor 
versions.

Basic Merge Algorithm
The basic procedure for handling changes in a merge operation is the same for all elements, including 
directory elements:

• At the time of the merge, one contributor is located in a workspace, where the new version will be 
created); the other contributor is the version in the workspace's backing stream or some other dynamic 
stream. (You might have specified this second version as part of a particular transaction or change 
package.)

• If just one contributor makes a change from the contributors' closest common ancestor, AccuRev 
incorporates the change into the new, merged version automatically.

• If both contributors make a change from the contributors' closest common ancestor, AccuRev regards 
this as a conflict, which you must resolve during the merge process.

For a more detailed discussion, in the context of changes to the contents of a text file, see Handling 
Change Sections on page 250.



258 AccuRev®  On-Line Help Guide

What Constitutes a Change to a Directory?
Given that the algorithm for handling changes is basically the same for all elements, the only thing special 
about merging versions of a directory is the nature of changes to a directory element.

• AccuRev tracks only namespace changes to a directory:

• Initial creation of the directory.

• Renaming the directory.

• Moving the directory to another location in the depot's directory tree.

Each of the above changes creates a new version of the directory element.

• AccuRev does not track changes to the contents of a directory. For example:

• Adding a new element to a directory or renaming one of its elements not a change to the directory 
-- it's a change to that particular element.

• Similarly, removing (with the Defunct command) an element from a directory is not a change to 
the directory -- it's a change to that particular element.

Each of the above changes creates a new version of the element within the directory, but does not 
affect the directory element itself.

Directory Merge Procedure
Since AccuRev tracks only namespace changes to a directory, not content changes, execution of the Merge 
command on a directory element never involves the Merge tool (or third-party tool). A conflict at the 
namespace-level merge involves making choices in the same one or two dialogs used for all kinds of 
elements.

The Merge Complete Dialog
The Merge Complete ("All conflicts have been resolved") dialog appears during a Merge tool session, 
when you accept a change that decrements the Conflicts count to "0 of 0".

Using the Merge Complete Dialog
You have these choices:

Keep & Exit

Ends the Merge session, closing the Merge tab. AccuRev overwrites the workspace file involved 
in the Merge with the merged version
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Note: You can think of the Merge tool as a fancy text-editor. It modifies the contents of a text file in 
the workspace. 

Then, it preserves this file by Keep'ing a new version in the workspace stream. If the file had (overlap) 
status in the workspace, that status is removed.

Note: The workspace file has (overlap) status when you're merging your workspace version with the 
version in the workspace's backing stream. When you're merging a Change Palette entry, using a 
workspace based on the destination stream, the workspace file does not necessarily have (overlap) 
status.

You can now Promote the new version.

Review

Resumes the Merge session, leaving the Merge tab open so that you can review your choices and 
changes. You can revise your merge choices and make manual edits. When you're done, click the 
Keep results and close button on the Merge toolbar:
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7. Security
This topic presents an overview of AccuRev's security-related features. We discuss and compare the 
following topics, and provide pointers to more detailed documentation.

Users and Groups
Each AccuRev user must have an AccuRev username (also called a "principal-name"). AccuRev maintains 
its own user registry in the repository; it is separate from the registry maintained by your machine's 
operating system (or the network).

Optionally, you can create AccuRev user groups, and add users to the groups as "members". Groups can be 
nested within one another; that is, a group can be a member of another group. AccuRev groups are 
independent of operating system groups.

AccuRev groups are used by the Access Control List (ACL) and Element Access Control List (EACL) 
facilities to grant or deny access to a particular resource for an entire set of users. Groups are used by the 
Locks facility to specify a set of users to which a stream lock does or does not apply.

Usernames and Groupnames
Each AccuRev group has a user-defined name. Usernames and groupnames share a "namespace" in the 
AccuRev repository. This means that a user and a group cannot have the same name.

User Authentication
With a few exceptions, a user cannot execute AccuRev commands unless he is authenticated as an 
AccuRev user. For authentication purposes, each registered AccuRev user has a username/password pair 
recorded in the registry. A user's password can be empty.

AccuRev automatically distinguishes two categories of users -- those who have non-empty passwords and 
those whose passwords are empty. The keywords authuser and anyuser, respectively, are used by the ACL 
facility to designate these categories.

The "AccuRev Login" User-Authentication Scheme
Most AccuRev users are authenticated by explicitly logging in to the AccuRev Server. Using the GUI or 
the CLI, the user logs in by entering his username and password (possibly empty). This launches a user 
session, which is typically of limited duration (a few hours). When the session expires, the user must login 
again to continue using most AccuRev commands.

A successful login command creates an encrypted session file that records the user's AccuRev username 
and password, along with the IP address of the client machine. If an AccuRev client command can be 
executed only by an authorized user, the command automatically sends the information in the session file 
to the AccuRev Server process. Thus, the user does not need to repeatedly 'remind' the AccuRev Server 
who (and where) he is.
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If a user is already logged in, and he successfully logs in again -- as the same user or a different user -- the 
existing session file is overwritten.

The "Custom" User-Authentication Scheme
AccuRev also supports script-based authentication of AccuRev users. For example, customers with an 
LDAP authentication scheme in place at their organization could configure a script to authenticate 
AccuRev users via LDAP. See Chapter 8 AccuRev Security Overview in the AccuRev Administrator's 
Guide for further details.

Locks on Streams
Each stream can have one or more locks on it. A lock prevents a certain set of users from using the stream 
to create new versions of elements. That is, it prevents execution of the Promote command -- either 
promoting from the designated stream, or promoting to the designated stream, or promoting in either 
direction.

A lock can be absolute, applying to all users. Alternatively, you can specify that a lock applies to a 
particular AccuRev user, or to a particular AccuRev group. Conversely, you can specify that a lock applies 
to everyone except a particular AccuRev user, or to everyone except a particular AccuRev group.

Locks can also prevent reconfiguration of the contents of a stream with the include/exclude facility.

For more on locks, see The Locks Command on page 51.

Access Control List (ACL) Permissions
In addition to (or instead of) locks, each stream can have one or more permissions on it. Whereas a lock 
controls the ability to create new versions (through the Promote command), a permission is more general: 
in addition to controlling Promote, it controls the ability to read data from the stream, using such 
commands as Annotate, Diff, and Open. A permission also controls workspace-specific commands, such as 
Update and Populate.

Unlike locks, which always apply to individual streams, ACL permissions can be configured to apply to 
entire stream subhierarchies.

You can also create an ACL permission that applies to an entire depot. This provides a way of controlling 
access to all of a depot's file system data, in all streams. It also provides a way to control access to issues in 
a depot.

ACL Permissions and Time Considerations
ACL permissions apply to a stream regardless of any basis time on the stream. Similarly, ACL permissions 
can be placed on a snapshot, even though such permissions are necessarily created after the snapshot is 
created.

For more on ACL permissions, see the description of The Security/ACL Subtab on page 278.

Element ACLs (EACLs)

AccuRev also provides element-level ACLs, called "EACLs". An EACL is a set of permissions that 
controls the privileges that individual users or user groups have with respect to a particular 
element. EACLs can only be set by an AccuRev administrator using either the AccuRev GUI or the CLI. 
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The following table shows you where to find more information on working with EACLs in AccuRev:

What Happens if You Are Denied Access?
GUI users can be denied access to elements or directories if an administrator has configured EACLs. 
Depending on the situation, you will either see an “Access Denied” error message, a (no such elem) status, 
or the element will be completely invisible to you, as if it does not exist:

• For commands that take element names, if you are denied access to the namespace or content, you are 
denied access.

• For commands that specify an eid, such as cat, the command will succeed if you are not denied access 
to that element. If you are denied access to the namespace of the element, the eid is displayed instead 
of the name.

• For commands that display transactions, such as hist, if you are denied access to the element in the 
transaction, the transaction is displayed, but “Access Denied” is displayed for the path name.

• For commands that take a transaction or issue, such as promote, if you are denied access to an element 
or elements in the trans or issue, the command succeeds and the elements are promoted, but the names 
are not displayed.

• Commands that modify workspaces, such as update and pop, will succeed even if you are denied 
access to some of the elements, but those elements will not be brought down to the workspace. The 
exception to this is if you specify the element name, such as with pop or co. In this case the command 
will fail as if the element doesn’t exist.

• For commands such as stat, dirstruct, and files, where you specify an option or nothing instead of an 
element name, if you are denied access to either the namespace or content, nothing will be displayed 
for that element. For example, stat –d displays all the elements in the default group of the stream. If 
you are denied access to an element in the default group, it will not be displayed.

• When you are denied access to an element, AccuRev behaves as if the element does not exist. 
Depending on the specific circumstances, AccuRev will either:

• Filter out the denied element altogether, so that there is no indication that it even exists. this is the 
default behavior.

• Return an Access Denied status. This occurs when the only element in a display is denied, and a 
blank display would be confusing (for example, if the Show Active Files display in the 
StreamBrowser contains only denied elements).

• Display a (no such element) status. If your access to an element or namespace changes during a 
session, and you are now denied access to something that was already displayed, that element or 
folder will appear with the (no such element) status.

If You Want To Learn... See...

More about EACLs and the privileges you 
can associate with an element

The section Element-Level Security (EACLs) 
in the AccuRev Administrator’s Guide

How to set EACLs using the AccuRev GUI Managing EACLs in the AccuRev GUI on 
page 265

How to set EACLs using the CLI The section eacl in the AccuRev CLI User’s 
Guide
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• If you have multiple Access Denied elements in the default group or in the Pending or Kept filters, the 
GUI will combine these into a single Access Denied row.

For information about EACLs, see Chapter 8 AccuRev Security Overview in the AccuRev Administrator’s 
Giude, and the command summary for eacl on page 97 of the AccuRev CLI User’s Guide.

Restricting Access to Commands using Triggers
By default, any registered AccuRev user can execute any AccuRev command. Many organizations wish to 
restrict users' access to certain commands, such as the ability to maintain users, groups, and passwords, the 
ability to lock streams and create ACL permissions, and so on. Triggers provide a flexible mechanism for 
implementing command-based security.

Many AccuRev commands can be configured to "fire a trigger". This causes a user-defined script to 
execute ...

• either before the command executes (pre-operation trigger), or afterward (post-operation trigger)

• either on the client machine, or on the server machine

A pre-operation trigger can affect the execution of the command or cancel it altogether. Typically, a 
security-related trigger checks the identity of the user invoking the command, then decides whether or not 
to allow the command to proceed.

Some triggers are configured on a per-depot basis, using the mktrig command. These triggers monitor 
individual commands (add, keep, and promote). Three are pre-operation triggers that fire on the client 
machine; one is a post-operation trigger that fires on the server machine.

Other triggers are configured, on a per-depot or whole-repository basis, by placing a script in a well-known 
location on the server machine. These triggers monitor groups of commands, rather than individual 
commands.

For more on triggers, see The Triggers Tab on page 50, and also Chapter 9 AccuRev Triggers of the 
AccuRev Administrator’s Giude.

Which Security Feature Should I Use?
AccuRev's security features overlap to a considerable extent. For example, when a user invokes the 
promote command, any of these mechanisms can prevent the command from proceeding:

• a lock on the source or destination stream

• an ACL permission on the destination stream, on a higher-level stream, or on the entire depot

• a read-only EACL privilege on the element being promoted

• a pre-promote-trig trigger script, which runs on the client machine

• a server_preop_trig trigger script, which runs on the server machine

How do you decide which feature to use in a given situation? There are no absolute rules, but here are 
some guidelines:

To script or not to script?

The trigger mechanism depends on execution of user-supplied scripts, written in Perl, Python, or some 
other scripting language. There's a trade-off: scripting required development time and significant 
expertise, but is infinitely flexible.
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In many situations, you may be able to use the AccuRev software distribution's sample Perl scripts, 
which are designed for fill-in-the-blanks customization.

It makes sense to implement as much security as possible with locks and ACL permissions (and 
perhaps the sample trigger scripts), before delving into original trigger scripting.

Locks vs. ACL permissions

Roughly speaking, a lock controls the placing of data into a stream, whereas an ACL permission 
controls the reading of data from a stream. (There are plenty of exceptions to this general rule.)

Both locks and permissions can be targeted at specific users or groups. The ACL is more flexible: you 
can create any number of permissions for the same stream, but only limited number of locks.

ACLs vs. EACLs

ACLs govern access to depots and streams, with broad all or none rights. EACLs govern access to 
individual elements in the depot, and provide finer-grained privileges for an element: Full, Allow, 
Read Only, and Deny. Note that if the ACL on a stream is set to none for a given user, you cannot set 
EACLs for elements in that stream for that user.

Running trigger scripts: client machine vs. server machine

Running trigger scripts on the client machine conserves networking and server resources. But keep in 
mind that all client machines must have copies of the scripts (or must have network access to a central 
script repository).

Running trigger scripts on the server machine provides administrative simplicity and centralized 
logging.

Managing EACLs in the AccuRev GUI
This section describes how to manage EACLs in the AccuRev GUI. You can also manage EACLs using 
the CLI. (Changes that you make using one interface are reflected in the other.) See the section eacl in the 
AccuRev CLI User’s Guide for more information on using the CLI. See Element-Level Security (EACLs) 
on page 60 of the AccuRev Administrator’s Guide for more detailed information on EACLs, permissions, 
and privileges.

Effect of Setting Permissions on an Element
By default, all users have the Allow privilege for elements under AccuRev control. Generally speaking, 
you use the procedures described in this section to assign a more restrictive privilege (like Read Only or 
Deny, for example) to an element, or to restore a user’s default privileges.

When you specify a privilege for an element, that setting is reflected throughout the depot. Consider the 
following simple depot:

If you change the privilege for an element in the velo_dfoster workspace, that change is automatically 
reflected in all the other streams in the depot; the same is true for changes made to an element’s privileges 
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in, say, the int stream. In other words, you do not have to promote an element or update a workspace to 
propagate changes to its privileges throughout the depot.

Setting Permissions for an Element
Use this procedure to set permissions for an element. If you want to control access to a stream, use ACLs. 

To set permissions for an element:

1. In the File Browser, select the elements whose permissions you want to set. 

For example:

2. Right-click one of the selected files and choose Permissions... from the shortcut menu.

Alternatives: Use the Ctrl+E accelerator key, or choose Actions > Permissions... from the main 
menu.

The Set Element Permissions dialog box appears.

3. In the Elements list box, select the element whose privileges you want to modify.

Tip: You can select only one element at a time.
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The Users/Groups list box displays the principals who currently have access to the element you 
selected, and the privileges specified for that element.

Note: The "All Users" name means just that -- all users and groups defined in the depot. Exceptions 
(like users banthony and jalan) are called out separately. In this example, all users have Allow privi-
leges for forms.xml, except users banthony and jalan, who have Read Only access for that element.

4. Click the Add button.

The Add Principals dialog box appears.
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Note that the list does not include any principals for whom privileges have already been defined for the 
selected elements. In this example, users banthony and jalan do not appear because privileges have 
already been set for them for the selected element. (Use the Edit action to change existing privileges. 
See Editing Permissions on page 270 for more information.)

5. Select the principal whose privilege you want to set for the element selected in Step 3.

Note: Changes that you make to permissions take effect as soon as you click the Ok button in the Add 
Principals dialog box.

6. Select the privilege you want to assign and click the Ok button.

If you selected a directory in Step 1, AccuRev asks whether you want to apply the privilege recursively 
to all elements in that directory. See Setting Permissions on a Directory on page 269 for more informa-
tion on this topic.

The change you made appears in the Users/Groups list box. Here, for example, we see that the privi-
lege for user eharvey has been changed from Allow to Read Only for the element selected in Step 3:

7. If you selected more than one element in Step 1, return to Step 3 and repeat this procedure for the 
remaining elements.

Otherwise, click Close.
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Setting Permissions on a Directory
When you set permissions on a directory, AccuRev displays a dialog box that allows you to specify 
whether or not you want these permissions to be applied recursively:

Choose:

 Yes to apply the permission to the selected directory, all child directories, and all elements within those 
directories.

 No to apply the permission to the selected directory only. 

 Cancel or click the X button on the dialog box to cancel the operation without making any changes.

Consider the following example. Here, the Deny permission was set recursively on the /forms directory for 
user jmarie. You can see that the Deny permission was set for elements within the 
/forms/xml directory, as with the euc-jp_prefs.xml file:
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Editing Permissions
Use this procedure when you want to edit the permissions associated with an element.

1. Display the Set Element Permissions dialog box. See Setting Permissions for an Element on page 266 
if you need help with this step.

2. In the Elements list box, select the element whose permissions you want to edit.

The Principals list box displays all of the users and groups who currently have a privilege set for that 
element.

3. In the Principals list box, select the user or group whose privilege you want to modify.

4. Click the Edit button.

The Edit Permission dialog box appears. The user’s current privilege is selected by default.

5. Select the desired privilege and click Ok.

The changes you make are applied immediately.

Copying Permissions
Use this procedure when you want to copy the permissions associated with one element and apply them to 
another element.

Note: When you paste, any existing permissions associated with the target element are overwritten.

1. Display the Set Element Permissions dialog box. See Setting Permissions for an Element on page 266 
if you need help with this step.

2. In the Elements list box, select the element whose permissions you want to copy.

3. Click the Copy Permissions button to copy that element’s permissions.

4. In the Elements list box, select the element to which you want to apply the permissions you copied in 
Step 3.

5. Click the Paste Permissions button to paste the copied permissions to the selected element.

The changes you make are applied immediately.
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Removing Permissions
Use this procedure to remove permissions for an element from one or more users.

Note: When you remove a privilege that you explicitly set for a user or group, that privilege reverts to the 
value set for any group to which that user or group belongs. Note, however, that the default behavior for an 
element whose ACL does have any permissions defined for a user is to deny access to that user.

1. Display the Set Element Permissions dialog box. See Setting Permissions for an Element on page 266 
if you need help with this step.

2. In the Elements list box, select the element whose permissions you want to modify.

The Users/Groups list box displays all of the users and groups who currently have a privilege set for 
that element.

3. In the Users/Groups list box, select the user or group whose privilege you want to remove for this 
element.

Tip: Use Shift+click or Ctrl+click to select multiple users or groups.

4. Click the Remove button.

File Locking
Parallel development is flexible and powerful, but it is not appropriate for every situation. Some 
organizations don't like the extra steps involved in merging, even though merging is largely automated. 
Some files cannot be merged, because they are in binary format. (The merge algorithm handles text files 
only, not binary files such as bitmap images and office-automation documents.)

Serial Development and Parallel Development
Accordingly, AccuRev supports both serial development, through its exclusive file locking feature, and 
 parallel development. Exclusive file locking can be implemented at the depot level, the workspace level, 
or the element level (when you place the file under version control or when you create a new version).

The serial development model places more restrictions on users in the edit stage, but it eliminates the 
merge stage altogether.

Example:

Here's a standard scenario, in which all the workspaces are in serial-development mode:

1. A user starts working on a file by specifying it in a Send to Workspace ("checkout") or Anchor 
command. The file changes from being read-only to writable.

2. AccuRev places an exclusive file lock on the file. This prevents the file from being processed with 
Send to Workspace, Anchor, or Keep in other workspaces.

3. The user can edit and Keep any number of private versions of the file in his workspace. Then, the user 
Promote's his most recently kept version to the backing stream. The exclusive file lock guarantees that 
no Merge will be required before this promotion.

4. After Promote records the new version in the backing stream, things return to the initial state: 
AccuRev releases the exclusive file lock, and the file returns to read-only status in the user's 
workspace.
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5. A user in any workspace can now Send to Workspace or Anchor the file, which starts the exclusive-
file-locking cycle again.

If exclusive file locking applies to a file element, and the element is not currently active in any sibling 
workspace:

• It is maintained in a read-only state in your workspace tree.

• If the element is active in a sibling workspace, you cannot make the element active in your workspace.

• If the element is not active in a sibling workspace, you can make it active in your workspace with the 
Send to Workspace or Anchor command. This makes the file in your workspace tree writable. (You 
must do this before you can use Keep to create a new version.) You can also make an element active 
with Revert, Rename, Defunct, Paste (after a Copy), or the CLI command undefunct.

Note: In this context, workspaces are considered siblings if they promote to the same stream. If the 
stream hierarchy includes pass-through streams, workspaces can be siblings even if they have different 
parents.

An exclusive file lock on a file element is released when active development on the file ends in that 
workspace:

• A promote command sends your private changes to an element from your workspace stream to the 
backing stream.

• A purge command discards your private changes to an element.

Either way, the workspace returns to using a backing-stream version of the element.

The Limited Effect of an Exclusive File Lock
Exclusive file locking does not freeze an element completely:

• The lock applies only within the scope of a particular backing stream. It doesn't affect other backing 
streams and the workspaces based on them.

• The lock acquired through workspace-level or depot-level exclusive file locking applies only to 
workspaces in serial-development mode. Users in parallel-development-mode workspaces can make 
changes and promote the changes to the backing stream.

• A lock placed on an individual file element in a workspace applies to all sibling workspaces, but not to 
other workspaces.

• The lock doesn't prevent the current version in the backing stream from being promoted to higher-level 
streams.

Exclusive file locking does not prevent any user from modifying any file with a text editor or IDE. 
AccuRev encourages users in serial-development-mode workspaces to "ask permission first": it maintains 
files in a read-only state, and makes a file writable when a user executes a co or anchor command on it. 
But users can modify a file "without asking permission", by changing the access mode (UNIX: chmod 
command, Windows: attrib command or Properties window) and then editing it. Such "unauthorized" 
changes can't be sent to the AccuRev depot, though: the exclusive file lock disallows a Send to Workspace, 
Anchor, or Keep.

Anchor-Required Workspaces
AccuRev also offers a less-restrictive variant of exclusive file locking. Anchor-required workspaces 
allow parallel development, with multiple users modifying the same file at the same time (in their own 
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workspaces). In an anchor-required workspace, all elements are maintained in a read-only state when you 
are not actively working on them. Using such a workspace is similar to working with exclusive file 
locking, except that you are not constrained by elements' activity in sibling workspaces:

• You can make a file element active with the Send to Workspace or Anchor command. This makes the 
file writable. You must do this before you can use Keep to create a new version.

• You can also make an element active with Revert, Rename, Defunct, Paste (after a Copy), or the CLI 
command undefunct.

The Security/Users Subtab
The Users subtab of the Security tab displays the repository's set of registered AccuRev users, and 
provides commands for maintaining the set of users. Various security (and non-security) features involve 
users:

• Before executing any AccuRev commands, you must Login as a particular user.

• Access Control List (ACL) entries can apply to particular users or to particular groups.

• AccuWork issue records can contain fields whose value must be a particular AccuRev user.

Opening a Security/Users Subtab
Choose Admin > Security from the GUI main menu to display the Security tab. Then, click the Users 
subtab.
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Security/Users Subtab Layout
The Users subtab contains a table with these columns:

Status

(appears if Show hidden users  is checked) Inactive indicates that the username has been removed, 
and can't be used in a Login command, or in the definition of an ACL entry or a lock. A removed 
user can subsequently be Reactivated.

Name

The username. You can change a username (for example, from derek to dpost) without disrupting 
AccuRev's bookkeeping, because it tracks user identities by their unique, immutable integer IDs.

A user cannot have the same name as any other user, or the same name as any group. See User-
Specified Names for AccuRev Entities on page 17.

License Type

The type of license associated with the user. Values include Full (AccuRev, AccuWork, and 
Kando), AccuWork, and Kando Only.

#

The integer that uniquely identifies this user. This number cannot be changed. Note: The same 
"namespace" of integer IDs is shared by users and groups.

Working in a Security/Users Subtab
You can use this subtab to activate/deactivate users, and to perform operations that maintain the user 
registry.

Controlling Which Users are Displayed

Show hidden users

If checked, the table includes users that have been deactivated with the Remove command. This 
also adds a Status column.

Creating a New User
Note: In order to successfully add a user, there must be at least one available user license.

To create a new user:

1. Click the Add User button ( ) on the toolbar.

The New User dialog box appears.
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2. In the User Name field, specify the new user’s name.

3. In the Password (Optional) field, optionally, specify a password; reenter the password in the Confirm 
Password field.

4. Specify the type of license you want to associate with this user. 

5. Click Ok.

Operating on a Selected User
You can choose any of the following commands from the context menu of a selected user:

 Edit User

Use this command to change either the user’s name or license type. See User-Specified Names for 
AccuRev Entities on page 17.

Change Password

Change this user's password. Note: AccuRev allows you to change any user’s password, not just 
your own. But your organization might use a trigger to disallow all but a few administrative users 
from changing another user's password.

See User-Specified Names for AccuRev Entities on page 17.

Reactivate User

Reactivate a user who has been deactivated with Remove User. In order to succeed, there must be 
at least one available user license.

Remove User

Deactivate the selected user. No one can Login as that user, but the user still appears in the 
repository's historical records, such as the History Browser. You can use the Reactivate User 
command to bring back a removed user.

The Security/Groups Subtab
The Groups subtab of the Security tab displays the repository's set of user groups. Individual users can be 
members of any number of groups. Likewise, a group can belong to -- that is, be a subgroup of -- any 
number of other groups.
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Access Control List (ACL) entries can apply to particular users or to particular groups.

Opening a Security/Groups Subtab
Choose Admin > Security from the GUI main menu to display the Security tab. Then, click the Groups 
subtab.

Security/Groups Subtab Layout
Status

(appears if Show hidden groups  is checked) Inactive indicates that the group has been Removed, 
and can't be used in the definition of an ACL entry or a lock. A removed group can subsequently be 
Reactivated.

Name

The group name. You can change a group name (for example, from sptgrp to sport_group) 
without disrupting AccuRev's bookkeeping, because it tracks group identities by their unique, 
immutable integer IDs.

A group name can be up to 96 characters long. A group cannot have the same name as any other 
group, or the same name as any user. See User-Specified Names for AccuRev Entities on page 17.

#

The integer that uniquely identifies this group. This number cannot be changed. Note: The same 
"namespace" of integer IDs is shared by users and groups.
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Working in a Security/Groups Subtab
You can use this subtab activate/deactivate groups, and to perform operations that maintain groups and 
their memberships.

Controlling Which Groups are Displayed

Show hidden groups

If checked, the table includes group that have been deactivated with the Remove command. This 
also adds a Status column.

Creating a New Group

Use the  toolbar button to create a new group.

Add Group

A New Group dialog appears, in which you specify the group's name and its members.

To specify a group's membership, select one or more users and/or groups, and click the  or  
button to move them between the Members and Not members lists.

A user can be a member of any number of groups. Likewise, a group can belong to (be a subgroup 
of) any number of groups.

Tip: You can filter both lists. Filters use an "includes" logic to display only those principal names 
that include the characters you enter.

Operating on a Selected Group
You can choose any of the following commands from the context menu of a selected group:
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Change Group

Change the name that AccuRev associates with this group identity, or change the group's 
membership. A Change Group dialog appears, works the same way as the New Group dialog.

A user can be a member of any number of groups. Likewise, a group can belong to (be a subgroup 
of) any number of groups.

Reactivate Group

Reactivate a group that has been deactivated with Remove Group. 

Remove Group

Deactivate the selected group.

The Security/ACL Subtab
The ACL subtab of the Security tab displays the repository's set of access control list (ACL) entries, also 
called permissions. Each stream and depot in the repository can have any number of permissions. Note: 
For this command, "stream" can be a dynamic stream, a workspace stream, or a snapshot.

Each permission controls the ability of a particular user, or a particular set of users, to access that stream or 
depot.

Opening a Security/ACL Subtab
Choose Admin > Security from the GUI main menu to display the Security tab. Then, click the ACL 
subtab.

Security/ACL Subtab Layout
The table in the ACL subtab includes these columns:

Type

The type of resource to which the permission applies: Stream or Depot.
Resource

The name of the stream or depot to which the permission applies. The permission also applies to 
(is inherited by) the entire subhierarchy below that resource, but it can be overridden at a lower 
level. 
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Note: Because permissions are inherited down a depot's stream hierarchy, a permission on a depot 
is almost equivalent to one on the depot's base stream. The only difference is that a depot 
permission also affects access to the depot's issues.

Applies To

The user or set of users to which the permission applies: all users with passwords (identified as 
"authuser" in the AccuRev CLI), all users without passwords ("anyuser" in the CLI), a particular 
user, or a particular group.

Rights

all: the user(s) can access the resource.

none: the user(s) cannot access the resource.
Inheritable

Depot permission:
yes: the permission applies to the depot, and also to the depot's entire stream hierarchy.

no: the permission applies only to the depot, not to any of the depot's version-controlled 
elements.

Stream permission:
yes: the permission applies to the entire subhierarchy below the stream in the Resource 
column.

no: the permission applies only to the stream in the Resource column, not to any lower-level 
stream.

How Individual Commands Use the ACL
The following commands check ACL entries on one or more dynamic streams, workspace streams, or 
snapshots before proceeding. In the following, 'stream' can be a dynamic stream, workspace stream, or 
snapshot. If a version is being accessed from stream A, and that version is cross-link'ed to stream B, 
AccuRev checks the ACL permissions on stream A only, not on stream B.

• Anchor, Defunct, Populate, Revert to Backed, Revert to Most Recent Version, Update and File Browser 
searches check the current workspace.

• Annotate, View, and Send to Workspace check the stream of the version being accessed. Send to 
Workspace also checks the current workspace.

• Promote checks the stream to which the version(s) are being promoted.

• Include from Stream and Clear Rule check both streams involved in the cross-link.

• The various Diff Against ... commands check the streams of both versions being compared.

• Merge checks the workspace/stream in which you're doing the merge, as well as any stream explicitly 
mentioned on the command line.

• Remove and Reactivate stream check the stream being changed.

• New Workspace, New Stream, and New Snapshot check the specified backing stream for the 
workspace/stream/snapshot being created.

• Change Stream checks the stream being changed (and, if appropriate, its new backing stream).

• View Streams checks the depot.
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• In a Stream Browser tab, Show History checks the selected stream. In a Depots tab, Show History 
checks the selected depot.

Conflicting Permissions
Two or more permissions on a resource can apply to the same user, or to the same stream. In such cases, an 
all permission overrides one or more none permissions. This makes it easy to implement "all but" access 
controls.

Example 1: "all but" at the user level

The permissions shown here prevent everyone in the Cupertino group -- except for users charlie and 
jalan -- from accessing stream velo.

Example 2: "all but" at the stream level

The permissions shown here restrict the Lowell group to working in the maint stream subhierarchy. 
Members of this group cannot work with other streams in the velo depot.

Working in a Security/Access-Control Subtab
Use the following commands to maintain the set of permissions in the repository's access control list.
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Add ACL Entry

Change ACL Entry

The same dialog enables you to create a new ACL permission, or to modify an existing one.

Resource: Select one of the repository's depots from the Depot listbox.
• If you want the permission to apply to the depot itself, leave the Set Permission for Stream 

checkbox cleared.

• If you want the permission to apply to one of the depot's stream, check the Set Permission for 
Stream checkbox, and choose a stream from the Stream listbox.

• If you want the permission to apply to the entire subhierarchy below the specified stream, 
check the Inheritable checkbox.

Security Group: Use the radio buttons (and listboxes) to specify an individual user or a single 
group to which the permission will apply. (You can't specify multiple users or groups, but you can 
produce the same effect by creating multiple permissions on the same resource.)

Permission: Select all or none from the listbox.

Remove ACL Entry

Deletes the selected entries from the access control list.
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The Available AccuRev Servers Dialog
(and the New Server and Edit Server dialogs)

The Available AccuRev Servers dialog provides a way to maintain the list of AccuRev Servers to which 
you can login. Each client installation of AccuRev maintains its own AccuRev Server list, in file 
<AccuRev-install-dir>/bin/acclient.cnf.

Invoking the Available AccuRev Servers Dialog

Choose Tools > Login from the GUI main menu. Then click the  button in the Login dialog.

Using the Available AccuRev Servers Dialog
To switch to another AccuRev Server, select its entry, and click Close.

Click the Name column header to reverse the order in which the AccuRev Servers are listed.

Toolbar Commands
The toolbar includes the following commands for maintaining the AccuRev Server list:
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Add Server

Identify an instance of the AccuRev Server, to which anyone using this client installation will be 
able to log in. A dialog appears, in which you identify the Server 

The Address can be a name (e.g. abbot or abbot.myfirm.com) or an IP address (123.156.189.047). 
Be sure to specify the correct port number for that Server. No attempt is made to check the validity 
of the new entry.

Edit Server

Modify the address and/or port number of the selected entry in the list. No attempt is made to 
check the validity of the modified entry.

Remove Server

Remove the selected entry from the list. This does not affect that AccuRev Server process; it 
merely removes the Server from this client installation's list.
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A. Miscellaneous Error Displays

No Query Results Error
This error box appears when a set of AccuWork issue records is to be displayed, but no table display 
format has been defined in the Change Package Results pane of the Change Packages subtab of the Schema 
Editor tab. 

Diff Previous Transaction Error
This error box appears when the selected version is the first version created in a stream or workspace. 
Thus, the search for a prior version in the stream or workspace fails.

The Issues Conflict Message Box
This error box appears when there is no way to produce a valid change package entry for an element, by 
combining your new set of changes with the existing change package entry. The requirement that the basis 
version must be an ancestor of the head version cannot be fulfilled.

You can remedy this situation by performing a merge at the element level. (There is no merge operation 
defined for change package entries.) In the example above, merging version H and version X would create 
a new version; a change package entry with the new version as its head can be combined with the existing 
entry.

No Schema Error
This error box appears when AccuWork has not been configured in the current depot. Use the Admin > 
Schema Editor command to define a schema.

Promote Coalesce Error
If a promote-by-issue operation (a standard child-to-parent promote, not a cross-promote) involves 
multiple issues whose change packages include the same element, AccuRev attempts to combine or 
coalesce those entries into a single, valid change package entry. If the element’s change package entries 
cannot be coalesced (caused, for example, by a “gap”), the promote operation fails.
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If this occurs, please follow the steps described in “Cross-Promoting Issues to a Non-Parent Stream — 
Patch Required” in the AccuRev Technical Notes.

Which update topic?
Which help topic would you like?

• General help on the Update command: see Updating a Workspace on page 30

• Help on the Update progress box only: see The Update Progress Box on page 130

Note: Why am I here? I was using the include/exclude facility or the Populate command.

• The commands that you execute in the File Browser's include/exclude mode complete their work by 
performing an Update of the workspace.

• The Populate command does not perform an Update, but these two commands use the same low-level 
routines to copy files from the repository to the workspace tree.
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B. AccuWork

This chapter describes how to work with AccuWork issues in the AccuRev GUI.

The Edit Form Tab
The AccuWork Edit Form tab provides a familiar, easy-to-use interface for creating new issue records and 
modifying the contents of existing issue records. The edit form also provides access to an issue record's 
change package.

Opening an Edit Form Tab

To create a new issue record, choose Issues > New Issue from the GUI main menu, or click the   button 
in the GUI main toolbar.

To modify an existing issue record, choose Issues > Look Up from the GUI main menu, or click the   
button in the GUI main toolbar.

AccuWork prompts you to enter the issue record's unique issue number (an integer). 

If you have implemented third-party issue tracking system (ITS) keys in your AccuWork schema, this 
dialog box displays a pair of radio buttons that let you indicate whether you want to use AccuWork issue 
numbers or third-party ITS keys when looking up issues. See the “Using Third-Party ITS Keys” chapter of 
the AccuRev Technical Notes for more information.

Notes:

Multiple depots

A typical AccuRev repository contains multiple depots.  Each depot can have its own AccuWork con-
figuration. In each depot, the issue records are numbered sequentially: 1, 2, 3, ... The New Issue or 
Look Up command applies to the current depot.

Alternate lookup field

AccuWork can be configured to use a lookup field other than the default (field name issueNum, field 
label Issue). In this case, the label for the configured field appears in the prompt window, and you must 
enter a value that exactly matches (except for uppercase/lowercase) some issue record's value of that 
field.
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Edit Form Tab Layout
All AccuWork edit forms have these features in common:

• The edit form consists of one or more pages, which appear as subtabs within the overall GUI tab. 
Typically, there's a header section, which always remains visible as you switch from page to page, 
using the mouse.

• Each field is represented by a simple text box, a multiple-line text box, a multiple-choice listbox, or a 
more complex user-interface "widget". To the left of this widget is a descriptive label for the field. (A 
red label indicates a required field.)
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Special Subtabs
Every edit form has two special subtabs, which appear and work differently than the standard fill-in-the-
blanks "pages":

• The Changes subtab displays the issue record's change package, and provides commands for 
analyzing and manipulating the change package's entries.

• The Issue History subtab displays a complete breakdown of how the issue record's field values have 
changed over time.

Workflow Toolbar
If your site is configured to use the optional AccuRev workflow feature, your Edit Form may display the 
following workflow toolbar:

AccuRev Workflow is documented in the AccuRev® Web Interface User’s Guide, Version 2012.1 or later, 
but a brief summary of this toolbar is:

Workflow:

A label that identifies the name of the workflow to which the current issue is subject.

Stage: 

A label icon that identifies the issue's current workflow stage. (This is not clickable.)

Transitions: 

One or more buttons that execute any transitions that are valid for the issue. 

Note: If an issue doesn't match any workflow stages, or is subject to multiple workflows, AccuRev 
displays a message to that effect where the buttons would otherwise appear. If an issue's fields don't 
match with the logic specified for a  transition, the transition button appears, but it is grayed out until  
the user changes the fields required to bring the issue into compliance.

Working in an Edit Form Tab
You can enter and change values in any number of fields, and visit different pages in a multiple-page form. 
Here are some notes, describing aspects of AccuWork edit forms that may differ from other fill-in-the-
blanks forms:

1. Navigating fields and pages

To move from field to field, use the mouse or press Tab and Shift-Tab. To move from page to page in 
a multiple-page edit form, click the subtab name (there is no keyboard accelerator).

The Enter key confirms a menu choice or enters a line-break in a multiple-line text field. It does not 
perform field navigation. Within a multiple-line text field, the Tab key inserts a TAB character, rather 
than jumping to the next field.

2. Browsing multiple issue records
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While you’re working with issue record, browse arrows are enabled in the edit form’s toolbar.

This makes it easy to view a set of consecutive issue records. If you’ve made some changes that you 
haven't yet saved, AccuWork prompts you to save or discard those changes before switching to the pre-
vious or next one.

3. Field initializations

When an edit form appears after you invoke the New Issue command, you may notice that some fields 
already have values. AccuWork can include any number of such field initializations.

4. Required fields

If a field's label appears in red, it is a required field. You cannot Save the issue record until every 
required field has a value. (A text field has a value if it's non-empty. A multiple-choice listbox field has 
a value it it's not “<none selected>”.) Some of those fields may have gotten their values through an 
automated field initialization. 

If you attempt to save the issue record when one or more required fields still need a value, a pop-up 
window prompts you to supply the value(s).

5. Other field validations

Field initializations and required fields are implemented through AccuWork's field validations (or "edit 
checks") facility. As you work in an edit form, changing field values, you may notice these field-vali-
dation effects:

• A text field, multiple-choice listbox field, or timestamp field has automatically been set to a 
specified value.

• The set of required fields has changed.

• A listbox's set of choices has changed.

• The entire issue record, a particular page (subtab), or a particular field has been set to read-only 
status.

6. An issue record's unique identifier

Each issue record has an integer identifier, its issue number. This number is unique within the depot 
(but not within the entire repository). AccuWork assigns the issue number automatically the first time 
the issue record is Save'd, and it cannot be changed thereafter. The issue number is stored in field 
issueNum. By default, the label for this field in an edit form is Issue, but the edit-form designer can 
change the label for this field.

Saving or Discarding Your Work

Your entries in an edit form are not stored in the issue record until you click the  Save or  Save & 
Close button in the edit form toolbar. If you don't wish to save your work, just close the edit-form tab as 
you would any GUI tab.
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When you save an issue record:

• (for a new issue record) AccuWork assigns the next available integer issue number to the new issue 
record. This number cannot be modified.

• The issue record is stored in the depot. A transaction of kind dispatch records the creation or 
modification of the issue record. No matter how the issue record is modified subsequently, you can 
revisit the issue record in its current form on the Issue History subtab.

• If you clicked Save, the edit form tab remains open, with the newly assigned issue number replacing 
the "New Issue" label and appearing in the Issue field.

Note: "Issue" is the default label for the issueNum field, but it might have a different label, depending 
on how the schema is configured. 

• If you clicked Save & Close, the edit form tab closes.

Working with Special Fields
AccuWork supports special field types, which have special user-interface "widgets" on an edit form. These 
are described in the following sections.

Timestamp field

You can fill in the individual subfields manually, or use the  Select Date button to display choices 
("tomorrow", "2 days ago", etc.) that fill in the subfields automatically. Once these subfields are filled in, 
you can revise them individually or by clicking the Select Date button again.

Multiple-Line Text and Log fields
A text field can have multiple lines, and can also specify both the width and the height of the textbox on the 
edit form. 
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When you use the form you can use the  control at the top of the textbox to temporarily expand the 

height. Click the control again (it is now ) to contract the height. A scroll bar appears on the textbox 
whenever the current contents of the field are not completely visible.

A log field is a variant of a multiple-line text field. You can type directly into such a field. And if you click 

the  Add Timestamped Text control, a timestamp text line is inserted at the beginning or end of the field.

Rich text fields
If support for rich text has been enabled by your AccuRev administrator, AccuWork displays tools to help 
you work with HTML, as shown in the following example of a Description field:

The following table summarizes rich text tools and what they do.

Tool Description

Show Source button Displays the HTML source for formatted text. When clicked, the button text 
changes to Hide Source. Clicking the Hide Source button reverts the display to 
formatted text only.
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Fields for which rich text support has been enabled display formatted text (numbered lists and bolded text, 
for example) by default. For example, if you create an issue in the AccuRev Web UI or a third-party issue 
tracking tool that supports rich text, the formatted text is displayed in AccuWork.

Note: If a field contains unescaped bracketed text in, say, a third-party issue tracking system, AccuWork 
renders the brackets and the string they contain as a button, as is the case with the string <unescaped> in 
the example shown here:

Toolbar Contains tools for text formatting and working with elements like table and 
images
 Font size
 Font color
 Bold text
 Italic text
 Underlined text
 Unordered list
 Ordered list
 Hyperlink
 Image

Tool Description
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To resolve issues like this:

1. Click the Show Source button to display the HTML source.

2. Copy the HTML source.

3. Click the Hide Source button to revert to the rich text display.

4. Replace the rich text with the HTML source you copied in Step 2.

Rich text support is available for fields with a data type of either Text or Log and is enabled on a per-field 
basis. See Enabling Rich Text for Text and Log Fields on page 326 for more information.

Timespan field
A timespan field is AccuWork's only numeric field type. You can type any value into the field, but when 
you leave the field, AccuWork automatically erases a non-numeric value. Negative numbers and decimals 
are allowed. If you enter an integer (e.g. 45), it is automatically converted to a decimal (45.0). 

Attachments field
An edit form can contain one or more attachment fields. In each such field, you can specify one or more 
files and/or Internet addresses (URLs) to be attached to the current issue record. AccuWork displays the 
attachments data as a table.

In addition to specifying the location of a file or Internet resource, you enter a name and optional comment. 
AccuWork automatically fills in your username, the date, and the size of the attached file. (Internet URLs 
are assigned a size of 0.) If the edit-form field is not large enough to show all these attachment parameters, 
use the scroll bar to see all the data. You can also resize and rearrange the columns of an attachments table.

An attachment field includes its own toolbar, with these buttons:

New Attachment

Define a new file attachment for this issue record. A New File Attachment dialog appears, 
in which you can specify one or more files, a name for the attachment, and a comment 
string.

You can specify multiple files at once -- each one becomes a separate file attachment. In 
this case, the Attachment Name input field is disabled; each filename is automatically 
assigned as the attachment name. The comment string that you specify is assigned to each 
file attachment.

New URL
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Define a new attachment to be the address (URL) of an Internet resource. A New URL 
Attachment dialog appears, in which you specify a URL, a name for the attachment, and a 
comment string. AccuWork inserts the string http:// in the URL field. You can erase this if 
you want to specify a location accessed by another Internet protocol, such as ftp:// .

Open Attachment

Open the existing attachment that is currently selected, using the appropriate program.

Save Attachment As

Create a copy of the currently selected attachment on the client machine.

Properties

Launch a Properties window, displaying the definition of the currently selected 
attachment. You can use this window to change the attachment's Name or Comment 
value.

Delete Attachment

Remove the attachment from the issue record (and from the depot). A URL attachment 
can be deleted at any time. A newly added file attachment can be deleted if you haven't yet 
Save'd the issue record.

When you save the issue record, each file is copied to the depot, so that the data always remains available 
through the issue record, even if an original file is deleted.

Relationship field
AccuWork supports several kinds of relationships between a pair of issue records:

• Duplicate: You can specify that issue record B duplicates issue record A, so that no work need be done 
on B. (Perhaps the same bug was reported twice.) Any number of records (B, C, D, ...) can duplicate a 
given record (A). The default AccuWork issue schema requires that a Duplicate relationship be 
established when an issue record's State field is set to the value Duplicate.

• Dependency: You can specify that issue record B depends on issue record A (for example, from a 
project management viewpoint). AccuRev imposes no further semantics on such dependencies; this is 
a good application for user-defined scripts or practices.

IMPORTANT NOTE: This relationship is independent of change package dependency relationships among 
issue records, which are maintained automatically by AccuRev.

• Subtask: You can specify that issue record B defines a subtask of the work to be performed for issue 
record A. In this case, AccuRev considers issue record A to be "in" a particular stream only if issue 
record B is "in" that stream, also.

You cannot create "relationship chains": for example, if B duplicates A, you cannot make C a duplicate of 
B.

Issue record relationships can be viewed only in the AccuWork GUI. The edit-form tables that display 
issue relationships are not included when you export an issue record (for viewing or printing). These tables 
are not included when you use the AccuWork command line interface (CLI) to dump the contents of an 
issue record. (see the AccuWork™ Command-Line Interface chapter in the AccuRev CLI User’s Guide.)

When you create or delete a relationship between issue records, the change to both issue records is saved 

immediately. There is no need to invoke the Save command on the issue record.(The  Save button is not 
enabled in the edit-form toolbar.)
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Viewing and Maintaining an Issue Record's "Duplicate" Relationships
The "duplicate" relationship is not symmetrical: "A duplicates B" is not the same as "B duplicates A". 

Accordingly, an edit-form field displaying a duplicate-type relationship consists of two tables: the top table 
shows issue records that are duplicated by the current record; the bottom table shows issue records that the 
current record duplicates.

Because of the "relationship chains" restriction, issue records can appear in only one of these tables, not 
both.

On the other hand, "A duplicates B" is the same as "B is duplicated by A". This means that when you add 
an entry to the top table of one issue record, AccuWork automatically adds it to the bottom table of the 
other issue record (and vice-versa).

A Duplicate relationship field has its own toolbar, with these buttons:
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Link Issue

Create a relationship link with another issue record. AccuWork prompts you to enter an 
issue record number.

Remove Link

Remove the selected relationship link.
Note: Duplicate Relationship and Duplicate State

In AccuWork's default issue schema:

• There is a State field in the header section, one of whose values is Duplicate. (The Status 
value must be Closed to enable the setting of the State value to Duplicate.)

• There is a Duplicates field in the Relationships subtab.

• An edit-form validation specifies that when you set the State field's value to Duplicate, you 
must indicate which issue record is duplicated, by creating an entry in the Duplicates field.

Exporting an Issue Record (Printing)
At any time when you're using an edit form, you can print the issue record. For AccuWork, printing means 
"publish to the Web" -- which means either "create an HTML file" or "create an XML file".

1. Click the  Export button in the form's toolbar.

2. Select the file type in the Save As dialog that appears.

3. Specify a pathname for the export file. You don't need to specify the .html or .xml suffix -- AccuWork 
adds it automatically.
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When creating an HTML file, AccuWork outputs all the content of the issue record and approximates the 
form layout, too. Even if the edit form has multiple pages, you need to "print" only once. All of the pages 
are combined into a single HTML or XML file:]

On Windows machines, AccuWork automatically invokes a web browser on the HTML file it creates. If 
you wish, resize the browser window to optimize the look of the issue record. HTML documents 
automatically adjust to changes in window width. Then, use the browser's print command to create a 
printout of the issue record.

The Edit Form Tab -- "Changes" Subtab
The Changes subtab of an issue record's edit form shows the change package of the issue record. You can 
invoke commands to see the details of the change package's changes, maintain its entries, and view the 
transaction and version history of its elements.

For a detailed discussion of change packages, see Patches and Change Packages on page 178.
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"Changes" Subtab Layout
The Changes subtab contains a table, each row displaying one "change package entry". A given element 
can have at most one entry in a change package -- but this entry can "grow" over time, as development 
work continues on the element. The table includes these columns:

Element (or separate "Name" and "In Folder" columns)

The element's pathname within the depot.
Version

The head version of the change package entry.
Basis Version

The basis version of the change package entry.
The head version and basis version are the "endpoints" of the change package entry. That is, the entry 
consists of all the versions between these two versions. (The head version is included; the basis version 
isn't.)

Working in the "Changes" Subtab
The Changes subtab has commands for modifying change package contents:

• The  Remove command deletes one or more selected entries from the change package.

• The  Send to Issue command copies one or more selected entries to another issue record's change 
package.

But the change package facility is designed so that most modifications to change packages occur as "side 
effects" to the Promote command, by the change-package-level integration between AccuRev and 
AccuWork. (Change-Package-Level Integration between AccuRev and AccuWork on page 344.)

See also: Working with Tables on page 10

Commands Available in the "Changes" Subtab

Remove

Deletes the selected entry(s) from the change package.

This change takes effect immediately -- you cannot discard the change by closing the edit 
form without invoking the Save command. (Removing change package entries does not 

enable the  Save button in the edit-form toolbar.)

Diff Against Basis

(text-file elements only) Compares the entry's head version with the basis version. This 
shows exactly what changes to this element are included in the change package.

Show History

Open a History Browser tab, containing the transactions involving the selected element.

Browse Versions

Open a Version Browser tab, showing all the versions of the selected element, and their 
interrelationships (ancestry).
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Send to Issue

Copies the selected entry(s) to another issue record's change package. If there's an existing 
entry for an element in a destination change package, an attempt is made to combine the 
existing entry with the entry you specified. The change(s) take place immediately in the 
destination issue record(s). There is no way to cancel the change(s) -- but you can open the 
issue record(s) and Remove the entry(s).

The default query is executed, and the results are displayed in a dialog (see The Send to 
Issue Command  on page 126). You are prompted to choose one or more of the issue 
records selected by the query. You can also create a new issue record, whose number will 
be entered in the dialog.

Properties

Displays information about the selected element. The data items displayed vary with the 
type of element.

The Edit Form Tab -- "Issue History" Subtab
The edit form of an AccuWork issue record always includes a subtab named Issue History, which is 
maintained automatically by AccuWork. This subtab shows, on a field-by-field basis, how the issue record 
has changed over time.

You can use this subtab to view past "versions" of the issue record.

"Issue History" Subtab Layout
The Issue History subtab contains a table, each row of which shows how one field was changed (or initially 
created) by a particular Save of the issue record.

The table contains these columns:

TransNum

The number of the Save transaction. (The transaction kind is dispatch.) 
User

The user who made the change to the issue record.
Date

The time at which the change tool place.
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Field

The field whose value changed (or was initially created).
New Value

The value to which this transaction changed this field.
Old Value

The value of this field prior to the Save. (Empty for the issue record's initial Save 
transaction.)

Working in an "Issue History" Subtab
If you double-click any row of the Issue History table, AccuWork opens a read-only edit form, showing the 
state of the issue record at the time of that particular Save. (Exception: the issue record's change package 
does not participate in this feature.)

The New File Attachment Dialog
The Browse for Attachment dialog allows you to browse for files to attach to an issue record when in a 
field of type Attachments.

Invoking the New File Attachment Command

Click the  New File Attachment icon in the toolbar of the Attachments field in an issue record's edit 
form.

Using the Browse for Attachment Dialog
The dialog is a standard file-open dialog for your operating system.

Browse to a directory, choose one or more files, and click Attach. 
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Then enter comments (if desired), in the Comments dialog that displays. Click OK to attach the file(s) to 
the issue record.

The New URL Attachment Dialog
The New URL Attachment dialog defines one or more URL attachments in an issue record field of type 
Attachments.

Invoking the New URL Attachment Command

Click the  New URL Attachment icon in the toolbar of the Attachments field in an issue record's edit 
form.

Using the New URL Dialog
Fill in these fields to define one or more attachments:

URL

A full Web address.
Comment

Any text string.
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Issue Record Queries

The AccuWork Queries Tab
An AccuWork query retrieves a set of records according to user-defined selection criteria. AccuWork has a 
point-and-click interface for creating and editing queries; it enables you to create simple queries quickly, 
and to create sophisticated queries in a straightforward, reliable way.

By default, the queries that you create are private queries, which cannot be seen by other users. You can 
declare any query to be a public query. Such queries are visible to all users, who can use and copy them, 
but cannot modify your original.

Opening a Queries Tab
Choose the Issues > View Issue Queries command from the GUI main menu, or click the View Issue 
Queries button in the GUI main toolbar.

AccuRev prompts you to choose a depot, and then displays the Queries tab.



304 AccuRev®  On-Line Help Guide

Query Mode Layout
In Standard Query mode, the Queries tab includes two (and sometimes three) panes, each with its own 
toolbar:

• The Query List pane lists the names of all your existing private queries, along with public queries 
available to all users. Using the toolbar in this pane, you compose new queries, view/revise/rearrange/
execute existing queries, and delete queries.

• When you execute a query, the set of issue records selected by the query are displayed as a results table 
in the Query Results pane. If you've set a default query for this depot, it's executed automatically when 
you open the Queries tab.

• If you click the  Show Issue Form button in the toolbar of the Query Results pane, an Edit Form 
pane appears below it. This pane is a fully functional edit form, which you can use to view and modify 
the issue record currently selected in the Query Results pane. A user preference (Tools > Preferences) 
configures this pane to appear automatically when you open a Queries tab.
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Query List Pane Layout
The Query List pane contains a list of the private queries you've defined for the current depot, along with 
any public queries defined by you and/or other users. 

The listing is not alphabetical -- whenever you create a new query, it's simply added to the end of the list.

Your queries (both private and public) are always listed above other users' public queries.

See Working in the Query List Pane on page 306.

Query Results Pane Layout
The Query Results pane contains a table that displays the results of a query.

Each row of the table displays one issue record; each column displays a particular issue-record field.

Each query has its own results-table design: a set of columns (fields), in a particular order and with 
particular column-widths. The results table’s design can also include a single-level or multiple-level sort 
order for the rows (issue records).

When you create a new query, AccuWork automatically starts off the results table with a couple of 
columns, including Issue (issueNum field). You can add more columns at any time. You can also remove 
the Issue column from the table. Note: "Issue" is the default label for the issueNum field, but the edit-form 
designer can change the label.

See Working in the Query Results Pane on page 309.

Edit Form Pane Layout
The Edit Form pane is just like the "full size" Edit Form tab, except that it occupies a pane within the 
Queries tab, instead of having an entire tab to itself. This pane displays the entire contents of the issue 
record that's currently selected in the Query Results pane. In addition, browse arrows are enabled in the 
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Edit Form pane's toolbar, making it easy to view some or all of the records selected by a query. There is 

also a Change Package History icon ( ) that displays all the modifications that have been made to the 
change package for this issue. In the upper-right corner, the Issue URL link allows you to easily capture a 
URL to the current issue, using the WebUI. To configure this feature, create or edit:

<accurev_install_dir>\storage\site_slice\dispatch\config\settings.xml 

to contain the following entry (customized for your specific installation) to point to your WebUI server:

<settings>

    <webui url="http://<webui-host>:<port>/accurev"/>

</settings>

To use this feature, either click Issue URL to bring up the issue in the WebUI, or to simply copy the URL 
to send to somebody else,  right-click Issue URL and then select and copy the URL from the resulting 
dialogbox. 

See Working in the Edit Form Pane on page 310.

Working in Query Mode
Here's a typical Queries tab procedure:

1. In the Query List pane, create a new query (or select an existing one), then execute the query.

2. In the Query Results pane, view selected fields from the issue records selected by the query.

3. Open the Edit Form pane to view the entire contents of one of the selected issue records (and perhaps 
modify it).

The following sections describe working in each of the Queries tab's panes.

Working in the Query List Pane
You can invoke the following commands in the Query List pane, using context menus or the Query List 
toolbar. 
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Most commands operate on the currently selected query.

Run query 

(equivalent: double-click the query name) Executes (or re-executes) the selected query, 
displaying the results in the Query Results pane. You don't need to run this command 
when you revise a query in the Edit Query window -- AccuWork automatically executes 
the revised query and updates the results table.

Save all queries 

Save all your private queries. (There is no way to save a single query.) Your private 
queries are stored in the AccuRev repository within the depot directory, in an XML-
format file:

.../storage/<depot-name>/dispatch/config/user/<username>/
query.xml

Notes:
Each user's private queries are stored separately

The <username> directory in the query storage pathname causes the private queries for each 
user to be stored separately.

Queries not version-controlled

Although your queries are stored in the depot, they are not version-controlled in the way 
AccuRev files are. For example, there is no command that displays or reinstates your queries 
as you saved them two days ago.

Automatic save-on-close feature

If you try to close a Queries tab in which you've made changes to one or more queries, but 
haven't run the Save all queries command, AccuWork offers to perform the save.

New query

Edit query 

Create a new query or revise an existing one, using the Edit Query window.

Clone query 

(Context menu only) Create a private query that is a copy of the selected private or public 
query. The new query is initially named "Copy of ...", but you can change the name.
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Move query up

Move query down 

(Context menu only) Change the position of the selected query in the Query List pane. 
Note that your own queries (both private and public) are always listed above other users' 
public queries.

Delete query 

(Context menu only) Remove the currently selected query. The deletion does not take 
effect until you run the Save all queries command. If you close the Queries tab without 
saving your queries, the "deleted" query will still exist the next time you open the Queries 
tab. This may or may not be the right thing to do: closing the Queries tab without saving 
also discards changes you've made to other queries since the most recent save.

Set as Default
Disable as Default 

(Context menu only) Designates one of your private queries to be -- or to stop being -- 
your default query for this depot. (This is your default query -- another user can set one of 
his own private queries to be his default query.) 

The query name is redisplayed in bold-italic to indicate that it is the default query. 

Your default query is executed:
• Whenever you open a new Queries tab.

• When the transaction-level integration between AccuRev and AccuWork is triggered by the 
Promote command (see Transaction-Level Integration between AccuRev and AccuWork on 
page 347).

• When you execute The Send to Issue Command  on page 126.

• A query loses its status as your default query when you run Disable as Default on it, or when 
you select another query as the default.

Set as Private
Set as Public

Changes a query that you created from public to private, or vice-versa.

Additional Operations in the Query List Pane
• Renaming a Query—You can rename any of your private queries in the Query List pane, without 

having to open an Edit Query window:

1. Select the query.

2. Press function key F2 or click the query name again. (Be careful not to double-click; that invokes 
the Run Query command.)

• Revisiting the Results of a Query—Whenever you select a particular query in the Query List pane, 
the Query Results pane displays that query's most recent results. The cache of previous query results is 
cleared when you close the Queries tab.
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Working in the Query Results Pane
In many cases, browsing the results table produced by running a query may be all you need to do. But in 
other cases, you may want to see a selected issue record in the context of its edit form. Why?

• The results table is read-only. To modify an issue record, you must access it through its edit form.

• The data you need may be in a field that is not included in the results table. Instead of adding a column 
to the results table, you can use the edit form to display all the fields.

You can use a "full-size" or "reduced-size" edit form to view a issue record:

• Invoke the  Open Issue command to open a separate Edit Form tab on the currently selected issue 
record.

• Invoke the  Show Issue Form command to make an Edit Form pane appear within the Queries tab.

With either tool, browse arrows in the edit form's toolbar make it easy to view some or all of the records in 
the results table.

Commands Available in the Query Results Pane
The following commands are available in the Query Results pane:

Open Issue

Open a separate Edit Form tab to view/revise the currently selected issue record.

Setup Columns

Open a Columns window, in which you can change which columns (fields) appear in the 
table, and also change their order.

Remove Column

(appears only in the context menu of an individual column) Removes the column you 
right-clicked from the results table. (This is a shortcut, eliminating the need to invoke the 
Setup Columns command.)
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Export Table

Open a File Chooser window, in which you specify a file to store the entire contents of the 
results table:

Show Issue Details

Toggles whether an Edit Form pane appears, displaying the complete contents of the 
currently selected record in the Query Results pane.

See also: Working with Tables on page 10.

Working in the Edit Form Pane
Using a "reduced-size" edit form within a pane of the Queries tab is virtually the same as using a "full-size" 
edit form in its own tab. Here are some notes on the few differences:

• The browse buttons in the Query Edit Form pane's toolbar makes it easy to visit all the records in the 
Query Results pane table.
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• After modifying a record and invoking the  Save command, you may want to rerun the query in 
order to update the table in the Query Results pane. This doesn't occur automatically.

Configuring the Users/Groups and Streams Panes
You can choose which user and group names appear in the users/groups pane, and which stream names 
appear in the streams pane:

• Use the  Setup User/Group List toolbar button to bring up a dialog box in which you select the 
items to appear in the users/groups pane. 

In this example, only the group name famgrp and the name of each member of famgrp will appear in 
the users/groups pane.

• Use the  Setup Stream List toolbar button to bring up a dialog box in which you select the items to 
appear in the streams pane.

• In this example, only the stream names bear and bear_tst will appear in the streams pane.
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The AccuWork Query Editor
The AccuWork Query Editor is a tool for creating and revising AccuWork queries.

Opening the Query Editor
You can create or revise an AccuWork query in these contexts:

• In a Queries tab, click the  New Query or  Edit Query button. This opens a separate Edit Query 
window.

• In the Change Packages subtab of a Schema Editor tab, click the  New Trigger or  Edit Trigger 
button to open a separate Promote Trigger window. The Query Editor runs in the bottom pane of this 
window.

Query Editor Layout
The Query Editor displays the contents of one query. The query appears as a hierarchy, which you navigate 
using familiar expand/collapse controls. The hierarchical organization is a natural fit, because each query 
is, itself, a hierarchy of simple clauses and compound clauses:

• The first hierarchy level contains the query's name, if the Query Editor was invoked from the Queries 
Tab.

• A simple clause, such as value of the assignedTo field is dfoster, can live at any level.

• A "compound AND" or "compound OR" clause consists of:

• The operator AND or OR at one hierarchy level

• Any number of clauses (simple or compound) at the next hierarchy level.

For example, this query can be expressed as:

"Retrieve each issue record that is (1) numbered at or above 2300, (2) is not documented, and (3) is 
assigned to user dfostet."

The context menu of a query's name in the Query Editor includes the command In English, which 
produces a sentence like the one above.
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Working in the Query Editor

The following sections describe the details of working in the Query Editor.

Naming a New Query / Renaming an Existing Query

When you click the  New Query button to create an empty query, AccuWork assigns it a placeholder 
name ("New Query nnn"). You can edit the name now: click the name once to select it, then press function 
key F2 (or click it a second time) to begin editing it. Don't double-click — that's equivalent to using the 
expand/collapse control.

You can change a query's name at any time while Query Editor is still active. Or you can change it later, in 
the Query List pane.

Creating a Simple Clause
Every query consists at least one simple clause . A simple clause has three parts:

<field-name> <comparison-operator> <value> 
The point-and-click interface makes creating a simple clause easy and (almost) foolproof. Start by clicking 
one of the "Click here to add ..." placeholders in the query:

First, you must select the <field-name> part of the clause from the list-box containing all the field-names. 
When you select a field-name, the query editor automatically adjusts the <comparison-operator> and 
<value> parts of the clause, based on the selected field. In the example below, the user has selected field-
name productType, whose value must be one of these names: ColorStar, Mixer, Publisher.

Video Tip Click this link to view an introductory video on creating queries.

http://www.accurev.com/training/s23_creating_a_new_issue.wmv
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The table below shows all the AccuWork data types, along with the corresponding choices for the 
<comparison-operator> and <value> parts of a simple clause. As you "fill in the blanks" to create simple 
clauses, you'll notice that AccuWork allocates new "Click here to add ..." placeholders, so that one is 
always available at each level of the query.

Field Type
Comparison 

Operator
Value

Text

contains
matches
does not contain
does not match
equal to
not equal to
less than
less than or equal to
greater than
greater than or equal 
to

Any character string. (Do not enclose it in quotes.) The value is always 
interpreted as a string literal; there is no way to specify the value of some 
other field here.
The comparison is always a case-insensitive string comparison, never a 
numeric comparison. For example, the value 3 is greater than the value 25.
The contains and does not contain operators perform a simple substring 
search (case-insensitive), with no pattern matching.
The matches and does not match operators perform pattern matching (case-
insensitive), using these wildcards:
*  matches 0 or more characters
?  matches any 1 character
[aekz]  matches a, e, k, or z
[a-e]  matches a, b, c, d, or e (Note: Don’t mix uppercase and lowercase; 
neither [E–k] nor [e–K] matches any character] 
{one,two,seven}  matches one, two, or seven 
\ or /  Matches any directory-separator character, even if it’s the "wrong one" 
for the client machine. For example, src/do_*.java matches 
src\do_something.java on a Windows client.
Examples: 
Rls 4* matches Rls 4 and Rls 4.01, but not Rls 4.2 or Rls 5
Rls [2-5]* matches Rls 2, Rls3.04, and Rls 5.3, but not Rls 1.02
the -? option matches the -X option and the -4 option, but not the -Op 
option
cop{y,ies} matches copy and copies, but not copy(s)

Timespan

equal to
not equal to
less than
less than or equal to
greater than
greater than or equal 
to

A numeric value, representing an amount of time.

Note: users specify the value in the edit form as a number of hours (e.g. 7.5); 
an XML-format dump of the issue record created by the Export command 
reports the value as a number of minutes (e.g. 450).

Choose
is
is not

One of the strings specified in the definition of this field in the Schema 
Editor.

List
is
is not

One of the strings specified in the definition of a particular named list in the 
Schema Editor.

User

is
is not
is member of
is not member of

One of the principal-names in the user registry maintained by the AccuRev 
server. Alternatively, a user-group defined in the registry.
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Creating a Compound Clause
A compound clause combines any number of subclauses together, using the same logical operator: AND or 
OR. (The NOT operator is not supported.) The subclauses to be combined can, themselves, be either simple 
or compound.

Examples and notes:

Example 1: simple AND simple

Example 2: simple AND compound

Timestamp

is
is not
is before
is after
is before or equal to
is after or equal to

An AccuRev timestamp.

Attachments
contains Any character string. This string is compared to the Name of each of an issue 

record's attachments. See .

internal

equal to
not equal to
less than
less than or equal to
greater than
greater than or equal 
to

An integer, identifying a particular AccuWork issue record ( issueNum field) 
or a particular AccuRev transaction ( transNum field).
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Example 3: simple OR compound OR simple

Example 4: Compound clause with a single subclause

A compound clause can contain a single subclause. This is logically equivalent to using the subclause by 
itself. In fact, the standard "one-line" query contain an AND clause with one simple subclause.

The query editor automatically creates placeholders for simple clauses. But you must explicitly insert a 
compound-clause placeholder yourself, then fill in the subclauses.

Following are guidelines for adding placeholders to a query:

• You cannot add a compound clause at the top level (directly beneath the query name). This level 
contains a single compound clause -- initially AND, but changeable to OR .

• To create a compound clause below a particular operator, right-click it, and select the type of clause 
from the context menu.

• To change any AND clause to an OR clause (or vice-versa), select the operator and press function key 
F2 (or click it a second time). This opens a listbox with the values AND and OR.

Viewing an English-Language Rendition of the Query
The query name's context menu includes the command In English, which renders the query in everyday 
language, displaying the results in a separate window.
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Ending the Query Editor Session
Whether you're composing a new query or revising an existing one, you end by saving your work (Ok 
button) or discarding it (Cancel button). If you didn't cancel the Query Editor session, AccuWork 
automatically executes the query and displays the results in the Query Results pane. Note: Closing the 
window using its title bar controls is equivalent to Cancel.

The Setup Columns Command
The Setup Columns command specifies a set of fields from AccuWork, and the order in which they will 
appear as columns in a particular table.

Note: What about column widths?

You don't specify column widths with this command. After finishing this command, you can drag col-
umn separators in the tab from which you invoked Select Columns. You can also drag-and-drop the 
column headers to rearrange the columns.

Invoking the Setup Columns Command
A Setup Columns command button appears in these AccuWork contexts:

• Schema editor: Change Packages tab (Change Package Results pane)

Specifies the format of the tables produced by Show Issues and Show Diff by Issues commands.

• Schema editor: Change Packages tab (Change Package Triggers pane)

Specifies the format of the table displayed by the change-package-level integration between AccuRev 
and AccuWork.

• Schema editor: Relationship Types tab

Specifies the format of the table that shows the set of issue records related to a given issue record.

• Queries tab: Query Results pane toolbar

Specifies the format of the table that shows the results of a user-defined AccuWork query.

Using the Setup Columns Dialog
The fields listed under Selected when you click Ok will be displayed in the appropriate table of issue 
records.



318 AccuRev®  On-Line Help Guide

• To move field names from the Available list to the Selected list (or vice-versa), select one or more 

names, then click the  button (or the  button).

• To move all field names between the lists, click the  or  button.

• To rearrange the Selected list, select one or more names, then click the  or  button.

Notes:

Field names vs field labels

The names that you work with in the Columns window are the actual field names (Name column of 
the Schema subtab of the AccuWork Schema Editor) In the Query Results pane, the column headers 
are the corresponding field labels (Label column of the Schema subtab).

Further adjustments, including column-width specifications

You don't specify column widths in the Columns window, just their order. You can adjust column 
widths and change the order of columns: see Working with Tables on page 10.

Multiple-line text fields

You can include a multiple-line text field in the set of columns to be displayed in the Query Results 
pane, but it's likely that you won't be able to see the complete contents of such fields, no matter how 
wide you make its column. But when you display an HTML file created by the Export Table command 
in a web browser, you'll see the complete contents of every field.

When you click Ok to close the Setup Columns dialog, the changes you've made are reflected immediately 
in the Query Results pane. But the changes to the query's columns setup are not saved in the repository 

until you invoke the  Save All command in the Query List pane.

The AccuWork Schema Editor -- Overview
Using the AccuWork Schema Editor, you can configure AccuWork, including issue record layout and 
validation. Each depot can contain a separate AccuWork configuration, including a custom-designed edit 
form, through which users create and modify the issue records. You can make the edit form "smart" by 
defining validations (edit checks) that specify default values, required fields, and interrelationships among 
multiple fields.
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Invoking the Schema Editor
Choose Admin > Schema Editor from the GUI main menu. The first time you invoke this command in a 
particular depot, AccuWork offers to use the repository's default schema. Accepting this offer copies a set 
of XML-format configuration files from the site_slice/ dispatch/config subdirectory to this depot. 

Note: The default schema does not actually become the schema for this depot until you click the 
Schema Editor's Save button.

The Schema Editor tab includes these subtabs:

Saving Changes to the Schema
At any time while working in the Schema Editor, you can click the Save button in the lower right corner of 
the Schema Editor tab. This saves the current state of the schema to a set of XML-format files in 
subdirectory dispatch/config of the depot directory (slice) in the AccuRev repository :

• Contents of the Schema subtab: schema.xml 

• Contents of the Layout subtab: layout.xml 

• Contents of the Lists subtab: lists.xml 

• Contents of the Relationship Types subtab: relation_types.xml 

• Contents of the Validation subtab: logic.xml 

• Contents of the Change Package Results section of the Change Packages subtab: cpk_fields.xml 

• Contents of the Change Package Triggers section of the Change Packages subtab: 
cpk_promote_queries.xml 
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The AccuWork Schema Editor
(Schema subtab)

The Schema tab of the Schema Editor contains a table that details all the data fields defined for AccuWork 
in the current depot.

If you are not using the repository's default schema, AccuWork initializes the Schema Fields table with two 
fields.

• issueNum: An integer-valued field that records the position of the issue record in the depot. This 
number is assigned when a user creates the record (i.e. at the first Save on the edit form), and it never 
changes.

• transNum: An integer-valued field that records the transaction number of the most recent update to 
the issue record. The transaction appears in the depot's transaction log -- the same log that records 
AccuRev transactions, such as keep and promote. The type of the issue-record-update transaction is 
dispatch.

Notes:

issueNum vs. transNum

A record's issueNum value never changes, but its transNum value changes each time a user Save's the 
record. issueNum and transNum are indexes into two different databases.

AccuRev/AccuWork integrations

The change-package-level and transaction-level between AccuRev and AccuWork also update issue 
records, and so changes the value of the transNum field. (See Change-Package-Level Integration between 
AccuRev and AccuWork on page 344 and Transaction-Level Integration between AccuRev and AccuWork 
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on page 347.)

See Also: The AccuWork Schema Editor -- Overview on page 318.

Adding Fields to the Schema
You can define any number of additional fields in the schema. Follow these steps for each new field:

1. Click the Add button at the bottom of the Schema subtab.

2. Fill in the Create New Field window that appears:

• Name: The official field-name of the field. AccuWork users don't ever need to know this name -- 
they know the field by its label. The field-name must not contain any SPACE characters. 
Validations must be expressed in terms of the field's name, not its label.

• Type: One of the data types supported by AccuWork. See Data Types on page 322 for more 
information.

• Label: The field-label character string that identifies the field on the edit form. A field-label can 
contain SPACE characters (e.g. Last Name ).

• Report Width: An integer that determines the relative width of the field in the HTML table created 
when the user clicks Export on the edit form of an individual issue record.

3. Click Ok to close the Create New Field window.

4. In the Field Values box to the right of the Schema Fields table, specify additional information about the 
field. The kind of information required varies with the data type.
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Repeat the steps above as often as required to create new fields. Your field definitions are not saved until 
you click the Save button in the lower-right corner of the Schema Editor tab. You cannot save your work 
until you place at least one field in the edit form (Layout subtab).

Data Types
Each field you define in the Create New Field window must have one of the AccuWork data types listed in 
the table below.

Field Type Possible Values Required Additional Information in "Field Values" Box
Text Any character string. For 

multiple-line fields, the string 
can include line-terminators.

Height: number of lines displayed for the field in the edit form 
(default: 1). For multiple-line fields (height > 1), the edit form 
includes an expand/contract button to increase/decrease the number 
of lines displayed.
Width: relative width of field in the edit form.
Note: Text fields can be configured to support rich text. See 
Enabling Rich Text for Text and Log Fields on page 326 for 
more information.

Choose One of the strings specified in 
the Field Values box for this 
field.

A set of strings.
In the edit form, a list-box containing this set of strings is offered to 
the user.
See Defining Multiple-Choice Lists on page 325 for more 
information on creating fields that displays lists.

Timestamp An AccuRev timestamp. Granularity (year, month, day, hour, minute, or second).
In the edit form, the user fills in fields that indicate a time, to the 
granularity you specify here.

User One of the principal-names in 
the user registry maintained by 
the AccuRev server.

None.
In the edit form, a list-box is offered to the user, containing the 
names of all registered AccuRev users.

Stream A Project stream name in the 
current depot.

None. NOTE: THIS DATATYPE WAS DEPRECATED AS OF 
RELEASE 5.5.0

Timespan A numeric value, indicating a 
number of hours. Decimal 
values (e.g. 4.5) are allowed.

None.

List One of the strings specified in 
the definition of a particular 
named list.

The name of an existing list, defined on the Lists subtab.
In the edit form, a list-box containing the set of strings defined in the 
named list is offered to the user.
See Defining Multiple-Choice Lists on page 325 for more 
information on creating fields that displays lists.

Log Any character string (variant of 
text field type)

In the edit form, an Add Text control appears above the input field. 
The user can type directly into the input field, or can click the Add 
Text control and create a "log entry" in the popup window that 
appears.
Note: Log fields can be configured to support rich text. See 
Enabling Rich Text for Text and Log Fields on page 326 for 
more information.

Attachments A set of attachment definitions. Height, Width: the height (number of lines) and width (approximate 
number of characters) of the edit-form field that lists the attachment 
definitions.

Relationship A set of issue records. See Defining Issue Record Relationships on page 326 and The 
AccuWork Schema Editor (Relationship Types subtab) on 
page 333 for more information.
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Removing a Field / Restoring a Field
To remove an existing field (except for issueNum and transNum), select it and click the Remove button. 
The field disappears from the Schema tab and can no longer be used in the edit form. But any data stored in 
existing issue records is preserved.

When you remove a field from the schema, AccuWork checks whether the field is used in the edit form. If 
so, it removes the field from the edit form 

You can restore a removed field to the schema:

1. Check the Include deactivated trees checkbox. All removed fields appear in the list, with a gray 
background.

2. Select the field to be restored, and click the Reactivate button.

Specifying the Lookup Field

The   Issues > Look Up command prompts the user to enter a value, then uses that value to locate an 
issue record. 

Internal A positive integer. None.
You cannot create a field with this data type; it is used only by the 
built-in fields issueNum and transNum .
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By default, this lookup operation uses the issueNum field (whose user-visible label is Issue).

You can configure another field to be used for issue-record lookups, using the 3pty ITS Key listbox. (This 
feature is designed to facilitate AccuBridge and AccuSync integrations with third-party issue-tracking 
systems.)

Select another field from the listbox, and save the schema.

Thereafter, the Issues > Look Up command will prompt for a value to be matched against the specified 
field. 

Notes:

Value-matching on lookups

The Issues > Look Up command requires an exact match between the user's entry and the value in the 
issue-record field. Exception: upper-case/lowercase differences are ignored. This can cause problems if the 
lookup field is a Text field.

Uniqueness of lookup values

AccuRev guarantees uniqueness of the issueNum field value only. It allows duplicate values in all other 
fields. Be sure to specify an alternative lookup field whose values are rendered unique by some other 
mechanism. If a user performs a lookup on a non-unique value, an error occurs:

Integrating Configuration Management and Issue Management: the 
`affectedFiles' Field and Change Packages
If you wish to enable the integration of a depot's version-controlled files and its AccuWork issue records, 
define a field whose name is affectedFiles. The field's data type must be Text. You can choose any label for 
the field. (Such a definition is included in the default AccuWork schema.)

The integration also depends on the enabling of a built-in AccuRev trigger procedure:
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accurev mktrig -p <depot-name> pre-promote-trig 
client_dispatch_promote

The integration routine writes the transaction number of each promote command to the affectedFiles field 
of a particular issue record. Alternatively, in the AccuRev Enterprise version of AccuWork, the integration 
routine records each promoted version in the issue record, in a special section named Changes . This 
section is maintained automatically by AccuWork -- you don't need to define any fields to enable this 
additional aspect of the integration.

See Also:

• Change-Package-Level Integration between AccuRev and AccuWork on page 344

• Transaction-Level Integration between AccuRev and AccuWork on page 347

Defining Multiple-Choice Lists
The choose and list data types are similar:

• For a choose field, the set of possible values -- an ordered list of strings -- is part of the individual field 
definition. You enter the possible-values list in the Field Values box for that field.

• For a list field, the set of possible values is also an ordered list, but it is not part of the individual field 
definition. In the Field Values box, you specify the name of one of the lists created on the Lists subtab. 
Any number of list fields in AccuWork (within a single depot) can use the same named list.

The mechanics of defining the ordered list is similar in the "local" case (for an individual choose field) and 
in the "global" case (on the Lists subtab, for use by any number of list fields). On the Lists subtab, you 
must supply a ListName for the list; for an individual choose field, the possible-values list doesn't need or 
have a name.
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Defining Issue Record Relationships
When you create a field of type Relationship, you must select the Duplicate, Subtask, or Dependency 
relationship type for the field. On an edit form, the field's edit-widget is a pair of tables. The upper table 
displays "inward" or "child" relationship links -- that is, links from other issue records to the current record. 
The lower table displays "outward" or "parent" relationship links -- that is, links to other issue records from 
the current record. (Multiple-link chains are not allowed -- each issue record can be related to others by 
child links or parent links, but not both.)

The figure below show how a Duplicate relationship field appears in an edit form. A relationship field of 
type Subtask or Dependency appears similarly.

Enabling Rich Text for Text and Log Fields
AccuWork supports rich text for fields with data types of Text and Log. Fields for which you wish to enable 
rich text must have a Height of at least 1. 

When you enable rich text for a field, AccuWork:

 Displays tools for working with rich text

 Renders formatted text (and not tagged HTML, for example)

See Rich text fields on page 292 for more information and examples.

To enable rich text for an AccuWork field:

1. Close any open issues.

2. On the Schema tab, select the field for which you want to enable rich text.

Tip: Only fields with a data type of Text or Log support rich text.

3. In the Field Values pane:

1. Ensure that the field’s Height is 1 or more.

2. Click the Enable Rich Text check box.

3. Click the Save button.
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4. Close the Schema Editor tab.

The AccuWork Schema Editor
(Layout subtab)

An edit form consists of field-labels and corresponding edit-widgets, arranged in rows and columns. The 
field-labels come from the Labels column of the Schema Fields table (Schema subtab). The edit-widget for 
a field depends on its data type and, in some cases, on the additional Field Value information.
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Contents of the Layout Subtab
The Layout subtab provides a drag-and-drop canvas on which you design the edit form's rows and 
columns. On this canvas, each field-label/edit-widget pair is represented by a yellow box.

As the screen-shot annotations indicate, the yellow box contains a field-name (e.g. actTime), not a field-
label (Actual Time). On the edit form, the field-label and the corresponding edit-widget will appear, side 
by side, at this position. You can also expand a yellow box to make it span two or more columns.

You can organize the fields into multiple "tables", each of which defines a separate tabbed page in the edit 
form. One of the tables can define a header section, which always appears on the edit form, no matter 
which tabbed page is currently visible.
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The layout for a multiple-page edit form looks like this:

Form Layout Operations
This section lists the edit-form design operations available on the Layout subtab.

Adding a field to the edit form
The Fields list-box offers all fields that do not currently appear in the edit form. Click to select a field in 
this list-box. Then, click at the empty location on the canvas where you want to place the field.
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Arranging fields into rows and columns 
Drag-and-drop the yellow boxes to the desired location on the canvas. Drop a box on top of another one to 
push it rightward or downward.

Changing column-spanning
Right-click a yellow box, and select one of the spanning operations from the context menu.

Creating a new page in the edit form
Click the Add Table button above the Fields list-box. Fill in the Table Title field in the dialog box that 
appears, then click OK . This title will appear on the page's tab in the edit form.
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A gray box with the specified title appears at the bottom of the layout. Fields that you place below this box 
will appear on the new page of the edit form.

Creating a header table for the edit form
When creating a new page for the edit form (see above), check the Header checkbox if you want it to be 
the header table.

An edit form can have at most one header table. If another table is currently selected as the header table, it 
is automatically deselected. Its fields always appear at the top of the edit form, even if it is not the topmost 
table on the Layout tab.

You can also redefine an existing page to be a header table: right-click the gray box and select Properties. 
All fields in the header table will appear at the top of the database's edit form, above every tabbed page.

Renaming a page
Right-click on the gray box, select Properties , and change the entry in the Table Title box.

Arranging fields into multiple pages
Drag-and-drop the yellow boxes (fields) and the gray boxes (pages). Fields that you place below a gray 
box will appear on the corresponding page of the edit form.

Removing a field or page
Right-click the yellow box (field) or gray box (page), and select Delete from the context menu. Deleting a 
page doesn't delete the fields currently on the page -- it just deletes the gray box, effectively merging the 
fields into the page above. Note: You cannot delete the first gray box; an edit form must have at least one 
page.

Setting the edit form's colors
Click one of the colored buttons at the right side of the Layout subtab. Then select a color from the Pick a 
color window. You can set these colors:

• Foreground: the color of the edit form's field-labels.

• Required Foreground: the field-label color for fields where a value must be specified. Required fields 
are defined on the Validations subtab.

• Background: the color of the edit form's background.
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The AccuWork Schema Editor
(Lists subtab)

A field whose data type is List can have any of the values in a predefined list. Any number of fields can get 
their values from the same list.

The Lists subtab maintains the set of predefined lists for AccuWork within a given depot .

Lists Subtab Layout
The Lists subtab has two sections:

• In the "Lists" section, you create and delete named lists.

• In the "List Values" section, you specify the values in each list.

Lists Subtab Operations
This section describes the edit-form design operations available on the Layout subtab.

Creating a New List
Click the Add button in the Lists section, and type a name into the popup window.

Specifying the Values for a List
Select one of the list names in the Lists section. Then, in the List Values section: type a name in the input 
field at the top, and click the Add button.
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The new name is added to the listbox below the input field, allowing you to type another name and click 
Add again.

Reordering the Values in a List 
Select a name in the listbox showing the current values, and click the Up or Down button.

The order of the names in this listbox determines the order in which they will appear in the edit-widget on 
an edit form.

Removing a List
In the Lists section: select a name, then click the Remove button.

Renaming a List
There is current no provision for renaming an existing list.

The AccuWork Schema Editor
(Relationship Types subtab)

An issue record can be related to one or more other issue records, through a variety of relationship types:

• Duplicate: You can specify that issue record B duplicates issue record A, so that no work need be done 
on B. (Perhaps the same bug was reported twice.) Any number of records (B, C, D, ...) can duplicate a 
given record (A). The default AccuWork schema requires that a Duplicate relationship be established 
when an issue record's State field is set to the value Duplicate.

• Dependency: You can specify that issue record B depends on issue record A (for example, from a 
project management viewpoint). AccuRev imposes no further semantics on such dependencies; this is 
a good application for user-defined scripts or practices.
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Note: This relationship is independent of change package dependency relationships among issue 
records, which are maintained automatically by AccuRev.

• Subtask: You can specify that issue record B defines a subtask of the work to be performed for issue 
record A. In this case, AccuRev considers issue record A to be "in" a particular stream only if issue 
record B is "in" that stream, also.

• Track: This relationship type is used internally by AccuWork to track change package gaps. 

The edit-widget for a field whose data type is Relationship is a table. It displays selected fields from all 
the other issue records that are related, through a particular relationship type, to the current record.

On this subtab, you specify -- for each relationship type -- which fields from a set of related issue records 
are to be displayed in a Relationship field.

Relationship Types Subtab Layout
The Relationship Types subtab contains two sections:

• The upper section lists the several relationship types, along with the captions that appear in the edit-
widget (a pair of tables) for a Relationship field of that type. (The captions cannot be edited.)

• The lower section specifies the set of fields to be displayed from each related issue record, along with 
their order and display widths.
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Working on a Relationship Types Subtab

1. In the upper section, click to select one of the relationship types.

2. In the lower section, click the Setup Columns button to bring up a dialog box in which you select a set 
of database fields, to be displayed as columns in a Relationship field's edit-widget. (See The Setup 
Columns Command on page 317.) You can also specify the order of the fields.

3. After closing this dialog box, you can adjust column widths and change the order of columns (see 
Working with Tables on page 10).
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The AccuWork Schema Editor
(Validation subtab)

Users of AccuWork create and modify issue records through the issue edit form. To increase the efficiency 
and accuracy of this process, you can create a set of validations to be applied as the user works with the 
edit form. (Validations are sometimes called "edit checks".)

You create and maintain the set of validations using a point-and-click interface on the Validation subtab. 
AccuWork displays the current validations in tabular format; each one takes the form "if a certain condition 
is true, then perform a particular set of actions".

Initializing Field Values in a New Issue Record
The first entry in the table of validations is special. Its condition is always "initialization of new issue", so 
that its actions are performed exactly once: between the time the user invokes the New Issue command and 
the time the new edit form appears.

To define an action, right-click in the Actions column, then select Add Action from the context menu. An 
Action window appears, in which you define the action. For initialization of a new issue record, the only 
appropriate action type is setValue. ( Note: Some releases of AccuWork allow you to include setRequired 
and setChoices actions in a record initialization. Such actions will be ignored when a new record is 
initialized.)

After setting the action type to setValue, select a field to be initialized and specify the initial value. The 
Value edit-widget adjusts to the selected field. In the example below, the data type of the state field is 
choose, so the list-box offers the field's predefined choices as the initial value.
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Conditional Validations
The setting of initial field values is an unconditional validation: it happens every time a New Issue 
command is invoked. All other validations are conditional: a certain set of actions are performed if, and 
only if, a certain condition is met.

The unconditional setting of initial field values occurs just once; but the conditional validations are 
performed repeatedly: when an edit form first appears and each time the user changes any field value. Each 
repetition involves:

• Clearing the "required" status of all fields.

• Performing all validations (except for that first one: "initialization of new issue"). If a validation's 
condition is true, the corresponding actions are performed.

Specifying the Condition
To create a new conditional validation -- that is, a new row in the table -- right-click anywhere in the 
Conditions column, then select Add Condition from the context menu. Then proceed to construct the "if" 
clause. The same context menu provides the Edit Condition command (for revising an existing "if" 
clause), and the Remove Condition command (for removing a conditional validation).

Specifying the "if clause" of a conditional validation is very much like specifying an AccuWork database 
query (see Working in the Query Editor on page 313). But there are some differences. In a validation 
condition, you can:

• Compare the current value of a field with its "old" value -- that is, compare the value currently 
displayed for the field vs. the value stored in the AccuWork database by the most recent Save. 
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• Compare the (current or old) value of a field with the (current or old) value of another field in the same 
record. 

• Test the AccuRev user identity or group membership of the person using the edit form (CUR_USER).

Query conditions cannot make such field-to-field comparisons; they can only compare field values to 
literal values.

Specifying the Actions
Each conditional validation can include any number of actions. You create an action by right-clicking in 
the Actions column of the validation, and selecting Add Action from the context menu. This displays a 
window in which you define the action. 

After you've created one or more actions for a conditional validation, you can use the same context menu 
to revise or delete individual actions.

The following sections describe the actions that you can define to be performed if the validation condition 
is true. Each validation can invoke any number of actions, of any type.

• Setting a field value (setValue)

• Revising the choices for a "choose" field (setChoices)

• Requiring a value to be entered in a field (setRequired)

• Setting permissions on all or part of the issue record (setIssuePermission, setTabPermission, 
setFieldPermission)

• Requiring change set entries (setChangesRequired)
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• Requiring a relationship with another issue record (setParentRelationshipRequired, 
setChildRelationshipRequired)

Setting a Field Value
In addition to initializing field values (see Initializing Field Values in a New Issue Record), you can set the 
values of fields while the user is working with the record, based on certain conditions. For example, if the 
user enters ColorStar in the program_name field, a validation could automatically set the fix_priority field 
to high . (Management has mandated rapid improvement in the robustness of the ColorStar application.)

To define a setValue action for a validation condition:

1. In the Action window, select setValue as the action type, and select the field to be set.

2. The Value edit-widget adjusts to the selected field, just as it does when you're initializing a field in a 
new issue record. 

For a "text", "log", or "timespan" field, you enter a text string as the value; for a "date" field, you specify a 
date in the standard way; for other field types, you use a list-box to specify any of the field's predefined 
values.

Revising the Choices for a "choose" Field
The definition of each field of type "choose" includes an ordered list of strings. The user fills in this field 
by choosing one of the strings from a list-box.

In a validation, a setChoices action can change the "choice list" that the user will see when he opens the 
list-box: The changes to the choice list can include:

• Removing one or more of the existing choices

• Changing the order of the choices

You cannot add new strings to the choice list with a setChoices action. The changes made by a setChoices 
action are temporary: they last only until the next setChoices action on the same field, or until the user 
closes the edit form. When an edit form is opened on another issue record (or subsequently on this issue 
record), the user will see the field's original choice list, as defined on the Schema tab.

To define a setChoices action for a validation condition:

1. In the Action window, select setChoices as the action type, and use the Field list-box to select one of 
the database's fields of type "choose".

2. Use the controls at the bottom of the Action window to define the temporary change to the choice list: 

Requiring a Value to be Entered in a Field
Like many other programs that process fill-in-the-blanks forms, AccuWork can treat certain fields as 
required fields -- the user must specify a value in each such field before AccuWork will create or update an 
issue record. (For a "choose", "list", or "user" field, the value must not be the <none selected> 
placeholder.)

AccuWork affords you great flexibility in controlling required fields. A field's "required" status is not part 
of the basic database schema. Instead, it is controlled by the conditional-validation facility. Thus, 
AccuWork repeatedly redecides whether a field is required: when the edit form first appears and each time 
the user changes any field value on the edit form. Whenever the user clicks the Save button, AccuWork 
uses the current set of required fields to allow or disallow the "save" operation.
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To define a setRequired action for a validation condition:

1. In the Action window, select setRequired as the action type.

2. Select the field to be required.

If you want a field to be required in all circumstances, use the setRequired action along with a condition 
that's always true. For example, you can exploit the fact that every issue record has a positive integer as its 
issue number: 

Setting Permissions on All or Part of the Issue Record
The setIssuePermission, setTabPermission, and setFieldPermission actions are essentially similar: they 
restrict the editability of some component of the issue record:

• setIssuePermission makes the entire issue record read-only.

• setTabPermission makes a particular page (tab) of the issue edit form read-only. 

• setFieldPermission makes a particular field of the issue record read-only.

There are two attributes that you can assign to these actions:

• ro— Make read-only for all situations.

• auto— (AccuRev Workflow only.) Make read-only for end-users, but allow AccuRev to make 
changes. 

The "read-only" ( ro ) permission affects the user's current access to the issue record; the "read-only" status 
is not stored in the repository as part of any issue record. For example, user allison might find that she 
cannot change any fields on the Assignment page of any issue record, because of this validation:

This restriction affect allison 's access to issue records; other users' access remains unaffected. And if this 
conditional validation is subsequently removed, allison will regain access to the Assignment page of all the 
issue records.

Note that setting read-only permission on an issue record will affect the behavior of AccuRev commands 
such as cpkremove and promote, in addition to restricting the user's ability to edit the issue. 

The “automatic” ( auto ) permission is similar to ro, but in AccuRev Workflow, AccuRev can perform 
actions that end-users are prevented from making as described above. For more information about 
AccuRev Workflow-specific details, see the AccuRev Web Interface User’s Guide.

We recommend that each change to the schema be tested thoroughly to prevent unexpected side-effects to 
your organization's processes.

Requiring Change Package Entries
The setChangesRequired action specifies that the user cannot Save an issue record unless there is at least 
one entry in the issue record's change package.

Note: Be careful not to specify this action with the "initialization of new issue" condition (see 
Initializing Field Values in a New Issue Record on page 336).
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Requiring a Relationship with Another Issue Record
The setParentRelationshipRequired action specifies that the user cannot Save an issue record unless there 
is at least one entry in the lower table of a particular relationship field.

The setChildRelationshipRequired action specifies that the user cannot Save an issue record unless there is 
at least one entry in the upper table of a particular relationship field.

You cannot set both these requirements for the same relationship field, because each field can have parent 
relationships or child relationships, but not both.

Revising and Removing Validations and Actions
Each conditional validation consists of a condition (left column) and a set of actions (right column). To 
revise or remove an entire validation, right-click anywhere within the condition, and select the appropriate 
command, Edit Condition or Remove Condition , from the context menu.

For the first (unconditional) validation, "initialization of new issue", you cannot remove or revise the 
condition. You can only work with the validation's actions.

To revise or remove an individual action from a validation, right-click on that action and select the 
appropriate command, Edit Action or Remove Action , from the context menu.
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The AccuWork Schema Editor
(Change Packages subtab)

AccuRev Enterprise supports an enhanced integration between AccuRev and AccuWork: any AccuWork 
issue record can act as a change package, keeping track of which versions were created to fix the bug (or 
implement the new feature) described in that issue record. For a thorough discussion, see the topic Change-
Package-Level Integration between AccuRev and AccuWork on page 344.

The Change Packages subtab configures the way in which change packages are reported and updated, on a 
depot-by-depot basis.

Change Packages Subtab Layout
The Change Packages subtab specifies the change-package configuration for the current depot. It is 
organized as follows:

• In the Change Package Results section, you specify the format of the change-package table displayed 
by a Show Issues or Show Diff By Issues command. This set of fields is also used to identify issue 
records in the Issue Dependencies tab.

• In the Change Package Triggers section, you enable the change-package-level integration between 
AccuRev and AccuWork, by specifying one or more AccuWork queries, one of which will be invoked 
during execution of the Promote command. (The user chooses one or more of the issues records 
selected by the query; AccuRev adds the promoted versions to those issue record(s)' change packages.) 
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In this section, you also specify the format of the table that displays the results of the Promote-time 
query to the user. 

• In addition, the Issue Owner Field drop-down list displayed at the bottom of the tab can be set to any 
AccuWork field that contains user/group data. The field specified here displays on the Send to Issue 
dialog, and allows the user to choose an issue belonging to another user or group.

Working in the Change Package Results Section
Click the Setup Columns button to bring up a dialog box in which you select a set of issue fields, to be 
displayed as table columns. See The Setup Columns Command on page 317. You can also specify the order 
of the fields.

After closing this dialog box, you can adjust column widths and change the order of columns. (See 
Working with Tables on page 10.)

Working in the Change Package Triggers Section
This section contains a set of condition/query pairs, one of which will be executed at Promote-time. If the 
first condition is satisfied, the first query will be executed; otherwise the second condition will be 
evaluated, and if it's satisfied, the second query will be executed; and so on. No error occurs if no condition 
is satisfied; the Promote command proceeds without triggering any change-package-level activity.

Note that there is no checkbox or button to enable the change-package-level integration. Rather, the 
existence of one or more condition/query pairs in this section implicitly enables the integration. 

Composing a Condition
Each clause of a condition performs a test on the Promote destination stream (indicated by the keyword 
PROMOTE_DEST_STREAM). For example, this condition is satisfied if the user is promoting to either of the 
streams maint or forms: 

The mechanics of composing the condition are similar to that of composing an AccuWork query (see 
Working in the Query Editor on page 313).

Composing a Query
Corresponding to each Promote-destination condition is any AccuWork query, to selects a set of issue 
records. For the mechanics of composing the query, see Working in the Query Editor on page 313.

Formatting the Table Displayed by the Change Package Trigger
To specify the format of the table displayed by the Promote command when it invokes the change-
package-level integration between AccuRev and AccuWork, click the Setup Columns button to bring up a 
dialog box. Use this dialog box to select fields to appear as columns, the order of the columns (fields), and 
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the sort order of the rows (records). After closing this dialog box, you can adjust the column widths and 
rearrange the columns.

Change-Package-Level Integration
between AccuRev and AccuWork
There are two similar, but separate facilities that integrate AccuRev's configuration management 
functionality with its issue management (AccuWork) functionality. The one described in this topic uses 
change packages as the point of integration. The other uses a particular issue-record field as the point of 
integration (see Transaction-Level Integration between AccuRev and AccuWork on page 347). Both 
integrations record information about the Promote transaction in a user-specified AccuWork issue record.

When a Promote command is executed a user's workspace (but not in a higher-level dynamic stream), the 
change-package-level integration records all the promoted versions on the Changes subtab of a user-
specified AccuWork issue record.

Enabling the Integration
The change-package-level integration is enabled on a depot-by-depot basis. Open the Schema Editor for a 
particular depot, and go to the Change Packages subtab. Filling in the lower section, "Change Package 
Triggers", enables the integration for that particular depot.

The Change Package Triggers section is structured as a set of condition/query pairs. One of the queries will 
be selected for execution at Promote-time. If the first condition is satisfied, the first query will be executed; 
otherwise the second condition will be evaluated, and if it's satisfied, the second query will be executed; 
and so on.  
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Each clause of a condition performs a test on the Promote destination stream. For example, this condition 
is satisfied if the user is promoting to either of the streams maint or forms: 

The condition must test the destination stream (PROMOTE_DEST_STREAM) of a Promote command. The 
query corresponding to each condition can be any AccuWork query, which selects a set of issue records.

The Change Package Triggers section also specifies the format of each query's results table -- the fields to 
appear as columns, the column widths, the order of the columns (fields), and the sort order of the rows 
(records).

In addition, the Issue Owner Field drop-down list displayed at the bottom of the Change Packages tab can 
be set to any AccuWork field that contains user/group data. The field specified here displays on the Send to 
Issue dialog. 

Triggering the Integration
Once the integration is enabled for a depot, it is triggered whenever a user performs a Promote command in 
a workspace associated with that depot:

1. One of the AccuWork queries specified in the Change Package Triggers section is executed, selecting 
a certain set of issue records.

2. Those records are displayed to the user in the results table format specified in the Change Package 
Triggers section. In this example, AccuWork has been configured to allow the user to choose from 
issues assigned to another user or group if necessary. 
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Note: If you have enabled the use of third-party issue tracking system (ITS) keys in the AccuWork 
schema, the Select Issue (Change Package) dialog displays additional controls that let you specify 
whether you want to use AccuWork issue numbers or third-party keys when selecting issues to 
promote against. See the section “Using Third-Party Keys in the AccuRev GUI” in the AccuRev® 
Technical Notes for more information.

3. The user selects one or more of the issue records, or types an issue identifier into the Issue # field.

Promoting to Issues Other than Those Shown -- The dialog has a New Issue button, 
which enables the user to create a new issue record "on the fly".  If the user hovers over 
the icon to the right of the New Issue button, it will display a tooltip containing the Change 
Package Triggers query. This makes it easier to create an issue that will be selected by the 
query, and thus available to promote against.

There may also be a user field to the right of the Issue # field that can be used to show 
issues belonging to another user. 

Typing an Identifier when using a Third-Party ITS -- If a field other than the default 
issueNum is specified as the 3pty ITS Key (on the Schema Editor’s Schema subtab), 
specifying issue records by typing their identifiers can lead to errors: if multiple issue 
records have the same identifier, AccuRev automatically adds the promoted version(s) to 
just one of those records — perhaps not the one you intended.

4. The command completes its work.

5. The versions involved in the command are recorded in the change package section (Changes page) of 
the selected issue record(s).

What happens if the user specifies no issue record or a non-existent issue record, such as 99999 or 0?

• If the user enters "0" (or equivalently, makes a blank or non-numeric entry), AccuRev checks whether 
issue record #0 is among the issues selected by the query executed Step 1. (Note: the query can select 
issue record #0, even though it doesn't exist -- for example with this clause: issueNum equal to 0.)
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• If the query does select issue record #0, the user's command completes but no information is 
recorded in the issue. This provides a way for the user to bypass the integration when performing 
the Promote command.

• If the query does not select issue record #0, the user's command is cancelled, and no information is 
recorded in the issue.

• If the user specifies a non-existent issue record, such as "99999", the command is cancelled, and no 
information is recorded in the issue.

What if Both Integrations are Enabled?
Both the change-package-level and transaction-level integrations can be enabled for a given depot at the 
same time. In this case, a user performing a Promote command in a workspace is prompted to specify an 
issue record just once, not twice. The prompting for an issue record by the change-package-level 
integration takes place as usual. That issue record is then updated by both integrations.

Note that even if both integrations are enabled, a Promote command performed in a dynamic stream (not a 
workspace) activates just the transaction-level integration, not the change-package-level integration.

Transaction-Level Integration
between AccuRev and AccuWork
There are two similar, but separate facilities that integrate AccuRev's configuration management 
functionality with its issue management (AccuWork) functionality. The one described in this topic a 
particular issue-record field as the point of integration. The other (Change-Package-Level Integration 
between AccuRev and AccuWork on page 344) uses change packages as the point of integration. Both 
integrations record information about the Promote transaction in a user-specified AccuWork issue record.

The integration between configuration management and issue management at the transaction level records 
the number of each promote transaction in a particular field of a user-specified issue record.
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Enabling the Integration
The transaction-level integration is enabled on a depot-by-depot basis, by setting the depot's pre-promote-
trig trigger. For example:

accurev mktrig -p kestrel pre-promote-trig client_dispatch_promote
Note that "client_dispatch_promote" is simply a keyword, not the name of a script file. The integration is 
implemented by two cooperating routines, one built into the AccuRev client software, one built into the 
AccuRev server software.

Triggering the Integration
Once the integration is enabled for a depot, it is activated whenever a user executes the Promote command 
in any workspace or dynamic stream:

1. The depot's default query, as defined on the Queries tab (Issues > Queries), is executed and the results 
are displayed to the user.

Note: If you have enabled the use of third-party issue tracking system (ITS) keys in the AccuWork 
schema, the Select Issue (Change Package) dialog displays additional controls that let you specify 
whether you want to use AccuWork issue numbers or third-party keys when selecting issues to 
promote against. See the section “Using Third-Party Keys in the AccuRev GUI” in the AccuRev® 
Technical Notes for more information.

2. The user selects one of the issue records. Note that if no default query is defined for the depot, the user 
is prompted to type an issue record number.

3. The Promote command completes its work, propagating the versions to the backing stream.

4. The Promote transaction number is recorded in the affectedFiles field of the selected issue record. 
(This change to the issue record is, itself, recorded as a transaction, of kind dispatch.)

If the user enters "0" or makes a blank entry, the Promote command completes but no change is made to 
any issue record. This provides a way for the user to bypass the integration.

Over time, the affectedFiles field of a given issue record can accumulate a SPACE-separated list of 
Promote transaction numbers.

Implementation and Customization of the Transaction-Level 
Integration
When the transaction-level integration is activated, processing takes place on both the AccuRev client 
machine and the AccuRev server machine:
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• The client-side processing -- querying the AccuWork issues database and prompting the user to specify 
an issue record -- is structured as a pre-promote-trig trigger routine built into the AccuRev client 
software.

• The server-side processing -- updating of the AccuWork issue record -- is structured as a server-post-
promote-trig trigger routine built into the AccuRev server software.

You enable the integration by setting the pre-promote-trig trigger with the "client_dispatch_promote" 
keyword, as described above. You don't need to explicitly set a server-post-promote-trig trigger script. If 
you do, the script runs instead of -- not in addition to -- the server-side built-in routine.

In most cases, you'll want to avoid setting a server-post-promote-trig trigger script, just letting the built-in 
routines do their work. But suppose that after a Promote , you want the server machine to perform 
operations in addition to those defined in the transaction-level integration -- for example, updating 
reference trees and sending email messages. In such cases:

1. Create a script that performs the server-side part of the transaction-level integration, along with the 
desired additional processing. Start with the sample script server_dispatch_promote_custom.pl, which 
is located in the examples/dispatch subdirectory of the AccuRev installation directory.

2. Place the script in the AccuRev bin directory.

3. Use a mktrig command to make the script the depot's server-post-promote-trig trigger script.

Further customizations of the transaction-level integration are possible. For example, you might want the 
user to be able to specify several issue records, not just one. Or you might want to link promote commands 
in one depot with the AccuWork issues database in another depot. Or you might want to update an issue 
record field other than affectedFiles. In such cases, you'll want to dispense with the built-in 
"client_dispatch_promote" routines altogether:

1. Start with the sample script client_dispatch_promote_custom.pl (in the examples/dispatch 
subdirectory), and create your own script for use as a pre-promote-trig script to execute on the client.

2. As described above, start with the sample script server_dispatch_promote_custom.pl (in the examples/
dispatch subdirectory), and create your own script for use as a server-post-promote-trig script to 
execute on the server.

If Both Integrations are Enabled
Both the change-package-level and transaction-level integrations can be enabled for a given depot at the 
same time. In this case, a user performing a Promote command in a workspace is prompted to specify an 
issue record just once, not twice. The prompting for an issue record by the change-package-level 
integration takes place as usual. That issue record is then updated by both integrations.

Note that even if both integrations are enabled, a Promote command performed in a dynamic stream (not a 
workspace) activates just the transaction-level integration, not the change-package-level integration.
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C. Support and Troubleshooting

Customer Support Notes
To assist in a speedy resolution of problems with AccuRev usage or performance, AccuRev Customer 
Support personnel may ask you to provide data that you may not be accustomed to gathering on a day-to-
day basis.  The most frequently requested items are listed below, with instructions on how to gather the 
data. In your initial e-mail communication with Customer Support, please include the data items that you 
know (or suspect) are related to your specific issue.

Metadata collection

UNIX or Linux
1. Run the accurev backup command. This command will back up your metadata into the AccuRev 

 site_slice/backup directory. 

2. Use accurev show slices to find the location of the relevant depot directory (slice).

3. Stop the AccuRev Server.

4. tar your site_slice directory (including the backed-up metadata from step 1). Example:

cd /opt/accurev/storage/site_slice

tar -cvf ~/site_slice.tar . 

Remember to include the dot '.' at the end of the tar command.

5. tar the relevant depot directory (slice), but exclude the data subtree. (The data subtree contains the 
content of the files you have placed into AccuRev source control;  please do not send it to us!) 
Example:

cd /opt/accurev/storage/depots/ACME

tar -cvf ~/ACME.tar --exclude data . 
6. Compress the  .tar files using gzip. Example:

gzip ~/site_slice.tar ~/ACME.tar
7. Start the AccuRev Server.

8. Send the gzipped files (.tar.gz suffix) to Customer Support. We recommend using FTP rather than 
email, since the files may be too large for your outgoing email server. Please contact sup-
port@accurev.com to obtain a username and password for our FTP server.

Windows
1. Run the accurev backup command. This command will back up your metadata into the AccuRev 

site_slice/backup directory. 

2. Use accurev show slices to find the location of the relevant depot directory (slice).

3. Stop the AccuRev Server.
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4. Create a ZIP archive of the entire site_slice directory (including the backed-up metadata from step 1). 
Typically, it is C:\Program Files\AccuRev\storage\site_slice.

5. Create a ZIP archive of the relevant depot directory (slice). Typically, it's a subdirectory of C:\Program 
Files\AccuRev\storage\depots. Remove the data subtree from the ZIP archive. (The data subtree con-
tains the content of the files you have placed into AccuRev source control;  please do not send it 
to us!)

6. Start the AccuRev Server.

7. Send the ZIP files to Customer Support. We recommend using FTP rather than email, since the files 
may be too large for your outgoing email server. Please contact support@accurev.com to obtain a 
username and password for our FTP server.

Database inconsistencies
Gather the following information to begin troubleshooting the issue:

1. What changed in the environment? Power failure? Hardware failure?

2. What are the hardware specs on the AccuRev Server machine?

3. What is the AccuRev version on the AccuRev Server machine?

4. Get output of accurev info on the AccuRev Server machine.

5. Copy (ZIP or tar file) all AccuRev Server logs, located in subdirectory .../storage/site_slice/logs. 
Search for any messages that might be the cause of your issue: disk failure, power outage, etc.

6. Copy all operating system logs (location varies from OS to OS).

7. Stop the AccuRev Server.

8. Get output of maintain dbcheck. 

9. Start the AccuRev Server.

10. Gather AccuRev metadata.

Running the AccuRev GUI in debug mode
If you experience your problem while running the AccuRev GUI, then running the GUI in Java debug 
mode can help diagnose and further troubleshoot your problem. Running in debug mode is also useful for 
monitoring the commands that the GUI sends to the AccuRev Server. This can help with scripting efforts, 
for example:

# Windows example - run the following commands in a Command Prompt window

cd C:\Program Files\AccuRev\bin

java -Daccurev.debug.acapi -cp "oro.jar;xercesImpl.jar;xml-
apis.jar;fw.jar" fw.MainApp

# UNIX/Linux example - save and run the following shell script

#!/bin/sh

acbin=/opt/accurev/bin

acjre=/opt/accurev/jre/bin/java

cd $acbin
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$acjre -Daccurev.debug.acapi -Daccurev.debug.env -classpath 
"oro.jar:xercesImpl.jar:xml-apis.jar:fw.jar" fw.MainApp

Note that if you are running AccuRev 3.7 or earlier, the class path specified in the command should be 
"oro.jar, xerces.jar, fw.jar". If AccuRev is not installed in the standard location, you will also need to 
specify the correct path in your commands.

User authentication problems
You can diagnose authentication problems with the accurev secinfo command:

accurev secinfo
The output is one of three keywords: anyuser, authuser, or notauth.

anyuser

The user is allowed to perform operations on streams except where permissions require an 
authenticated user.

authuser

The user is considered authenticated. 
notauth

The user is not authenticated.
For more information on the accurev secinfo command, see the AccuRev CLI User's Guide.

Getting AccuRev Server and client version information
How can you get the version information about the AccuRev Server without having to log into the server 
machine? You can perform either of the following operations on any AccuRev client machine:

• To get the integer version number of the AccuRev server and client software:

> accurev info -v
...
client_ver:    58
...
server_ver:    58

 ...
• To get the major/minor/patch version numbers of the AccuRev Server, use the accurev xml command:

1. Create a file (say, ver.xml), containing this very short XML document:

<serverInfo/>
2. Submit this file as an argument to the xml command:

accurev xml -l ver.xml
The command output in this format:

<serverInfo>
  <serverVersion
    major="4"
    minor="7"
    patch="2"/>
  <handleCount>10</handleCount>
</serverInfo>

This example indicates that the AccuRev Server is Version 4.7.2.
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Integration issues
If you are reporting a problem with an AccuRev integration with a third-party IDE, send to Customer 
Support:

1. The name and version number of the IDE software.

2. The steps required to reproduce the problem. Be sure to include the type of project you're working with 
in the IDE and the location of the AccuRev workspace you're accessing through the IDE.

3. The version of AccuRev you are using.

4. (if applicable) The version of the AccuBridge integration you are using.

AccuRev license issues
Send to Customer Support copies of:

• The acserver.log file (in .../storage/site_slice/logs).

• The license file, accurev.lic or keys.txt (in .../storage/site_slice). [NOTE: keys.txt is not supported as of 
AccuRev 5.4.]

• A screen shot of the error box or a copy of the error text.

• Output from accurev info, executed on the AccuRev Server machine.

• Output from accurev show users.

Potential AccuRev defects
Send to Customer Support:

• A screen shot of the error dialog or a copy of the error text.

• The steps required to reproduce the problem. Include the depot's stream structure, if it is relevant.

• The operating system version on the client machine

• Are multiple users or multiple machines (client vs. server) involved?

• Output from these commands:

accurev

accurev info -v

accurev show wspaces

accurev show streams

accurev show slices

accurev show depots

accurev diag
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Replication problems
Send to Customer Support:

• A copy of the acserver.cnf file from both the master server and  the replica server.

• A copy of the acserver.log file from both the master server and  the replica server.

• Output from this command (if the problem is performance-related):

accurev diag 

Performance problems
Send to Customer Support the answers to this questionnaire:

1. Has performance always been poor? If not, what changed in the environment?

2. What exactly was the user trying to do? Does the performance problem occur with other users, on 
different client machines?  Or is it a common issue on the same machine?

3. Does the operation actually finish? (A hang or lock-up can often be mistaken as performance 
problem.)

4. What are the AccuRev versions on the problem clients and server machines?

5. What are the hardware specs on the problem clients and server machines?

6. Is performance different in the AccuRev CLI and the AccuRev GUI?

7. Is the user's home directory on a remote disk? If so, consider moving the home directory so that it is on 
the machine where the AccuRev client software runs.

Send to Customer Support:

• Complete AccuRev server logs (in .../storage/site_slice/logs)

• Two samples of output from accurev diag, run on the AccuRev Server machine in the depot storage 
directory.

• Two samples of output from accurev diag, run on the client machine in the user's workspace directory.

• Output from accurev show triggers.

• The contents of the trigger script files with the names listed below, located anywhere under the storage 
directory on the AccuRev Server machine:

server_admin_trig

server_preop_trig
The filenames might include a suffix, such as .bat on Windows.

• The AccuRev Server task list.

Server task list
How do you create a listing of the AccuRev Servers currently active tasks (execution threads)? 

1. Create a file (say, tasks.xml), containing this very short XML document:

<tasklist/>
2. Submit this file as an argument to the xml command:
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accurev xml -l tasks.xml > tasklist.out
The contents of tasklist.out will resemble this example:

<tasklist>
  <task>
    <task_id>1299</task_id>
    <task_name>promote</task_name>
    <user>john</user>
    <host>192.168.89.222</host>
    <status>1</status>
    <starttime>2006/07/25 14:42:49</starttime>
    <seconds_on_server>2</seconds_on_server>
    <depot_write_lock>true</depot_write_lock>
    <progress_counter
      counter="0"
      count="6"
      max_count="11"/>
    <progress_counter
      counter="1"
      count="200"
      max_count="900"/>
  </task>
  <task>
    <task_id>1300</task_id>
    <task_name>xml</task_name>
    <user>john</user>
    <host>192.168.89.222</host>
    <status>1</status>
    <starttime>2006/07/25 14:42:51</starttime>
    <seconds_on_server>0</seconds_on_server>
  </task>
</tasklist>

If you are not seeing an element...
If you cannot see an element that you believe that exists, there is a good chance that your AccuRev 
administrator has set element-level security using the eacl command, and you are being denied access to 
the element (or its container directory). For more information about EACLs and their behavior, see 
Element ACLs (EACLs) on page 262.

If you perform an Update, and the version displayed in the File Browser is correct but the content of the 
file does not appear to have been updated, this is typically due to a timestamp problem. It usually occurs 
when a file is changed outside of the workspace and then copied back in. The timestamp of the file that was 
dropped back into the workspace has a date and time stamp older than the date and time stamp of the file in 
the workspace. To update the file, temporarily uncheck Timestamp Optimization and perform the Update 
again. For more information, see “Validity of Traditional Timestamp Optimization” in the AccuRev 
Administrator’s Guide for more information.

Logging
Two types of logging are available in the AccuRev AccuRev GUI:

• The Logs tab 

• The accurev.log log file

This section describes logging features in the AccuRev GUI and how to use them. Logging is also 
available for the AccuRev Server. See Server Logging on page 14 in the AccuRev Administrator’s Guide 
for more information.

Note: Logging in the Logs tab and in the accurev.log are independent. Settings for the accurev.log file 
have no effect on the information displayed on the Logs tab, for example.
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The Logs Tab
The Logs tab provides access to command logs created during the current GUI session by these 
commands:

• Update and Update Preview

• Populate

• commands that change include/exclude rules

AccuRev creates these logs automatically, and deletes them when you close the AccuRev GUI.

Opening a Logs Tab
Choose View > Logs from the GUI main menu.

Logs Tab Layout
The Logs tab contains a table with Operation, Stream, and Date columns:

• Operation - The command that created the log: Update, Update Preview, Populate, Include, 
Exclude, Clear.

• Stream - The workspace or stream in which the operation took place.

• Date - A timestamp indicating when the operation took place.

Working in a Logs Tab
You can display, save and delete individual logs, using these commands:

• View - Display the contents of the selected log in a text editor window. You can use environment 
variable AC_EDITOR_GUI or EDITOR to control which text editor gets invoked. If neither variable 
is set, AccuRev selects a program provided by the operating system. 

• Save As - Copy the selected log to another location. 

• Delete - Remove the log file from disk storage (and from this table). Logs are stored in temporary 
files (for example, C:\Documents and Settings\jjp\Local Settings\Temp\log3382.tmp). These files are 
removed automatically at the end of the GUI session.

The accurev.log File
AccuRev records all operations performed in the AccuRev GUI in the accurev.log file on a daily basis; if 
you stop and start AccuRev multiple times during the same calendar day, the existing log is updated. The 
accurev.log file for a given day is archived upon creation of the first log message on the following day. To 
create the archive log file, AccuRev renames the daily log file with a yyyy-mm-dd timestamp; the archive 
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log file for June 1, 2012 would be named accurev.2012-06-01.log, for example. The daily log file, 
accurev.log, is always used to record activity for the current day.

By default, AccuRev stores archive log files for 10 days; archive log files older than 10 days are deleted. 
Both the daily log file and archive log file are written to the \log directory where you installed the AccuRev 
client (c:\Program Files (x86)\AccuRev\log, for example). 

Example. Imagine you started AccuRev on June 1, 2012 and used it every day for a couple of weeks. At 
9 a.m. on June 2, you performed a keep of several modified files; AccuRev creates a message in the 
accurev.log file, and creates the archive log file for the activity for June 1 (\log\accurev.2012-06-01.log). 
Archive log files would be created each day in this fashion (accurev.2012-06-02.log would be created 
sometime on June 3, accurev.2012-06-03.log sometime on June 4, and so on). Upon the first logged event 
on June 12, however, two things would occur:

• An archive log file for June 11 activity would be created (\log\accurev.2012-06-11.log) as usual.

• The archive log file for June 1, 2012-06-01.log, would be deleted because it is older than 10 days.

You can configure the number of days you want to keep archive log files and other aspects of the log. See 
Configuring Logging on page 359 for more information.

Sample Log
Following is a sample of the output that is written to the daily log file:

15:04:07.783 [AWT-EventQueue-0] DEBUG [RunProcess.java:341] fw.process.RunProcess - 
ACAPI: [xml]  'C:\Program Files (x86)\AccuRev\bin\accurev.exe' 'show' '-p' 'depot1' 
'-fxg' '-r' '-l' 
'C:\Users\jhollows\AppData\Local\Temp\roots3557908586359241917.tmp' 'streams'

15:04:08.192 [AWT-EventQueue-0] DEBUG [RunProcess.java:341] fw.process.RunProcess - 
ACAPI: [xml]  'C:\Program Files (x86)\AccuRev\bin\accurev.exe' 'show' '-fix' 
'users'

15:04:08.515 [AWT-EventQueue-0] DEBUG [RunProcess.java:341] fw.process.RunProcess - 
ACAPI: [xml]  'C:\Program Files (x86)\AccuRev\bin\accurev.exe' 'show' '-fx' 
'wspaces'

15:04:08.890 [AWT-EventQueue-0] DEBUG [RunProcess.java:341] fw.process.RunProcess - 
ACAPI: [xml]  'C:\Program Files (x86)\AccuRev\bin\accurev.exe' 'show' '-fx' 'locks'

15:04:09.615 [AWT-EventQueue-0] DEBUG [RunProcess.java:341] fw.process.RunProcess - 
ACAPI:  'C:\Program Files (x86)\AccuRev\bin\accurev.exe' 'xml' '-l' 
'C:\Users\jhollows\AppData\Local\Temp\kandoFinding8147860611326777358.tmp'

Logging Levels
AccuRev supports several logging levels, as summarized in the following table:

Level Description

TRACE Includes TRACE, DEBUG, INFO, WARN, and ERROR.

DEBUG Includes DEBUG, INFO, WARN, and ERROR.

INFO Includes INFO, WARN, and ERROR. INFO is the logging level default.

WARN Includes WARN and ERROR.

ERROR Includes only ERROR.

OFF Turns off logging.
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To change the logging level, modify the level= attribute of the <root> element in the logback.xml file. 
See Configuring Logging on page 359 for more information.

Configuring Logging
The logback.xml file contains several editable settings that allow you to configure logging in the 
accurev.log file as summarized in the following table:

NOTE: You should not change other values in the logback.xml file.

To change a setting in the logback.xml file:

1. Open the logback.xml file. This file is in the \bin directory where you installed the AccuRev client.

2. Find the XML element tag whose value or attribute you need to change.

3. Save the logback.xml file. 

Changes to logging settings take effect after a minute or two; you do not have to restart AccuRev.

Additional Information
AccuRev uses logback third-party software to implement logging. You can find more information on 
logback, including logback user documentation, here: http://logback.qos.ch.

Configuring a Web Browser to View Help Topics
The AccuRev help system is JavaScript-based to provide advanced search and navigation capabilities. 
Invoking help automatically launches a web browser , or opens a new tab in an existing web browser 
window, depending on which browser you use. Any JavaScript-enabled web browser is capable of 
displaying AccuRev GUI help topics, although you may need to adjust some security settings in more 
recent browser releases (see below). 

By default, AccuRev tries to launch the operating system’s default web browser. However, you can tell 
AccuRev which browser to launch by setting a preference that specifies the complete pathname of the web 
browser you which to use. Each user can do this either in the GUI or through the Command Line Interface 
(CLI).

In the GUI, click Tools > Preferences and enter the full pathname of the browser in the Online Help 
Browser field on the General tab:

If You Want to ... Edit This XML Element Tag Comments

Change the number of days 
AccuRev stores archive log files

<maxHistory> By default, AccuRev stores archive 
log files for 10 days.

Change the logging level <root level="INFO"> The default value for the level= 
attribute is "INFO". See Logging 
Levels on page 358 for more 
information.

Turn off logging altogether <root level="INFO"> Set the value of the level= attribute 
to "OFF".

http://logback.qos.ch
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Or, use the setpref command from the CLI. For example:

accurev setpref AC_BROWSER "C:\Program Files\Mozilla Firefox\firefox.exe"

Either method updates the AC_BROWSER setting in preferences.xml in the .accurev subdirectory of the 
user’s home directory. 

Note: If you are upgrading from AccuRev 4.9 and are having difficulty getting the Help to work, 
particularly on a 64-bit Windows system, check to see if you have an old browser preference set. If so, 
clear out this setting and let AccuRev use its default value to get going.
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Notes on Internet Explorer

Allowing "Active Content" with Internet Explorer 7
The first time you use AccuRev Help with MS Internet Explorer, you may get a pop-up blocker. We have 
placed instructions on the default screen that appears with the pop-up blocker to guide you through the 
Advanced Settings of MSIE that will allow it to work with AccuRev help. These instructions are:

1. In MSIE, click Tools > Internet Options.

2. In the Internet Options window, click the Advanced tab.

3. Scroll down to the Security settings, and ensure that Allow active content to run in files on My 
Computer is checked. 

4. Exit and restart MSIE. 

Notes on Google Chrome
Recent Chrome browsers have introduced a new security model which by default prevents them from 
working with Javascript-based web content residing on a local file system rather than on a server (see 
http://code.google.com/p/chromium/issues/detail?id=47416). This has caused several 
companies’ help systems to stop working with these browsers. 

Possible workarounds include:

• rolling back to an older version of Chrome

• using a different browser

• disabling the security feature in the AccuRev preferences

• disabling the security feature system-wide

Google has provided a command line switch to disable this new security feature. You can try disabling this 
feature just for AccuRev Help, by using the following procedure:

1. In the AccuRev GUI, go to Tools, Preferences

2. In the On-line Help Browser field, specify the start-up command line for Chrome with the “--allow-
file-access-from-files” argument (Windows example shown):
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"C:\Documents and Settings\<user>\Local Settings\Application 
Data\Google\Chrome\Application\chrome.exe" --allow-file-access-from-files "%1" 

If this does not work for your installation, another option is to try using this switch as the 
default for all instance of Chrome on your system. The following example shows how to use 
this fix in Windows. Adjust appropriately for other operating systems. The following 
procedure assumes that you have Chrome set as your default .htm/.html browser:

1. Open Windows Explorer.

2. Navigate to Tools => Folder Options => File Types

3. Select "HTM" or "HTML", then click Advanced. 

4. Select Open, then click Edit...

5. In the "Application used to perform action:" field, you should see a line similar to:

"C:\Documents and Settings\<user>\Local Settings\Application 
Data\Google\Chrome\Application\chrome.exe" -- "%1" 

6. Replace the empty "--" with "--allow-file-access-from-files":

"C:\Documents and Settings\<user>\Local Settings\Application 
Data\Google\Chrome\Application\chrome.exe" --allow-file-access-from-files "%1" 

7. Click OK, OK, and Close to save your changes and exit out of the dialogs.

Of course, if this line has already been customized at your site, you will need to adjust the above 
instructions as needed.

Also, note that implementing this fix will disable a security change introduced with Chrome, so the 
security policies of some organizations may prohibit them from doing this.
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